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Preface

Since the TPWorks13902_20211130 version, the mView software and the
TPWorks software have been combined into one, that is, the HMI of TK and TP
use the [TPWorks] software uniformly (download website: "TPWorks14001").
Precautions:

1. The project file suffix is unified as .tpf;

2. Open the previous TK (mView) project, click Save and it will be
automatically saved as a project file with a .tpf suffix.

Vi
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Chapter 1 TPWorks software introduction

1.1 How to install TPWorks software

(Please go to the official website :WWW.COOLMAY.COM to download the
latest version)

This chapter will detaily introduce the installation process of TPWorks
software.
mHardware requirements

The basic hardware requirements for installing TPWorks editing software
are as follows:

1. Personal computer host: It is recommended to use a CPU of 80486 or

higher.

2. Memory: It is recommended to use more than 128MB RAM to expand
the memory.

Hard disk: The hard disk must have more than 100MB of space.

Display: General VGA or SVGA display card.

Mouse: Use a Windows compatible mouse.

. Printer: Use a Windows compatible printer.

Before you install it, please check whether the computer hardware is as
above or higher. In order to avoid problems with hardware incompatibility,
please use the recommended specifications as much as possible. If you have
any questions, please contact our customer service.

m Software source

You can enter our company's website WWW.COOLMAY.COM to obtain
the latest version of the software.

m Installation steps (take the simplified Chinese version of TPWorks as an
example), note that "TPWorks ***" software version is subject to the official
website.

Select TPWorks 13802.exe in the installer window to start the installer and
start the installation;
eSet the storage path of the installation file, select the default, or enter the
address, or click the [Browse ...] button to select the address, and then click
the [Next] button;

o0k w
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i3 Setup - TPWaorks version 1.38.02 = et

Select Destination Location
Where should TPWorks be installed?

Setup will install TPWorks into the following folder.

To continue, dick Mext, If you would like to select a different folder, dick Browse.,

|C:'|,Pr-:|gr.am Files (x86)\CMTP\TPWorks 1.33.03] Browse...

At least 227.4 MB of free disk space is required.

eSet the name of the saved folder. It is recommended to select the default and
click the [Next] button directly.

i3 Setup - TPWaorks version 1,38.02 o =

Select Start Menu Folder
Where should Setup place the program's shartouts?

|J Setup will create the program's shortcuts in the following Start Menu folder.,
[~ =]

To continue, dick Mext. If you would like to select a different folder, dick Browse,

|TF"|.fu'|:|rks Browse...

eChoose whether to create a desktop shortcut icon, and then click the [Next]
button.
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i Setup - TPWaorks version 1.38.02 = X

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing TPWorks,
then dick Mext.

Additional shortcuts;
Create a desktop shortout

eConfirm the installation path and other installation information, and then click
the [Install] button to install.

i3 Setup - TPWorks version 1.38.02 — *

Ready to Install
Setup is now ready to beqin installing TPWorks on your computer.,

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Destination location:
C:'\Program Files (x86)\CMTPYTPWorks 1,38.02

Start Menu folder;
TPWorks

Additional tasks:
Additional shortcuts:
Create a desktop shortout

< Back Install Cancel

eThe installation process is shown below:
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i3 Setup - TPWorks version 1.38.02 == *

Installing
Please wait while Setup installs TPWorks on your computer,

Extracting files...
C:\Program Files (x88)\CMTPYTPWarks 1. 38.02'picture‘\Button\321.BMP

Cancel

oClick [Next] to install the driver wizard

Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work,

S

To continue, click Mext.

Bact Mewst = Cancel

eThe driver installation is completed
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Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

5

The drivers were successfully installed on this computer.

fou can now connect your device to this computer.  vour device
came with instructions, please read them first.

Driver Name Status

»' STMicroelectronics (usb... Ready to use

Bat Finish Cancel

eFinally, click [Finish] to complete the installation.

g[@ Setup - mView version 1.38.02

Completing the mView Setup
Wizard

Setup has finished installing myiew on your computer. The
application may be launched by selecting the installed
shortouts,

Click Finish to exit Setup,

Launch mView

1.2 How to open TPWorks software

After the installation of TPWorks software is completed, a shortcut will be
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placed on the desktop , At the same time, the corresponding
TPWorks program group has been added to the Windows start menu:

. TPWorks

. T TPWorks 1.38.02
Ry

Choose one of the above two methods to open the TPWorks
programming software. When the application is started, a startup window will
pop up, as shown in the following figure. After the software is opened, it will be
checked according to the menu bar [View]->[Option...]->[File]->Program start
automatically open file, to determine whether to start the last project file when
the software is opened, or not to open any file.

1.3 Introduction to the TPWorks software interface

TPWorks editing interface layout:
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P8 mView : [CAUsers\EN\Desktop\ENGLIS~ TNALARM-~1.VXF] —==mp. Title bar - o X
File Edit View Project HMI(M) Component Tool Window Help __.‘.,Menu bar
BE~d| -~ Y By R T i | g ~———*Slandard toolbar

Zlh&ho bl _m'?am'Q@. B é'“':- o-¢maAGHEE w-I
Graphic Component | Static Component | Button  Display | Edit |
@ Emmem ~HE H e LBt bend
D02EREEDES Engish (United States) -
|
Scene Management = ﬂﬁ:Cmrent Alarm Scene [100%]
2R OBEOO DS | Y Index | Alarm Time [Message

=& Intt Scene Group ~
1: Alarm Show Scene

: Alrm Screen?

: Shield Secen

: Alarm Record Scene

+ Alarm Count

+ Current Alarm Scene

© Alarm Point1

: Alarm Point2

: Alarm Point3

ﬂ 10 : Current ARrm

=8 System defauft group
65000 : Value input dislogue box

-3 65001 : String input dislogue box
[ 65002 : Password input dizlogue box

- 65003 : Password accurately message
[ 65004 : Password error message

aa

ooooooo

B3 65005 : System setting screen
(3] 65006 : System message screen
3 65007 : HEX input: dialogue box
-8 65010 : Download i e e R
B €511 + Vel ondne S i e HeRcunhahas R b
- 65012 : USB Download | Cpersgtis H#ts Flow gezas —— L Now: HEESHEHEHEN D SHEE G

e anBliiiat Cycle:#ttt# ## 5 B-Press: 4ttt 1t prop spmpesan N DiETimel g sgs

E1 65101 : Calendar
~B 5102 : Backals Llﬂk Management . ||| Alarm Show Scene l | ‘ Shield Secen

Preview : 25%

a
SceneManagement— Tag Management

Scene Edit

eTitle bar: Displays the currently opened project path and file name, window
number, and window name.

eMenu bar: A menu that displays various commands of View. These menus
are pull-down menus.

eStandard toolbar: Shortcut buttons for placing some commands.
Corresponding buttons and editing tools for displaying files, editing, printing
and other functions.

eDesign components: Command buttons for component objects.

eScreen management: The management window of the screen used by the
project.

eCommunication management: engineering designers to manage, set up a
window to communicate with PLC or other serial devices.

el abel management: Set labels for system variables and external variables to
facilitate users to quickly find the corresponding variables.

eStatus bar: Displays the current operation status, human-machine interface
parameters, and communication equipment.
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Chapter 2 Introduction of TPWorks Software Running

Menu

File Edit View Project HMIM]) Compornent Tool Window Help

2.1 File menu

Use the mouse to directly click [File], or use the keyboard to press [ALT] +
[F], the [File] drop-down menu appears, as shown in Figure 2-1.1. In order to
facilitate users to quickly select, shortcut icons are also provided in the toolbar,
as shown in Figure 2-1.2.

"File Edit View Project
| [ New File ... Ctrl+M
= OpenFile.. Cirl+0
& save File Ctrl+5
Save As File
Close File

Import 4
Export »

Exit Alt+F4
2-1.1

(13 €23 (3)
b= ~H

2-1.2
File toolbar
(1)|New File...
(2)|Open File...
(3)|Save File

2.1.1 New File...

To create a new project, you can directly click [New File] under [File] menu,
Or click the icon [ in the toolbar, Or use the hot key Ctrl + N set by the
system. The dialog box shown below is displayed:
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Mew File 2
Title: |Undefined
Model: | TKB070FH |

7" Color TFT LCD,65535 Colors, 800%480 pixels,
COM1BCOM2(R5232/R5422/R5485),RTLC.

Direction: | Horizontal |

Description: | =

v Program Compression

o 0K X cancel |

Title: Enter the name of the new project;

Model: select the model of the human-machine interface (HMI);

Direction: select whether the editing screen is displayed horizontally or
vertically;

Description: Enter a help description for the newly created project, or
choose not to enter it.

After completing the project-related information input, click the [OK] button
to enter the communication information setting dialog box, as shown in the
following figure. For specific settings, please refer to section 2.4.2
Communication Management.
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EE ) |

—Protocol

Parity:
Delay:

Protocol:

Mitsubishi FX3U Series

Controllor:

! Model

FX3L Series

Electric:

Buad Rate: igﬁﬂﬂ

B

]

B

[T Multi-5tation Smart Link

Data Bit:
Stop Bit:
TimeCQut:

I Auto Detect(RS232/R5422/R5485)

| 7Bits

| 1Bit

]lsec

Retry Count ]Repeat 2

Lefledledle] Lo

v OK

X Cancel |

2.1.2 Open File...

To open an existing file, you can directly click [Open File...] under [File]
menu, Or click the icon E2 in the toolbar, Or use the hot key Ctrl + O set by the
system. The dialog box shown below is displayed:

iﬁh

37

L

EHOEIT: I | TPWorks

s eBcEr

e

E=iic]

Fuh

2020-06-24 18:02

TPWorks Editor File

ﬁjﬁf%g g B TPE043C.b01.tpf
B

TP5070C.b01 tpf

2020-06-24 18:29
2020-06-24 18:06
2020-06-24 18:08

TPWorks Editor File
TPWorks Editor File
TPWorks Editor File

>

HiHE T

AN

lTPWor]{s File (*. tpf)

| o |
R B |

Select the file with the suffix vxf that needs to be opened, press the [Open]
button, or double-click the selected project file with the mouse.
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2.1.3 Save File

To save the currently edited project to disk, you can directly click [Save
File] under [File] menu, Or click the icon Ein the toolbar, Or use the hot key
Ctrl + S set by the system.

B save s st
Save in: | TEWorks L] & Ev
S:IIV Name - Date modified Type Size
5| 2020-06-24 18:02 TPWorks Editor File
Quick access ETP6M3C.b01 pf i ;
B TPa043Ctpf 2020-06-24 18:29 TPWorks Editor File
ﬁ B TP6070C.b01.tpf ) 2020-06-24 18:06 TPWorks Editor File
Desktop B Tre070Ctpf 2020-06-24 18:08 TPWaorks Editor File
= |
Libraries
This PC
Network
File name: |TESt ﬂ Save |
Save astype: |TP'|'|'orks File (% tpf) __VJ i

When saving a new project, the save vxf file box as shown above will pop
up, enter the name of the project you want to save in the file name field, and
click the [Save] button. If the project has already been saved, pressing [Save]
will not display any dialog box, but only save the latest information of the
current project.

2.1.4 Save As File

Save the currently edited screen data to another specified file name on
the disk. This item can only be selected by [Save As File] under [File] Whether
it is @ new project or an old project, the Save New File dialog box will pop up:

11



m Save As

Savein: | TP orks

*

Quick access

Desktop
= |
Libraries

L

This PC

2

Network

=
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«= [E % E

Mame Date modified Type Size
B TP6043C b0 tpf 2020-06-24 18:02 TPWaorks Editor File
ETPGD‘BC-tpf 2020-06-24 18:29 TPWorks Editor File

B TP6070C.b01.4pf 2020-06-24 18:06 TPWorks Editor File

G TP6070C tpf 2020-06-24 18:08 TPWorks Editor File

File name: |

Saveastype:  |TPWorks File (& tpf)

T
T o |

Cancel

After entering the new project name, click [Save] to save the project as a
new project file.

2.1.5 Close File

Close the currently edited project file. This item can only be selected by
[Close File] under [File]. If the project file is modified, the following dialog box
will pop up to save the modified project file.

Close File

(?)

Data change, Save?

Yas Mo

|

Cancel

it

Click the [Yes ] button to save the newly modified file, and then exit the
current project file;
Click the [No ] button to save the newly modified file, and then exit the
current project file;
Click the [Cancel] button to exit the dialog box and do nothing with the
newly modified file;
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2.1.6 Import

|File Edit View Project HMI(M) Component Tool

[3 NewFile.. Cti+N pu ~ | ¥ Bz B || /s ~ 2
= OpenFile.. Ctrl+0Q
E - :::. 5 - I:d}l 1
& save File Cirl+S | i =
Save As File Component | Button  Display | Edit
Close File I@m|mgg||ﬁ
impor [
Export %? Tag
Exit Aft+Ed 5] ImpeortSound ...
- .ﬂ Importilarm ..

e 22 - & : : S
_u TKB070FH @ Keyboard Define ..,
Data Sync ...
=- % Init Scene Gro 2 ¥
o E 2 : Size Tyr ﬁ Data Record ...

-~ 1 : Scenel % Import Data Schedule ..
- - 3 : scenel | B@ ImportDictionary ..
El % System 'jEfT:'U"C ImportRecipe ...

B 65000 : Va ?B% Translate text import

- RRNNT » S,

2.1.7 Export

|File Edit View Project HMI(M) Component Tool

[A NewFile.. Ctri+N f« ~| ¥ Bz B || /s ~ &
= OpenFile.. Ctrl+0
E AN i @l |

& save File Ctrl+S | :f B

Save As File Component | Button  Display | Edit

Close File O E-E = B e

Import W NN M ey
BT = s

Exit Alt+F4 & Tag .

: (EF ExportScund ...

Ig® Exportilarm ..
=9 TK6070FH S o Define
=B Init Scene Gro R R

----- B3 2: Size Typ
..... B 1: Scened ﬁ Data Record ...

----- B 2 : Scenel | @ Export Data Schedule ...
=Ty System default g ExportDictionary .

""" 55 : !‘
: ':II:”:I N E}(pﬂrtHECIFI'
""" ] 1 . St' I LY'el
. 6300 | REQISI:E Define ...

----- 65002 : Pas g
..... 65003 - Pat 39 Translate text export

w3 Data Sync ..
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2.1.8 Exit

End the application and save the project, select the [Exit] option under the

menu [File], Or click the button in the main window. If the project has

changed, or has not been saved, the following dialog box will appear:

Cloze File i

19' Data change, Save?

Yes Mo ‘ Cancel

Click the [Yes ] button to save the newly modified file, and then close the
current software program;

Click the [No ] button to save the newly modified file, and then close the
current software program;

Click the [Cancel] button to exit the dialog box and do nothing with the
newly modified file;

2.2 Edit menu

Use the mouse to directly click [Edit], or use the keyboard to press [ALT] +
[E], the drop-down menu of [Edit] appears, as shown in Figure 2-2.1. In order
to facilitate users to quickly select, shortcut icons are also provided on the
toolbar, as shown in Figure 2-2.2.
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7 Undo

¥ Cut

Copy

| 3¢ Delete
Selectall

k5 Align

:E||I| Order

Setup

| I8 Group

1 Lock

Ctrl+Z

Ctrl+ X
Ctrl+ C

Ctrl+ Del
Ctrl+ 4

v v w v v

| ER Copy Screen Picture

Save to BMP ...

Add Repository ..

TP Series HMI Programming Manual

2-2.1
(1) (2 @E) B (7)) 8 (9) (10)(11)(12)(13)(14)(15)
== RSeS| EHE B T Fe
2-2.2
(1) |Undo [Ctrl+Z] (9) |Order
(2) |Redo [Shift+Ctrl+Z] (10) |Group
(3) |Cut [Ctrl+X] (11) |UnGroup
(4) |Copy [Ctrl+C] (12) |Lock
(5) |Paste [Ctrl+V] (13) |Propertie
(6) |Alig (14) [Same bevel
(7) |[Size (15) |Same font
(8) |Jog

2.2.1 Undo

To undo the last edited action, you can select the [Undo] option under
[Edit], Or click the icon ¥2 in the toolbar, Or use the hot key Ctrl + Z set by the

system.
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2.2.2 Redo

To restore the previous undo action, you can select the [Redo] option
under [Edit], Or click the icon &= in the toolbar, Or use the hot key shift + Ctrl +
Y set by the system.

2.2.3 Cut

Cut the selected components to paste in the new location. You can select
the [Cut] option under [Edit], Or click the icon & in the toolbar, Or use the hot
key Ctrl + X set by the system.

2.2.4 Copy

If the components used are the same, you can use the copy operation to
make the same components. You can select the [Copy] option under [Edit], Or
click the icon in the toolbar, Or use the hot key Ctrl + C set by the system.

2.2.5 Multi-Copy

Select a specific component to make multiple copies, you can select the
[Multi-Copy] option under [Edit], or use the hot key Ctrl + M set by the system.
After clicking, the selection box as shown below will appear:

1 Multi-Copy »
Multi-Copy e
Horizontal: | :j: Frce
Vertical: | __[ -
2 X v Inc by horizontaly
{ i 1
Horizontal space: |g - Inc by vertically
Vertical space: |g |- Offset: PP =
W OK X Cancel |

Multiple copy settings

Number of horizontal copies: Set the number of copies in the horizontal
direction.

Number of vertical copies: Set the number of copies in the vertical
direction.

Horizontal interval points: Set the distance between horizontal elements.

Vertical spacing points: Set the distance between vertical components.
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Component variable modification

Uncorrected: No processing is performed on the copied components.

Increasing in the horizontal direction: Set the order in which the device
reads the soft elements to increase horizontally and then vertically.

Vertical increment: set the order in which the device reads the device to
increase vertically first and then horizontally.

Address offset value: Set the number of increments of the device reading
device value.
@ Example of multiple copying: select the horizontal number = 2 and the

vertical number = 3 above the number of copies

-2 Multi-Copy X
C 0 rMulb-Copy 1 Var
: Horizontal: -
................... 2 = " Fix
................... Vertiml: 3 :¢

G - & Inc by horizontally
................... 'r‘-\. >

SR e Hnrizunmlspacelm e oy vty
oo veed paces g = Offset: i e

................... .,/ oK x Cancel |

@ Example of multiple copy: Click [OK] to complete multiple copy. The result is
shown below:

2.2.6 Paste

To insert the copied or cut components, you can select the [Paste] option
under [Edit], Or click the icon E& in the toolbar, Or use the hot key Ctrl + V set
by the system.
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2.2.7 Alignment

Select the components that need to be aligned, and there must be more
than two components. Click [Align] under [Edit], as shown below, Or click the

. = | .
icon |7 in the toolbar.

"Edit View Project HMI(M

% Undo Ctrl+Z
¥ Cut Ctrl+X
; Copy Ctrl+C
% Paste Ctrl+V
| ¥ Delete Ctrl+Del
| SelectAll Ctrl+ 4
Hj: Slze aF=: i Align horizontal centers

| o Align right edges

II|'z| Order ¥ L Center horizontally inwindow
Setup F | &f |_:: Space equally, horizontally
18] Group DE Align tops
| & 3G EE Align vertical centers
EIE Align bottoms

{97 Lock

T Center vertically in window

g 5! Space equally, vertically
|E? Copy Screen Picture

Save to BMP ...
Add Repository ...

In this example, select [Upper Edge Alignment]. This alignment method
uses the top edge of the reference object as the object alignment. As shown
below:

1: Align Type [100%] 1: Align Type [100%]

Before Align After Align
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2.2.8 Size

Select the components that need to be set with the same size. There must
be more than two components. Click [Size] under [Edit], as shown below, Or

click the icon ZE 7! in the toolbar.

Edit View Project HMI(M

7 Undo Ctrl+Z

& Cut Ctrl+X

Copy Ctrl+C

ﬁ Paste Chrl+V

| 3 Delete Ctrl+Del

i Selectall Ctrl+A

' Align |

| Clx EEEY i Sorne width

“ log ¥ LT same height

% Order 4 H; Same size

Setup k[ a

|

[} Group |

9 Lock !
- |
i
|

B Copy Screen Picture
Save to BMP ... |
Add Repository ... !

When selecting more than two graphic components, in order to speed up
the editing of the component size, you can use this alignment function to first
select the graphic component whose size you want to modify, and then select
which component is the main one. Then select [Same Width] or [Same Height]
or [Same Size]. As shown in the following figure [same width]:

2 : Size Type [100%] 21 Size Type [1003%4]

Before Set After Set
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2.2.9 Jog

Use this function to finely move the position of the selected component.
After selecting the component, click [Fine Adjustment] in the [Edit] menu as

shown below, Or click the icon * Ylin the toolbar, You can move the selected

component position up, down, left, and right in detail, or you can use the
keyboard up, down, left, and right keys (fine adjustment), or you can use Shift
+ keyboard up, down, left, and right keys (with a grid point) Main), Ctrl +
keyboard up, down, left, right button (change the selected component size
fine-tuning) for rapid movement and size adjustment.

Edit View Project HMI(M

% Undo Ctrl+Z
% Cut Ctrl+ X
Copy Ctrl+C
B2 Paste Ctrl+V
¥ Delete Ctrl+Del
SelectAll Ctrl+ A
k5 Align ,
LIT Size »
"l Order »|® Down
Setup P @ Left
E Group L Right
1 Lock

B Copy Screen Picture
Save to BMP ...
Add Repository ...

2.2.10 Order

After selecting the component, click [Sequence] in the [Edit] menu as

shown below, Or click the icon i1 g in the toolbar, When the components

overlap, the components can be moved to the upper layer, the next layer, the
uppermost layer, and the lowermost layer according to requirements.
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7 Undo Ctrl+Z
3 Cut Ctrl+X
Copy Ctrl+C
ﬁ Paste Ctri+V
| ¥ Delete Ctrl+Del
Selecthll Ctrl+A
"5 Align »
[ E: Size L4
+ Jog >

o Y s o e

Setup ¥ | By Bottom layer
w G Lh Bring Forward
e Q Send Baclkward
37 Lock

| Copy Screen Picture
Save to BMP ..,
Add Repository ...

2.2.11 Setup

TP Series HMI Programming Manual

Select the component components that need to be set with the same
border and the same font. There must be more than two components. Click
[Setup] under [Edit] as shown in the figure below. Or click €3 or FF icon in the
toolbar, You can set the border or font of multiple components to be the same
as the border or font of the selected reference component.
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Edit View Project HMI(M

7 Undo Ctrl+Z
| b Cut Ctrl+X

Copy Ctrl+1C

ﬁ Paste Ctrl+Y

| ¥ Delete Ctrl+Del
{ Selectall Ctrl+A

k5 Align ’

| g Size 4

“# Jog »

II|'z| Order L4

@ Someere
1% Group | B Same Font
87 Lock

B8 Copy Screen Picture
Save to EMP ...
Add Repository ...

2.2.12 Group / Ungroup

When selecting multiple components, when moving or copying, in order to
be able to edit quickly and easily. You can click [Group / Ungroup] under the

[Edit] menu, Or click flor Hicon in the toolbar.

To group multiple components into one component, namely [Group], you
can also use the hot key [G]. Select the previously assembled components
and click [Cancel Group] to separate them, or use the hot key [U].

2.2.13 Lock object / unlock object

After selecting one or more components, click [Lock Object] under the
[Edit] menu to fix the component. The fixed component cannot be moved and
its attributes cannot be modified. To release the setting, select the component
to be released and click [Lock Object] under the [Edit] menu again to release.

Orclick B or B icon in the toolbar to lock or unlock the component, you

can also use the hot key [L] to fix or cancel.
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2.2.14 Object properties

Since the object property window of each component is different, please
refer to the detailed description in the [Chapter 3 Components] chapter of this
manual.

2.2.15 Copy Screen Picture

Click [Copy Screen Picture] under the [Edit] menu to copy the current edit
screen window, as shown in the figure below. After copying, you can paste the
screen picture into drawing software or office software such as WORD to
facilitate file sort out.
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@ | B ™ @ = | Untitled - Paint - o X
e i e
¥ cut % arop ] NVOOOGA - Pouine: | = EEEEE EEEE
s OA K
o Bllew J0e & 3gests it = MICIFERES RRas W 9
% Anctater ¥ AR TS G R OOO - - | 2 O IEIE I ] cotors  paintse

Clipboard Image Tools Shapes Colors

“+ 556, 35T [ 10 1152 % 648px 100% (=) v @ .

2.2.16 Save to BMP

After selecting the component you want to save as a picture, click [Save to
BMP] under the [Edit] menu, a dialog box as shown in the figure below pops up,
select the save path, enter the name of the picture to be saved, and click [Save
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(S)] button to save the selected component as a picture.

2.2.17 Add Repository

This function puts the component into the component library. When using
it, you can open the component library and quickly select the component
according to the component setting classification and name in the component
library. After selecting any component, click [Edit]-> [Add Repository], the
following dialog box will pop up:

Add Repository >
Type:  |gtn3 -
Group: |1 ll
Mame: I21|
Descrt:rﬁl It
W
£ >
¥ 0K X cancel |

Type : Set the category of the component in the component library.
Group: Set the group of components in the category of the component
library.
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Name: Set the name of the component in the component library.

Description: Fill in the auxiliary description of the description component.
After the setting is completed, click the [OK] button, and the selected
component will enter the software component library, as shown in the following
figure:

Compaonent-

When in use, you can double-click the component directly in the
component library, which can save the details such as setting the appearance
font, which greatly improves the speed of program writing.

2.3 View

Use the mouse to directly click [View], or use the keyboard to press [ALT]
+ [V], the [View] drop-down menu appears, as shown in Figure 2-3.1. In order
to facilitate users to quickly select, shortcut icons are also provided in the
toolbar, as shown in Figure 2-3.2.

View Project HMIM) Cot
i Project Management *

Message
Repository F12
Component List F10

¥ Option(H) ...

Object Properties r
v |
Bl Scale L5

ToolBar r

2-3.1

(1) (2) (3) (4)(5)
v .8 B @ 8

2-3.2
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Project
Option
Scale
Zoom in
Zoom out

2.3.1 Project management

The project management window refers to the comprehensive display and
management of the screen and communication of the current editing project.
Click [Project Management] under the [View] menu, there are the following four
sub-options.

1. Scene: After clicking scene, a window for screen management will appear
on the left of the software (this window is also the default display window), or
directly click [Screen] in the lower left corner of the software. The picture
management window is shown in the figure below. The management window
is responsible for the organization and planning of all screens of the
man-machine interface. For details, refer to 4.1ScreenManagement.

File Edit View Project HMI(M) Compeonent Tool Window Help

DE-"d|-- b B @B £
E & & b mrfH-Qa ||[d-B~-¢ -8~ - BRAIDTRDE Y~

Grashic Companent | Static Component | Button  Dsplay |Edit |
| @@ meeoE |- 5 S 2% e B EYEEeD

P0RP2QEEQEee

Scene Management
; FEoaod v

=84 TK6070FH ~
B0 Intt Scene Group

B 2 : Size Type

B 1:5cene

B 3: Scenel

B0 Systern default group

B 65000 : Value input dialogue box

English (United States) hd

B 2 Size Type [100%)

[ 65001 : String input dialogue box
B 65002 : Password input dizlogue box
B 65003 : Password accurately message
B 65004 : Password eror message

B 65005 : System setting screen

B 65006 : System message screen

- 5007 : HEX input dizlogue box

-8 65010 : Download screen

-8 65011 : virtual on-ine:

-8 65012 : USB Downioad

=0 System screen

-3 65100 : Brightness and Contrast

-8 65101 : Calendar

- 65102 : Backlight

- 65103 : password edit

B 65104 : Communication

P A5105 - adinck crraan

Preview : 25%

|
o

|

Screen | % Lnk | ¢F Tag < i
i

[ [Grid [Snap | Align

2. Communication: After clicking communication, a window for link
management will appear on the left side of the software, or click [Link] in the
lower left corner of the software. The link management window is shown in the
figure below. This management window is responsible for the man-machine
interface and programmable control The communication protocol and
configuration settings between the PLC (PLC) or other serial communication
devices. For details, refer to 4.2 Link Management.

Cursor - 408, 436 11
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B8 mView : [CAUsers\EN\Desktop\0527.vxf] - o b
File Edit View Project HMI(M) Component Tool Window Help
BE -~ ® ] . B 5 -
Zlhha b O E-88 | B -%-2-2-a0-JdRL2SFBE Y~
Grahic Companent | Static Comuan.ent | Button Display |Edit | )
L@ EBmpE®E = E TR L rHBLEYE D

00RRVWEeEEeQ @ English (United States) =

Meseewperonl R R
1 Py S BhE e
EX-. | reoo7or] CNO| sesr [ N2 wre | N4 | wwre - Na s [
-5 comL

El-4B CoolMay PLC(3U/3G)/FX3U [9600,E,7,11:0 e e o A e e e —_—
+[E 0: CoolMay 3U Series [St=1] i [ S B | R A

-8 comz 3 : EE 22 S o FEE¥ : #HEE N [22 5 BN e
El-% CoolMay PLC(3U/3G)/FX3U [9600,E,7,1]:1 - NL | N3 N3 7

L[ 1 : CoolMay 3U Series [5t=1]

© 100

- e A

o \
i ]

™

60

50

0

\
. \
10 ‘
5 AV

=
b
[

Lt
|t

Toeer,
e

%3 Screen |% unki&' Tag < >

B | Grd snap | Angn Tursor 0118, 7%

3. Tag: After clicking Tag, the tag management window will appear on the left
of the software, or directly click [Tag] in the lower left corner of the software.
The tag management window is shown in the figure below. For details, refer to
4.3 Tag Management.

Bl mView : [C:\Users\EN\Desktop\0527 vx] - o X
File Edit View Project HMI(M) Component Tool Window Help
- | <~ | w @ B i ?
| & & = mr-SfE-QQ || BB 8 O-+-¢RaLFRHBEY B
Graphic Component | Static Companent | Button  Display |Edit |
YO EmmEEE| S e L HEEEEGAD

(@] D2@0EeBD ()] English (United States) -

Tag Management B 2 : Size Type [100%)
BEE G b4

Defaut | For monitoring pages | NO|| ###s N2 #xix | N4 HER . N6 FHEE
Tag N... | Address | Descri... ~ E - .

X0_¥15  N63488

YO_Y15  N63616 - i i e
BRIGHT... NES024 N1:| ###¢ [N3 ###¢ | NG 4 | N7 FhEE
CONTR... NES025 o o 1 T

BACK-L... N65026
VOLUME  N65027
STATU... N65028
SWITC... NES029
SOUND... N65030
SOUMND... N65031
AUXILL. N65040
AUXILL.. NES041
DIAGLG... N65044
INCREA... N65048
DECRE... N65049
POWER... N65050
TMEZ... N65056
ALARM... N65068
COM1... N6S077
COMI ... N65078
COM2 ... N6S5085
COM2 ... N65086
COM3 ... N65093
COM3 ... N65094
COM4 ... N6S5101
COM4 ... N65102
TWINK... N65104
TWINK.. N65105
TWINK... N65106
TWINK... N64107
INPUT ... NES112
Euan | neetin

Ea5creen | Wy Lmkl & Tag I < >

oS TPET

n
e
e

4. Language : After clicking Language, a dialog box for language setting as
shown in the figure below will pop up. For details, please refer to Chapter 5

28



TP Series HMI Programming Manual

Language Management.

Language n

o 5 wr i 4 ="
Al A Al A
Add Language Edit Language Delete Language Set Init Language Str Translate
a2 =] e s
Dic. Translate Str Collect Translate Dic Translate text import Translate text export
Index | Mame LocallD | Font _ Decimal | Separate
English (Unit... 00000... Tahoma [9]
1 Chinese (Sim... 00000... M5 Sans Sefi.. g )
2 French (Fran... 00000... MS Sans Seri.. .

2.3.2 Message window

Click [Message] under the [View] menu, and the grammar check window
as shown below will appear. When running, if there is a setting error, it will be
displayed in the syntax check window for program modification.

s i s e e -
File Edit View Project HMI(M) Component Tool Window Help

B |- b BBt -t B n |

Zlbhs bl |O-I5-06 B %0 57 00~ ¢RaA0RBE Y-

Graphic Component | StathomDﬂn‘ent] Button Display | edit |

b | @ @EEmeeeE =3 = TR RBEEYEE e A

002eeeedaq Englsh (United States) -

2l Al
Scene Management || B8 2: size Type [100%) s
iR 08 B L e e L e T L
=84 TKe070FH A NO: FaEd N2 R N4 FHRE - N6 E2220 s
= Intt Scene Group S el il e S
- 2 : Size Type e D L D L
-3 1: Scened i i s L
-0 3: 5cenel N1 EXEE ] E2 TR FEPE o E3E )
B0 System default group N1 N3 N5 N7
@ 65000 : Value input dislogue box (||t —o——  ——
[ 65001 : String input dialogue box v
3 65002 : Password input dislogue box B A R e
I3 65003 : Password accurately message kTR 1 Fi o .
3 65004 : Password eror message 80 IR} 1y 1 T
P CENNE .« Corctnm cnttinn necann hal || 8 t 1 v .
[Preview : 25% & A { 1 | mml - e
e - - = L[N | O O O O O O~ - - oy | [
£ e = AL T | Enmm  aaaeeea—
R | 1 \ i i
a0 i e e Peeaaaw 880009
2 N —
10 e E e
e el L R L Al L ([
........................ 0D, 050} T
< >
#, [Warning] 1 : Scene0 ( SW Button ) Read Address undefined! ~

‘Warning] 1 : Scene0 ( SW Button ) Write Address undefined!
‘Warning] 2 : Size Type ( Track Bar ) Read Address undefined!
‘Warning] 2 : Size Type ( Track Bar ) Write Address undefined!

Size Type ( Scroll Bar ) Read Address undefined!

: Sze Type ( Scroll Bar ) Write Address undefined!
Warning] 2 : Size Type ( List Box ) Read Address undefined!
Warning] 2 : Size Type ( List Box } Write Address undefined!
Warning] 2 : Size Type ( List Box ) Read Address undefined!
Warning] 2 : Size Type ( List Box ) Write Address undefined! £

5 |6 [Snap | Algn s (70,28 |

2.3.3 Repository

Click [Repository] under the [View] menu, or use the keyboard shortcut
[F12], the repository as shown below will appear. When performing interface
programming, use this window to conveniently access the required
components.
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File Edit View Project HMI(M) Component Tool Window Help
EBE-E||eo -t BBs - B wd B |
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-8 65012 : USB Download
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When in use, select the component classification as required. As shown in
the figure below, select the component to be used in each category,
double-click the component, and the component is placed in the right screen

window.

—Component

Type: |ptn3

container
—Lamp

1 Motor
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Display: B
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2.3.4 Component list

Click [Component List] under the [View] menu, or use the keyboard
shortcut [F10], and the component list window as shown below will appear. In
the component list window, you can intuitively see all the components used in
the current screen window.

2.3.5 Option(H)

Click [Option(H)] under the [View] menu, and the auxiliary setting dialog
box as shown in the figure below will appear.

31


WMB220303
改


TP Series HMI Programming Manual

Setup
Snap/Grid | Aux. Data of Obj. | Component Edit | File | Frame Size Transfer

[ Snap OM [+ Grid OM
Snap Grid

Snap X: |8 Grid X: [g
el Grid ¥: [g

Grid Color: -

4k

4k
k| 4]

[+ Object Snap

Component Align

Align X: [g Bplion
Align Y: |a W Above 40%,Show Grid

a4k

a4k

W OK | X cancel |

Snap/Grid: The dialog box is shown above

Snap ON: This option refers to whether the upper left corner of the set element
must be on the set grid when editing the screen.

In the snap combo box, the distance between the snap is set separately in the
XY direction, and the allowable setting range is 1 to 32. It is recommended that
the setting be consistent with the grid XY direction.

Grid ON: This option refers to whether to display background auxiliary grid
when editing the screen.

In the grid combo box, set the spacing of grid points in the XY direction, and
the allowed range is 1 ~ 32.

Grid color: Set the display color of the grid.

Object snap: This option refers to whether to display the alignment guideline
when the moving element is aligned up, down, left, and right when editing the
screen.

In the object alignment spacing combo box, set the alignment spacing in the
XY direction, and the allowable setting range is 1 ~ 32. The alignment
guideline is displayed when the distance between the moved component and
other components is equal to the set alignment distance.

Option: This option sets whether the screen displays a background grid when
the screen display ratio is greater than 400%.

Aux. Data of Obj.: The settings dialog box is shown below

32



TP Series HMI Programming Manual

Setup
Snap/Grid Aux. Data of Obj. | Component EI:I'rt] File ] Frame Size Transfer

Setup

[~ Only Selected Obj.
[ Obj. Sequence

[ Obj. Name

[ Parameter(Morral)

W Parameter(Simplify)

Font: [M5 Sans Serif [8] Font

o 0K | X cancel |

Only Selected Obj.: Check this option, the following options are only displayed
for the selected components, otherwise all components in
the screen are displayed.

Obj. Sequence: Check this option, the order of each component will be

displayed on the screen.

Obj. Name: Check this option, the name of each component will be displayed

on the screen.

Parameter (Normal): Check this option, the screen will display the complete

information of the variables corresponding to each component.

Parameter (Simplify): Check this option, the simple information of the variables

corresponding to each component will be displayed on the screen

Display font: Click the [Font] button to pop up a font selection dialog box, as

shown in the figure below, you can set the default font, font style, size, effect,

underline, and color of the displayed font.
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=F{E
(B FREN: FoE):
|MS Sans Serf Iﬁ'ﬂ. |8 Bm=
MS Sans Serif EE -
MT Extra s 10 L
Segoe UI Emoji FE 12
Segoe UI Symbal FHIRSHR ::
SimSun—ExtB 17
Symbol 18 W
erdana v
— &= -
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BEC):
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S -

Component Edit: The settings dialog box is shown below
Setup

Snap/Grid | Aux. Data of Obj. Component Edit | Fle | Frame Size Transfer |

—Setup

[~ Auto. Open Window after Add Component
v chxEditQuickMove

—gbxUndo

lbiUndoMemornyLimit I ;I

IblUndoCountLimit | ;I

[~ chxUndoClearOnClase

o 0K X cancel |

Set up
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After adding a new component, the editing window is automatically opened:
Check this option, after adding a new component, the system immediately
opens the component properties dialog box. Otherwise, you need to manually
double-click the component to open the properties dialog box.

Fast moving components: Check this option, select the component and press
the up, down, left, and right buttons of the keyboard or the left mouse button to
move the components quickly.

Recovery settings

Memory limit of recovery function: It is the undo function. Choose to close, not
subject to this restriction; choose 8M-512M, that is, to revoke the memory size
limit.

Limit the number of recovery function: Choose Close to cancel the unlimited
number of times; choose 1 time, irrevocable; choose 2-64 times, you can
cancel 1-63 times.

When the editing screen is closed, clear and restore function: Check this
option to close the editing screen and clear the editing memory cached by the
software at the same time, that is, when the page is opened again, the undo
operation cannot be performed.

File: The settings dialog box is shown below

Setup

Snap;‘Grid] Aux. Data of Obj. | Component Edit  File lmee Size Transfer

Setup
[+ Auto. Add Protocol after Open File
[ Save File ? Close Window
v Archive, automatically backup files
v Automatic backup old files
[+ Program start automatically open file
IblautoBackupTime j

Decompiler Information
v Add Decompiler Information

[+ Program Compression

o 0K | X Ccancel |

1. After a new project is created, a communication protocol is automatically
added: Check this option. After a new project is created, a dialog box for
adding a new communication protocol is automatically displayed to
facilitate the user to set the communication protocol. Otherwise, it needs
to be set manually in the communication management.
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2. When closing the screen window, ask if you want to save: check this option,
when closing the file, if the file adds new content, it will prompt whether to
save.

3. Automatically back up files when saving a project: Check this option to
automatically back up files when saving a project. The backup file has the
same location as the source file, and the file name is different.

4. Automatic backup when opening the old version project: Check this option to
back up the old version file when opening the old version file.

5. Automatically open old files when the program is opened: Check this option
to open the file from the last close when the software is newly opened.
Otherwise, you need to create a new file or manually open the old file after
opening the program.

6.Interval time backup: you can choose to close or 1-10 minutes, preset 3
minutes; after selecting the number of minutes, the project will be backed
up according to the selected time interval; the same project can backup up
to 32 files, namely backup00-backup31, and then will be overwritten in a
loop. Backup path [C:\Users\<user name>\Documents\HMI
Backup]\backupxx,[xx=00~31]

7. Add decompiled information: Check this option to add decompiled
information when compiling the project file. That is, the project file read
from the HMI can be modified by programming.

8. Program compression: When the program is downloaded, the project file will

be compressed to save download time.

Frame Size Transfer: The settings dialog box is shown below

Setup
snap/Grid | Aux. Data of Obj. | Component Edic| Fle  Frame Size Transfer |

Setup

Min Size: |g ﬂ

Max Size: |32 ﬂ

W OK X Cancel |
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Mini Size: After setting the model conversion, the minimum size of the
component text size is 8

Max Size: After setting the model conversion, the maximum size of the
component text size is 32

In the same program, when the model is converted, due to the different
screen size, the screen components will be enlarged or reduced proportionally.
The font size is set here. During the conversion process, the font size will be
modified according to this setting to make the converted screen The layout is
more coordinated.

2.3.6 Auxiliary data of Object

For the content of this section, please refer to Auxiliary data of Object in
Section.

2.3.7 Scale

Click [Scale] under the [View] menu, as shown below:

View Project HMIM) Component Tool Wi
] Project Management * E8

Message Ferne @L a |
Repository Sl RN |
Component List F1g h Display lEdit |
L (I
¥ Option(H] ... | E w =
_ Object Properties r i T—————
| E Zoom In
ToolBar 5 &, Zoom Qut !
TEETELTE e
070FH T s
-omM1

ik 518 Singlex Series [19200,N 150%
L[] 0 : 51MCU Series [St=0] 200%
~0M2 300%
4009

800%

You can choose the size ratio of the picture window according to your
preferences. To adjust the size ratio of the screen, you can also use the
zoom-in hoTPey [I] and zoom-out hoTPey [O] set by the system.
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P8l mView : [C\Users\EN\Desktop\0527.xcf]
File Edit View Project HMI(M) Compenent | Tool Window Help

OE-H RS -B-F-T- B e | B
EZ h kY b D~ E-QE || F-H-F-B-a0-CRL2ITEE $-H
Gra_pthnmuunant] Static Component | Button  Display |edit |
bl mmmmm| == Hofs LB &seend |
@@@@@@@@@ English (United States) 7] |

=l

B8 1: Scenel [50%) =

Scene Management
i RREL g BH
E TKG070FH ~

-0 Init Sceane Group

3 2: Size Type

8 1 : Scenen

8 3: scenel

=5 system default group

B 65000 : Value input dizlogue box
B 65001 : String input dizlogue box
2 65002 : Password input dialogue box
[ 65003 : Password accurately message
/3 65004 : Password errar message
B 65005 : System setting screen
B 65006 : System message screen
@ 65007 : HEX input dialogue box
‘8 65010 : Download screen

8 65011 : virtual on-line

B 65012 : USB Download

=0 System screen

B 65100 : Brightness and Contrast
B 65101 : Calendar

B 65102 : Backlight

B 65103 : password edit

5 65104 : Communication

A AS10S « Ariuck erraan

Preview : 25%

50% magnification display

B8l mView : [C:\Users\EN\Desktop\0527 vxf]
File Edit View Project HMI(M) Component Tool Window Help
BE-d|o- -y r@mB|SE | &
Zl2 LB bW [D-rE-qa|n-%-o-3-
Graphic Component | Static Component | Button  Display |Edit |

YO EmEEE| S 2R AP HKBEYEYE®E

BRRRACRCQRQ ||rd Gmedsme) |

SO~ ¢BaAOBEE Y -

= B

P8 1 Scened [100%]

lanagement—
E SRER 4 %H
E TK6070FH ~

B0 Init Scene Group

B2 2: Size Type

B 1:Scened

B 3:5cene1

-0 Systern default group

B 65000 : Value input dizlogue box
-3 5001 : String input dialogue box
-E 65002 : Password input dislogue box
-E 65003 : Password accurately message

- 65004 : Password error message
-B3 65005 : System setting screen
-2 65006 : System message screen
- 65007 : HEX input dialogue box
-89 65010 : Download screen

-89 65011 : Virtual on-ina

B 65012 : USB Download

-0 Systemn screen

B 65100 : Brightness and Contrast
B 65101 : calendar

B 65102 : Backight

B 65103 : password edit

B 65104 : Communication

| P A5105 - adinct crraan
[Preview : 25%:

2.3.8 Toolbar

100% magnification display

Click [Toolbar] in the [View] menu, you can freely select and display the

tools in the shortcut tool, as shown in the following figure:
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View Project HMIM) Cor
i Project Management *

Message
Repository F12
Component List F10
::¥ Option(H) ..
Object Properties r
B Scale »
| TooBar |
1w Edit
[ View
./ Project
[| o HMI
¢ Component
¢ Status

Language Management

2.4 Project

Use the mouse to directly click [Project], or use the keyboard to press
[ALT] + [P], the [Project] drop-down menu will appear, as shown in Figure 2-4.1.
In order to facilitate users to quickly select, shortcut icons are also provided in
the toolbar, as shown in Figure 2-4.2.

:.ﬁ’.rnjéct. HMI(M] Component

% Screen

% Communication
| Tag

| #% Language

v v w v

| @ Alarm ...

| “& Password ...

'f Sound ...

@ Protection ...

|a-& Data Sync ...

@ Record ...

| %) Data Schedule ...

: Recipe ...

Systern Configuration ...

: % Macro ... »

| el

Setup ]

2-4.1
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(1) (2 (3 (@ (6) (8) (100 (12} (14){15) (18)
vy vy a0« ROASFTHE QYL
(5 (7 (9) (11) (13}
2-4.2

Screen

—~
—_—

Communication

Tag

Language

Keyboard Define

Alarm

Password

—_— —~ o~ —~ [~ [~ [~
OINO| OB [WIN
~ [ |~ |~ [~ [~ [~ [~

Sound

(9) |Protection

(10)|Data Sync

(11)|Record

(12)|Data Schedule

(13)|Recipe

(14)|System Configuration

)

)
(15)|Macro
(16)|Report Manager

2.4.1 Screen

Click [Screen] under the [Project] menu, the options shown in the figure
below appear, and users can perform operations such as adding, copying,
editing, and deleting screens according to the needs of the program. When the
mouse focus is on the current screen group of the software program, the
options of adding, editing, deleting a group, and opening and closing the group
screen will be highlighted and can be used.
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'.Pru:uject HMI(M)  Component  Tool Window Help

= Y % A scen Grouy

45 Communication * | B3 Edit Screen Group
| & Tag ¥| B2 Delete Screen Group
JE Language 3

Open Secreen Group
iy K Close Screen Group
[ i Alarm ...

“8 Password ...

<{ Sound ...
| E Protection ...

-4 Data Sync ...

@ Record ...

Eé;"l Data 5chedule ...
' Recipe ... £F All Screen to BMP
_ System Configuration ...

% Macro ... ]

q Add Screen

Setup 3

1. Add Screen Group: Click [Add Screen Group], and the setting dialog box
shown as below will pop up.

Add Screen Group >

Group NHmE:chreen Groupld

Security: lLl5er Level 9(Low) ﬂ

Description:

Group Name: Enter the name of this group.

Security: Operation authority 1 ~ operation authority 9, the greater the
number, the lower the authority.

Description: Enter the help description of this group, you can leave it blank.
2. Edit Screen Group: Click [Edit Screen Group] to pop up the setting dialog
box as shown in the figure below. This function refers to when the group
description is not perfect when creating a new group, or when the original
group description needs to be modified, use this function to modify the relevant
information of the group.
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Edit Screen Group >

Group N3m9111n¢ Screen Group

Security: lLl5er Level 9(Low) ﬂ

Description:

3. Delete Screen Group: Click [Delete Screen Group], and the setting dialog
box shown as below will pop up. After clicking the [OK] button, the system will
delete all the screen information under the group. After clicking the [Cancel]
button, the system does not perform any operation on the group.

Delete Screen Group >

l:el Are you sure to delete [Init Screen Group] scene group?

4. Open Screen Group: click this option to open all the screen information in
the selected group.

5. Close Screen Group: click this option to close all screen information in the
selected group.

6. Add Screen: When you click this option, the New Screen dialog box as
shown below will pop up.
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4 Add Screen ot

Mormal ] Adv. ] Communication

-Screen Data
Name:  Iscreen
Mum.: |2 ii Auto Switch
Delay Time: 5
Type: |Normal Screen | elay Time:jo 2 Sec
Security: |B}r scene group LJ Jump to: |Lln|:|eﬁned LJ

nherit: Stop function of Auto. swith screen
nhert:  |undefined | | as Delay Time set zero , The Defay
Time rang is 0 .. 32767 .

BG Color: HES
Description:
Load BG Image
Clear BG Image
Position: |Center LJ
Macro
« Screen OPEN Macro CYCLE Macro Interval: 0.55ar LJ

i Screen CLOSE Macro
<7 Screen CYCLE Macro

0K X Cancel |

Screen

Name: Enter the name of the newly created scene.

ID: Enter the number of the newly created screen. The setting range of the
number is 1 ~ 32767. The number of each screen cannot be
repeated.

Type: Click on the drop-down arrow and 4 options appear.

Normal Screen: Basic editing operation screen.

Dialog box: Select this option to set the screen as the dialog box page.

Dial box specific functions refer to 4.1.1 chapter.

Boot Screen: Select this option, the current page is the first screen that
appears when you open the touch screen, similar to the startup screen of a
computer.

Initial screen: The first screen after the touch screen is turned on (the
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startup screen has been displayed).

Security: Operation authority 1 ~ operation authority 9, the greater the
number, the lower the authority. Corresponding authority password setting is
set in [Project]-> [Password]

Set by screen group: The operation authority is the same as the screen
group authority.

Inherit: Select this option to make the screen inherit the settings of the
selected screen.

The inherited picture is called the parent, and the current inherited picture
is the child. When the child inherits the parent, all the components of the
parent will be inherited together, but the child cannot change the parent's
components, and can only create or modify their own components. If you want
to modify the parent components in the child screen, you need to open the
parent screen and then modify the components At this time, all the parent
symbols in the child pictures inheriting the parent will be modified at the same
time.

Description: Enter a help description for the current screen.

Auto Switch

Delay Time: The time interval when switching between scenes.

Jump to: After setting the selection screen, when the delay time is reached,
it will jump to the set screen.

Load BG Image: Click this button to select the desired picture as the screen
background.

Clear BG Image: Click this button to delete the screen background image.
Position: Set the position of the background image.

Macro:

Screen OPEN Macro: Click here to pop up a dialog box to edit the macro
program when the screen is opened.

Screen CLOSE Macro: Click here to pop up a dialog box to edit the macro
program when the screen is closed.

Screen CYCLE Macro: Click here to pop up a dialog box to edit the macro
program executed in this screen.

CYCLE Macro Interval : Set the interval time when executing the macro
program of this screen.
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{ Add Screen bl |
Normal Adv. ]Cnmmunimtinn]
Quick jump page-
[~ Apply All Screen
Controlled conditi _'.]
|Undefined ~| I Apply All Screen
Controlled cnnd'rtii _'.]
|undefined ~| [ Apply All Screen
Controlled cnnd'rtii _'.]
|Undefined ~| [ Apply All Screen
Controlled cnnd'rtq _ﬁ]
-Sub Screen
Display Addr.: | _vj
Control Addr.: | -]
Sub Screen 1: |Llndeﬁned _'J (BIT 0, Bottom Layer)
Sub Screen 2: |Llndeﬁned _'J (BIT 1)
Sub Screen 3: |Llndeﬁned _'J (BIT 2}
Sub Screen 4: |Llndeﬁned _'J (BIT 3, Top Layer)
0K X Cancel |

Quick jump page:

Set the screen page for page change when using the gestures left, right,
up, and down.

Controlled condition: refers to the necessary conditions for the
establishment of this slide function, as shown in the above figure, when NO =
100, slide the HMI touch screen to the left, and the screen jumps from the
current screen to screen 1.

Apply all screens: Check this option, the slide screen pages of all screens
in this group are the same.

Sub Screen:
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Display Addr.:

Control Addr.:

Sub Screen 1:

Sub Screen 2:

Sub Screen 3:

Sub Screen 4:
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o <]

i <]

[2 : Screent -] (BIT 0, Bottom Layer)
|3 : Screent | (8T 1)

|4 : Screen2 | (BIT 2)

|5 : Screen3 ~| (BIT 3, Top Layer)

Display Addr: Set the variable position. Bit0-bit3 of the variable control sub
screen 1-sub screen 4 respectively. When the variable is
changed, the corresponding sub screen will be displayed,
but the sub screen is only in the display state. As shown in
the figure above: when N0O.0=1, sub screen 1 is displayed;
when NO.1=1, sub screen 2 is displayed; and so on...
Control Addr: Set the address of the control screen variable, bit0-bit3 of
this variable control the variables of sub screen 1 to sub
screen 4 respectively; when the [Display Addr] changes,
the corresponding sub screen will be displayed, at this
time [Control Addr ] You can operate the sub-screen when
changing. As shown in the figure above: when N0.0=1,
sub-screen 1 is displayed, and when N1.0=1, the variables
of sub-screen 1 can be operated. And so on...

Sub-Screen 1/2/3/4: Set the sub-screen to be displayed when the variable

changes.

For details, please refer to the official website "Sub-screen example"
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14dd Screen bl |

Marmal | Adv. Cnmmunimtinn]

Fast Communication

#1 : || -] Data Length:  [nysed d
#2 | -] Data Length:  [nysed d
#3: | -] Data Length:  [nuged -]
#4: | ~] Data Length:  [nysed |
#5: | ~] Data Length:  [nysed |
26 | ~l Data Length:  [ynused ~
#7 | -] Data Length: | ynyged -]
#8 | -] Data Length:  [ynuged -]

o OK X Cancel |

Fast Communication:

Namely fast reading area, set the fast communication variable of the
current screen, so that the set variable can be read quickly.
7. Copy Screen: When you click this option, the current screen will be copied
to the PC pasteboard, which is convenient for quickly creating a new screen.
8. Edit Screen: Click this option to edit or modify the attributes of the current
screen.
9. Delete Screen: When you click this option, the current screen will be
deleted.

The confirmation dialog box for deleting the screen is displayed as shown
in the figure below. Click [OK] to delete the screen, and click [Cancel] to do
nothing on the current screen.
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Delete Screen ot

[9] Are you sure to delete [Start screen] Frame

oK H Cancel |

10.Lock Screen: Click this option to fix the current screen components. You
cannot add, delete, or modify the components in the screen.

11. Open Screen: click this option, the screen jumps to the screen where the
focus is in the screen management.

Example: The current screen is screen 1, click screen 2 in screen
management, and then click [open screen], then the current screen jumps to
screen 2.

12. All Screen to BMP: Click this option to output all pictures in the current
project as pictures and save them in the path specified by the user.

2.4.2 Communication

Click [Communication] under the [Project] menu, and the options shown in
the figure below appear. The user can add, edit, and delete communication
protocols and controllers according to the needs of the program.

. P'ru:uject. HMI(M] Component Tool Window Help

| B3 Screen (N

& T .

& Tag 5. Edit Protocol
3% Language ¥ | &L Delete Protocol

i : B, Add Centroller
O slarm ... |

“® Password ...

- Sound ...

B Protection ...

a-a Data Sync ...

| ¢ Record ...

& Data Schedule ...

. Recipe ...

Systern Configuration ...

% Macro ... L4

## Variable Window

Setup 3

1. Add Protocol: After selecting a communication port that has not been
configured with a communication protocol, click [Communication], and then the
option [Add Protocol] will be highlighted. Click this option, the following dialog
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box will pop up:

Add Protocol -
Protocol
Sl T oGy PLC(3U/3G)/FX3U v
Controller:
Company | Model | Des... |
CoolMay CoolMay 3U Series PLC
Port: | Auto Detect{RS232/RS422/RS485) Ed
Baud Rate: [gg0p -] Data Bit: | 7Bits -]
Paricy:  [Even =] Stop Bt [1p¢ -
Delay: [oms | TimeOut:  [1gec x|
[ Multi-Station Smart Link Retry Count [ Timeout, Repeat |
' 0K X Cancel |

Protocol: Use the drop-down options to select the communication protocol
to be used.

Controller: Display the manufacturer and model selected by the
communication protocol.

Port: There are four options for selection, automatic identification, RS232,
RS422, RS485.

Baud Rate: from 150 ~ 115200 rate, available for selection.

Parity: [none], [odd parity], [even parity], [mark], [space].

Data Bit: [5], [6], [7], [8].

Stop Bit: [1 digit], [2 digits].

Delay: from no delay, delay 10ms to delay 5000ms, available for selection.

Timeout: [0.1 sec], [0.2 sec], [0.5 sec], [1 sec], [1.5 sec], [2 sec], [3 sec], [5
sec], [10 sec] total 9 Options.

Retry Count: Set the number of retransmissions when the communication
is unsuccessful.

Multi-Station Smart Link: see Appendix 5 for details.

OK / Cancel: After setting, press [OK] to save the completed settings,
press [Cancel] to exit the dialog box without setting the communication
protocol.

2. Edit Protocol: After setting up a new communication protocol, if there is a
setting error, you can use this function to modify it.

3. Delete Protocol: delete the communication protocol that has been newly
created.
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4. Add Controller: After the communication protocol is added, the controller to
which the protocol belongs needs to be set. Click the [Add Controller] option, a
dialog box as shown below will pop up:

Add Controller

Controller
ID:
Station: 1
Controller: Company Model Description
CoolMay CoolMay 3U Series PLC
Description:
¥ 0K X Cancel |

ID: ID number of the controller.

Station: the station number of the controller, that is, the ID number of the
PLC,

Controller: Display the selected manufacturer, model, description and
other information.

Description: Enter a description or help for this controller.

OK / Cancel: After setting, press [OK] to save the completed settings.
Press [Cancel] to exit the dialog box without setting the controller.
5. Edit controller: Select an existing controller and click this option to modify its
settings.
6. Delete controller: Select an existing controller and click this option to delete
it.
7. Variable Window: Click this option to pop up the dialog box as shown in the
figure below,
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B8 variable Window o O ot
—Variable
Controller:
Variable/Para.: Type | Name | Range | Sp... | Description | "
W BIT Xooo 0- 367 1 Inputs
W BIT Yooo 0-367 1 Outputs
&8 BIT Mnnnn 0-7679 1 Auxiliary r...
&8 BIT Mnnnn 8000 - 8511 1 Special au...
B BIT snnnn 0-4095 1 States
W BIT T5nnn 0-3511 1 Timer con...
W BIT C5nnn 0-2535 1 Counter c...
&3 \WORD THnNn 0-511 1 Timer curr...
=3 WORD CMnnn 0-199 1 Counter c...
DWORD  CHMnnn 200 - 255 1 Counter c... W
Mumber:
o 0K X Cancel |

#85 I | e | s

BIT Xooo 0- 267 1 Inputs

BIT Yooo 0- 267 Qutputs

8 BIT Mnnnn 0-3071 Auxiiary r...
W BIT Mnnnn 8000 - 82535 Special au...
BIT snnn 0-999 States

BIT T5nnn 0-255 Timer con...
BIT csnnn 0-255 Counter c...
=3B WORD THnNN 0-255 Timer curr...
3B WORD CHnnn 0-199 Counter c...
DWORD  CHnnn 200 - 255 Counter c...

e e e e e ]

NB5340 -

Ve | X |

Controller: Provide HMI internal variables or controller variables set in the
communication protocol for selection.

Variable/Para.: Displays the specific information of the variables included
in the selected controller.

Number: Open this window in the component properties window, you can
directly enter the variables of the system or controller.
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2.4.3 Tag

There are many types of controllers that communicate with the
human-machine interface. The communication protocol and memory numbers
of different manufacturers are not the same. In order to facilitate the function of
memorizing contacts and memory numbers, you can use tag management to
increase readability. For example, when adding a label, we want to replace the
X1 contact with the name "for testing". After the addition is complete, enter "for
testing" in the write or read position only when the component needs to use X1
"Or click the drop-down option to select” for testing ", the system will treat" for
testing "as X1. After setting to tag management, users can replace the names
of contacts and memory on the communication protocol specifications with
names that are easy to remember.

Click [Tag] under the [Project] menu, and the options shown in the figure
below appear. The user can perform operations such as adding, editing, and
deleting communication protocols and controllers as required by the program.

.F‘rnject HMI(M] Component Tool Window Help

% Screen L -

% Communication I: | B,
¢ T ; 2 s Group

| 2% Language L &9 Edit Tag Group

_ ﬁ Delete Tag Group

O Alarm ... <E Add Tag

| & Password ... e
Cf] Sound ...

.. & Protection ...
| a4 Data Sync ...
[ @ Record ...
| B Data Schedule ...
' Recipe ...

B System Configuration ...

%! Macro ... L4

Setup r

1. Add Tag Group: classify tags for easy management and editing.
Click [Add Tag Group], a dialog box as shown below will pop up:
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Add Tag Group 2

Tag Group Mame:

For monitoring pages

o OK X cancel |

Enter the name of the newly added tag in the tag group name and click the
[OK] button. The newly added tags are newly added to the tag management,
as shown in the following figure:

Tag

G| 4t £|DP

Default JFor monitoring pages

MName Address Descri...

2. Edit Tag Group: modify the name of the currently selected tag.
3. Delete Tag Group: modify the currently selected tag.

Click this option to pop up the dialog box as shown in the figure below.
Click the [OK] button to delete the selected tag group. Click the [Cancel] button
to keep the selected tag group.

Delete Tag Group x

':e] Are you sure to delete [For monitoring pages] tag group?

OK I Cancel |

4. Add Tag: add a new tag.
Click this option to pop up the dialog box shown below:
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Add Tag pd

Tag Group: |For monitoring pages =

Tag Name: |TES TX

Address: |D1I31 b3
Max: |5|:||:|
Min: ]1|:||:|

Description | Test Max and Min of X

W OK | x Cancel|

Tag Group: The current tag group is written by default and can be selected
using the drop-down list.

Tag Name: Enter the identification name corresponding to this location,
you can replace the location.

Address: Enter the correct contact or memory location of the controller to
be used, and the register address D101 of Mitsubishi PLC FX3U is used in the
above figure.

Max: Enter the maximum value of this contact or memory, you can not
enter it.

Min: Enter the minimum value of this contact or memory, you can not enter

Description: Enter the description of this label, you can not enter it.
OK / Cancel: After setting, press [OK] to save the completed settings,
press [Cancel] to not proceed Set the label and exit the dialog box.
5. Edit Tag: modify the content of the existing tag and other operations.
6. Delete Tag: delete the existing tag.

2.4.4 Language

Click [Language] under the [Project] menu, and the options shown in the
figure below appear. The user can add, edit, delete language selection, and
set the initial language translation according to the needs of the program.
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| Project HMI(M) Component

% Screen L4

}:% Communication L

& Tag . N

ﬂ Alarm ..

| w0 Password ... S

(- Sound ... 2% Translate
F@ Protection ... Dictionary

{m=a Data Sync ...

E_ @ Record ...
| & Data Schedule ...

\ Recipe ...
& system Cenfiguration ...
%7 Macro ... *

= |
|

Setup r

1. Add Language: add a new language.
Click this option to pop up the dialog box shown below:

. 4 il o
A REd A
Add Language Edit Language Set Init Language Str Translate
» ® b
| Str Collect Translate Dic Translate text import Translate text export
Index | Name | Loeip | Font _ Decimal | Separate |
S£0  English (Unit... 00000... Tahoma [9]
Add Language *
Language Na1 frikaans (South Africa) -
Local ID: 00000436
Font: [MS 5ans Serif [8] Font s )
Test: [ il
€ Afrikaans
Decimal: i
Separate:

lxee) | W

Name: Click the drop-down list to select the language to be created.

Local ID: The region code of the region where the selected language is
located. This item is added by default.

Font: displays the selected preset default font.

Font: Click this button to pop up the font selection dialog box, as shown in
the following figure, you can set the default font, font style, size, effect,
underline and color of the new language.

—
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Font X
Font: Font style: Size:
]Hegular ]B oK |

MS Sans Serif

i Cancel

Hold Oflgue 17

18 v
Effects Sample -
[T Stikeout
[ Underdine AsbiDz
Calor:
| I Custom x| | Secnpt:
|Westem L]

Test: display the template of the selected font.

Decimal: Set which symbol to display when displaying the decimal
symbol.

Separate: Set which symbol to use when displaying the separator.
2. Edit language: Click this option to set the font, font style, size, effect,
underline and color of the existing language.
3. Delete language: Click this option to delete the existing language.

Delete Language >

I."' : f Delete all word of this phylum, Are you sure to delete
L [Afrikaans [South Africa)] phylum?

Ok “ Cancel |

4. Initial language: click this option under multiple languages to set the initial
language.

5. Translate: Click this option to convert the language on the screen to the
selected language.

6. Dictionary: Set the corresponding language translation by yourself.

For a detailed introduction and application examples of language management,
please refer to Chapter 5 Language Management.

2.4.5 Keyboard Define

This model does not have this function temporarily.
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2.4.6 Alarm

After clicking [Alarm] under the [Project] menu, the setting dialog box
shown below will pop up to set the alarm information. For detailed introduction
and cases of specific alarm management, please refer to Chapter 6 Alarm

Management.
Alarm |E
e, . | = L % &
Add Alrm Edit Alarm Delete Alarm Alarm Configuration Import Export
—Alarm Para. Area ~Alarm
Name | Alrm A... | Mask Ad...||| Index | Level Trig Met... | Alrm Pi... | Alarm Pictu... | Check Pi.. | Alarm V... | Desc...| Wor... | Alar... |

| . v

Add Alarm: Add a new alarm information area.
Add Alarm =

—Alrm Area Define

Mame:
Addrass: | L]
Mask: | L]
Update: |35ec |
Delay: |0sec ]
Group: L Alarm Group 0 A

| Alarm Group 1

| Alarm Group 2

Alarm Groun 3 b

Description:

W 0K | X Cancel‘

Name: Enter the name set for the newly added alarm zone.
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Address: The position of the input variable can be selected by the drop-down
arrow symbol or directly input the variable position. As shown in the
above figure, the icon button & behind the input box indicates that
this position must be WORD. Click this button to pop up the variable
window shown below The type of variable. At the same time, you can
also enter or select the desired variable in the number edit box in the

figure below.
M variable Window — O *
~Variable
Controllor:
Variable/Para.: Type MName Range 5p... | Description "
BIT Xooo 0-367 1 Inputs
BIT Yooo 0-367 1 Qutputs
BIT Mnnnn 0-7e79 1 Auxiliary r...
BIT Mnnnn 8000 - 8511 1 Specal au...
B BIT snnnn 0-4095 1 States
BIT T5nnn 0-511 1 Timer con...
BIT C5nnn 0-235 1 Counter c...
=3 WORD THnnn 0-511 1 Timer cur...
= WORD CNnnn 0-199 1 Counter C...
DWORD  CNnnn 200 - 235 1 Counter C... W
Mumber:

=]
o OK | X Cancel ‘

Mask: When the alarm is triggered, this function can be used to mask the
alarm, that is, the alarm information and sound are not
displayed. The method of selecting the mask address is the
same as the method of selecting the address of the alarm
area.

Update: You can choose how often to update. If you select 3 seconds, it means
that you will check whether the alarm is triggered every 3
seconds.

Delay: choose whether to wait for the controller to start to create data and then
start the alarm time.

Group: You can check the group to which this alarm will be classified.
Double-click the left mouse button in the group to edit the
group name.

Description: Enter the help description for this alarm.

2.4.7 Password

After clicking [Password] under the [Project] menu, the setting dialog box
shown below will pop up to set the password for setting the user authority. For
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a detailed introduction and case of specific password management, please
refer to Chapter 7 Password Management.

e L=
—Password
Mo.1: ||_|5.3|- Level 1(High) :l I
Mo.2: IUser Level 2 ;l I
Mo.3: IUser Level 3 Ll I
Mo.4: IUser Level 4 Ll I
Mo.5: IUser Level 5 ;l I
Mo.6: IUser Level 6 ;l I
Mo.7: IUser Level 7 Ll I
Mo.8: IUser Level 8 ;l I
IWI X Cancel |

2.4.8 Sound

After clicking [Sound] under the [Project] menu, a dialog box for setting
audio as shown in the figure below will pop up to set the audio that the user
needs to use. For a detailed introduction and case of specific audio
management, please refer to Chapter 8 Sound Management.

Sound @
& & ¢ % = |
Add Sound  Edit Sound  Delete Sound Bdd Ttem Edit Item Delete [term Play
—Sound —Content
| Index | Mame i Repeat ..| || Order | Frequence | Time |
1] Key MNon-rep.
b Dialog MNon-rep.
| EN| | v
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2.4.9 Protection

After clicking [Protection] under the [Project] menu, a dialog box as shown
below will pop up to set the upload / download password of the HMI program.
To achieve the function of data protection.

I ﬁr"_otech‘:on P
Protocok
Upload: | (Mo more than 14
Upload Hint: | (Mo more than 14
Download: | (Mo more than 14
Download Hint: | (Mo more than 14
Edit: | (Mo more than 14
Edit Hint: | (Mo more than 14
W DK X Cancel |

Password protection for project uploading, downloading, uploading and
editing, and setting of passwords and password prompts.
After setting the [Download Password], use the [Save Project to File] function
under the [HMI] menu to save the project as a tpo file. If you want to use this
tpo file to download to HMI later, select [Tool]-> [Download HMI program ...], a
dialog box as shown in the figure below will pop up to select the tpo file.

B open >
Look in: I , TPHarks LJ & cF B
ﬁ Marme - Date modified Type Size
ik R TP6043C.tpo 2020-06-24 1&:28 TPWorks Editor File
uick access
ETPGD?D 2020-06-24 18:08 TPWorks Editor File
Desktop 5
|
Libraries
This PC
Network
£ >
wpEm: | =l [ save
Ef‘*ﬁﬂ“) |TP'|\'or]<s HMI Object File (%, tpo) L] Cancel |

After confirming the tpo file selection, click the [Open] button, and the
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download password input box will pop up as shown in the figure below. After
entering the password correctly, click the [OK] button to download the program
to the HMI.

Download Password b4

Password

Password Hint:l

Password: | (Max.14 Char

o DK X Cancel |

2.4.10 Data sync

After clicking [Data Sync] under the [Project] menu, a dialog box as shown
below will pop up. For a detailed introduction and case of data synchronization
management, please refer to Chapter 9 Data Synchronization Management.

Data Sync n

m:E 3 B | a
L] - m:E B
Add i ) = | Import Export
Data Sync
Index | Synchronize Time | Condition | Synchronize Proviso Method | Source Data | Target Data | Dafa Length | Description

2.4.11 Record

After clicking [Record] under the [Project] menu, the following dialog box
will pop up.
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Data Record

B 58 | B

Add Ed'rt_ Delete | Import Export
Record

0 HNN [16Bit] ... NO

In... | Name Data For... | Source ...

Data Le...
2

Record ...
10

Update ...
3.05ec

Record F...
N10.0

Clear Flag
N10.1

Clear[Clr FG]
Setting

Stop set... | Backup Adc

20

Add: Click this button to pop up the dialog box for defining a new data record
as shown in the figure below.

Edit: Click this button to re-edit the selected existing data record.
Delete: Click this button to delete the selected existing data record.

Import: Click this button to import the data record of the vdr file stored in the

computer into the HMI project.

Export: Click this button to export the data records in the HMI project to a
computer and store them in a vdr file.

The Add data record definition dialog box is shown below:
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1 Add Data Record x
{ ~Data Record
Mame: |NNNN
Data type: \[168it] Signed -]
Source: |NI:| j oy
Data Length: |2 j
Record Count: |1|3 j Range 1 .. 32767
Update Time: |1Sec j
Record Flag: |N1EI.IZI ﬂ
Clear Flag: |ng_1 ﬂ
v Clear[Clear flag]
Auto. stop as touch record
Stop Count: 20 | setting,No use this function
Description:

¥ Record Date/Time
[ Retentive

W OK | XCEnceI‘

Name: Enter the name of the data record.

Data Format: Select the type of data. There are five types of contacts,
16-bit signed / unsigned, 32-bit signed / unsigned.

Source: Set the location of the data source.

Data Length: set the length of the data, the range is 1 ~ 16. For example, if
it is set to 4, and the source address of the data is set to DO, it means that the
data is read from DO ~ D3, which has 4 register addresses.

Record Count: set the total number of records of the data, the range is 1 ~
32767.

Update Time: set the interval time record data. That is how often to record.

Record Flag: Set a variable, and use this variable to control start recording
and stop recording.

Clear Flag: Set a variable to control the clearing of previously recorded
data. For example, select MO here, when MO is turned on, clear the previously
recorded data.

Clear [clear flag]: Check this option to clear the flag while disconnecting
the clear flag. That is, when MO is turned on, after clearing the previously
recorded data, MO is turned off.

Stop Count: Set to stop recording when recording to the set quantity.

When set to 0, this function is not used, that is, the data is always
recorded.
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Description: Provide supplementary explanation for this record, you can
leave it blank.

Record Date/Time: Check this option to record the time when recording
data when recording data.

Retentive: Check this option, the data will be saved when the HMI is
powered on again.

2.4.11.1 Case of Record use
Click the software menu-> [Project]-> [Record...], Data record

management dialog box as
shown below pops up.

Data Record Management a
oo E
€  Add Import Export

Record
26| In... | Name Datz For... | Source ... | Datale... | Record ... | Update... | Record F...| Clear Flag | Clear[Cr FG] Stop set... | Backup Addr. | Desc...

S\
=
S\
t

Click the [Add] icon, and in the pop-up New Data Record Definition dialog
box, set each record as shown below:

Add Data Record x
Data Record

Mame: |NNNI"-I

Data type: |[168it] Signed |
Source: |NEI ﬂ s
Data Length: |1 ﬂ
Record Count: |1|;| j Range 1 .. 32767

Update Time: |1Sec ﬂ
Record Flag: |N1IZI.IZI ﬂ &8
Clear Flag: |N1E|.1| ﬂ

I Clear[Clear flag]
; Auto. stop as touch record
5top Count: IEI ﬂ setting,Mo use this function

Description:

¥ Record Date/Time
[~ Retentive

o OK | X Cancel]

After the setting is completed, click the [OK] button, and the data record
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management display is as shown below.

Data Record Management n
B = B &
Add Edit =let Import Export
Record-
|| In... | Name | Data For... | Source ... | Datale... | Record... | Update ... | Record F...| Clear Flag | Clear[Cir FG] | Stop set... | Backup Addr. | Desc...|
1] MHIM [16Bit] ... NO 2 10 1.05ec N10.0 MN10.1 Setting o

After the data is added, the data record can be used. When using
[Element]-> [Display Element]-> [Historical Trend Graph], the [Historical Trend
Graph] property screen as shown below.

Historical Trend X

Bevel Control l Curve Setting 1 Dlsplaﬂ Scale ] Display Time | Time Scroll

Control

Data Record: | .

Data type
Source Address: | _"_J
Data Length: |

Rang 1 .. 32767

Record Count: |

Update Time: |E|.159c

Record Flag: |

Clear Flag: | ™ Clear Flag aft, Clear Rec

Stop Count: | _‘J Auto. stop when touch recode
|

Leflefledledle

setting , Mo use this function as

x| =

Vishility:

o OK | X Gincel‘

In the data record drop-down list, select the data to be recorded. In this
example, select the NNNN data. After selection, the following figure is shown.
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Historical Trend *

Bevel Control ] Curve Setting | Display | Scale | Display Time | Time Scroll|

Control

Data Record: HNHN =

Data type |[16Bit] Signed |

Source Address: |r.|g _J

Data Length: |2 _J

Record Count: |1g _J Rang 1 .. 32767

Update Time: |1Ser. _J

Record Flag: |r.|1,;,..:. _J

Clear Flag: |[.|1|:|.1 _J ¥ Claar =

Stop Count: |[| _J Auto. stop when t_uuch re_cude
setting , No use this function as

Visibility: | _‘J

W OK | XCanceI‘

As set in this example, when the recording flag condition is reached, that is,
when N10.0 = 1, the data of NO and N1 will be displayed in a curve, and the

record is shown in the figure below
1 : Initial Screen

NO a0

N1 20

100
a0
it}
it}
60
50
410 3
a0 _1

20

10

N10 1

When you need to delete the curve, set the value of the clear flag to 0, that is,
N10.1 = 0. In this example, set N10.0 to 0, as shown in the following figure.
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1 : Initial Screen

NO a0

N1 20

100
a0
it}
it}
60
50
40
a0
20
10

N10 0

2.4.12 Data schedule

After clicking [Data Schedule] under the [Project] menu, the following
dialog box will pop up. It can be used to implement the scheduling
requirements for a fixed time or a specific time to perform control.

Data Schedule |EJ
a5
B ; L &
Add =]z Import Export
Data Schedule
Index Arrange Time Condition | Source ... | target o... | Length Desc...

Add: Click this button to pop up the new data schedule definition dialog box as
shown in the figure below:
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Add Data Schedule oo
Condition
%+ Fix Time Set(M.W.D.H.M.5}
" Fix Time Set(M.\W.H.M)
" Time Para. Set
" Use Time Para.[W.H.M)
! January v Sunday W 1Day a 0 Hour  ~
v February v Monday v 2 Day vl 1 Hour
¥ March ¥ Tuesday ¥ 3 Day v 2 Hour
v April ¥ Wednesday ¥| 4 Day v 3 Hour
v| May | Thursday vl 5 Day v 4 Hour
vl June & v| Friday & v 6 Day & v 5 Hour
v July v| Saturday ¥| 7 Day v & Hour
¥ August ¥ 8 Day ¥ 7 Hour
v| September v/ g Day vl 8 Hour
v QOctober v 10 Day v G Hour
¥ Movember ¥| 11 Day | 10 Hour
v| December vl 12 Day v 11 Hour
¥ X ¥ X ¥ X ¥ X
Min: 10 +!  Mon-CHKif Set 60 Sec ||;| 4! Non-CHK if Set 60
Action
Format: |[16Bit] Signed |
Condition: |1 ~| ==
Data Type:  |[16Bit] Unsigned |
Source: | ~| =
Destination: | j b5
Length: |1 j
[T W
Description:
o 0K | X Cancel I

Condition: Select the time condition of data scheduling, which can be set
by four modes, which are explained separately below.

Use fixed time setting (month, week, day, hour, minute, second)

Check this option, the user can use the action to the nearest second to
trigger. As shown in the above figure, the value of register D100 is passed to
D101 at 0:20:37 on January 1 and August 4 of January and August. The
setting method is shown in the figure above.

Use fixed time setting (month, week, hour, minute)

Check this option, the user can use the action trigger to the nearest minute
or a period of time (to avoid the situation that the power is turned on after the
set time point and the action is not completed), as shown in the picture, every
Thursday in January When 0, transfer the value of register D100 to D101, the
setting method is shown in the figure below. It should be noted that the
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"minute" setting column needs to select all, so to avoid if only select 0 points, if
the boot time is at 0: 1 or after, this action can still be completed.

Add Data Schedule *
Condition
" Fix Time Set{M.W.D.H.M.5)
{+ Fix Time Set(M.W.H.M)
" Time Para. Set
" Use Time Para.[W.H.M)
L1 January LI Sunday ¥ 0 Hour vl OMin ~
[ February [ Monday [ 11 Hour v 1Min
| March | Tuesday 12 Hour v 2Min
f LI April v Wednesday L 3 Hour v 3Min
v May [ Thursday [ 4 Hour It 4min |
1 June L1 Frida 15 Hour [15Min
1 3uy I | D6 Hour v
LI August & & L7 Hour & L 7Min
| September 18 Hour L1 8Min
] October 19 Hour L1 9Min
| Movember 110 Hour 1 10Min
B Decermber | 111 Hour L[] 11Min
L1112 Hour L 12Min
L1 13 Hour L 13Min
| EvT i Admin Y
¥ X ¥ xR ¥ X ¥ xR
Action
Format: [[168it] Signed |
Condition: |1 j =
Data Type: ][1EB'rt] Unsigned ﬂ
Source: IDlDD j =
Destination: Iglgl j B
Length: Il j
Description:
W 0K | X cancel ]

Use time variable settings (month, week, day, hour, minute, second)

Check this option, the user can choose the controller by himself, use a
continuous register (8 Words) as the time variable, this option can change the
time condition at any time through the variable setting, as shown in the
following figure:
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Add Data Schedule *

—Condition

" Fix Time Set(M.W.D.H.M.5)
" Fix Time Set(M.W.H.M)

& Time Para. Set
™ Use Time Para.(W.H.M)

Time Para.: ] lJ

—Action

Format: |[168it] Signed =]
Condition: 11 v 3@
Date Type:  |[16B] Unsignad ]
Source: IDlnu v =B
Destination:  [D101 x|
Length: 11 L]
[~ Write multiple data at once
Description:
o OK | X cancel ‘

Use time variable setting (week, hour, minute)

Check this option, the user can select the controller by himself, and use a
continuous register (3 Words) as the time variable. This option can change the
time condition at any time through the setting of the variable, as shown in the
following figure:
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Add Data Schedule »

Condition

" Fix Time Set{M.W.D.H.M.5)
" Fix Time Set{M.W.H.M)

" Time Para. Set

(& {Jse Time Para.(W.H.M}

Time Para.: | ;J

Action

Format: [[16B1] Signed |
Condition: |1 |
Data Type:  |[16Bit] Unsigned =l
Source: [p1o0 ~| &
Destination:  [D101 x| ®»
Length: |1 j
Description:

o OK | X Cancel]

Edit: Click this button to re-edit the selected existing data schedule.

Delete: Click this button to delete the selected existing data schedule.
Import: Click this button to import the vdh file data stored in the computer into
the HMI project.

Export: Click this button to export the data schedule in the HMI project to a
computer and store it as a vdh file.

2.4.13 Recipe

After clicking [Recipe] under the [Project] menu, the following dialog box
will pop up. Set the data recipe that the user needs to use. For detailed
introduction and cases of specific recipe settings, please refer to Chapter 10
Recipe Management.
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Recipe |E|
_ Add —dit Delete | Import  Brport

Recipe Content-

Index Name De...

2.4.14 System Configuration

After clicking [System Configuration] under the [Project] menu, the

following dialog box will pop up. Can set the screen control and power saving
mode.

System Control 2

Scene Control | power Down Mode |

Use Para. Switch Frame-

Control Address: | j

Para. is 16Bits Unsign

Update Time: |15ec -
Manu Switch Frame:  fyyrite -
 OK X cancel |

ke r

Scene Control: Set the variable, and control the automatic switching of the
man-machine screen through the change of the variable data.

Control Address: select the variable address or label name to control the
screen switching. The variable must be a 16-bit unsigned number.

Update Time: Set the update time of screen switching.
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Manu Switch Frame: Set the variable value change after manual screen
switching, by "variable writing 0" and "variable writing switching screen ID
(number)".

Power Down Mode: set whether the system uses power saving mode

22X

System Control

Srene Control Power Down Mode

Select Itemn

[~ Use Power Down Mode

W OK X Cancel |

A

Use power saving mode: After checking this option, the items shown in the
figure below can be set to set the time of power saving mode.
System Control 2

Scene Contral Power Down Mode ]

Select Itermn

v Use Power Down Mode

Time of Power Down Mode  |3g5ac -

[T Switch picture as enter power down mode.

W OK X cancel |

Switch screens when entering power saving mode: After checking this
option, the settings shown in the figure below appear.
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System Control 2

Scene Control Power Down Mode l

Select Ttem

v Use Power Down Mode

Time of Power Down Mode |3I:|Sec j

v Switch picture as enter power down mode.
Switch Picture | j

I Set last priorty after play.
¥ Jump to above picture as renew.

o OK X cancel |

Screen switch: Select the screen to switch to when entering the power
saving mode.

After the action, set to the lowest operation authority: After checking this
option, when entering the power saving mode, the operation authority is set to
the lowest.

When recovering, jump back to the previous screen: After checking this
option, touch the screen in the power saving mode to jump back to the
previous screen when the screen is switched.

2.4.15 Macro

Click [Macro] under the [Project] menu, as shown in the figure below, you
can select the macro to be set to write the macro. The preparation of specific
macro instructions and case introduction, please refer to Chapters 11 and 12
for details.
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Project HMI(M) Component

| % Screen

% Communication

& Tag

| BE Language

v v v v

ﬂ Alarm ...

| “& Password ...

‘§- Sound ...

.. E] Protection ...

{a-4 Data Sync ...

[ @ Record ...

| & Data Schedule ...

‘ Recipe ...

| System Configuration ...
v G INTAL Viacr
«B BACKGROUND Macro

v | dp CLOCK Macro

Setup

Screen OPEM Macro
Screen CLOSE Macro
Screen CYCLE Macro

\? Sub Macro

2.4.16 Report Manager
This model does not have this function temporarily.
2.4.17 Setup (Station ID / Model)

Station ID

Click [Setup]-> [Station ID] under the [Project] menu to open the station
number setting dialog box as shown in the figure below. In general use, the
man-machine interface can be master or slave. This product provides a total of
191 (0 ~ 190) groups of Master station numbers for users. Group) station
number, you can set multiple display units to use in the same group.
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Station ID &

rSetup
Station ID|1 - Range [1 .. 191]

F Group Setup

e S
| Select All Clear Al
Group ID | Name |_Description | o
[J192 ID Groupd
193 ID Groupl
104 ID Group2
195 ID Group3
1196 ID Group4 i
¥ 0K X Cancel |
Model

In general use, planning a human-machine interface solution is very
time-consuming, so the engineer will choose to modify or apply the previously
used solution. If you need to modify the model when using different models,
click [Setup]-> [Model] under the [Project] menu to open the conversion model
inquiry dialog box as shown in the figure below.

Trasfer Type

'.o:' After trasfer type,can't recover, Save?

Yes Mo

Selecting the [Yes] button will save the unconverted project, and selecting
[No] will not save anything, and a dialog box for modifying the model, number
and other information as shown in the figure below will pop up directly.
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Trasfer Type =
Title: |Undefined
Model: | TK6070FH |
7" Color TFT LCD,65535 Colors, 800%480 pixels,
COM18&COM2(RS232/RS422/R5485),RTC.
Direction:  |Horizontal |

Description:

4 L,

¥ Program Compression

W DK X Cancel |

After inputting the project title, model number and display direction of the
new project, click the [OK] button to pop up the dialog box as shown in the
figure below. You can click the corresponding button to replace the project as
required.

Trasfer Type X

 Frame 5ize deffer,[Y] Auto. dimmention,[N] Area limit, [Esc]
l % Cancel Trasfer,

Yes Mo Cancel

2.5 HMI

Use the mouse to directly click [HMI], or use the keyboard to press [ALT] +
[M], the drop-down menu of [HMI] will appear, as shown in Figure 2-5.1. In
order to facilitate users to quickly select, shortcut icons are also provided in the
toolbar, as shown in Figure 2-5.2.
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HMIM) Component Tool Window Help

| %% Syntax Check ... F& |8y v | By B
| & On-Line Run s~ Frty @ -
| & Off-Line Run Shift+Fg |

B Bl e
| &@ Download to HMI ... Ctrl+Alt+S T

'm Save To File ... | _']
BT > o

ication Setup ... I
2-5.1

(1) (2) (3)(4) (5)

% BB o

W= o =x &

2-5.2
) |Syntax Check
)|On-Line Run

(3) |Off-Line Run
)
)

Stop
Download to HMI

2.5.1 Syntax Check

Click [HMI] menu bar [Syntax Check] or directly press the shortcut key [F8]
or directly click the toolbar icon % . When running [Syntax Check], check
whether the variable names or settings are correct during the compilation of
each screen in the project, and provide error information in the [Grammar
CHK], so that we can eliminate the error information. In addition, the [Syntax
CHK Mes.] dialog box will pop up, displaying information such as memory
usage, data type ratio, memory font data, etc., for the user to refer to when
editing. As shown below:

78



File Edit View Project HMIM) Component Tool
Os~-d|-~
# 258 al

Graphic Companent | Static Companent | Button  Display |Edit |

L@ EEmmEE -~ & 5 TRILPHRBEYES e A
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|m-sE-eaa|m-2-2-2-o0-~¢RAGBEE Y[

00O PHEROO

English {(United States) b
3

E| A
Scene Management: ﬂ 2
QRS v = FGrammar CHI Mes. !
- Tre070FH ~ ]
£-ffh Ini Scene Group :
i BB 2 Size Type . Error: 0 | Warmning: 16 | Hint: 0
8 1: Scene0 :
i B 3: Scenel N Time: 10sec
£ I System default group 2
¢~ 65000 : Value input dislogue box Program Ca| 65512 Bytes/16252928 Bytes
@ 65001 : String input dialogue box :
@ 65002 : Password input dizlogue box 1 Memery Rate: | 0% ]
[ 65003 : Password accurately message Type: \
i [0 65004 : Password error message G
FR connt . comeame anetinn nmenn — — —
e [[] scene  [] Font  [T] Picture
i Inter-pattern Data
—‘ Font Capacity(Byte) ~
22272(P) [9] 2812
MS Sans Serif [16] 5024
MS Sans Serff [8] 2400 i
Tahoma [14] 5940 v |
" 8 { {0, 0Bl .
screen (B Lnk [ & Tao < >
%\ [Warning] 1 : Scene0 ( SV Button ) Read Address undefined! ~
'A [Warning] 1 : Scene0 ( SW Button } Write Address undefined!
aming] 2 : Size Type ( Track Bar ) Rea ress undefine
|5y [waming] 2 : Size Type ( Track Bar ) Read Add defined!
aming] 2 : Size Type ( Track Bar ) Write Address undefine
|5y [waming] 2 : Sze Type ( Track Bar ) Wiite Add defined!
aming] 2 : Size Type ( Scroll Bar ) Rea ress undefine
|28y [waming] 2 : Se Type ( Scrol Bar ) Read Add defined!
'A [Warning] 2 : Size Type ( Scroll Bar ) Write Address undefined!
'A [Warning] 2 : Size Type ( List Box ) Read Address undefined!
'A [Warning] 2 : Size Type ( List Box ) Write Address undefined!
'A [Warning] 2 : Size Type ( List Box ) Read Address undefined!
2\ [Waming] 2 : Size Type ( List Box ) rite Address undefined! v

Gramimar CHK

Ef | Grid [Snap | Align Cursor 137,82

2.5.2 On-Line Run

Click [HMI] menu bar [On-Line Run] or directly press the shortcut key [F9]

or directly click the toolbar iconss . Execution of this function requires actual

connection with the controller, and during execution, the project will modify the
corresponding variable register set by the controller to verify whether the set
controller action can be performed normally.
Before [On-Line Run], you need to set the communication, click [HMI]

menu bar [Setup]-> [Communication Setup], the communication port setting in
the upload / download page refers to the use of the designated PC Which port
of the terminal is connected to the display unit. The communication port setting
in the emulation communication setting page refers to the communication port
on the display unit. Screenshots of the two pages are shown below.
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Protacol Set...

Protocal Set...

Upload/Download | Simulate COM Set
Upload/Download  Simulate COM Set
COM Port Set
COM Port Set
Connection Device: |COM1 Lj
COM1: |COM1 j

" Fix Baud Rate(115200,M,8,1)
&+ Auto. Baud Rate conz: |com2 |
Order | Setting Connect... I

0 115200,Mone,8 Bits,1 Bit 0

[#1 9600,None,7 Bits,1 Bit 0

[¥] 2 9600,Even,7 Bits,1 Bit 0

[ 3 9600,0dd,7 Bits,1 Bit 0

4 9600,Mask,7 Bits, 1 Bit ]

Ms 9600.Snare.7 Rirs.1 Rir n i

o 0K | XCancell o OK

2.5.3 Off-Line Run

Click [HMI] menu bar [off-Line Run] or directly press the shortcut key [shift

+ F9] or directly click the toolbar iconsx. When using this function, there is no

need to connect with the actual man-machine interface, so that the customer
can use it to check whether the project can be executed normally and verify
whether each function is correct.

2.5.4 Stop

When [Offline Execution] is not executed, this option is grayed out and
cannot be selected. This option is highlighted when the offline execution of the
computer needs to be ended. You can click [HMI] menu bar [Stop] or directly
press the shortcut key [Ctrl + F9] or click the toolbar icon &directly. Stop the
execution of offline.

2.5.5 Download to HMI

Before downloading the project to the HMI, you need to set up the
communication settings first. Here you can refer to the communication settings
in 2.5.2 online execution.

After the project is completed, you need to download the project to the
HMI. You can click the [HMI] menu bar [Download to HMI] or directly press the

shortcut key [Ctrl + Alt + S] or directly click the toolbar icon@. The dialog box

shown below is displayed.
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Download *

Download Time:
Download Data 68900 Bytes, Meed 11 Sec.

W Turbo Download(Valid aft. 0S v1.21, RS485 non-valid)

COM Port Set: |cOM3 - (USB Serial Device) -]
Option

[~ Init Register [ init Station 1D Group!

[ Update Password v Update RTC

[~ Clear Retentive Reg.

4 annloadl X cancel ‘ W5 Setup ‘

Turbo Download: After checking, the download speed is faster.

Com Port Set: Here, select the PC port where the host PC and HMI are
connected.

Init Register: After checking, the buffer is initialized when downloading.

Update Password: After checking, the password table will be updated
when downloading.

Clear Retentive Reg.: After checking, the data in the power-off retention
buffer will be cleared when downloading..

Init Station ID Group: After checking, the station number group setting will
be updated when downloading.

Update RTC: After checking, set the HMI time to be the same as the
computer time when downloading.

[Download]: Click the download button to download the program to the
HMI.

[Cancel]: Click the Cancel button to cancel the download of the program.

[Setup]: Click the setting button, a communication setting dialog box pops
up to set upload / download and COM port.

2.5.6 Save To File

In addition to downloading the created program directly to the HMI, the
software also provides a specific project to save the user-made program as a
suffix (.tpo) for users to download the program.

Note: if unchecked the menu bar [View]->[Option...]->[File]->[Add
Decompiled Information],then this file of(.tpo) can only be downloaded, and the
program cannot be modified.

Click the [HMI] menu bar [Save project to file], a dialog box will pop up
shown as below. Click the [Save] button to save the project as a HMI specific
file with the extension (.tpo). Click the [Cancel] button.
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Quick access B TP6043C.tpo
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Desktop
| |
Libraries
This PC
Network
File name: |
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& [ £ Ev

Date modified Type
TPWorks Editor File

TPWorks Editor File

2020-06-24 18:28
2020-06-24 18:08

=
=]

Size

Save

Cancel

it

If you need to download this program to the HMI in the future, you can
click the [Download HMI program ...] under the [Tools] menu to select the
desired file with the suffix (.tpo) to download to the HMI Interface.

2.5.7 Setup

Click [Setup]-> [Communication Setup] under the menu bar of [HMI], and a
dialog box as shown below will pop up.

Protocol Set...
Upload/Download | Simulate COM Set |

COM Port Set

Connection Device: ]COMl

" Fix Baud Rate(115200,N,8,1)
* Auto. Baud Rate

Order
[#o
[#11
[vl2
3
04
Ms

Setting
115200,Mone, 8 Bits,1 Bit
9600,None,7 Bits, 1 Bit
9600,Even,7 Bits,1 Bit
9600,0dd,7 Bits, 1 Bit
9600,Mask,7 Bits,1 Bit
G60N.Snace.7 Rits.1 Rit

Connect... | o

cCooo oo

Protocol Set...

Upload/Download

COM Port Set

COM1: ICOM]_

COM2: ]COM2

L Led

ok ||

" 0K | XCanceI|

Upload/Download

Connection Device: Set the COM port of the computer that the display unit

is connected to.

Fixed Baud Rate (115200, N, 8,1): Select this option to use only this
communication rate to communicate with the PLC.
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Auto. Baud Rate: Select this option, you can select multiple speeds. When
the HMI communicates with PLC, you can use the
selected speed for communication.

Simulate COM Set

COM1: Select the COM port on the computer.

COM2: Select the COM port on the computer.

After the simulation communication setting is completed, select [HMI
(M)]-> [Online Simulation] to enable the PC to communicate with the controller
as an HMI, so that the user can check whether the set function has achieved
the desired effect.

After the COM1 / COM2 settings on this page is completed, the
communication tap in the software is shown as below.

Bl mView : [C:\Users\EN\Desktop\0527.vxf] - O X
File Ecit View Project HMI(M) Component Tool Window Help

Ds-d Gy mE o k| 1

= & & Bh mrAE-QQ || Bry-F- - - BRABPEWE Q-

Graphic Component | Static Component | Button Display |edit |

O Em@ED®E| = H 5 @20 LB E @D

@ 220860 @ English (United States) >

E ~
EA— Blossbperon
% : » =T e = T e e
EE- 0FH NO ETT N2 ETE s N4 #2ad NG ETE s
B coM1
48 CoolMay PLC(3U/3G)/FX3U [9600,E,7,
[# 0 : CoolMay 3U Series [S5t=1]
""" i FHHE L N3 FHEH NG L] :
o Y 7Y
o rai y i i
2T 1 1 1
Al =] I
o I VI | WP
e I A I O W
o 0 O Y O
;. A/
o LUK
o AV N

< >

1
%S(reenl k=] Unkl & Tag

1= | Grid |Snan | Alian Cursor -1 40.. 429

2.6 Component

Click [Component], or press [ALT] + [C], the [HMI] drop-down menu
appears, as shown in Figure 2-6.1. In order to facilitate users to quickly select,
shortcut icons are also provided on the toolbar, as shown in Figure 2-6.2.

B mview : [C:\Users\EN'\Desktop\0527.vxf]
File Edit View Project HMI(M) | Component | Tool Window Help

B ™ | - - | %11l Cursor : : 7 B
| e = T [ Gephic B @ BB g B
Graphic Cumnunent] Static Component ;tatlc : IEu:lit ]
utton
| @ | @ m @ © = Disply + | & X @ R 12 1 B o
ODL20@&®OE Ht _ __Lih (United States) j
B
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2-6.1

Graphic Component | Static Component | Button Display | Edit |

L@ EmEmEE -~ = E @ We DB G A

2-6.2
For the use of each component, refer to Chapter 3 [Component] for details.

2.7 Tool

Click [Tool], or press [ALT] + [T], then the [Tool] drop-down menu will
appear, as shown in figure 2-7.1.

B mview : [C\Users\EN\Desktop\0527.vxf]
File Edit View Project HMIM) Component | Tool [Window Help
B ~H |l o ~r % Ez @ || T® Download HMI ...

; Upload HMI ... :
e o - .5 | W P S B0
% Update HMI 05 ...

v
=
Graphic Component | Static Component | Button  Displ; |

YO EEmE@E| B S P 'E

; 7 - | v English
@ NRERERORERERE) &) [ |Eng|i5h_[LIn'rted States) chr (EiE)

=

2-7.1
2.7.1 Download HMI...

Click the [Download HMI program ...] option under the [Tool] menu bar, and
the dialog box shown below will pop up. The purpose is to download the saved
file with the suffix name (.tpo) from the HMI. The file is for download only and
cannot be modified.

Create a (.tpo) file, click the [Save Project to File ...] option under the [HMI]
menu bar, and the current project will be saved as a (.tpo) file to the
user-specified location.
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| e E® e E
Date modified
2020-06-24 18:28

Type Size

TPWorks Editor File

Quick access s TP6043C.tpo
[EGTPe070Ctpo |

2020-06-24 18:08

TPWorks Editor File

Desktop

Libraries

=

This PC

Network

IiTPGD?DC. t;o i

File name:

Cpen |

Files of type:

I]TPWorks WM Ohject File (% tp01

iz
_vJ Cancel I

After selecting the (.tpo) file to be downloaded, select and click the [Open]
button. The following download dialog box pops up. After selecting the correct

port number, click the [Download] button.

Download

Download Time:
Download Data 69284 Bytes, Need 11 Sec.

|
¥ Turbo Download(Valid aft. 05 v1.21, R5485 non-valid)

COM Port Set: |cOM3 - (USB Serial Device)

—Option

[ Init Register
[~ Update Password
[~ Clear Retentive Reg.

& Download |

[~ Init Station ID Group:
W Update RTC

X Cancel J 5 Setup J

=

The project download process is shown below.
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Download >

Model : TPEO70C [0S Ver:1.38]
Download Time:25ec
Download 26880 Bytes

COM Port Set: |coM3 - (USB Serial Device) -]

Option

[T Init Station ID Group

X cancel ] M Set J

After the download is complete, click the [Finish] button to complete the
download process.

Download 34 .

Model : TP6O70C [0S Ver:1.38]

Download Time:65ec

Finish
AEEREEEEREEREREREEEEEEERREERRREREERD

COM Port Set: |COM3 - (USB Serial Device) -]

—Option
[T In

[T Init Station [0 Group

2.7.2 Upload HMLI...

Use this function to read the project in the HMI to the PC and save it as
HMI project for modification and subsequent download. Click the [Upload HMI
Program ...] option under the [Tool] menu bar, a dialog box as shown in the
figure below pops up. After selecting the correct communication port, click the
[Upload] button.
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Upload from HMI x
)
Upload Time:
COM Port Set: |cOM3 - (USB Serial Device) |
X Cancel ‘ & Setup ‘

After selecting and clicking the [Upload] button, if an upload password is

set in the program, the following password input screen will pop up:
i

Upload Password >

—Password

Password Hint:i

Password: I (Max.14 Char

W 0K X cancel |

Input password and click [Confirm], an upload picture will be shown as
below.

Upload from HMI Mo

Upload Time:205ec
Upload 22272 Bytes

COM Port Set: [coM3 - (USB Serial Device) -]

After the transfer is completed, the user will be asked to save the project
as a dedicated project with the suffix (.tpo), as shown in the figure below.
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ﬂ Save s et
Savein: | TPWorks l] L cf B
ﬁ' Name Date modified Type Size
Ghich oo ETPEVIMBC.tpo 2020-06-24 18:28 TPWarks Editor File
: ETPGD?{}C.tpo 2020-06-24 18:08 TPWorks Editor File
Desktop
M
Libraries
Thiz PC
Network
File name: ] Lj Save |
Save as type: |TEWorks HMT Object File (. tpo) | Cancel

Select the path to save the (.tpo) and click the [Save] button to save the
file that read from the HMI. Click the [Finish] button in the upload program
dialog box below, and the HMI reads the program is finished.

Upload from HMI o |

Upload Time:1:1
Finish

COM Port Set: |coM3 - (USB Serial Device) -]

« Finish T B et |

2.7.3 Update HMI OS...

For this software, if the new TPWorks software version is released, it will
be matched with the corresponding version of the OS. The role of the OS is to
the software compatible with the lower computer. If users need to use the
functions provided by the new software version, they need to use the new
version of the OS. The download steps of the HMI OS are as follows.
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1. Click [Update HMI OS ...] in the [Tool] menu bar, shown as below.

File Edit Wiew Project HMI(M) Component | Tool Window Help

DE~" |~ | % @@ % Download HM ..
e i ' Upload HMI ...
m ke bW .E'zzz?%ﬂi e

| %55 | oo wx = |
Graphic Component | Static Component | Button Displéh ipsabs HIMIOS < _

[+ | @ | = bed (ol (6] @ |m= @ B || LanguageSelect *

2. In the pop-up dialog box, select the OS version to update, as shown in the
figure below. It is recommended to update as the software version of the host
computer used.

Bl open 05 File ®
Look in: | L TPHorks 1.38.02 ~| = ErcfEr
ﬁ | Mame Date modified Type Size
; 1028 6/2/2020 5:17 PM File folder
Cluick access )
1033 6/2/2020 5:17 PM File folder
7l 2052 6/2/2020 5:17 PM File folder
Desktop model 6272020 5:17 PM File folder
= protocol 6/2/2020 5:17 PM File folder
m repository 6/2/2020 5:17 PM File folder
Libraries res 6/2/2020 5:17 PM File folder
@ runtime B/2/2020 5:17 PM File folder
= ush driver 6/2/2020 5:17 PM File folder
This PC [ vx0513802.vos 6/1/2020 4:46 PM VOS File 703 KB
Network
File name: [wos13802 -] Open
Files of type: jTP'ﬁ'orks 0S5 File (% bin;#. wos) LJ Cancal

3. After selecting the OS file, click the [Open] button, the following dialog box
pops up, click the [Update] button to start updating the OS system.
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Download Time:

X cancel |

COM Port Set: |coM3 - (Prolfic USB-to-Serial Comm Port) |

W Setup |

4. The update process is shown as below.

Update 05

Download Time:105ec
Download 40704 Bytes

5. After the update is completed, you need to power on the display unit again,

the following prompt box pops up, click [OK].

i Update 05 x

%

h Update Q5 FinishiTurn off HMI, and turn on.

2.7.4 Language Selection

There are three editing software languages available, [Chinese
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(Traditional)], [English], [Chinese (Simplified)]. The software for each language
is shown below.
[Chinese (Traditional)]

[English]

File Edit View Project HMI(M) Component Tool Window Help

R IEEERIET 1 RS- R Bl £ I |

Z L& el |[[DvsE-QQ b evovavia0-~¢raAD
Graphic Component | Static Component | Button Display | Edit |

KO EmmeE |~ B ag®e ket e

[Chinese (Simplified)]

TR

MfHF $REBE ZENV TEEPE) HMIM) mTHCQ IEM SO0 EEH)

A IEREGRAE | R e e B I
Zlbho ol |O-SEvQQ | Bvevovnv[a0~¢Ba
28 | #esntt | BT ETalF |§ﬁ§gm’¢|

0 EmEeE =2 B B a%e LS et aand

2.8 Window

Click [Window], or press [ALT] + [W], the drop-down menu of [Window]
appears, as shown in Figure 2-8.1.

N DR TP P TR R e A

File Edit View Project HMI{M) Component Tooi Window le[p

BE-E|o -~ ml|l5 - [% oo | %o ® F \
v ¥ = = Tile Herizontal(H) :
|u-§x@|@h vamv@m'ﬁte\krﬁc&fm nsc'l&ﬂ"@@llﬁ j
GradﬁlchrponentlethomponentlEutton Display | Edi
’_|.|---|§I-|-—EE||%ﬂklﬁl&%ﬁ%%%‘ﬂ%% |
2-8.1

When you need to use multiple screens in a project, in order to facilitate
viewing and editing, you can select this way to edit the screen, as shown in the
following figure, you can choose [Cascade], [Tile Horizontal], and [Tile
Verticall.


WMB220303
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[Cascade]

m mView : [C:\Users\EN\Desktoph0527.vxf]

File Edit View Project HMI(M) Component Toeol Window Help
B "o~ 3me||s-t-E-a
(#|2h6 bW |[m-SE-QQ
Graphic Comuonent.1 Static Comuonént] Button Display |Edit | .

O EmemomE|~=28 B adSebkrkBtsesand ]
90220 @©&®@®® |||engsh (Unted States) ] |

0~ ¢RBBBE Y-

1
rScene Management =
REBESROL BF -

B TK6070FH ' BN 1 Scened 50%] [= |]
=B Init Scene Group Bl Scenet 50%] =

-3 2 : Size Type [

B 1: Scenen

-3 3 : Scenel

B Systern default group
& 65000 : Value input dialogue box =

65001 : String input dialogue box

65002 : Password input dizlogue box i | E | 1 | g | o | N7| B |

65003 : Password accurately message |

: Password error message | ) 7

: System setting screen

: Systemn message screen

: HEX input dizlogue box

: Download screen

: Virtual on-line

-8 65012 : USB Downlozd

=B System screen nig  FEEE [
- 65100 : Brightness and Contrast | ] k

3 65101 : Calendar C
-3 65102 : Backlight

- 65103 : password edit
- 65104 : Communication
B3 65105 : Adjust screen

By 2 Size Type [50%)]

NO| |N2| |N4 | NG| |

[Tile Horizontal]
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File Edit View Project HMI(M) Component Tool Window Help
BDE-& v - | % Bz & * et : L v s
L4692 B M-S E-Qa || %
Graphic Component | Static Component | Button  Display |Edit |

k@ EmmEm -8 E S ekhsesY Y et ‘
DORO0@OEOQEGO || nted sotes) =

x|
Scene Management- P 2 Size Type [50%)] @

BB RRBELIGS (BH 0 i | M
1 N3 NS e I‘J? L
3 7
T

= M TKG070FH
n
T

&
“

%
]

25 Init Scene Group H

B 3: Scene1

E-0 System default group

: Value input dialogue box

: String input dizlogue box

: Password input dialogue box
: Password accurately message
: Password error massage i ’— |
: System setting screen

: System message screen IS

: HEX input dialogue box
: Download screen

< Virtual on-ine

: USB Download

B-FY System screen

B3 65100 : Brightness and Contrast
: Calendar

: Backlight e
: password edit

: Communication
B3 65105 : Adjust screen

F—
7
]

Preview : 25% E

Zscreen: | Link ] & Tag

= Snap | Align Cursor [ 144, 100

[Tile Vertical]

File Edit View Project HMIM) Component Tool Window Help
DES-d b G B : a i
E b & ol ] O fE-QE | B-%-¢ "R c0-¢BA0F0E V-]
Graphic Component | Static Component | Button Displey |Edit |
O mMEEE®E ~& & @50 B EYEE®

Q02O eeREeE Englsh (United States) -
| ||

Scene Management B 3: Scenet [50%] (55| =] =

hEm(ABOA | O& BE 1 (73 I TR Y e,
T T6070FH 3 R
I Inic Scene Group El sel | az
[ 2 : Size Type

B 1: 5cened

B 3 : 5cenet
I System default group
[ 65000 : Value input dislogue box
@ 65001 : String input dialoque box
{3 65002 : Password input dislogue box
[ 65003 : Password accurately message
B3 65004 : Password error message b ’/ —

acx)

B3 65005 : System setting screen
B3 65006 : System message screen
[ 65007 : HEX input dialogue box
B3 65010 : Download screen

B 65011 : virtual on-ine

B3 65012 : USB Download

I System screen

B3 65100 : Brightness and Contrast
B 65101 : Calendar

B3 65102 : Backight

B 65103 : password edic

B3 65104 : Communication

B3 65105 : Adjust screen

2.9 Help

Click [Help], or press [ALT] + [H], the [Help] drop-down menu appears, as
shown in Figure 2-9.1.
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|Help (H)
TPWorks Help  F1
About (A} ..

2-9.1
Click [TPWorks Help],pop up the user manual of this software. Users can
find related contents.
Click [About...], the software version will appear, as shown in the figure
below. Please pay attention to whether it is the latest version. If you have any
questions, please contact us.

TPWorks

Chapter 3 TPWorks Component Function Description

The components provided by this software are divided into the following five
categories:

1. [Graphic].

2. [Static].

3. [Button].

4. [Display].

5. [Edit].

3.1 Graphic

To use a graphic component, you can click [Graphic] under the
[Component] menu bar, and the drop-down options appear, as shown in the
following figure 3.1-1, or you can directly click this option on the shortcut bar of
the tool, as shown in the following figure 3.1-2 Shown
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|_ComponenE- Tool Window Help
s Cumor |~ ~ %« | B
Static | Line
Button b O Circle
Display  *| 2 Ellipse
Edit ¥ | [ Rectangle
() Round Rectangle
) Arc
£ Pie
£} Chord

=P clygon
% Curve

@ Fill Ellipse

E2 Fill Rectangle

(&) Fill Round Rectangle
<3 Fill Pie

<) Fill Chord

#% Fill Polygon

3.1-1
Graphic Component | Static Component | Button | Display | Edit |

K|+ 20000 Q& wli
3.1-2

Select the component you need. Click the component and press the right
mouse button to select the object properties, or double-click the mouse directly
on the component to be edited, the component property settings appear. The
[Point] and [Line] property window are shown as below:

—Point

Style: (o JE -

Color: | 1| :I

—Position

X: |141 X: |1|:|1

W: IE H: IH

v 0K X Cancel |
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rLl'ne ﬁ
Pen

Style:

Color:

Position

X1:  [456 Y1 1152
X2 [102 Y2 {160

W OK X Cancel |

Style: The display of point or line is available.

Color: Modify the color of the component.

Position: X1 /Y1 represents the leftmost point of [Line], X2 / Y2 represents
the rightmost point of [Line].

X: Modify the coordinates of X so that the component X coordinates move to
the modified X coordinates.

Y: Modify the coordinates of Y so that the component Y coordinates move to
the modified Y coordinates.

The properties of other components are the same. There is an example here.

Ellipse |

Pen Brush

Style: Style:

Color

Position

X |12 Y: o |80

W: |97 H: |73

o DK X Cancel |

Pen:

Style: Select the style of the ellipse frame.

Color: Select the color of the ellipse frame.
Brush:

Style: display and set the style of ellipse inner frame.
Position:

X: Enter the X coordinate position of the ellipse element.
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Y: Enter the Y coordinate position of the ellipse element.
W: Enter the width of the ellipse element.
H: Enter the height of the elliptical element.

3.1.1 Brush Settings

The previous section introduces brushes. This section explains the brush
setting steps and details.
Click the preview image in the Brush Style, there will pop up the variable brush
dialog box shown as below.

Yariable Brush

Brush
Brush 5tvle: [ Brush Effect:  [jormal -l

[~ Variable Brush

& OK | %X [‘.ancel|

Brush Effect: Select normal or flash effect in the drop-down list.
Click the preview of the brush style, and the brush selection dialog box will

pop up.
[ Select Brush ﬁ

Patten | Gradual

Foreground Color:

I Background Color
e v|

D Sample:

W OK X cancel |

Pattern: Select the brush pattern to be displayed.
Foreground Color: set the brush pattern color.
Background color: Check the background color to display the

97



TP Series HMI Programming Manual

background, otherwise there is no background color. Set the background color
of the brush pattern.

[OK]: After setting, click [OK] to save the settings.

[Cancel]: Click [Cancel] to not save the selected settings.

Variable Brush: Check this option to set the parameters that control
brush changes. The dialog box is shown below.

Variable Brush
Brush
Brush Style: | ‘ ‘ Brush Effect:  [yormal |
v Variable Brush
Data Format: |[16|3'rt'_| Signed ﬂ
Condition: [p1 | =
= = Condition: - -
Add Delete Copy |{ J
Condition Condition: |[33 j E..]
E==D1
_——- D2 Pen Style: =11 =]
11 <=D3
Pen Color: v|
Brush Style:
NENRN NN R RN AR NAN
Brush Effect: |Normal |
V' e | X B \

Data Format: Select the type of variable that controls the brush change.

Condition: Set specific variables.

Condition: Set the conditions of the brush changes, providing a total of six
conditions to choose from: equal to, not equal to, greater than, equal to, less
than, less than or equal to.

Condition: Set the contrast variable. As shown in the figure above, set DO
to display different brushes when compared with D1/ D2/ D3.

Pen Style: Select the style of the brush frame.

Pen Color: Select the color of the brush frame.

Brush Style: Select the pattern displayed by the brush.

Brush Effect: Select normal of flash effect.

[OK]: After setting, click [OK] to save the settings.

[Cancel]: Click [Cancel] to not save the selected settings.

3.2 Static Component

Click [Static] under the [Component] menu bar, and the drop-down option
for the static component appears, as shown in the following figure 3.2-1, or you
can directly click this option on the tool shortcut bar, as shown in the following
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figure 3.2-2 Shown
| Cl:rr'rjpcu_rjen_t- Tot
[:.}- Cursor

Graphic * |

Button b ] Bevel
Display  F|uww Scale

|

Edit » BB Table
"W Picture
Memo
3.2-1

& ViewX
File Edit View Project HMIM) Component Tool W
DE~"djv >~ B8 .
lZ| 2 2 3| a'wm | > E @ al|

Graphic CommnenButton | Display | Edit |
[Ty | eee (3 we BB

3.2-2

3.2.1 Static Bevel/ Text

After selecting the component to the editing area, right-click the mouse to
select [properties], or double-click directly on the component to be edited, the
properties of the component will appear, the static bevel and text property
dialog boxes are shown in the figures below.
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=

Label :
Bevel |Tex’c |
~Bevel P
Style:
Label QutColor: [ ||,
In Color: . -

—Position

X 209 ¥ 105

¥ 240 " ZI

W 0K i X cancel I
Label X
Bevel Text i
—Text
Language:  |Englsh (United States) =~
Color: I .| ¥ Word Wrap
Align: | center |
Effect: [Normal -]
Flash: INDrmaI ;]
Font: [Tahoma [9] 4|F0nt
Text: Label
o 0K X cancel i
Bevel

Select: Select the bevel style of the component, click [Select] to pop up the
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Bevel
{Rectangle of System |
Label Label Label Label
Mo Frame A0 -tiny 30-Mean 3D -Thickness
Label Label Label Label
Framel-Tiny Framel-tean Framel-Thickness Frarmel-F at
Label Label Label Label
30_Angle-Tiny 30_Angle-Mean 30_Angle-Thickness Framell-Tiny -

o OK I x Cancel‘

Out color: select the color of the frame of the component.

In color: select the inner frame color of the component.
Brush

Style: Select the brush style of the component, refer to 3.1.1 for details.
Position

X: Set the X coordinate position of the element.

Y: Set the Y coordinate position of the element.

W: Set the width of the element.

H: Set the height of the element.
Text

Language: Select the language to be used by the component.

Color: Select the text color of the component.

Word Wrap: Check this option. When the length is insufficient, the text will

automatically wrap. Otherwise, no line feed processing will be performed.

Align: Select the text alignment position of this component.

Effect: Select whether the text is displayed as normal or move.

Flash: Select whether the text is displayed normally or blinked.

Font: Select the font of the text. A dialog box for selecting specific font
properties is displayed as shown in the figure below.

Text: Enter the text to be displayed. This component supports the display
function of the embedded numeric value of the character string. For detailed
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settings, please refer to Appendix 6 for the display function of the embedded
numerical value of the character string.

Font: Font style:

|Tahn:|ma |Hegular

Team\Viewearls
erminal

imes New Roman
Tradicional Arabic W

- Hfects

[ Strikeout
[ Underine AaBbYyZz
Color:
| I Custom | | Script:
|‘|"'.|'estem LJ

Font: Select the font style of the text.

Font style: Select the font style of the text.

Size: Select the font size of the text.

Effect-Strikeout: Select whether the text needs to be displayed with
strikeout.

Effect-Underline: Select whether the text needs to be underlined.

Effect-Color: Select the color of the text display.

Sample: Display the effect of the selected text style.

Script: Select the language range when entering characters.

3.2.2 Scale

The property dialog box of the scale component is shown in the figure
below. Since the [Bevel] setting is the same as that in Section 3.2.1, there is
not much to repeat here, please refer to the [Bevel] setting in Section 3.2.1.
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B scale — O *
Bewel Smlel
Scale Pen
Posicion: R = -]
Master Count: |5 ﬂ Colar: 'I
Slave Count:
2 2]
[+ Scale
v Axis
Cption
v Display Marks Color: T v]
Max: |1|;||;| ~| Em Decimal Pu:us.:||:, LJ
Mir: ||;| l.| Display unit: |
Font:
Tahoma [8] Font
W 0K | X cancel |

Scale

Position: Select the scale direction.

Master Count: select the main scale number, including the top and bottom
scale.

Slave Count: select the minor scale number, the small scale in the main
scale.

Scale: Check “scale”, the scale will be displayed when editing the screen,
and it will not be displayed if it is not checked.

Axis: Check “axis”, the coordinate axis will be displayed under the scale of
the editing screen, and if it is not checked, it will not be displayed.

Pen
Style: Select the scale style.
Color: Select the color of the scale style.

Option

Display Marks: Check the display marks, and the scale will display the
value of the large scale, subject to the maximum and minimum settings.

Max: Set the maximum value on the scale.

Min: Set the minimum value on the scale.

Color: Set the display color.

Decimal Pos .: Set the number of decimals in the display mark.

Suffix: Set the display unit of the display mark, which can be left blank.
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Font: Set the font of the display mark. For detailed settings, please refer to
the font setting in 3.2.1.

3.2.3 Table

The property dialog box of the table component is shown below. Since the
[Bevel] is the same as that in Section 3.2.1, there is not much to repeat here,
please refer to the [Bevel] setting in Section 3.2.1

B Table 12 0 %
Bevel Table l
Tahle— Pen
Row Count: 5 - Style: |E| 11 LJ
Column Count: |5 ii Color: i 3 ,J

[~ Separator Line

o OK X cancel |

Table

Row Count: Select the number of lines in the horizontal grid.

Column Count: Select the number of lines in the vertical grid.

Separator Line: Check the separator line, a diagonal line will be generated
in the upper left corner of the field, as shown in the blue circled part below.

Pen

Style: Select the line style of the table component.
Color: Select the line color of table components.
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3.2.4 Picture

The property dialog box of the picture component is shown below. Since
the [Bevel] setting is the same as that in Section 3.2.1, there is not much to
repeat here, please refer to the [Bevel] setting in Section 3.2.1.

[ Picture ﬁ

Beve| Picture ]

Image/Picture

Load

Clear

conlma“ X=|IE| 2] vo 3
PLC &' HMI Dpltrifnsnetch

[~ Transparent

AII-In'One Transparent Color:

I

W 0K | b4 Cancell

Image / Picture
Display the display effect after loading the graphics.

Load: Click this button to pop up the dialog box, select the graphic or
animation pattern to be loaded.

Available formats: png, gif, jpg, jpeg, bmp, ico, emf, wmf.

Clear: Click this button to clear the previously selected graphic.

Offset

X: Use the center point of the picture element as the base point to shift left
and right in the X direction.

Y: Use the center point of the picture element as the base point to shift up
and down in the Y direction.

Option

Stretch: Tick stretch and the graphics will be automatically scaled
according to the window size.

Transparent: Tick transparent to make the selected graphics appear
transparent.

Transparent Color: Select the color that needs to be transparent.
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3.2.5 Memo

For details of attribute setting, please refer to chapter 3.2.1 Static Bevel/
Text.

3.3 Button

To use the button component, you can click [Button] under the
[Component] menu bar, and the drop-down option of the button component
appears, as shown in the following figure 3.3-1, or you can directly click the
option on the tool shortcut bar, as shown in the following figure 3.3-2.

Component  Tor

[+ Curser
Graphic
Static o

|

Display * OFF Button
Edit r Switch Button
1 [a] Held Button

Set Value Button
23 Const Button
Inc Button

=] Dec Button

B8l Jurmp Buttom
[E4 Back Button
[Fun] Fun Button
[ve¥] ey Button

[123] Set Status Button
[=2] Traget Button
Data Maove Button

3.3-1

Graphic Component | Static I:ZI::nml:lcnr'lvar1tDisl:ll.an.-I | Edit |
[y | N el B9 (o) | ([ E 6 & (=] | PE (B ) e | e G 63

3.3-2
3.3.1 ON/ OFF Button and Switch/ Hold Button

After selecting the component, right-click the component to select the
component properties, or double-click the component to open the component
properties dialog box. The property dialog box of the ON/ OFF button and
Switch/ Hold button components is shown below.
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SW Button b4

Button l Control 1 Status ]

—Bevel —Brush

| Select I Style:

Out Color: T ",I
In Color: [ ',I

—Position

X 608 Y: 208
W ]807 iz Ini
o 0K ‘ X cancel J
1. Button

As the properties of the [Button] page are the same as the [Bevel] settings
in Section 3.2.1, there is no need to repeat here. Please refer to the [Bevel]
settings in Section 3.2.1.

2. Control

SW Button X

Button Control | status |

Data 7 Option
Action: |S'.'Jitch _,J Security: |By ccene _,J
Read Address: || ,,] Confirm: |PFESS.aCtiDn _"J
o A Key Def: |Undefined |
Write Address: hd Key Window: |Undeﬁned _'J
Notification: - Sound: |Undefined -
Enabled Flag: | _,J o

On Macro: T [~ Hide Object

. [~ Hide object when disabled or security
R :]' ¥4 [~ Prompt if Priority Lack
[~ Set last priority after play.

W 0K | xCanceI‘

Action: There are four actions to choose from, and you can choose the
state the button action.

Read Address: Read the value of the position of input relay or system
variable.
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#8: Represents the reading position, and the type is bit.

Write Address: Write the value to this location of the input relay or system
variable.

#8: Represents the writing position, and the type is bit.

Notification: If a value is written to the position of the input relay or system
variable, the position will be notified.

On Macro: Click the drop-down arrow to select the macro command
edited in advance, and execute the selected macro command when the button
is ON.

Off Macro: Click the drop-down arrow to select the macro command
edited in advance, and execute the selected macro command when the button
is OFF.

Option

Security: Since you have the authority to set the screen when creating a
new screen, please refer to Section 2.4.1 Screen. If the authority set here is
higher than the screen authority, the account and password will be required to
enter when the button component is run on the emulation or human-machine
interface.

Confirm: Release. action: Run the action when the button component is
released.

Wait Sec: Set waiting time in order to avoid accidentally pressing. When
press the button, you will wait for the time as set here before running the
component action.

Press. action: Run the action when the button element is pressed.

Key Def: After setting the keyboard definition in Section 2-4.5, you can

select the function you need.

Key Window: This function is only available when the screen properties
have dialog box properties. Press the button, the selected
dialog box window will appear. If this function is oprated, a
dialog box window will appear to determine whether to run a
certain function.

Sound: Set the sound when the button is clicked.

Enabled Flag: Set the condition variable. If set variable as 1, the button
can perform the corresponding action, otherwise the button
does not act.

Hide Object: Check this option to hide the component.

Hide Object when disabled or security: Check this option, the component
will be hidden when the authority is not reached, or the
controlled conditions are not met.

Prompt if Priority Lack: Check this option, when the permission is
insufficient, the component will display a prompt symbol (small
lock) to indicate that it cannot be operated. The lock will not be
canceled until the permission is sufficient.
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Set Last Priority after Play: After the action, set the last priority. Check this
option, click the button, after the action is completed, modify
the [Option]-> [Security] — “Use Level 9 (Low)”.

3. Status

SW Button x

Button | Control Status l

Language: |Eng|i5h (United States) ﬂ
Preview 1 ~Status 1
B OB &
j clete Brush Immge  Text
Index | Text
1
Text: | B

o 0K | XCanceI‘

Language: Select the current language. For details, please refer to
Section Chapter 5 Language Management.

Preview: You can see the input text preview here to prevent input errors.

Status

Add: Since there is only 0 or 1 status, there is no new function here.

Delete: Since there is only 0 or 1 status, there is no new function here.

Brush: For specific settings, please refer to 3.1.1.

Image: For specific settings, please refer to 3.2.4.

Text: For specific settings, please refer to 3.2.1.

Copy: Since there is only 0 or 1 status, there is no new function here.

Index | Text: Index O is the text displayed when the button is pressed, and
index 1 is the text displayed when the button is not pressed.

Text: Input text to be displayed here.

aﬁ'.: Click this button to copy current text to all status.

3.3.2 Set Value/ Const Button and Inc/ Dec Button

After selecting the component, right-click the component to select the
component properties, or double-click the component to open the component
properties dialog box.
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1. Button
As shown in the figure below, the properties of the [Button] page are the
same as the [Bevel] settings in Section 3.2.1, please refer to the [Bevel]
settings in Section 3.2.1.
Set Value Button

Button | pata | status|

~Bevel —Brush
Style:
Select
Out Color: |:|!_I
In Color: N |~
—Position
X |112 ¥: |32
width: [gg Height: |4g

' 0K | X Cancel |

2. Control
Set Value Button

Button Data |status|

Data —Option
Action: [yar/Const | Securtty: |By scene =l
Format: |[16Bit] Signed x| Confirm: | press_action =l
Write Address: I vI » Key Def: |Undeﬁned ]
Rule: I ,I @ Key Window: Iundeﬁned ;j
Max: I .I = Destine Voice |Undeﬁned -
Min: I vI IE..] Enable Provison I ,i
Notification: I .I Enabled Condition: |NDRMAL ]
Motification Type: |SET | I~ Hide Obj
Befor M 7 - ; g ;
ELSLE I :] ¥4 [~ Hide as priority lack or disable
After Macro: | vI 3

[~ Prompt as priority lack
[ Set last priority after play.

—Format
Decimal Pos.: g 5 & Dac
| —l " Hex
[~ Data arrangement swap " 32bit Float
" 0K X cancel |
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Data

Action:

Input: Used in conjunction with the keyboard window, input data
from the screen to the contact variable position.

Var/Const: Select this option, the value to be input to the contact

variable can be input by the writing rule.

Inc/Dec: Select this option, and click the button once to add or

subtract the data set in the rule once to the contact variable.

Format: Select the data format to be written.

Write Address: Enter the position of the contact variable to be written.

Rule: Set the calculation method of the written data or variables.

When the action selection is variable / constant, directly input the
value to the contact variable.

When the action selection is Inc/ Dec, if the value is increasing, the
symbol [+] should be added in front of the value, and if the
value is decreasing, the symbol [-] should be added before
the value.

@n: This icon is the identifier of the arithmetic element variable, indicating
that the calculation between variables is supported here. For example: N100 +
N200 are filled here, when writing data, the system will calculate the result of
N100 + N200 and write it in. For details, please refer to Appendix 4 Instructions
for Using Operation Variables.

Max: The maximum value of the reading range of the input position.

Min: The minimum value of the reading range of the input position.

The maximum and minimum value can be not input. When not input,

the value range refers to the set data type.

Notification: The input relay or system variable position will be notified

when a value is written to the position.

Notification Type: Used in conjunction with write notification, you can

choose to write 1 or write 0. If the write notification is set to
[MO] and the write notification mode is [write 1], if a value is
written to the write location, MO=1.

Before Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The macro
is triggered when the button is pressed.

After Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The button
will trigger when the macro pops up.

Option
Please refer to option instructions in 3.3.1.

Format
Decimal Pos.: Set the number of decimal places.
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Data arrangement swap: high and low bytes swap. 16 bit: high and low
BYTE swap; 32 bit: high and low WORD swap.

Dec: Check this option to display as a decimal value.

Hex: Check this option to display it as a hexadecimal value.

32bit Float: Check this option to display 32-bit floating point values.

3. Status
For details, please refer to the status instructions in 3.3.1.

3.3.3 Jump/ Back Button

After selecting the component, right-click it to select the component
properties, or double-click it to open the component properties dialog box.

1. Push Button
Please refer to the [Bevel] settings in Section 3.2.1.

2. Control

| 5cene Button pd

Push Button Control | status |

Control i —Option

Scene Switch: [FREAE - - Priority |By scene -
. Confirm |Prass.action -
Switch Notes | LJ Key Def. |Lln|:|eﬁnen:l LJ
| Befor Macro: | ~ & Key Window  |yndefined ]
o e | LJ » Destine Voice ||_||-|E|Eﬁned -
Controlled cnndi| LJ BB

| Hide Obj.

[ Hide as priority lack or disable
[ Prompt as priority ok
[ Set Levle 9.

o OK | x Cancel‘

Control

Scene Switch: When there are multiple screens in the project, this function
can be used to switch screens, and we can choose which screen to jump to or
return to.
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Switch Notes: Set the naotification action when the screen is switched, i.e.
you can set a certain register to be turned on or off when the screen is
switched.

Before Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The macro is triggered when the
button is pressed.

After Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The button will trigger when the
macro pops up.

Option: Please refer to option instructions in 3.3.1.

3. Status
For details, please refer to status instructions in 3.3.1.

3.3.4 Fun Button

The details of the function button property settings, please refer to chapter
3.3.1. This section only explains the different settings.

Action:

Set to last priority: Select it to set the screen attribute authority to the
minimum.

Inputs password again: Select it to input password again.

Clear all alarm event: Select it to delete all alarm events.

1 Fun Button >

Button Control | status |

Data 1 Option

Action: Set to last priori 2 Security: |B}i sCene L]
Notfication: | ~] - Confirm: |Press.action |
; Key Def: |Undefinad |
Befor Macro: | LJ ¥ Key Window: |Llndeﬂned L]
After Macro: | lJ 2 Sound: |L|nl:leﬁneu:l =
Enabled Flag: | LJ

| Hide Object

I Hide ohject when disabled or security
[ Prompt if Priority Lack

o 0K | X CancelJ
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3.3.5 Key Button

The detailed instructions of Button and Status, please refer to chapter
3.3.1. This section only explains the different settings.

| Key Button x

Key Define Option

Normal: {Undefined =~ RHOEY |By scene =
Shift: [Undefined ~| Key Def.  [yndefined |
Ctrl: [Undefned ] Destine Voice [ndefined =
Alt: [undefined =l

Motification: | ﬂ .

Befor Macro: | - 2

After Macro: | x| &

o 0K X cancel
| |

Normal: The action to be performed when the button is pressed.

: Click this icon to copy the function set by the current button to the

other three buttons.

Shift: The action to be performed when you press the [Shift] key and then
press the button.

Ctrl: The action to be performed when you press the [Ctrl]] key and then
press the button.

Alt: The action to be performed when the [Alt] key and then the button is
pressed.

Notification: Click the button and write 1 into the set position.

Before Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The macro is triggered when the
button is pressed.

After Macro: directly enter the name of the edited macro or click the
drop-down arrow to select an existing macro. The macro is triggered after the
button pops up

Key Def.: It can be used when the man-machine model supports keyboard
keys.
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The Shift, Ctrl, and Alt keys here refer to those that set with the key buttons,
not those of the computer keyboard. As shown in the following figure, the Shift
key is used as an example, and this button will be used as the functions of
shift.

| Key Button X
Button Control | status |
[~Key Define ~Option
Norre O rrr—
Shift: [shift | Key Def. |undefined -l
Cerl [shift = Destine Voice |ndefined id
Al [shift |
Motification: | Lj
Befor Macro: | e (e
After Macro: | x| &
Eralia

In the status, all the texts are typed into shift since this button is only used
as a shift function and has no other functions. If it contains other functions,
please set according to the function name.

As shown in the figure below, the index value is 0 ~ 3, which means that

the normal key is 0, Shiftis 1, Ctrl is 2, and the Alt state is 3, so if we want a
key button to have many functions, we can set the functions according to it.
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] Key Button <
Euttun] Control Status ]
Language |English (United States) ~]
Preview: —Status
22 ™ -
= Brush Image Text
|| Index | Text
0 shift
T shift
2 shift
3 shift
shift
Word Input |5h'rFt B
o OK | X CanceIJ

The setting of the shift key is completed as shown above. When the button
is pressed in the screen, it means that the shift key is pressed, so that the
above-mentioned Shift, Ctrl, Alt state can be used accordingly.

3.3.6 Set Status Button

The detailed instructions of Button and Status, please refer to chapter
3.3.1. This section only explains the different settings.
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1 Set Status Button p4

Push Button Control | status |

Press | [ Option i
Format: |[153-¢] Signed LJ Priority |B}f s LJ
Virte Address: " lJ * Key Def. |Undeﬁned LJ
Value Address: | LJ o8 _

Notification: | ~| == Key Window | indefined |
Press Macro: | LJ o Destine Voice 1L|ncleﬂned =

Release Controlled cnn| L]

Format: |[168it] Signed ~]

Write Address: | LJ ¥

Value Address: | LJ 3 [ Hide Obj.

Write Nntiﬁmtinn| LJ - [ Hide as priority lack or disable
Release Macro: | LJ ) [ Prompt as priority flack

o 0K | X Cancel‘

Control

Format: Set the format of the register variable.

Write Address: Set the location to write data.

Value Address: Set the content that written in. For example, set it as DO,
and the writing position as D1. When the action occurs, write the contents of
DO to D1.

Notification: When writing, set the variables set by the notification.

Press Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The macro is triggered when the
button is pressed.

Release Macro: Enter the name of the edited macro directly or click the
drop-down arrow to select an existing macro. The macro is triggered after the
button is released.

3.3.7 Target Button

The detailed instructions of Button and Status, please refer to chapter
3.3.1. This section only explains the different settings.
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Trigger Button

Push Button Control | status |

Control Opfion
Read Address: | j Priority |B}r scene j
Base Address: | ﬂ Key Def. |L|n|:|eﬁneu:l -
i Scale Address: | | Controlled con| -]
Press Macro: | ﬂ v tonim
Release Macro: | ﬂ v I Hide Obj.
[ Hide as priority lack or disable
Operation variable [16Bit] sign T
Target id=base+{read*scale). [ Prompt as priority lack
Paint
Pen Style: ||:| 10 ﬂ Brush Style:
Pen Color: I |~ |
' 0K X Cancel |

Project making: when there is a series of parameters to be set, in order to
facilitate the settings and avoid misoperation to hit other settings, you can use

the trigger button.

Read Address: Select a variable as the basis for switching the number of

columns.

Base Address: Set according to the serial number of the first column of
components, click [F4] to view the component serial number. For example, if
the serial number of the first element of the parameter element needs to be set
as 8 on this line, the cardinal position is selected as 8.

Scale Address: Set according to the number of rows of the group where
the component is located. For example, if the row is the third row, set it to 3.

3.3.8 Data Move Button

The detailed instructions of Button and Status, please refer to chapter
3.3.1. This section only explains the different settings.
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1Data Move Button >

Push Button Control | Status|

Control 1 —Option 1
Read Addr. | j Priority |B‘r‘ ccene ﬂ
wite Addr. | & Confirm [Press.action %
: Key Def. |undefined |
Datalength: |1 | (16Bits) Key Window  [Undefned E|
™ Write multiple data at once Destine Voice |Undeﬂned -
Write Not'rﬁmtio| j B Controlled condi ~| =m
[ Hide Obj.

Befor Macro: | ﬂ ) [~ Hide as priority lack or disable
[~ Prompt as priority lack

After Macro: | ﬂ ) [ Set last priority after play.

o 0K | X Cancel]

Read Address: Set the start position of the variable that needs to read
data.

Write Address: Set the start position of the variable that needs to write
data.

Data Length: Set the number of data to be read and written.

For example: As shown in the figure above, when you click the button, the
values of 10 data in DO-D9 will be read and then written into 10 registers in
D10-D19 respectively.

3.3.9 Numerical set ON/ OFF button and Alternate / Hold type button

After selecting the component, right-click in the component to select
component properties, or double-click the component to open the component
properties dialog box. The property dialog box of Numerical set ON / OFF
button and Alternate/Hold button components is shown in the figure below.

1.Button: As shown in the figure below, since the page properties of [Button]
are the same as the settings of [Bevel] in Section 3.2.1, there is no need to
repeat the explanation here. Please refer to the [Border] settings in Section
3.2.1 for yourself.
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ON Button
Push Button | pata | Status|
—Bevel —Brush
Type:
Selact
Out Color: [ !,!
In Color: N~

rLocation

X |15 ¥ |24
Width: Ilgq Height: |24

2.Control: as shown in the figure below.
The button to set the value to ON

Push Button Dafa |Smtu5|

—Action: —Option
& Set ON " Set OFF =

P 3 -
" Alternating type  { Retention type LY IE'f SCENE _I
Confirm: |press.action |
~Data Key Def.: |Undeﬁned ;I
5 Key Window: =
Data Format: | 16-bit unsigned value = | |undefined 5]
Destine Voice: IUndeﬁned ;I

Read Addr.: I ~| @
Read bit offset (U16): [g e Enable Provison: | =]
Enabled Condition: |NDRMAL -

Write Addr.: I Li ¥

iite bt offset (U16): [g o= {0 L it
[ Hide as priority lack or disable
Write Motification:: v
rike HotHication I _i [ Prompt as priority lack
Motification Type: - Ll

o SE TR ISET _i [ Set last priority after play.

On Macro: I Li 3

Off Macro: I Li 3

Action
Action: There are four actions to choose from, you can choose which state
the button action is.

Control
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Data Format: Select the type of data, there are two types: 16-bit unsigned
and 32-bit unsigned.

Reading Addr.: The position of the input system variable.

Read bit offset (U16): Set the bit of the variable to be read; 0-15.

Write Addr.:The position of the input system variable.

Write bit offset (U16): Set the bit of the variable to be read; 0-15.

Write Notification: The input relay or system variable position, if a value is
written to the writing position, the position will be notified.

Notification Type: Used in conjunction with write notification, you can
choose to write 1 or write 0. If the write notification is set to [MO] and the write
notification mode is [write 1], if a value is written to the write location, M0=1.

On Macro: Click the drop-down arrow to select the pre-edited macro
command, and execute the selected macro command when the button is in the
ON state.

Off Macro: Click the drop-down arrow to select the pre-edited macro
command, and execute the selected macro command when the button is OFF
Options

Priority: Because there is the authority to set up the screen when
creating a new screen, please refer to section 2.4.1 Screen Management. If
the authority set here is higher than that of the screen, when this button
component is run on the emulation or HMI, it will be asked to enter the account
password.

Use confirmation:

Action when released: Run action when the button element is released.

Wait X seconds: In order to prevent us from accidentally pressing it, so
here is set to wait for the set time after pressing the button before running the
component action.

Action when pressed: Run the action when the button element is
pressed.

Keyboard Def.: After setting the keyboard definition in chapter 2.4.5, you
can select which function you need to set before.

Keyboard Window: This function can only be used when the screen
attribute has a dialog box attribute. When the key is pressed again, the
selected dialog box window will be displayed. Generally, this function is used
to display a dialog box window to determine whether to run a certain function.

Destine Voice: Set the sound to be emitted when the button is clicked.

Enable Provision: Set the condition variable. When the set variable is 1 or
0, the button can perform the corresponding action, otherwise the button will
not operate.

Enable condition: Used in conjunction with controlled condition, when the
variable can be setto 1 or O, it is controlled. If the controlled condition is set to
[M1], the controlled condition mode is [when the variable is 1, controlled]; when
M1=1, the button can perform the corresponding action, otherwise the button
will not work.
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Hidden Obj.: Check this option, the component will be hidden.

Hide as priority lack or disable: Check this option, and the component will
be hidden under the following conditions: when the permission is not met, or
when the controlled condition is not met.

Prompt as priority lack: Check this option, when the authority is insufficient,
the component will display a prompt symbol (small lock) to indicate that it
cannot be operated, and the lock will not be cancelled until the authority is
sufficient.

Set last priority after play.: Check this option, click the button, after the
action is completed, modify the minimum operation authority of [Options] ->
[Usage Authority].

3.Status: as shown in the figure below.

SW Button
Push Buttnn] Data Status ]
Language |§E(i@] ﬂ
Preview Status
B OE &
Brush Image Text
Index | Text
0
k2
Word Input | B

o OK | X cancel ‘

Language: Select the language currently in use. For details, please refer
to Section 5 Language Management.
Preview: You can see the input text preview screen here to prevent input
errors.
Status
New: Since there is only 0 or 1, there is no new function here.
Delete: Since there is only 0 or 1, there is no delete function here.
Brush: Refer to section 3.1.1 for specific settings, and will not repeat the
description.
Image: Refer to section 3.2.4 for specific settings, so the description
will not be repeated.
Text: Please refer to section 3.2.1 for specific settings, and the
description will not be repeated.
Copy: Since there is only 0 or 1, there is no copy function here.
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Index/Text: Index O is the text displayed when the button is pressed,
and index 1 is the text displayed when the button is not pressed Text.
Text input: Input the text to be displayed here.

aﬁ';: Click this button to copy the currently entered text to all states.

3.4 Display

To use the Status component, you can click [Status] under the
[Component] menu bar, and the drop-down option of the status component
appears, as shown in the following figure 3.4-1, or you can directly click this
option on the tool shortcut bar, as shown in the following figure 3.4-2.

Component  Tot

[l+ Cursor

Graphic ¥

Static E

Button »
T ©
| Edit

_’_ Mumeric Display
) F Text Display

> Alarm String

& | B ZF| |||[® Time Display
| Date/Time

= Progress Bar
= Bar
= Float Bar

Meter

Dynamic Picture
E/ Path Picture
@ Dynamic Lamp
% Path Lamp
[#% Trend Graph
- [#3 Historical Trend
% Record Table
& Alarm Display
¥4 Alarm Count Display
® Current Alarm Display
40 Status Poygon
“iz Graph
o XY Graph

3.4-1

Graphic Component | Static Component | Button Edit |
| @ @ EEE @~ E @R BB EYEY @D

3.4-2
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3.4.1 Lamp

The detailed instructions of Bevel, please refer to chapter 3.3.1. This
section only explains the different settings of Control and Status.
1. Control

|Lamp x
Bevel Control | status|
Control
Data Type |[1Bit] Bit |
Read Addr. || -~ &
Max: | ~| em
Min: | ~| Em
Vigibility: | -
o 0K | X cancel |

Data Type: Set the variable type or variable data format displayed by the
lamp.

Read Addr.: Set the variable position displayed by the lamp.

Max: When read a register, the maximum value is the one you set. If not
set value here, the value is decided by data format.

Min: When read a register, the minimum value is the one you set. If not set
value here, the value is decided by data format.

Visibility: Set the variable position that makes this lamp show or hide.

2. Status
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. Lamp X
Bewvel | Control SGtUS]
Language |Engli5h {United States) L]
Preview | [Status
+ = B B 2
| Add Delete Brush Image Text Copy
Condition | Text
==1 Red
==1
Word Input |Red| B
Condition: |== Lj iu Lj
o 0K | X Cancel J
For details, please refer to the description of the status page in 3.3.1, only

the differences are introduced here.

Add: Click this button to add a new condition.

Delete: Click this button to delete the selected condition.

Condition: Set the comparison condition of the selected condition. There
are six types of comparison conditions: equal, not equal, less
than, less than or equal, greater than, and greater than or equal
to choose from.

Connection / Para .: Enter the 16-bit register to compare with the
register displayed by the lamp. According to the comparison
results, the lamp shows different status.

3.4.2 Numeric Display

The detailed instructions of Bevel, please refer to chapter 3.3.1. This
section only explains the different settings of Control and Text.

1. Control
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Numeric Display

Bevel Data ]Text]

Data Display Format
Data Format |[168it] Signed j ' Decimal
Read Add. | <] e B
s | J o ™ 32 Bits Float. Point
Min: | j =
Display Flag: | ~] Ritegeec | -
Display Condition: |NORM.~'-\L j Decimal Pos.: |IJ j
[~ Zero of Hi Bites
[~ Data arrangement swap
o 0K | X cancel J
Data

Data Format: Select the data format to be read.

Read Addr.: Set the variable address to be read.

Max: Set the maximum value of the variable to be read.

Min: Set the minimum value of the variable to be read.

Display Flag: Set the variable that makes the numerical display
component show or hide.

Display Condition: Use with visibility, and display when the selectable
variable is 1 or 0. If the visibility is set to [M0] and the display condition mode is
[When the variable is 1, display], then when M0=1, the component is visible.
Display Format

Integer: Set how many digits to display for integers.

Decimal Pos .: Set how many digits to display for decimals.

Zero of Hi Bites: When the integer number is set to 4, the value will be
filled with 0O to 4 digits if this option is checked.

Decimal: Select this option, the value is displayed in decimal form.

Hex .: Select this option to convert the displayed value to hexadecimal
display.

32 Bits Float. Point: Select this option to display as a 32-bit floating point
number.

Data arrangement swap: high and low bytes swap. 16 bit: high and low
BYTE swap; 32 bit: high and low WORD swap.

2. Text
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Numeric Display

Bevel | Data  Text ]

Text

Language |y (wik. E) E
Color v|
Align: | Center =l
Flash Effect |Ngrma| j

Font [Tahoma [9] Select Font

o 0K | X cancel J

Text
Language: Select the language type displayed.
Color: Select the color of the value displayed.
Align: Select the alignment of the numeric display when displaying.
Flash Effect: Select whether the value is normal or flashing during display.
Font: Set the font type and size of the value when displaying, please refer
to 3.2.1 for details

3.4.3 Text Display

The detailed instructions of Bevel, please refer to chapter 3.3.1. This
section only explains the different settings of Control and Text.

1. Control
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Text Display X
Bevel Control | Text |
Control-
Data Type IAB j
String Length: |4 Char ﬂ
Read Addr. | j o3
Visibility: | R
" 0K | X cancel J
Control

Data Format: Select the display format of the text.

String Length: Set the length of characters that can be displayed.

Read Addr .: Set the read variable address.

Visibility: Set the variable that controls the display or hiding of the text
display element.

2. Text
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Text Display *

Bevel | Contral TE!K'C]

Text
Language English {United States -
Color I .,| v Auto. Linefeet
Align: | Center ﬂ
Word Effect |Nc|rmal ﬂ
Flash Effect | yormal |
Font [Tahoma [9] Select Font
Text

0K | xtlancelj

Text

Language: Select the language type displayed.

Color: Select the color of the value displayed.

Align: Select the alignment of the numeric display.

Auto. Linefeed: Check this option, when the total length of the font is
greater than the length of the component, it will automatically display the line.
Otherwise, no line breaks.

Word Effect: Select whether the text display is normal or mobile.

Flash Effect: Select whether the value is normal or flashing display.

Font: Set the font type and size of the value when displaying, please refer
to 3.2.1 for details.

Text: Enter the text to be displayed.

3.4.4 Alarm String

The detailed instructions of Bevel, please refer to chapter 3.3.1. This
section only explains the different settings of Text and Option.

1. Text
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Alarm String *
Bevel Text ]Dptiun]
Text
Language z
Color . v| [~ Continue
Align: | center | Move Speed f
Slow 0 Fast|

Word Effect |MmfeLeft ;J S i
Flash Effect  [Normal ~] > -
Font Tahoma [3] Select Font
Visibility: | ;J

| 0K | X Cancel I

Text

Language: Select the language type displayed.

Color: Select the color of the value displayed.

Align: Select the alignment of the numeric display.

Word Effect: Select whether the text display is normal or mobile.

Flash Effect: Select whether the value is normal or flashing display.

Font: Set the font type and size of the value when displaying, please refer
to 3.2.1 for details.

Visibility: Set the variable that controls the display or hiding of this alarm
text component.

Continue: Check this option, the alarm text will be displayed continuously,
otherwise the alarm information will reappear after the alarm information
moves and disappears in the alarm text component.

Move Speed: Set the speed of alarm text movement.

2. Option
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| Alarm String X

Bevel | Text Option

Option 1 rBrush

....................................... : Type

Group Option
Read Address: [ LJ ER _J

Format: 32 Bits unsigned

Date/Time
Language:  |English (United States) ]
f Custom: b
i | J
Preview:
1 o 0K | X cancel ‘
|
Option

Index Number: Check this option, the alarm text will appear with the
alarm number, otherwise only the alarm text will be displayed.
Group Option
Read Address: Set the address of the read alarm zone.
Date / Time
Language: Select the language type displayed.
Custom: Set the alarm text.
Preview: Preview the display of the alarm text for easy modification in
time.
Brush
Type: Set the brush style.

3.4.5 Time/Date

The detailed instructions of Bevel and Text, please refer to chapter 3.3.1.
This section only explains the different settings of Control.
1. Control
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;Tlr'ﬂEDiS-FﬂE‘_'{ >
Bevel Control | Text |
Contraol
DAy et %
Visibility: | ~]
W 0K | X Cancel ‘
Control

Display Format:

Custom: When this option is selected, enter the format to be
displayed in the custom format on the text page.
For the time format, refer to the table below.

hh: mm: ss: The time will be displayed as hour: minute: second.

hh:mm: The time will be displayed as hour: minute.

MM / dd / yy: The time will be displayed as month / day / year.

dd / MM / yy: The time will be displayed as day / month / year.

Dd.MM.yy: The time will be displayed as day, month, year.

Format Descriptions Input string | Display string

string “Year” Year

yyyy 4-digit year yyyy 2004

yy 2-digit year yy 04

M 1-digit month M 7

MM 2-digit month MM 07

d 1-digit date d 5

dd 2-digit date dd 05

H 1-digit hour (12 H 9
hour system)

HH 2-digit hour (12 HH 09
hour system)

h 1-digit hour (24 h 9
hour system)
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hh 2-digit hour (24 hh 09
hour system)
m 1-digit minute m 7
mm 2-digit minute mm 07
S 1-digit second S 7
SS 2-digit second Ss 07
AM AM/PM AM AM/PMA

Visibility: Set the variables that control the display or hide of the display
element.

3.4.6 Progress Bar

The detailed instructions of Bevel, please refer to chapter 3.3.1. This

section only explains the different settings of Control.

1. Control
Progress Bar 4
Eex.rel Cl:lrltrl:ll ‘
Control 1 —Option

Data Type  |[16Bit] Signed | Direction: |Horizontal -]
t Read Addr. | LJ @ Grid Color: I v|

Max: | LJ &

Min: | LJ ==

Visibility: | LJ

W 0K | X Cancel ‘

Contr0| ...................................................

Data Type: Select the data format to be read.

Read Addr .: Set the variable address to be read.

Max: Enter the maximum value of this contact or memory, or you can not
enter it.

Min: Enter the minimum value of this contact or memory, or you can not
enter it. If not, the maximum and minimum value range is the default
value range of the variable.

Visibility: Set the variables that control the display or hide of the display
element.
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Option
Direction: Adjust the direction of the progress bar. The default is the
horizontal direction. If you select vertical, the graphics on the screen
should also be adjusted to be vertical.
Grid Color: Set the color of the grid of the progress bar.

3.4.7 Bar/ Float Bar

The detailed instructions of Bevel, please refer to chapter 3.3.1. This
section only explains the different settings of Control.

1. Control

Bar >

Beve| Co ntrol ‘

Control Hption

Data Type |[15E='rt] Signed ﬂ Type: |Bar j
i
E Read Addr. | ﬂ = Direction: |TI:||:| ﬂ

Max: | j E...

Min: | ﬂ E..) o

vbiky: | K - -

IW' X Cancel |

Contro| ...................................................

Data Type: Select the data format to be read.

Read Addr .: Set the variable address to be read.

Max: Enter the maximum value of this contact or memory, or you can not
enter it.

Min: Enter the minimum value of this contact or memory, or you can not
enter it. If not, the maximum and minimum value range is the default
value range of the variable.

Visibility: Set the variables that control the display or hide of the display

element.
Option
Type: Select to use Bar or Float Bar.
Direction: Select the direction of Bar or Float Bar.
Bar:
Type: Select the type of Bar or Float Bar.
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3.4.8 Meter

The detailed instructions of Bevel and Control, please refer to chapter
3.3.1 and 3.2.4 respectively. This section only explains the settings of Scale.

1. Scale
Bevel | Control Scale lAdv. |
Scale | rPen
Graduation: 270 deg. Crc-Up ) T =1 R
Master Count: |5 j Color 1
= I -

Slave Count: |2 ﬂ
Length: |8 i{ Indicator Pen

Type ] 5 |
Disc size: |5 i{

Color - |
¥ Scale _
P Axis Disc color: _1

-Option
I Display Marks Colaor: I ,1
Max: |1|3|;| j R Decimal P°5-:{D j
Min: |D j =5 Display unit: |
Font: Tahoma [8] Eont
o 0K X cancel ‘
Scale

Graduation: Select the direction and angle of the meter display.
Master Count: Select the number of main scales.
Slave Count: Select the number of minor scales.
Length: Select the length of the scale display.
Disc size: Select the size of the disc in the center of the meter.
Scale: Tick it and scale will appear, otherwise not.
Axis: Tick it and the arc-shaped coordinate axis will appear below the
scale. Otherwise not.

Pen
Type: Select the line style of scale and coordinate axis.
Color: Select the color of the line style.

Indicator Pen
Type: Select the line style of the meter pointer.
Color: Select the color of the line style.
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Disc color: Select the color of the disc.

Option

Display Marks: Tick it and the digital marks of the main scale will appear.
Otherwise not.

Max: Enter the maximum value of this contact or memory, or you can not
enter it.

Min: Enter the minimum value of this contact or memory, or you can not
enter it. If not, the maximum and minimum value range is the default value
range of the variable.

Color: Select the color of the digital mark.

Decimal Pos.: Set the number of decimal places.

Suffix: Set the displayed quantity unit.

Font: Set the font type and size of the numeric value when displaying,
please refer to 3.2.1 for details.

2. Adv.
Bevel] CDntrDI] Scale  Adv. 1
Fill Pie
W Fil Pie
- - ‘
Graphic Distance: |8 EI
' OK | X cancel ‘
Fill Pie

File Pie: Tick it and Bush settings will appear, otherwise not.
Graphic Distance: Set the interval time between graphics display.

3.4.9 Dynamic Picture

The detailed instructions of Bevel, Image/ Picture, please refer to chapter
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3.3.1 and 3.4.7 respectively. This section only explains the settings of Control.

1. Control
Dynamic Picture
Elevel] Image/Picture  Control
Coordinate
Type:
X W
Data Format  |[16git] Signed -] Format: [168it] Signed -]
Read Addr. I -| = Read Addr. I - @
Max: ] -| = Max: ] -| @
Min: I ~| = Min: I ~| @m
W 0K | X Cancel ‘
Coordinate

Type: According to the way represented by the X and Y coordinates, the
absolute value and the offset value can be selected.

XY

Data Format: Set the variable data format.

Read Addr .: Set the read variable address, so as to change the position of
the picture according to the value of the address.

Max: Set the maximum value of X /Y coordinates.

Min: Set the minimum value of X / Y coordinates.

3.4.10 Path Picture

Click [Component]-> [Status]-> [Path Picture]. When the mouse moves to
the edit screen, a cross cursor will appear. When moving to the desired
position, press the left mouse button, as shown in the following figure, then
move to the relevant position of the desired path in sequence, then press the
left mouse button, and finally confirm the path position, press the right mouse
button to end the drawing.
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Right-click or double-click to enter the property setting page. The detailed
instructions of Bevel, Image/ Picture, please refer to chapter 3.3.1 and 3.4.7
respectively. This section only explains the settings of Control.

1. Control

[ Path Picture -‘

Elevel] Image/Picture  Control

Control

Type:

Control Para. | —Path Information

Format: [[168it] Signed ~] Point Cpunt: | 9

Read Address: I ﬂ IF e

W 0K | XI:anceI‘

Control

Type: There are four options including read address, increasing cycle,
decreasing cycle and trapeze cycle.

Read Address: The picture moves to the corresponding coordinate point
according to the value of the variable in the read position.

Inc cycle: According to the value of the variable in the read position X
milliseconds, automatic coordinate increases with cyclic
movement.

Del cycle: According to the value of the variable in the read position X
milliseconds, automatic coordinate decreases with cyclic
movement.
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Trapeze cycle: The picture moves automatically in a coordinate cycle
according to the value of the variable X milliseconds in the
read position. When the picture is in the initial coordinate, it is
an increasing cycle, and in the final coordinate is a decreasing
cycle, which is equivalent to moving back and forth.

Control Para.
Format: Set the variable data format.
Read Address: Set the read variable address, so as to change the position
of the picture according to the value of the position.

Path Information
Point Count: Display how many positions of the set path coordinates.

i Path Picture < |
I
Eevell Image/Picture Coordinate Control ]

Control

Type:

Inc cycle j

Delay Time Path Information

Format: |[1 it] Signed ﬂ Point Count: ]

Read Address: | j =

Uint:ms
0:no change
=30000: stop inc or dec.

W 0K | xl:ancel|

3.4.11 Dynamic Lamp

The main purpose is to use variable control, so that the components
display different screens or different text at different positions.

Right-click or double-click to enter the property setting page. The dynamic
coordinate display property setting dialog box is shown in the figure below.
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1 Dynamic Lamp >
Bevel Control lsmtusi Coordinate Control |
r~Control
Data Type J[lBit] Bit LJ
: Read Addr. J LJ =
: Max: J LJ =
Min: J LJ =
Visibility: J LJ B

o 0K | X Cancel‘

1. Bevel: Please refer to chapter 3.3.1 for detailed instructions.

2. Control: Please refer to chapter 3.3.2 for detailed instructions.

3. Status: Please refer to chapter 3.3.1 for detailed instructions. Only
differences are explained here.

=D},rnar'ﬂir: Lamp x
Bevel | Control Status | Coordinate Control

Language

Preview-

+ = B B & B

I Add Delete Brush Image Text Copy

-_Cnnd'rth:rn | Text

==

==1

Word Input ] B

Condtion: [—=— ~| [0 |
W OK | X Cancel ‘

Add: Click this button once to add a new state.

Delete: Select a state and click this button once to delete the selected
state.

Copy: Select a certain state and click this button once to copy the selected
state once. The copied content includes conditions, text content, brushes, and
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images.
4. Coordinator Control: Please refer to chapter 3.4.9 for detailed instructions.

3.4.12 Path Lamp

The component combines dynamic path picture and dynamic lamp. The
main purpose of using the dynamic path is to display different pictures or
screens when using variables to control different states. At the same time, the
components can be displayed in different positions.

Click [Component]-> [Display]-> [Path Lamp]. When the mouse moves to
the edit screen, a cross cursor will appear. When moving to the desired
position, press the left mouse button, then move to the relevant position of the
desired path in sequence, then press the left mouse button, and finally confirm
the path position, press the right mouse button to end the drawing.

Right-click or double-click to enter the property setting page. The path
lamp property setting dialog box is shown in the figure below.

|Path Lamp 4
Bevel Control \ Status | Coordinate Control |
Control
Data Type |[IBit] Bit ﬂ
Read Addr. -
| | X e
: Max: | ~| om
Min: | ﬂ =
Visibility: | ﬂ

o OK | X E‘ancel|

1. Bevel: Please refer to chapter 3.3.1 for detailed instructions.

2. Control: Please refer to chapter 3.3.2 for detailed instructions.

3. Status: Please refer to chapter 3.3.1 and 3.4.11 for detailed instructions.

4. Coordinator Control: Please refer to chapter 3.4.9 for detailed instructions.

3.4.13 Trend Graph

The man-machine interface reads the continuous data of the
corresponding address and presents it to the user intuitively and graphically in
real time. For example: if the display points are 50 points and three curves are

141



TP Series HMI Programming Manual

set, then a total of 50 * 3 data of 150 WORDs will be taken and data
processing needs to be done in the PLC program.

Click [Component]-> [Display]-> [Trend Graph] to display the trend graph
in the editing screen. Right-click or double-click to enter the property setting
page.

1. Bevel: Please refer to chapter 3.3.1 for detailed instructions.
2. Control:
Trend Graph

Bevel Data ]Cunfe Set | Display | Scale | Display Time | Time Scrol|

Data
| Zl
Data Format |[16git] Signad =]
Source Address: | ﬂ o3
Data Length: |1 ﬂ
Record Count: |1D j Range 1 .. 32767
Update Time: |15&c ﬂ
Record Flag: | ﬂ ]
Clear Flag: | ﬂ gw | Clear Flag aft. Clear Rec.
Stop Count: |D ﬂ Auto. stop 'l.'Jhen touch .
recode setting , No use this
Display Flag: | ﬂ BB
Display Condition: [yoRMAL -]

v Record Date/Time

o 0K X cancel J

Control

Data Type: Set the starting position of the register variable address for
data reading.

Source Address: Set the length of the read data, i.e., the number of
displayed curves. For example, the source address is D10
and the data length is 10, i.e., the data from D10 to D19 is
read, and 10 curves are displayed in the trend graph.

Record Count: Set total times to record data, i.e., the maximum record
times to be recorded for each curve.

Update Time: Set the time interval for each record of data. For example, as
set in the figure above, D10 ~ D19 data is recorded once
every second, and a total of 10 (humber of records) are
recorded.

Record Flag: Set the condition to start recording data, i.e., the variable
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starts to record data when it is 1, and does not record when it
is 0.

Clear Flag: Set the conditions for clearing the recorded data, that is, when
the variable is 1, all data is cleared, and O is not cleared.

Clear Flag aft. Clear Rec.: Check this option to clear the flag together
when clearing the recorded data.

Stop Count: Set the number when stop recording automatically, and set to
0 means not to use this function (the value here must be less
than or equal to the number of records).

Display Flag: set the variable that makes the trend graph component show
or hide.

Display Condition: Use with visibility, and display when the variable is 1 or
0. If the visibility is set to [MO] and the display condition mode
is [When the variable is 1, display], then when M0=1, the trend
graph is visible.

Record Date/Time: Check this option, the system records the time of data
recording.

3. Curve Set
Trend Graph

Bevel | Data  Curve Set ]Displav] Scale | Display Time | Time Scroll|

Curve
=E=d |_ [ Point
A Delete Copy
Point Style: [+ 10 -
In... | Max Min Display Flag : | _]
; Point Color: | | -
T 100 o
[« Line
Pen Style: |E| 11 L]

Pen Color: | -

[ Fill

O \

Max: [100 x| »

Min: |g L] b33

Flag: | L] B

Display Format: [[16t] Signed |
Reg Addr; |1 L]

[ Data arrangement swap

o 0K | X cancel J

Curve
Add: Click this button to add a curve.
Delete: Click this button to delete the selected curve.
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Copy: Click this button to copy the selected curve.

Point: Check this option, the curve is displayed in the form of points.

Point Style: Set the form of the point.

Point Color: Set the color of the point.

Line: Check this option, the curve is displayed in the form of a line.

Pen Style: Set the brush style.

Pen Color: Set the color of the pen.

Fill: Check this option, the curve is displayed in the form of a brush.

Brush Style: Set the brush style and color.

Max: Set the maximum value of a single curve.

Min: Set the minimum value of a single curve.

Visibility: Set a single curve display and hidden variables, when the
variable is 1, the curve is displayed, and 0 is not displayed.

Data arrangement swap: select this option, the high and low bytes will be
swapped. 16 bit: high and low BYTE swap; 32 bit: high and low WORD swap.

4. Display
Trend Graph

Bevel | Data | Curve Set Display ISG|E! | Display Time | Time Scroll|

Preview Show Setting
Tl 1% 7 Type: |MD\fe—LEﬂ: j
I ) 7 _
] T ] Show Data Mum.: |4 ﬂ
| /
| i | i Page Down Gap: |3 -
| ! | ! | £l
T L I"k !,"I [~ Show Break
Grid of Num. Grid of Time
Show Grid Mum.: |1D ﬂ Point/Grid: |30 ﬂ
Pen Style: |E| 11 j Pen Style: |E| 11 j
Pen Color: | - | Pen Color: | - |
o 0K | X cancel ‘
Preview: Shows the style of curve display.
Show Setting

Type: Set the direction of movement when the curve is displayed.
Show Data Num .: Set the number of points for displaying data, that is,
the trend graph starts moving when it comes to the quantity of
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the data set..

Page Down Gap: Set the interval between two pages when turning pages.

Show Break: Check this option, each curve is displayed with its own
unique area.

Grid of Num./Time

Show Grid Num .: Set the number of grids to be displayed.

Point / Grid: Set the number of grids required for time display.

Pen Style: Set the brush style.

Pen Color: Set the color of the pen.

5. Scale

Trend Graph

Bevel] Data ] Curve Set] Display Scale | Display Time] Time Scmll]

Left/Top Scale

I Left/Top Scale Color: S | - |
Max: |1DD j B Decimal Pos.: |D j
Min: g ~| = Suffic: |

FONt: [rahoma [€] Font

Right/Bottom Scale

[~ Right/Bottom Scale Color: v|
Max: |1DD j Decimal Pos.: |D j
bz =l Suffix: |

Font: [ Tahoma [8] Font

o 0K | X cancel J

Left/ Top Scale

Left / Top Scale: Check this option, the scale value will be displayed on the
left side of the trend graph, and it will not be displayed when it is not checked.

Max: Set the maximum value displayed on the scale.

Min: Set the minimum value of the scale display.

Color: Set the color of the scale display on the left.

Decimal Pos.: Set whether display decimals. 0 means no decimal.

Suffix: Set the unit symbol indicated by the scale. If it is not filled in, the
unit symbol will not be displayed.

Font: Set the font for the scale display. For detailed settings, please refer
to the font setting in 3.2.1.
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Right/ Bottom Scale
Refer to the parameter introduction on the left/top scale.

6. Display Time

Trend Graph
Bevel | Data | Curve Set| Display | Scale  Display Time | Time Scrol|
Display Time
[ Display Time
Display Format: |hh:mm:55 j Color: v|

Font: [T3homa [8] Font

Start Record Time

[ Start Record Time
Display Format: |hh:mm:55 j Color: v|

Font: [T3homa [8] Font

End Record Time

[ End Record Time
Display Format: |hh:mm:55 j Color: v|

Font: [Tahoma [8] Font

o 0K | X cancel J

Display time

Display Time: Check this option to display the time of recorded data below

the trend graph.

Display format: Set the time display format.

Color: Set the color of time display.

Font: Set the font for time display.
Start Record Time

Start Record Time: Check this option, the upper left of the trend graph
displays the time to start recording data.
End Record Time

End Record Time: Check this option, the time at the top right of the trend
graph shows the time when the data recording is ended.

7. Time Scroll
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Trend Graph

Bevel | Data | Curve Set| Display | Scale | Display Time Time Scrol
Time Scroll

[~ Time Scroll

o 0K | X cancel J

Time Scroll
Time Scroll: Check this option, the time scroll will display under the trend
graph.

3.4.14 Historical Trend

The man-machine interface reads the continuous data of the
corresponding address and presents it to the user intuitively and graphically in
real time.

Click [Component]-> [Display]-> [Historical Trend] to display the historical
trend in the editing screen. Right-click or double-click to enter the property
setting page. Historical trend graph property dialog box as shown below.
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Historical Trend

Bevel Data ]Cunfe Setting] Displaﬂ Scale ] Display Time] Time Scmll]

Data
Data Record: | j
Data Format | J
Source Address: | J
Data Length: | J
Record Count: | J Rang 1 .. 32767
Update Time: |.:,|15,9,_- J
Record Flag: | J
Clear Flag: | J r
Stop Count: | J Auto. stop when touch recode
setting , Mo use this function as
Display Flag: | ﬂ BB
Display Condition: |yoRMAL -]
™ R
o 0K | X cancel J

1. Bevel: Please refer to chapter 3.3.1 for detailed description.
2. Control: as shown above.
Data

Data Record: Select the required data record in the data record
management as the display of the historical trend graph. For the detailed data
setting, please refer to Section 2.4.11
3. Curve setting: For details, please refer to section 3.4.13 Curve Setting Page
Setting.
4. Display: For details, please refer to section 3.4.13 Display page settings.
5. Scale: For details, please refer to section 3.4.13 Scale page settings.
6. Time display: For details, please refer to section 3.4.13 Time display page
settings.
7. Time scroll bar: For details, please refer to section 3.4.13 Time scroll bar
page settings.

3.4.15 Record Table

The man-machine interface reads the continuous data of the
corresponding address in the programmable controller, and can also be
presented to the user in the form of a table.

Click [Component]-> [Display]-> [Record Table] to display the record data
table in the editing screen. Right-click or double-click to enter the property

148



TP Series HMI Programming Manual

setting page. The record data table property setting dialog box is shown in the
figure below.
Record Table

Eevell Data Column Set l,ald\_f_ getl

Column
Language |y (i, im) =l
Color v|
Font [Tahoma [9] Select Font
& - Caption Text: |
Add Delete Copy Width: (50 4]
In... | Caption ... | Width Display C... | Display F... Align:: |Center j
g 2 T Color: -
il a0 [16Bit] ... 4.0d : 2
Display Format: |[1ﬁBit] Signed j
Reg Addr: [g =]
Integer: |4 j
Decimal Pos.: |D j
* Decirmal
" Hex.
I™ Zero of Hi Bites
™ Data arrangement swap
< >

" 0K X cancel
| |

1. Bevel: For details, please refer to Section 3.3.1.
2. Control: For details, please refer to Section 3.4.13.
3. Colum Set: as shown below.
Column
Language: Set the language to be used.
Color: The text color in the table.
Font: Set the font in the table.
Add: Click this button to add a column of data information to be displayed.
Delete: Click this button to delete the selected data column information to
be displayed.
Caption Text: Set the title of the data to be displayed in the selected
column.
Width: Set the width required for displaying the selected column data.
Align: Set the alignment of the selected column data display.
Color: Set the color when the selected column data is displayed.
Display Format: Set the data source for the selected column data display.
Integer: Set the number of integer digits when the selected column data is
displayed.
Decimal Pos.: Set the number of decimal places when the selected
column data is displayed.
Zero of Hi Bites: Check this option to perform zero padding automatically
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when there is no data in the high position.

Decimal: Select this option, the data is displayed in decimal form.

Hex .: Select this option, the data is displayed in hexadecimal form.

Data arrangement swap: select this option, the high and low bytes will be
swapped. 16 bit: high and low BYTE swap; 32 bit: high and low WORD swap.

4. Adv. Set

Record Table

Bevel | Data | Column Set  Adv. Set

Title
| | =
Select Bevel
Out Color: | | ~
In Color: | | - |
Brush Style:
Select Option
Brush Style: [~ Sort by latest information shc
Write Addr.: | j
Format:16 Bits undigned
" 0K | X cancel ‘

Title
Select Bevel: Set the display style of the title bar border. For details,
please refer to Chapter 3.3.1.
Out Color: Set the color of the outer frame of the title bar.
In Color: Set the color of the inner frame of the title bar.
Brush Style: Click the brush button and select the brush style in the
pop-up dialog box.
Select: When a row of data is selected, the display form of that row.
Brush Style: Set the brush style of the selected row.
Write Addr. : Set a 16-bit unsigned number, and display the selected line
number in the 16-bit unsigned number.
Option
Sort by latest information shows: Check this option to display the latest
data at the front when displaying. Otherwise, the
latest data is displayed at the last.

150



TP Series HMI Programming Manual

Hide title bar: check this option. Hide the header column of the table.
3.4.16 Alarm Display/ Alarm Count Display/ Current Alarm Display

Click [Component]-> [Display]-> [Alarm Display]/ [Alarm Count Display]/
[Current Alarm Display] to add an alarm component to the edit screen, as
shown in the figure below.

B4 3 : Dispaly Com [100%]

Index | alam Time | Recovery Time | Message
Index | Message | count |
Index | alarm Time | Message

Right-click or double-click to enter the property setting page. The dialog
box for setting the alarm table properties is shown below.
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Alarm Display x

Bevel Column Set ],-!\dn.r. Setl

Column
Language English (United States =
o I -
Font Tahoma [9] Select Font
Visibility: | L]
< v Caption Text: |In|:Ie:(
Add Delete Copy
' - Width: -
In... | Caption ... | Width Display C... | [ 72 2
i Index 72 Murmber B : :
Display Content: -
1 AbmTi.. 72 Alarm Ti.. s [Number -l
2 Recover... 72 Recover ... B
3 Message 128 Alarm ... Al | Center -~
Coler: I |
Display Format: -
L4 » |3 _J
W OK X Cancel ‘

1.Bevel: refer to 3.3.1
2.Column Set: as above picture.
Column

Language: Select the language displayed.

Color: Select the color of the title text.

Font: Select the font to be displayed in the title text.

Display Flag: Sets the variable position where the alarm element is
shown or hidden.

Caption Text: Set the text to be displayed for the selected title.

Display width: Set the width of the selected title bar.

Display content: Set the alarm content to be displayed in the selected
title bar.

There are five options: alarm time, recover time, message, number, and
passed time.

Alignment: Set how text or data is aligned when the column of the
selected title is displayed.

Display color: Set the color of the selected display content.

Display Format: Set the format of the selected title display. Depending on
the display content selection, the selection provided by the
format here is also different.

3. Advanced settings: The page is shown below.
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Alarm Display '
Bevel | Colurn Set Adv. Set |
Title
Index [ &larm TimeRecovery Timg |~ | Celoct Bevel |
| Out Color: N v|
In Color: I v|
Brush Style:
1] | » . ‘
Option Select

[ Show Frame when Sel. Item

Brush Style:
[ Index Big-=Small Index _
i -
Group Option i | =]
Read: 0 ﬂ Format:16 Bits undigned
Format:32 Bits undigned
o OK | X Cancel |

Title

For detailed settings, refer to the parameter settings in the title bar of the
advanced setting page in section 3.4.15.

Option

“Show Frame when Sel. Item”: When this option is selected, if the alarm
display is selected, the corresponding viewing screen that is set is displayed. If
no selected, it is not displayed.

‘Index Big->Small Index”: When this option is selected, the alarm serial
numbers are displayed in descending order of index values.

Group option

Read position: Set the read position, which can be selected as the alarm
group you want to read.

Select

For detailed settings,, refer to the parameter settings in the selection items
of the advanced setting page in section 3.4.15.

3.4.17 Status Polygon

Click [Component]-> [Display]-> [Status Polygon]. When the mouse is
moved to the edit screen, a cross cursor will appear. Press the left mouse
button when moving to the desired position, then move to the relevant position
of the desired path in sequence and then press the left mouse button. After
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confirming the path position, press the right mouse button to end drawing. As
shown below.

Right click or double click to enter the property setting page. The Status
Polygon property setting dialog box is shown in the figure below.

Status Poygon >

Location Control | status |

Control
| Data Type |[16Bit] Signed -
| Read Addr. || h E
Visibility: | o

o 0K | XCEnceI|

1. Location: Refer to section 3.2.1
2. Control: Refer to section 3.4.2.
3. Status: The page is shown below.
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| Status Poygon W
Location | Control Status ]
Poyaon
4 _ |
| Add Delste Copy | Pen Style: |E| 11 ﬂ !
Index I -
' Pen Color: -
o - ‘
i
I
1
| ' OK | X Cancel|
3.4.18 Graph

The HMI reads the continuous data of the corresponding address in the
programmable controller. In addition to displaying it to the user in the form of
trend graphs and tables, it can also choose to display it to the user in the form
of a graph.

Click [Component]-> [Display]-> [Graph] to display the graph in the editing
screen. Right click or double click to enter the property setting page. The graph
property setting dialog box is shown in the figure below.
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4 Graph 4
Bevel Control ] Curve ]
Control
Read Addr.: | = »
Data Type: |[168it] Signed ]
Curve Count: m Range 1 .. 4
Mumber of Paints:  [1p ¥| Range 2 ..128
Number of H Grids: [5 v
H Grid Line Style:  [5 11 i
H Grid Line Color: I v|
Curve visibility: | j -
Clear Flag: | ﬂ
Visibility: | ]

W OK | X Cancel |

1. Bevel: refer to section 3.3.1.
2. Control: The page is as shown above.

Read Addr.: Set the address of the variable to be read. The first variable is
the number of points, and the value is less than or equal to the
display point setting value. The reading address starts from the
second variable of the reading position. As shown in the figure
above, D10 reads number of points, D10 <10 (display the
number of points setting value), read data from D11.

Data Type: Only 16-bit signed numbers are available.

Curve count: Set the number of curves to be displayed. The setting range
is1~4.

Number of Points: Set the number of points to be displayed for each curve,
that is, the number of registers to be used. The setting range is
2~128.

Number of H Grids : Set the number of horizontal grid lines in the graph.

H grid line Style: Set the display form of the horizontal grid line in the
graph.

H grid line color: Set the color of horizontal grid lines in the graph.

Curve display flag: Set the variable position to make the curve show or
hide. When the condition is reached, the curve is displayed.

Clear flag: Set the variable position of the clear curve. When the condition
is reached, the displayed curve is cleared.

Visibility: Set the variable position that makes the graph component show
or hide. When the condition is reached, the graph is displayed.
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Note: As shown in the figure above, if the number of curves is set to 1, only one
curve is displayed, so the number of points displayed on the curve is a line
chart composed of a total of 10 points D10-D19.

As shown in the figure above, if the number of curves is set to 2, two curves
need to be displayed. At this time, the 10 points of the first curve are D10/ D12
/....... D28 and the 10 points of the second curve are D11 /D13 /.../ D27.

If The number of curves is set to other, the number of points displayed on the
curve can be like this sample, and so on.

3.Curve : The page is as shown in the figure below.

i Graph @ﬂ

Bevel | Data  Curve |

rCurve
' s = ™ Paint Point Style: |n j
Add Delete Copy Point Color: I -
In... | Max | Min Display Fl... _
100 0 v Line Pen Style: =11 -
1 100 : Pen Color: I |
[ Fil Brush Style: _
Fil Type: |Bottom Area |
Max: 100 | »
Min: |n j 5
Display Flag: | -

o OK | X Cancel |

Add: Click this button to add a new state. When in multiple states, different
states are displayed according to the read variable data.
For detailed parameter settings, refer to section 3.4.13.
Pen Style: Set the pen form.
Brush color: Set the color of the brush.
Brush form: Set the form and color of the brush.
Fill Type: Set “which direction area to fill” when selecting the fill area.
Delete: Click this button to delete the selected state.
Copy: Click this button to copy the selected state.

3.4.19 XY Graph

The HMI reads the continuous data of the corresponding address in the
programmable controller. In addition to displaying it to the user in the form of a
trend chart and a table, it can also choose to display it to the user in the form of
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an XY curve.

Click [Component]-> [Display]-> [XY Graph] to display the XY graph in the
editing screen. Right click or double click to enter the property setting page.
The graph property setting dialog box is shown in the figure below.

1%Y Graph =

Beve| Control \ Curve l

Control
Read Addr.: || j o
Data Type: |[168B1t] Signed =l
Data Arrangement:  |FORMATL(X0YOX1Y1) |
Curve Count: i = Range 1 .. 4
Mumber of Points: 5 &
f Range 2 .. 128
: Mumber of H Grids: |5 -
H Grid Line Style: |E| 11 j
H Grid Line Color: | ,|
Mumber of V Grids: |5 -
V Grid Line Style: |E| 11 j
\ Grid Line Color: T ,|
Curve visibility: | ﬂ
Clear Flag: | ﬂ
Visibility: | |

W 0K | xrlancel|

1. Bevel: refer to section 3.3.1.
2. Control: as shown above.

(Refer to 3.4.18 for specific settings. Only the differences are described
here.)

Number of H Grids: Set the number of vertical grid lines in the XY graph.

V grid line Style: Set the vertical grid line display format in the XY graph.

V grid line Color: Set the color of vertical grid lines in the XY graph.

For example

Set as above, the number of graph is 2, and the number of displayed points is
5, that is, two graphs are displayed, and each graph consists of 5 points. The
read position is D10 and the format is X0X1YO0Y1.

When displaying a graph, the value of D10 indicates the number of graph
points. This value can be set, and must set be less than or equal to the number
of displayed points. When the set value is greater than the number of
displayed points, the system treats as the set value equal to the number of
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displayed points.

Data arrangement X0X1Y0Y1:

Reads a total of 20 register data of D11-D30, where D11-D20 is the value
of the first graph, and the coordinates of the 5 points are (D11, D16) (D12, D17)
(D13, D18) (D14, D19) (D15, D20). Then D21-D30 are the values of the
second graph, and the coordinates of the five points are (D21, D26) (D22, D27)
(D23, D28) (D24, D29) (D25, D30).

If the secondary material arrangement is selected as X0Y0X1Y1

It means read a total of 20 register data of D11-D30, where D11-D20 is the
value of the first graph, and the coordinates of 5 points are (D11, D12) (D13,
D14) (D15, D16) (D17, D18) (D19, D20). Then D21-D30 are the values of the
second graph, and the coordinates of the five points are (D21, D22) (D23, D24)
(D25, D26) (D27, D28) (D29, D30).

3. Curve: refer to section 3.4.13
3.4.20 QR code

Can store some simple ASCII characters, that is, all uppercase and
lowercase letters, numbers 0 to 9, punctuation marks, etc.;

In the touch screen, it can be used with the [text editing] control, and the
user can scan the corresponding QR code to get the corresponding
information.

QR Code
Bevel Data ]
Data
Data Format: |AB j
String Length:: |4 Char ﬂ
Read Addr.: | j 53
Display Flag:| j
Display Condition: |r-JORM.-'-\L ﬂ
QRCode
Error Correction rate: |H(3IJ%] ﬂ
Foreground color: | -
Background Color: v|
Prefix Text: |
Suffix Text: |

" 0K | X cancel ‘

1. Bevel: Please refer to section 3.2.1 for detailed page description.
2. Control: The page is shown in the figure above.
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Control
Data Format: select the format of the text string corresponding to the writing
position

0, AB: The first word is written into the high bit of the variable, and the
second word is written into the low bit of the variable.

1. BA: The second word is written into the high bit of the variable, and the
first word is written into the low bit of the variable.

2. _A: Each variable only stores one text in the low position.

3. A_: Each variable only stores one text in the high position.

4~7. Same as 0~3, except that no text is displayed, only "*" is displayed.

String length: Set the number of characters to be displayed, 1~64
characters can be displayed.

Reading Addr.: Set the variable position of QR code display.

Display Flag: Set the variable position to show or hide the QR code.

Display Condition: Use with visibility, and display when the selectable
variable is 1 or 0.

If the visibility is set to [MO] and the display condition mode is [When the
variable is 1, display], when M0=1, the QR code display is visible.

QR code

Error correction rate: It means that the QR code can be scanned normally
after being blocked, and the maximum area that can be blocked is the error
correction rate;

The higher the error correction rate, the larger the part of the
two-dimensional code picture that can be blocked. (Note: The three positioning
boxes on the side of the QR code and the small positioning block in the middle
cannot be blocked, otherwise the error correction rate cannot be scanned even
if it is high.)

The error correction rate of the two-dimensional code is indicated by
letters, and the error correction ability level is divided into four levels: L, M, Q,
and H:

L 7%

M 15%
Q 25%
H 30%

Foreground color: set the color of the QR code pattern.

Background color: Set the background color of the QR code.

Prefix text: Set the front text displayed after scanning the QR code, for
example, you can set the company logo, address, etc.

Suffix text: Set the text displayed after scanning the QR code, such as
company phone, etc.
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3.4.21 Pipe Line

Pipe Line
Bevel Data ]
Data Block area
Type: |Hc|rlzc|ntal,Right j Hight(Width): [1g ~l  (8..128)
i & aaan | =l Width(Height): 15 <] (8..128)
Enabled Condition: |NORM.~'-\L j
s | &
Data Format: |[153-[t] Signed -
Move Speed: |4 j =
Blank area
ok Hags | =l Width(Height): [15 < (8..128)
Display Condtion: [oRMAL -]
I e—
o 0K | X cancel ‘

1. Bevel: Please refer to chapter 3.2.1 for detailed page description.
2. Control: The page is shown in the figure above.
Control

Type: Set the flow direction of the pipe line. Options: Horizontal to the left;
Horizontal to the right; Vertically downwards; Vertically upwards.

Enable Provision: Set the condition variable. When the set variable is 1 or
0, the pipe line can execute the corresponding action, otherwise the pipe line
will not act.

Enable Condition: Used in conjunction with controlled condition, when the
variable can be set to 1 or 0, it is controlled. If the controlled condition is set to
[M1] and the controlled condition mode is [when the variable is 1, controlled];
when M1=1, the pipe line can execute the corresponding action, otherwise the
pipe line does not act.

Data Format: Select the format of the data to be written.

Move Speed: Set the movement speed of the pipe line, the larger the
value, the faster the movement speed.

Display Flag: Set the variable position to show or hide the pipe line.

Display Condition: Use with visibility, and display when the selectable
variable is 1 or 0.

If the visibility is set to [MO] and the display condition mode is [When the
variable is 1, display], when M0=1, the pipe line display is visible.

Block/blank area
Height (width): Set the height and width of the flowing block/blank block.
Brush: Please refer to section 3.1.1 for page details.

3.5 Edit
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After the HMI is connected to the programmable controller, some data in
the programmable controller can be modified by the editing component. At this
time, the editing component is used to complete the modification operation.

Click [Component]-> [Edit]-> to find different edit option as figure 3.5-1,or
directly click the option from the tool shortcut bar, as figure 3.5-2

Component Tot

[l Cursor
Graphic  *
Static k
Button »
| Display
IETI © Multiple Status Edit
Murmeric Entry
Text Entry
Password Edit
i, Track Bar
ECH Scroll Bar
= List Box
3.5-1

Graphic Cnmnnnent] Static Cnmnnnent] Button ] Display | Edit

5
&
&
&
&
%
g

3.5-2

3.5.1 Multiple Status Edit

Click [Component]-> [Edit]-> [Multiple Status Edit] to display the mutil
Status Edit element in the edit screen. Right click or double click to enter the
property setting page. The mutil Status Edit property setting dialog box is
shown in the figure below.
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Multiple Status Edit oy

Bevel Control | status |

Control 7 —Option-
Data Type  |[168it] Signed =] || Prem ey scene -
Read Addr. | ~| = Confirm: |Press.action |
Mae: | -] = Key Def: |Undefined -~
Min: | | e Key Window: |ndefined =
Write Addr. | | Act. State: | ~| =
Virite Notificatiof ~| =

. [~ Hide when Priority Lack or Dis.

Befor Macro: | :.] wd [ Prompt if Priority Lack
After Macro: | :J 3 [ Set last priority after play.

W« 0K | X Cancel‘

1. Bevel: refer to section 3.3.1

2. Control: as shown above, please refer to section 3.3.2. (Difference below)
Read position: Set the position of the variable to be read, and then read

the value of that position.

3. Status: as shown above, please refer to section 3.3.2. (Difference below)
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| Multiple Status Edit >
Bevel | Control Status 1
Language: English (United States) M
Preview- g :Smtus- ol
+ - H B 2
| Add Delete Brush Image Text Copy
Condition | Text
==
==1
Text: J B
Condition:  [—— | [o =]

o OK | X Cancel‘

Conditional expression: Set the value of the conditional expression, that is,
you can set different values to make the component display different states.

3.5.2 Numeric Entry

Click [Component]-> [Edit]-> [Numeric Entry] to display the value editing
element on the editing screen. Right click or double click to enter the property
setting page. The Numerical property setting dialog box is shown in the figure
below.
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Mumeric Entry

Bevel | Control| Text |

[ Bevel [ Brush
‘ Select | Type
rHEER Out Color %
In Color . -
rLocation
X 416 : 176
104 64
o 0K J X Cancel J
1. Bevel: As shown above, refer to section 3.3.1.(Difference below)

Select button: Click the select button to pop up the dialog box as below.

Bevel

Rectangle of Svstem] Circle of System Rectanale of System ]Rect:mgle of S',rstem] Circle of 4| *

| &2 |

#rEe #rEy R FFEd
Mo Frame 30 1-Tiny 30_I-kean 30_1-Thickness
L #EEE FHER
30_1-Tiny 30 _llMean 30_1I-Thickness

o OK | X cancel ‘

You can choose the shape of the editing component. There are 5pages
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2. Control: Page as below.
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MNumeric Entry x
Bevel Control | Text |
Control Option

Data Type 16Bit] Signed - Priority |B}r scene hd
Read Addr. | ~| o= Confirm |Press.action -]
Max: | ~| o Key Def. |Undefined |
Min: | ~| o= Key Window |g5000 : Value input dia v |
Write Addr. | :J ¥ Controlled cnn| _..J 8
Write Motificat -

rike Hothca 1 _.] L [~ Hide as priority lack or disable
Befor Macro: | :J 3 [ Prompt as priority fack

[ Continue Input

After Macro: S

er Hacro | _.] ¥4 [~ Set last priority after play.

Engineer Transfer Display Format

Offset: 0 Integer: 4 71 & Decimal

fe : e
Gan L0 Decimal Pas.:{u v] Hex.

" 32 Bits Float. Point
Aux. Cal. ‘ [~ Zero of HiBites

o DK | x Cancel‘

Refer to section 3.3.2. (Difference as below)

Read address: Set the position of the variable to be read, and then read

the value of that position.
Engineer Transfer

Offset: Set the offset value after entering numeric data.

Gain: Set the magnification value after inputting numerical data.

Auxiliary calculation: When the offset value and magnification value are
not calculated, click this button to pop up the auxiliary calculation dialog box as

shown in the figure below.

166



TP Series HMI Programming Manual

| Para. Cal, of EMG. Transfer o
Data 1 —EMNG. Transfer Data
Max: |1|:||:||:| ﬂ Max: |5|:||:||:| ﬂ
[«
Min: 0 |- Min: 0 [
ﬁ | 4 | ]
Cal. Resuk
Offset: 0 Scale:  |0.200000002980:
o OK X Cancel |

Parameter calculation of Eng. Transfer: Set the maximum and minimum
values to read.

Eng. Transfer Data: Set the maximum and minimum values after reading
position transfer data.

Cal. Result: The system automatically calculates the offset value and the
magnification value according to the input variable value and the project
converted value.

OK: Click this button to exit this setting dialog and display the calculation
result at the corresponding position on the previous page.

Cancel: Click this button to exit this setting dialog without making any
changes.

For example:

When the HMI communicates with the PLC, the analog value in the PLC
needs to be read, but the digital value in the PLC is 0 ~ 4000, but the HMI
needs the operator to see the temperature value of 0 ~ 50 °C. In this case, you
can set the offset and magnification values in the engineering conversion data.
Thus reducing the amount of calculation in the PLC.

Parameter calculation of Eng. Transfer set in the example above:
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| Para. Cal. of ENG. Transfer o
~Data —EMNG. Transfer Data
Max: l4[||:|r_'| ﬁ Max: l5[| ﬁ

Min: lg iﬁ Min: !EI iﬁ

—Cal. Result

Offset: 0 Scale: !gn

¥ 0K X Cancel |

After clicking [OK], the properties of the numeric entry component are
shown below:

| Mumeric Entry >

1 Bevel Control |Text |

—Control ~Option
Data Type  |[168it] Signed -] Priority |By scene =~
Read Addr.  [D100 ~| em Confirm |Press.action |
Max: |5|;| LI =3 Key Def. |Undeﬁned ;I
Min: o ~| om Key Window 65000 : value input dia_~ |
L Write Addr. IDlgU LI ¥y Controlled coni LI
1 Write Notificat ¥
laditnhil I _I [ Hide as priority lack or disable
Befor Macro: | ;I o3 [~ Prompt as priority lack
[” Continue Input
Aftar M : -
Ll Bl I _I < [T Set last priority after play.

—Engineer Transfer————— Display Format

Offset: Ig Integer: |4 vI &+ Decimal
Gain: IEU Decimal Pos.:lﬂ vi L

™ 32 Bits Float. Paint
| [~ Zero of Hi Bites

v 0K I X Cancell

After setting, when the corresponding digital value is read in the PLC, the
converted value is displayed in the HMI, as shown in the figure
below
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Device
& Device Name | D100 ;! T/ Set Value Reference Program Ii
¢ Buffer Memory  Module Start | ;I addrass I

D100

5

Display format

Modify Value... |’7 2 m J2132 @ R5C m 16 Detalls... | Open... | Save... |

Device FlElplclelalala]z]e]s]4]3]2]1]0 Dptp read in PLC
D100 oooo oI cBoooo :J_tmoJ

Data display on the HMI

D101 0/0|0j0|O(0|0OjO|O|0O|0|O[0|D|0O|O 0]
Device
' Device Name IDlUU ;I T/C Set Value Reference Program
DlOO " Buffer Memory Module Start I _,,I address I —
54
~Display format

2 3|32 32| (% esc|@ 16 | etmis.. | open.. | save.. |

HMI diaplay data Modify Value...

changes accordingly

?'jf: data changes
Device elelplclelalelalz]s]5]4]z]2]1]o z
D100 toooffo 0 oo mooJ
D101 olo/ololoooonooolooao 0
Mumeric Entry | 28
Bevel Control | Text |
—Control —Option
Da |[16Bit] Signed | Priority By scene -
ead Addr. |D1 j Confirm IPress.actinn j
Max: | x| o Key Def. |Undefined e
Min: | j Key Window |55EIEIEI . ﬁ[fﬁﬁ]}kﬂﬂﬁﬁj
W ddr. [p1 ¥ Controlled cunl j
Write Motificat - : o :
J [™ Hide as priority lack or disable
Befor Macro: | j %) ™ Prompt as priorty lack
[ Continue Input
After Macro: - i
| J < [T Set last priority after play.
—Enagj —Display Format
. Offset: Integer: |4 vI &+ Decimal
i _ -
fam |1'U Decimal Pns.:||3 vI Hik.
(" 32 Bits Float. Point
Aux. Cal. | [T Zero of Hi Bites
1T the wvalue of DI in the FLU 15 20, the screen will

display 15.
eptar Ao ¢ 0K I xmncell
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MNumeric Entry =
Bevel Control | Text |

—Control —Option

l[lErEl'rt] Signed Priority iEly scene -

ad Addr. |p1 Confirm | Press.action -l

l Key Def. ]Undeﬁned |

l Key Window 65000 : #higi#i ) i% v

Addr. IDl Controlled conl _'_j

Write Mot

Befor Macro: l

™ Hide as priority lack or disable
[~ Prompt as priority ck
[~ Continue Input

o B v 8 88|

After M :
er Hacro l [T Set last priority after play.

—Engineer Transfer —Display Format

LOMset: 5 > Integer: 14 vi & Dedmal
Gain: il.EI Decimal Pus.:!u vi e
" 32 Bits Float. Point
Aux. Cal. | [~ Zero of Hi Bites

If the value of D1 ip the PIC is 20, the screen will displaw

. o OK I X Cancell

3.5.3 Text Entry

Click [Component]-> [Edit]-> [Text Entry] to display the value editing
element on the editing screen. Right click or double click to enter the property
setting page. The text entry property setting dialog box is shown in the figure
below.
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Text Entry p4

Bevel Control | Text |

Control 1 —Option
Data Type  |ag | Priority By scene ]
! String Length:[4 char ~ Confirm | Prass.action |
: 4 Add Key Def. |LInn:Ieﬂneu:| LJ
Read Addr. :
" 2 Key Window 65001 : String input dia_v|
Write Addr. |

4 Controlled con | LJ

Write Notificat
1 [ Hide as priority lack or disable
23 [ Prompt as priority ok

[ Continue Input
¥4 [ Set last priority after play.

Befor Macro: |

Lefled L Led Lo
-

After Macro: |

o OK | X Cancel ‘

1. Bevel: refer to Chapter 3.3.1 and Chapter 3.5.2.
2. Control: The page is as shown above, please refer to section
3.3.2.(Differences as below)
Data Type: Select the format of the text string corresponding to the writing
position
0. AB: the first word is written to the high-order bits of the variable, and the
second word is written to the low-order bits of the variable.
1. BA: The second word is written to the high-order bits of the variable,
and the first word is written to the low-order bits of the variable.
2. _A: Each variable only stores one text in the low position.
3. A_: Each variable only stores one text in the high position.
4 ~7,same as 0 ~ 3, But no text is displayed, only "*" is displayed.
String Length: Set how many characters to display. It can display 1 ~ 32
characters.
3. Text: refer to section 3.4.2 .

3.5.4 Password Edit

Click [Component]-> [Edit]-> [Password Edit] to display the password
editing element in the editing screen. Right click or double click to enter the
property setting page. The password edit property setting dialog box is shown
in the figure below.
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Password Edit

Bevel Control ]Text ]

Control

Password Inde|set No.2 password

! Work notify I

Befor Macro: |

After Macro: |

Option
Priority |B}r scene LJ
Confirm |Press.action =l
KeyDef.  [Undefined [#)

Key Window 65001 : String input dia = |

Controlled con | LJ 5B

| Hide as priority lack or disable
[ Prompt as priority lack

| Continue Input

[ Set last priority after play.

o 0K | X Cancel |

1. Bevel: refer to Chapter 3.3.1 and Chapter 3.5.2.
2. Data: The page is as shown above. (refer to section 3.3.2, Difference as

below)

Password index: Set the second to eighth passwords. At this time, the
keyboard window in the option section on the right needs to set the input
screen as the password input dialog box, otherwise it cannot be entered.

3. Text: refer to section 3.4.2.

After setting the parameters, click this component during execution, and
the previously edited input screen will appear. After the input is completed, the

password setting operation is completed.

3.5.5 Track Bar

Using the slider element, you can use the adjustment knob to quickly set

the value of the element.

Click [Component]-> [Edit]-> [Track Bar] to display the slider component
in the edit screen. Right click or double click to enter the property setting page.
The slider property setting dialog box is shown below.
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|Track Bar >

Bevel Control | Display |

Write Nnt’rﬁmt|

Wit bacra: | [ Hide as priority lack or disable

Control 1 —Option

Data Type  |[16Bit] Signed | Priority |By scene 2
: Read Addr. | ~| o Confirm |Press.action -
: Max: | | = Key Def. |Undefined -
Min: | ~| em Key Window [yndefined =
Wirice Addr. | ﬂ > Controlled cn:un| ﬂ

B2

B3

B3

<
after Macro: | 3 [ Prompt as priority lack

o 0K X Cancel |

1. Bevel: refer to section 3.3.1.
2. Control: refer to Section 3.3.2.
3. Display: The page is as shown above.

Display form: Set the position display mode of the component display
scale.

Scale form: Set the display form of the scale.

Scale color: Set the display color of the scale.

Select Bevel: Set the form of selecting the internal border display.

Adj. Key Sel.: Set the display mode of the selection adjustment button.

Scale Numbers: Set the number of scales to be displayed. The setting
range is 1 ~ 100.

Scale Length: Set the length of the scale line, the setting range is 3 ~ 12.

Outer frame color: Set the outer frame color of the inner frame and the
adjustment button separately.

Inner frame color: Set the inner frame color of the inner frame and the
adjustment button respectively.

Brush Style: Set the brush form of the inner border and the adjustment
button separately.

3.5.6 Scroll bar

Quickly set the value of the component. In addition to using the slider
component, you can also use the scroll bar.

Click [Component]-> [Edit]-> [Scroll Bar] to display the scroll bar
component in the edit screen. Right click or double click to enter the property
setting page. The scroll bar property setting dialog box is shown below.
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{Scroll Bar ot

Bevel Control ] Display ]

Control | Option -
Data Type  |[168it] Signed | Priority |By scene |
Read Addr. | L] & Confirm |Pr955.acti|:|n LJ
Max: | ~| o= Key Def. |Undefined |
[ Min: | ~| o Key Window [Undefined =
: Write Addr. | x| »
Wirite Nnt'rﬁmq L] - Controled cn:un| LJ 1
Befor Macro: | L] ¥4 [ Hide as priority fack or disable
pltes Mae: | L] 4 [ Prompt as priority lack
Para. Edit(Format=16Bit Unsign)
Normal Offset:  [1 |
Fast Offest: |1[| LJ
Form size: ||:| LJ

o OK | x Cancel‘

1. Bevel: refer to section 3.3.1.
2. Control: The page is as shown above.(refer to section 3.3.2,differences
below)
Para. Edit(Format=16Bit Unsign)

Normal offset: Set the general offset value, that is, the data that moves
every time you click the left and right arrows of the scroll bar.

Fast offset: Set the value of fast movement, that is, the data that moves
every time the scroll bar is clicked once.

Form size: Set the width of the slider.
Note: The setting in the parameter editing column is only effective when the
data format is set to 16-bit signed / unsigned number.
3. Display: refer to section 3.5.5.

3.5.7 List box

In addition to the scroll bars and sliders described in the previous sections,
you can also use list boxes to quickly change the data of register elements.

Click [Component]-> [Edit]-> [List Box] to display the list box component in
the edit screen. Right click or double click to enter the property setting page.
The list box properties setting dialog box is shown in the figure below.
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List Box *

Bevel Control | Status | Display |

—Control —Option
Data Type  [[1681] Signed ~] | | Priority |By scene =l
Read Addr. | R Confirm |Press.action |
Max: | | o= Key Def. |Undefined =]
B I Lj e Key Window Iundeﬁned -
Write Addr. I = » Controlled cnni |
Write Notiﬁmt' ;] 1]
Bitoe Kaern: I ;] 2 [ Hide as priority fack or disable
Aiier Bbacro: I ;] 2 [~ Prompt as priority lack

" 0K I XElancell

1. Bevel: refer to section 3.3.1.
2. Data: refer to Section 3.3.2.
3. Status: refer to Section 3.3.2.
4. Display: refer to section 3.5.5.
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Chapter 4 Project management

4.1 Screen management

The [Screen] allows us to quickly understand all the current pictures. Add,
edit, delete, preview all pictures. For details of this chapter, please refer to
2.4.1 Scene. After we create a new file, we can see the screen section shown
in the figure below, which is divided into two parts: screen and preview.

{Screen Management |
G Go B |0 H O, CL
= TK6070FH

=-0 Init Scene Group
----- B2 2 : Size Type
----- B3 1 : Scenel

----- B3 3 :5cenel
=08 System default group

& E

Preview : 25%

----- 65000
----- 65001 :
----- 65002 :
----- 65003 :
----- 65004 :
: System setiing screen
: System message screer
: HEX input dialogue box
: Download screen

: Virtual on-line

: USB Download

Value input dizlogue bo|
String input dialogue b
Password input dizlogue
Password accurately me
Password error messag:

: Brightness and Contrast|
: Calendar

: Backlight

: password edit

: Communication

: Adjust screen

. LR
e Pl

R Moo

=5 Screen |% Liﬂk] & THEI]

Screen management
Use a tree structure to represent the relationship between each group.
Example: Only the scenes belonging to this group will be displayed under the
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initial screen group.

[TK6070FH]: indicates the HMI model set when creating a new file.

[Init Screen Group]: The system's preset starting screen group is convenient
for us to edit the screen and can be clearly classified. When the
screen is edited to a considerable degree, the group function
becomes more important. You can also create a group according to
your needs. Right-click the TK6070FH or start screen group, and
select [New Screen Group] in the pop-up scene. Set the group name
and permissions for this group. For example, the system in the figure
above Preset group.

[Start Screen]: Under each group, you can create a screen belonging to the
group, which is convenient for us to edit and browse, and can quickly
know the current relationship between all the scenes and groups.

Preview
When a certain picture is selected, the screen preview will display the

preview graphic of the selected picture, and the size of the preview picture size

can also be adjusted. Therefore, when there are many scenes, you can
directly click the screen in the screen management, and you can see the
preview graphic of the selected screen in the screen preview.

4.1.1 Dialog box screen

The purpose of the dialog box is that when we press a certain function
button, such as when confirming or canceling, in order to avoid human
negligence, pressing the button first causes loss of important data, so the
dialog box window is set to prompt when the button is pressed to ask whether
OK to avoid the loss caused by accidentally pressing the button.

The dialog box made in the case is only a basic form. Of course, users
can make dialog boxes of different styles according to their own ideas or needs.
After reading this chapter, Hope it can give you useful information.

Add, edit, delete dialog boxes
Click [Project]-> [Screen]-> [Add Screen],
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File Edit View Pro_|v.=.-r:t HMIM)  Component Tool Window Help

03 - @[T % A Screen Group

: sz | B L .. ® Communication ¥ | B Edit Screen Group
E s - C}' Tag ¥ | B3 Delete Screen Group
G[:Dhl;UFHD'IJEI;Er: dec Language d Open Screen Group

o emh KEYDO efine Close Screen Group

! @ @ @ @ n FHae . q Add Screen

| & Password ..

—Scene Managem(ﬁ Sound .. s
B G On E Protection ..

__r\, a-a Data Sync ... :

TKBO7OF @ o]
Record ..

- Init 5

B ctEI Data Schedule ..

""" = % 1T Recipe . £ All Screen to BMP
---- B 3 :1E System Configuration ... 5 Py

D%Smerﬁ?"ﬂafrﬂ ' o
""" -55r§___
..... .EEE.": g 2

..... 55E Setup » .

(PR (- et o o e e T e ol I L |

a.

or right-click [Init Screen Group] in the Windows management, as shown
in the figure below.
[Scene Management

' H TK6070FH
25y

----- B 2 : Sz B3 Add Screen Group

""" B3 1 : Sce B3 Edit Screen Group

""" 83 D'Er_ %5 Delete Screen Group
-8y System de

----- 65000  Open Screen Group

65001 | Close Screen Group

..... & 65002 ¢
..... & 65003 q. Add Screen e |
..... . BS004| 5 ,L? - E

----- 8 65005 |

..... ﬁ B5006 e

----- 63007

roanrtracrt

After selecting [Add Screen], a window for adding a screen will pop up as
shown in the figure below. Select the dialog box in the [Screen Type] . For
other settings, refer to section 2.4.1. Click the [OK] button to add a dialog box
window.
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14dd Screen bl |

Mormal ]Adv. ] Communication

-Screen Data
Name:  Iscreenz
Mum.: |4 _;J Auto Switch
Delay Time: 5
Type: |Normal Screen | elay Time:jo 2 Sec
Security: |B}r scene group _'J Jump to: |Undeﬁned 1.]

nherit: Stop function of Auto. swith screen
nhert:  |undefined | | as Delay Time set zero , The Defay
Time rang is 0 .. 32767 .

BG Color: _ v|
Description:
Load BG Image
Clear BG Image
Position: |Center _vj
Macro
«/ Screen OPEN Macro CYCLE Macro Intenval: 0.55ar _vj

i Screen CLOSE Macro
<7 Screen CYCLE Macro

0K X Cancel |

When editing or deleting a screen, you can select the screen to be edited
or deleted, and then click [Project]-> [Screen], or right-click on the selected
screen to select the edit or delete screen. The settings for the edit screen are
the same as those for adding new screen.

4.1.2 Case of dialogue box

After adding the dialog box window, you can start editing the dialog box
screen you need, as shown below. The examples given here are examples of
extending multiple languages and components. Please refer to Chapter 5
“Language Management”.
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P TPword [C:\Users\EN\Desktop\English Case\Multi-Language.vxf] — [m] X
File Edit View Project HMI(M) Component Tool Window Help

BE-d||o-=- |y mR||5 -B-F -G En b B

#|l2bha|wh H-fE-QQ||B-%H-¢-8-a0-¢HaAFBEBE-H

Graphic Component | Static Component | Button  Display ]Edlt |

h @ BEmmom =D E Ho%Se 2kekgEsss e
@@@@@@@@@ IEnghsh(Unted States) LJ

~f8 1: Start Scene
+ 2 1 Eng-Corfirm Scene
“- 3 : chn-Confrm Scene
=-[f System default aroup
+-[3 65000 : Value input dialogue box

|
Scene Management- LB B eng cene [100%] =
L ABOR oS |mE
= M TP6070C ~ |l . .
=-If Intt Scene Group 7 View Multi-Language

Are your sure to English | ‘

Chinese

+{E 65001 : String input dialogue box
L PR £EANT « Nereurnrd ine Aindaann he T
% >

e | =

Preview : 51%

Fre e raetEuy ey

=

F5creen [ L\nkj & Tag J

B [ Grid [Snap | Align Move : Const Button | 235, 210

Step 1. Add new screen and set the screen property as dialogue box. As
shown in picture 2 above , the name is set to [Confirmation dialogue
box].

Step 2. Place two key buttons on the screen, and set them to [Confirm] and
[Cancel].

Step 3. Set the properties of the [Confirm] button, refer to section 3.3.5. The
settings of the data page are shown in the figure below.

Key Button X

Button Control | status |

Motification: |

& B

Befor Macro: |

—Key Define —Option-

Normal: [ok Ra REGEEY |By scene ]
Shift: oK -] Key Def.  [Undefined -l
Crl: [oK ~] Destine Voice [|jndefined |
Alt: [ok =l

B

=

]

After Macro: |

£

X Cancel I

Normal: The action to be performed when this button is pressed.
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Shift: The action to be performed when the [Shift] key and the button are

all pressed.
Ctrl : The action to be performed when the [Ctrl]] key and the button are all

pressed.
Alt: The action to be performed when the [Alt] key and the button are all

pressed.

In the definition of the keys in the figure above, there are too many
functions to choose from. In this Case, we take two examples to explain. The
OK button is used as the OK key, so select [OK] in all four fields columns.
Step 4. Select the [Status] page to set the parameters of this page. Because
the main function of this button is to use it as the OK key, all the text in the 0 ~
3 index value is entered Confirm. As shown below.

Key Button 5
Button | Control Status |
Language lChinese (Simplified, China) j
Preview Status
B OBE %
Jelete Brush Image  Text
Index | Text
0 HE
1 THE
2 TAE
3 TAE
HEE
Word Input |EEE| B
o OK X cancal |

Step 5. Set the Other language text. Otherwise, the language text cannot be
displayed normally. As shown below.
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Key Button X
Button | Control SGtUB]
Leupans |English (United States) ~]
rPreview: —Status
H & =
: Brush Image Text
Index | Text
o Yes
1 Yes
2 Yas
3 Yes
Yes

Word Input |Ye5

o OK | X Cancel |

Step 6. Set another key button as the cancel key. For the method, refer to Step
3, Step 4, and Step 5.

Step 7. After setting the properties of the two buttons, the Chinese confirmation
dialog box is completed.

As shown below.

File Edit View Project HMI(M) Component Tool Window Help

DE-&| <~ B s -8 2 v | B
Z &4ho bl D -SE-QQ[ BB - 8- o0~dREOBBEAY

Graphic Component | Static Component | Button  Display |Edit |

0 EEmE@E ~ HE T Y E R
0200 E@O0 |

Scene Management M viseascenepioony [

E

‘Enghsh {United States)
134

ﬂ 2 Eng-Corfirm Scene [100%]

A

E-f& Init Scene Group
¢ 0@ 1:Start Scene
i =8 2 : Eng-Corfirm Scene

Are vour sure to Bnglish |

- System de

-3 65000
65001
-3 65002

A

Preview : 51%

e WU T

fault group

: Value input dialogue box

: String input dizlogue box

: Password input dialogue bi -

Aaceuined aeciebahe mace

>

View Multi-Language i

;Chinese

[ :‘ Yes

o Z‘ No

: English

5 5creen [ @ Link | & Tag|

[Ef | Grid |Snap | Align Select: Label 1= 11,53

Step 8. When we press the two buttons [Chinese] and [English] in the start
screen, the dialog box screen must appear for confirmation, so two
dialog boxes must be created. Here you can right-click [Confirm
Dialog Box] in the screen management and click [Copy Screen] in the
pop-up shortcut menu. Modify the screen properties, as shown below
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ﬂ mView : [ChUsers\EN'\Desktop\English Case\Multi-Language.vxf]
File Edit Yiew Project HMI{M) Component Tool Window Help

BE-E| o -y mBlls 55 %

MG

Zl hbholbw |D-SE-@Q B &vmvl O~ max¢

Graphic ComDonentl Static CornDonenti Button Display IEdlt

hO EEmoE ~ 2= HoRe LB eY e e
||@®®®@®®®.® |||EngIL5h(Unrtedsmtes) _;]_|

Bl —p
N

—Scene Management
55E0800 /299 |
H_ TK8037FH ~

B Init Scene Group

65001:5

FA scnno . n

<

—Preview : 51%

qnddScreen
PG Copysceen || B
E Edit Screen
ﬂ Delete Screen
. W ||=_=g' Lock Screen
Open Screen

Screen Property >

Normal |Ad1.r. | communication

—Scene Data

SCEHENEmﬁEng-CDrﬁrm Scene

SceneNum.Ig !:vj —Auto Switch
Delay Time:|g «l Sec
SceneType!pialogue Box ~| | =l
e Jump to: -
Security: [By scene group =] |Undefined |
i Stop function of Auto. swith screen
Inherit: |UﬂdEﬁﬂEd ;! as Delay Time set zero , The Delay
Time rang is 0 .. 32767 .
BG Color: | | ,!
Description:
Load BG Image
Clear BG Image
Position: |Center ;!
~Macro

¢ Screen OPEN Macro CYCLE Macro Intenval: |D_5gec v|

«; Screen CLOSE Macro
</ Screen CYCLE Macro

Step 9. Click the [Confirm] button in the screen properties to successfully add a
new dialog box screen. After modifying the attributes of the components in the
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new screen, the project is shown in the figure below.

AL Y 4 Lt LA 1AL LA LI L U LTt —
fle Edit View Project HMI(M) Component Tool Window Help

BE-d|o-o-|imB||s - F-S - [HE wed B |
#Zlhholaly m-sE-eQ B-R-S-EB- 00-¢RAIFBEY-E
Graphic Component | Static Component | Button  Display iEd\t |

o mmmoE |~ 6 B a ek hrnStetasnt
@023 @ 58 D303 | [eosh nred stares) = |

%
“Scene Management L SEECTE
&@%lq%ﬁ,ﬁ.l?ﬂﬂl%%}| DR R
=5 TP607OC o

=B Init Scene Group

~BR 1 : Start Scene

-8 2 : Eng-Corfirm Scene

-8 3 : Chn-Corfirm Scene

- System default group

-3 65000 : Value input dialogue box
65001 : String input dialogue box

- 65002 : Password input dialogue box
65003 : Password accurately message

-0 65004 ; Password error message ||| oo EnghSh

= ‘ Mo

-] 65005 : System setting screen ||
-3 65006 : System message screen (|-
--E 65007 : HEX input dialogue box
~E1 65010 : Download screen

-1 65011 : Virtual on-ine

-8 65012 : USB Download

= System screen

-3 65100 : Brightness and Contrast
-8 65101 : Calendar

-8 65102 : Backight

-8 65103 password edit i # = o |
-2 65104 : Communication & RHE 2 F R A |
- 65105 : Adjust screen &

~Preview : 51%

[ e g

ELiH

B35crean: ﬁ‘i’ Link | & Taa

Step 10. In the initial screen, modify the properties of the [Chinese] button
component as shown in the figure below. After completing the
modification, click the [Confirm] button to save the settings.

Const Button ot

Push Button Control | status |

—Data —Option
Action: I‘I.I'aerGnst | Security: IBy scene |
Format: [16Bit] Signed i Confirm: IPress.action ;j
Write Address: [| ANGUAGE INDEX [ v| 1 Key Def: Undefined -
Rule: IL'I ;i E... Key Window: |3 : chn-Confirm Scene
Max: | ;i IE.. Destine Voice IUndeﬁned ;i
Min: | ;i IE.. Controlled conl ;i 1
Motification: | ;i ™ Hide Obj.
Eefor Macro: | :j ] [ Hide as priority lack or disable
[ Prompt as priority lack
After M z - i
er Haco I _j “d [ Set last priority after play.
—Format i
&+ Dec i
Decimal Pos.: [q | g
" 32bit Float

o 0K I xCanceIl
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Step 11. In the initial screen, modify the properties of the [English] button
component as shown in the figure below. After completing the
modification, click the [Confirm] button to save the settings.

Caonst Button o
push Button Control | status |
Data 7 Option
Action: |\-’aerun5t ;J Security: |B}r scene =
Format: |[16I3it] Signed ;J Confirm; |F'ress.actic|n l.l
[Write Address: || anGUAGE INDEX [ ~| |53 Key Def: |Undefined |
Rule: [ | = I Key Window: |3 : Eng-Corfirm Scene _I'_]
Max: | L] IE Destine Voice 1Undeﬁned lJ
Min: | L] = Controlled ccnn| L] 1
Bithcamn: | x| - ™ Hide Obj.
Befor Macro: | L] 3 | Hide as priority lack or disable
[ Prompt as priority fack
After M z 7
er facra | _.] < [~ Set last priority after play.
Farmat
&+ Dec
Decimal Pos.: ID L]  dex
" 32bit Float
W 0K | X Cancel I

Step 12. Complete all design operations as above. The execution test screen
is shown below.

y 1: 5tart Scene b4

View Multi-Language

Chinese

English

When the [Chinese] button is pressed, a confirmation dialog box appears
as shown below.
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y 1: 5tart Scene 4

BT ERRARE

When the [English] button is pressed, a confirmation dialog box appears
as shown below.

y 1: Start Scene 4

Are vour sure to Chinese |

‘ Yes ‘ s

In this way, we can apply this case to other same functions, so as to avoid
the situation where the button is accidentally pressed.

4.2 Link management

When you select Link management, you can see a tree structure diagram
as shown in the figure below. You can quickly know which communication
protocol and how many controllers are currently set in COM1 and COM2. You
can select the communication protocol or controller by using the mouse. After
pressing the right mouse button, you can quickly create, edit, and delete
communication protocols or controllers to improve the timeliness of Link
management operations. It is also easy to create, edit, and delete
communication protocols or controllers.
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Link Management
=N i >
E‘"M TK&O70OFH
=& COM1
El---’i_li CoolMay PLC(3U/3G)/FX3U [9600,E,7,
: “iF] 0 1 CoolMay 3U Series [St=1]
------ s COM2
{ >

Eascreen | B Link |<F Tag

[TK6070FH] : Indicates the HMI model set when creating a new file.

[COM1] : Setthe communication protocol that COM1 on the computer
belongs to. After clicking, you can quickly create, edit, and delete
communication protocols, but only one communication protocol can be set for
a serial port.

[COM2] : Setthe communication protocol that COM2 on the computer
belongs to. After clicking, you can quickly create, edit, and delete
communication protocols, but only one communication protocol can be set for
a serial port.

[ Controller] : Set the controller to which the communication protocol
belongs in this serial port. You can set multiple controllers, but the station
number and ID must be unique (for details, refer to section 4.2.1).

Right-click on any serial port and select [Add Protocol] to pop up the New
Communication Protocol window. As shown in the figure below, select the
communication protocol you want to use.
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Add Protocol ot
Protocol

Protocol:

Controller: . - -
Company | Model | Des... |
CoolMay CoolMay 3U Series PLC

Port: | Auto Detect{RS232/R5422/R5485) -]

Baud Rate: 19‘6[”] LJ Data Bit: |?Bﬂ:5 LJ

Parity:  [Even B stop Bt [1g¢ =

Delay: |I:Im5 LJ TimeOut: 115&:: LJ

™ Multi-Station Smart Link Retry Count |Timenut, Repeat LJ

o DK X Cancel |

Protocol: Use the drop-down options to select the protocol to be used.

Controller: Displays the manufacturer and model selected by the
communication protocol.

Electrical: Four options for selection, automatic identification, RS232,
RS422, RS485.

Baud Rate: from 150 to 115200 speeds, which can be selected.

Parity: [None], [Odd parity], [Even parity], [Mark], [Space].

Data bit: [5], [6], [7], [8].

Stop bit: [1 bit], [2 bit].

Delay: no delay, 10ms delay to 5000ms delay, optional.

Timeout: [0.1], [0.2], [0.5], [1], [1.5], [2], [3], [5], [10] a total of 9 options.

Retry Count: Set the numbers of re-transmissions when the
communication is unsuccessful.

Multi-Station Smart Link: Select this function flag

Click the [OK] button to complete the setting of the communication
protocol. The [Add Controller] pops up as shown in the figure below. You need
to select the controller model you want to operate.
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Add Controller

Controller
ID:
Station: 1
Controller: Company Model Description
CoolMay CoolMay 3U Series PLC
Description:
¥ 0K X Cancel |

ID: The ID number of the controller.

Station : the station number of the controller, that is, the ID number of the
PLC,

Controller: Display the selected manufacturer, model, description, etc.

Description: Enter a description or help for this controller.

4.2.1 ID and station number

The station number (HMI station number) in the HMI unit setting is the ID
(PLC ID) corresponding to the connected controller, and the ID (HMI ID) set by
the human machine is the corresponding controller in the software setting. For
the setting of the station number, COM1 and COM2 of the HMI are
independent. Therefore, COM1 and COM2 can be set to connect the controller
with the same station number, but for the setting of ID, each HMI cannot be
repeated. Because the ID describes that this controller is which controller
connected to HMI unit, as shown below.
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COM1 COoMz
HMIIDE HMIIDZ HMIIDL HMI ID4 HMIIDS HMI IDG
[ [ [ [ I I
FLCE FLGCZ FLC1 FLC1 FLCZ FLCE
ID3 1Dz 101 101 1hz ID3
HnI HMI HhI HMnO HMI HMI
Btation3  Station2  Station1 Station3  Station2  Stationi

4.3 Tag management

Because there are many types of controller models, and the numbers of
contacts and registers of communication protocols defined by different
manufacturers are not the same, in order to facilitate the memorization of the
contact or register numbers, the software design uses label management to
increase readability.

For example, when creating a new label, we replaced the X1 contact with
the name [test]. After the new construction is completed, as long as the
component needs to use X1, type [test] in the write position or read position or
click the drop-down menu to select [test], then the system will treat [test] as It is
X1. In this way, each contact and register can be set with a convenient and
easier name instead of the name of the contact and register on the original
communication protocol.

4.3.1 Tag management case

Step 1. Click [Project]-> [Tag]-> [Add Tag Group], as shown in the figure below.
Using label classification can make labels more detailed, and it can be more
convenient and quicker to use.

miiew ; [Ch\UsershEMN\Desltoph 0327 vuf]
2

File Edit View | Project HMI(M) Component Tool Window Help
B ™ | 9 Scene L4 {

i 55 Communication r T o s

| SE | mr e [

& T . 2 s Group

Graphic Componen @ Language 2 &9 Edit Tag Group

I | @ | Delete Tag Group
[00®Q|®am. Piing

| =& Password ...
Tag Managemen ¢ Sound ...

Step 2. In the pop-up “Add Tag Group” dialog box, set the name of the newly
added tag classification, as shown in the following figure.
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| Add Tag Group >

Tag Group Mame:

For monitoring paged

o OK X cancel |

Step 3. Click the [OK] button to add a new tag group. At this time, you need to
click [Project]-> [Tag ]-> [Add Tag] to pop up the dialog box for adding labels,
as shown in the figure below.

1 Add Tag >

Tag Group: |For monitoring pages =]

Tag Mame: |-|-Eg-|-

Address: IDD b
Max: |1|:||:|

Min: |g

Description

o OK | XCancell

Set the content of each parameter, refer to section 2.4.3.
Note: If you do not need to subdivide the label classification, you can omit step
1 and step 2. When you add a new label, start directly from step 3.
Step 4. After clicking [OK] in step 3, the "For monitoring pages" tag will be

added with a "TEST" tab, as shown below:

{Tag Management |

Yy

' Defaul |For monitoring pages [

Tag M... | Address | Descri...

TEST Do Test ... |
TEST R DIO1  Test..

Step 5. Add “numeric entry” elements to the start screen, as shown in the
figure below.
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Step 6. Open the property page of the component, as shown in the figure
below. After setting the label, you can directly use the pull-down option to
select [Test] at the reading position instead of typing. Therefore, the use of tags
can greatly improve the visibility of contacts and memories during operation,

and reduce human error.

~Engineer Transfer

Offset: 0
1.0

Gain:

MNumeric Entry =
Bevel Control | Text |
—Contral 1 —Option i
Data Type ][168'rt] Signed LJ Priority JB',r scene L]
Read Addr. ]| LJ = Confirm Jpregﬁ_amnn L]
Max: SIGNAL SOURCE 5 I Key Def. -
_ SIGNAL SOURCE 6 .- _ |Undefned =]
Min: SIGNAL SOURCE 7 ] Key Window |g5000 : Value input dia v |
: SIGMAL SOURCE 8
Write Addr. | -ouPORT ALARM o Controlled cr:rnj L] L
Write Notficstl===_FOR MONITORIN
y TEST L) [ Hide as priority lack or disable
Befor Macro: | = | [~ Prompt as priority lack
= [~ Continue Input
After Macro: - it
] _J < [™ Set last priority after play.

1 rDisplay Format-

4 | & Decimal
f“
Decimal Pos.:]u = T

" 32 Bits Float. Point

Integer:

[~ Zero of HiBites

o 0K | x Cancel]
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Chapter 5 Language management

This software supports multiple languages. The purpose is to allow
anyone to use the language and symbols they are familiar with to edit the
required projects on this software platform. As a result, hmi can be used
quickly, the readability can be improved visually, and the work efficiency can be
increased.

Multi-languages can only be used in components that can display
numbers or text. When we create a new project, the system will use the
language preset by the operating system (here Simplified Chinese is taken as
an example), so the text or numbers entered on the component are classified
Under Simplified Chinese language. If we create a new English language, as
shown below. At this time, you can choose Chinese or English here. If we
previously set the component and set the component to text or number, we can
find that when Chinese is selected, the component displays the text or number
we entered, but when English is selected, the text and the numbers on the
component disappeared because we did not enter text or numbers in the
English language, so they did not appear.

Language n

@
Al

Add Language
; = 2
Translate Dic Translate text import Translate text export

Index | Name LocallD Font Decimal | Separate

#E0  Englsh (Unit... 00000... Tahoma [9]
1 Chinese (Sim... 00000... MS Sans Seri...

Therefore, to display several new languages, you must enter various new
languages and characters on the component. We can create multiple
languages in the language management. The object properties window of the
component can select the language under [Status], [Text ] can input the text of
the language we selected, so that no matter which language is selected, the
text we entered for this language on the component will appear.

5.1 Add, edit, delete languages

After selecting [Project]-> [Language], there will be six options, as shown
in the figure below.
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Bl ViewX @ [Li\Users\sy\Liocumentsy L1t
File Edit Wiew F"FDJEH HMI(M) Component Tool Window Help
D@val'g%ﬂcreen I

3
| % Communicaticn L
vz | BB f;,_ o
EE | e Ex C? Tk } % %

Graphic Componen E:B% Language M ﬁ, Add Language

i :_g_' ==l =
Lad¥ =]

B o= | & Edit Language
:‘_”__ 1= = o
@ @ ® @ {“ F\.larm fi= Delete Language
| -. Passw::rrd SE Init Language
~Scene- -C:Ei Sound ... 22 Translate
-é'i | 5| @ Protection .., Dictionary
: ..,p\..._ 1V"' [

fa-n Data Sync ... [
=-E& TK6070FH | | 8 Record .. o

=- Init Sce
g= % Data Schedule

..... B 2 ‘ Recipe ...

=B System|E2 System Configuration ...
""" B 6501 ¥ Macro .. .

----- B 6501 B Report Manac

..... o | 6501 i

_f L.FA ASNL Setyp ’

al LU — o __

Directly click the language management icon in the toolbar & ¥ the
language management dialog box shown as below.

Language n
& A kS i S
Add Language Edit Language Delete Language Set Init Language Str Translate
i = e 2
Dic. Translate Str Collect Translate Dic Translate text import Translate text export
{index|| Name | Localld | Font |_Decimal | Separate |

English (Unit... 00000... Tahoma [9]
il Chinese (Sim... 00000... MS Sans Sefi... . ;

Index: The index field is the index value of each language and it is unique.
Each index value corresponds to the system preset parameter N65342
[current screen language index]. Therefore, when the value of the system
parameter is changed, the corresponding language will be switched according
to the index value filled in the write position.

Add language: When you click this option, will pop up “setting dialog box”.
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Add Language >

Language N :

Lol D: | 0000040C

i

Font: MS Sans Serff [8] Font | [
i Test: :
j frangais

Decimal: jr

Separate: I

¢ OK X Cancel |

Name: Click the drop-down list to select the language to be added.

Local ID: The area code of the selected language area. This item is added
by default.

Font: Displays the preset default font you selected.

Select font: Click this button to pop up the font selection dialog, as shown
in the figure below. You can set the default font, glyph, size, effect, underline,
and color of the new language.

Test : Display the template of the selected font.

Decimal: Set which symbol is displayed when the decimal point symbol is
displayed.

Separate: Set which symbol to use when displaying the separator.

After clicking the [OK] button, a new language is added to the language
management screen, as shown in the figure below.

Language n
b4 A i3 8 %
Add Language Edit Language Delete Language Set Init Language Str Translate
a2 = = Ei
Dic. Transhate Str Collect Translate Dic Translate text import Transhte text export
Index | Name | LoallD | Font | Decmal | Separate |

S£0  Englsh (Unit... 00000... Tahoma [9]
1 Chinese (Sim... 00000... MS Sans Seri...
2 French (Fran... 00000... M5 Sans Sefi...

Edit language: Click this option to set the font, glyph, size, effect,
underline, and color of the existing language. The editing screen is the same
as that displayed in adding new language.

Delete language: Click this option to delete the existing language.
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Delete Language >

Delete all word of this phylum, Are you sure to delete [French
" (France]] phylum?

Ok ‘ Cancel |

Set initial language: Click this option under multiple languages to set the
initial language.

String translation: Click this option to convert the language on the screen
to the selected language, as shown in the figure below.

Translate pod
Transkte

(" Complex Chinese -=Simple Chinese

" Simple Chinese -= Cormplex Chinese

@ Dirtionary
] Find: [Englsh (United States) |
Replace: lChin:aSe (Traditional, Taiwan) ﬂ

o OK X cancel |

Among them, the software program sets Chinese and English as preset
translation functions. In addition, you can use the function of the translation
dictionary to set the corresponding language text, as shown in the figure
below.
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Dictionary
Add  Delete Reface | Import Export
hIT(EHE. £3) |HiEEE) |
T&E OK
HE Cancel
i Clear
{E[R Backspace
EL1=E N Mumber Input
—fin - Normal
FERE A String Input
TR A, Password Input
FamEan, System Information
EHEgE: Screen Width:
EEaE: Screen Height:
ELEE EEE Screen Color:
EE R Screen Size:
OSkRa: 05 Ver:
5 Year
A Maaon
=| Day

Dic. Translate:
Translation text export: When multiple languages are selected in the
program, such as Chinese (Simplified) and English (UK), the text can be
exported in batches, and the export format is a txt file, as shown in the figure

Set the corresponding language translation by yourself.

below:
n | Dictionary Export
B [ 1 123 ~| o+ & E
Ly &K i EREH il
BEQEG 20210611 2021-06-1117:07 AR
Sl
A
IREFE
,
i-.! < >
T
wpeem:  foeleile: | - BiFE
FTEZEEN(T): ]Text File (% txt) ﬂ Hig
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Import/Export
0 Export finish!

bizn=

Open the document and manually translate each language: For example, & 3|
W ERHE AR A translates to Shenzhen Coolmay Technology Co., Ltd.
(note that the format of the document should not be changed when translating,
that is, the text should not be shifted and line-wrapped)

""" | 20210611 - Translated - 2584~ - -
MAHF) 4R8E(E) 18=U(0) EE(V) #FEEN(H)

Viewd Dictiocnary Text File

[gﬂﬂggﬁé A*)UXDDDDD@_‘Q_E =)
e 1= Ed
%ﬁﬁﬁﬁ%$~ﬁﬁﬁﬁﬁﬁﬁ| chenzhen Coolmay Technology Co., Ltd. |
E OE

Hg{ﬁ Cancel
‘fﬁ% Clear
gi_ Backspace

ﬁu)\ “Mumber Input”
T i }\I‘-Iurmal

i “String Input”
%ﬁ%gf\ “Password Input”
f\,i. é?@ “System Information”
& ER: “Screen Width:”
EESE: “Screen Height:”
%’%ﬁ% “Sereen Color:”
c2-NO “Screen Size:”
OShRA: "08 Ver:”
5 Year
H Noon
H Day

After the translation is completed, import the translated text through the
[Translate text import] option.

Translate text import: Export from the above translated text and import it into
the project for use after the translation is completed.
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L 117
EHEEAO: [ 12 Y cmaEy
& ZR ) sk sem
SER || 120210611 - Translated | 2021-06-1117:220  Srasra
20210611 2021-06-1117:19 SRS
=®
=
REEn

>

@ .
i
praE=IIR [eo210811 - Trenslated = SR |
TEMFZEANT): [Text File (k. txt) = T |

4

Import/Export

@ Data import ERR!

_ me |

The effect is as follows:

199



TP Series HMI Programming Manual

5.2 Multi-language and component cases

Step 1. Create a new project file.

Step 2. Add English language.

Step 3. Select the component. Here, take [Static Text] in [Static] as an example.
As shown below.

"8 1: Start Scene [100%]

Step 4. Open the Static Text Properties dialog box. First set the English
language as shown below.

Label X

Bevel Text }

Text
Language: |Engli5h (United States) L]
Color: I | ¢ Word Wrap
Align: | Center -]
Effect: |Normal |
Flash: |Normal -]

Font: 27 [16] F_":'”t

Text: " View Multi-Language

o OK | X Cancel‘
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Step 5. Set the Chinese language again as shown below.

Label .
Bevel Text }
Text
Language: |Chinese (Simplified, China) j
Color: . ,| v Word Wrap
Align: | Center -]
Effect: |Normmal |
Flash: |Normmal |
Font: ” [18]
e mViewz &1 E F=H

W OK | x[‘ancel|

Step 6. When both languages are set, click the [OK] button. The static text will
now display the font of the selected language. As described in the
previous chapter, when Chinese or English is selected, different fonts
are displayed.

Step 7. Add [value button] to the initial screen, open the object property
window , select [variable or constant] in [action], and select [language
index of present screen] in [write ADDRESS]. [Rules] Please enter [0],
which refers to the index value mentioned in section 5.1, which
indicates that the language family is Chinese, and 1 indicates English,
as shown in the figure below.
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Const Button

Push Button Control | status|

ped

—Data —Option
Action: |Varj'Const | Security: |E|5.r scene |
Format: |[1ErB'rt] Signed | Confirm: |Press.actinn |
Wirite Address: || ANGUAGE INDEX ~| 3 Key Def: |Undefined |
Rule: ||:| ;I (Ees] Key Window: |Undeﬁned LI
Max: I ;I (Ees] Destine Voice IUndeﬁned -
Min: I LI Ee] Controlled coni ;I L
Motification: I LI B [ Hide Ob;.
Befor Macro: I ;I o [~ Hide as Driﬂri‘.tj" .lack or disable
| H [l e

—Forrmat
Decimal Pos.: |[] j fu 52;

" 32bit Float

o 0K I xtlancell

[Status] page, set the language of Chinese status and the language of English
status, as below.

Const Button
Push Button | Control Status

Language

Const Button
Push Button | Control Status

Language

review

= H E % &= + = B @ 7 =
Add Delstz Brush Image Text Copy Add Delste Brush Image Text Copy
Index | Text | Index | Text ‘
a Chinese
0
1 $§ 1 Chinese
3T Chinese
Word Input. [e3e B Word Input. [chinesa B
Talie i

Step 8. Add a second [Value button], set the setting button properties as shown

below
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Const Button X
Push Button Control | Status|
Data - Option
Action: |var/const | Security: |By scene =l
Format: |[16Bit] Signed | Confirm: |Press.action |
Vurite Address: [ ANGUAGE INDEX ~| 3» | | KeyDef:  [yndefined =
Rule: 1 v] = Key Window: |Undeﬂned _‘J
Max: v] (] Destine Voice 1Undeﬂned -
Min: v] IE... Controlled con v]
Motification: - ; -
otfication = [~ Hide Obj.
Befor Macro: v] ) [ Hide as priority lack or disable
| [ Prompt as priority lack
After Macro: 71 S
er Macro < [ Set last priority after play.
Format
' Dec
Decimal Pos.: |D L] ) e
¢ 32bit Float
o 0K | X cancel J

Set its status page to Chinese and English text as shown below.

Const Button % Const Button X
Push Button | Control Status | Push Button | Control Status |
Language i i ¥
Langusge [chinese (smpified, China) = quag [Engish (United States) |
Preview | (Status Preview | [Status
H B 2 = o Eh B oz
Brush Image Text (c I 1 B Brus! Imge Text
Index | Text ] | Index | Text
0 BX 0 English
1 BY 1 English
=53 English
Word Input [z B Word Input ,_ B
X concel X cance

Step 9. The setting is completed, and the project can be downloaded to the
HMI. Or select [HMI (M)]-> [Offline Execution] or use the hot key Shift + F9 to

check the effect.
When you click the [English] button, the effect is as shown in the figure below.

1: Start Scene hd

View Multi-Language

Chinese

English

203



TP Series HMI Programming Manual

When you click the [Chinese] button, the effect is as shown below.

f

1: Start Scene

View= E g = Z=1|

x
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Chapter 6 Alarm management

Click [Project]-> [Alarm] in the menu bar or directly select the [Alarm ] icon
@in the toolbar to open the window, as shown in the figure below.

| Alarm Management n
o : | e % * o
Add Alarm c l ielate Sot Alarm Configuration Import Export
\-Alarm Para. Area Alarm Info.
Mame Alrm A... | Mask Ad... | Upc||| Index | Level Trig Method | Alarm Picture | Algrm Picture Set | Check Picture | Alarm Voice | Description | Word Color | Alarm word

4 v e i

Click the New Alarm Area button to open the New Alarm Area window, as
shown in the figure below.

Add Alarm pod

alarm Area Define

Name:

Address: | -]
Mask: | R
Update: |35ec =]
Delay: |0Sec =]
Group: L] Alarm Group 0 "

Alarm Group 1
Alarrn Group 2
Alrm Groun 3 b

Description:

" 0K X Cancel |

Name: Enter the set name for the newly added alarm zone.

Address: Enter the position of the variable, you can select it through the
drop-down arrow symbol or directly enter the position of the
variable. As shown in the figure above, the icon button behind
the input box indicates that the position must be WORD. Click
the button to pop up the variable window as below to check
which variable is in WORD type. At the same time, you can also
enter or select the required variable in the number edit box as
below.
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B8 variable Window — O *
Variable—

Controllor:

Variable/Para.: Type Hame Range Sp... | Description A
BIT Xooo 0-367 1 Inputs
EmBIT Yooo 0-367 1 Qutputs
EBBIT Mnnnn 0-7679 1 Auxilary r...
EWBIT Mnnnn 8000 - 8511 1 Specil au...
EWBIT Snnnn 0 - 4095 1 Siates
BIT TSnnn 0-511 1 Timer con...
EBBIT CSnnn 0-255 1 Counter c...
3@ WORD THnnn 0-511 1 Timer curr...
3@ WORD CNnnn 0-199 1 Counterc...
DVWORD  CMnnn 200 - 255 1 Counter c... W

Number:

E
o 0K | XCanceIJ-

Alarm shielded address: When the alarm is triggered, this function can be used
to shield the alarm, that is, the alarm message and sound are not
displayed. The selection method of the shielded address is same
as that of the alarm area address.

Update cycle: You can choose how often you want to update. If you select 3
seconds, it means that the alarm will be checked every 3
seconds.

Classification group: You can check which group this alarm will be classified
into. Double click the left mouse button in the group to edit the
group name.

Start-up delay: Select whether to wait for the controller to start the alarm time
after the completion of data creation.

Help: Type a help statement for this alarm.

When the alarm area is added, the [Alarm] is shown in the figure below. At
this time, there are two setting buttons added in the toolbar of the window,
which are [Edit Alarm] and [Delete Alarm], [ Edit Alarm] means to edit the data
of the current alarm area again. [Delete alarm] is to delete the data of the
selected alarm event area.
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Alarm Management n
e, e, o ,' % s o’
| Add .-':\larr_n Edit Alarm Delete Alrm BSlarmn Se Alarm Configuration Import Export
Alarm Para. Area Alarm Info.
Name | Alrm A... | Mask Ad... | Upd| || Index | Level | Trig Method | Alarm Picture | Alarm Picture Set | Check Picture | Alarm Voice | Description | Word Color | Alarm word
I | prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1]
prompt Undefined Undefined Dizlogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1]
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1]
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
4 3| Kl b

As below figure, at the selected message to be set, and then press [Alarm
Setting] or double-click directly on the selected message, will pop up the alarm
setting window as below .

| Alarm Set e

Alarm Define ]hlarrn Mes. ]

-Alarm Define-

rec
Level =

Trigger ”"Eth':'d'-IUndeﬁned

Alarm screen: |Undeﬁned

Alarrm screen SEﬂDialngue Box

View screen: |Undeﬁned

Lef Lef Led Led Ll

Alarm sound: |Un.jeﬁned

Description:

o 0K X cancel |

Alarm define
Alarm definition

Index value: Because the alarm location is stored in WORD, the size of
WORD is 2bytes. When WORD is 1, it will be converted to binary [0000 0000
0000 0001]. Please refer to the table below.
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2power| el 4al1311211]10l 9|8 |7 16|54 !3]2]1]0

2Carry

index

514132 |1]0

Level: After setting the level, it is convenient for users to edit which level
this alarm is.

Trigger method:

Positive edge: When the data changes from 0 to 1, trigger the alarm.

Negative edge: When the data changes from 1 to 0O, trigger the alarm.

Positive and negative edge: When the data changes from 0 to 1 or from 1
to 0, trigger the alarm.

High level: When the data is 1, trigger the alarm.

Low level: When the data is O, trigger the alarm.

Positive edge and high level mixing: When the positive edge and high level
conditions are met, trigger the alarm.

Negative edge and low level mixed: When the negative edge and low level
conditions are met, trigger the alarm.

Alarm screen: Select the screen that appears during the alarm. You must
add a new dialog box before editing the screen to be used during the alarm.

Alarm screen settings:

Dialog box: 1. When selecting a dialog box, please note that the set
screen must have the function of leaving the dialog box; otherwise, when the
alarm occurs, the set dialog box will cause the problem of being unable to
leave.

2. When operating the screen (screen type is dialog box),
if the alarm occurs at this time, the screen that has not been completely
operated before will disappear.

Screen change: Select the display screen to jump to when the alarm
occurs, such as the current alarm display table screen.

Message: When selecting message, you can choose seconds for the
message to appear, will not affect the function of the current operation.

View screen: You can add a dialog box to edit the screen. When an
alarm occurs, you want to see what kind of alarm occurred before, this screen
will appear. We set the screen expressed by this alarm, and can do convenient
alarm point to search screen.

Alarm sound: Select the sound when the alarm occurs, you must first
set the sound in the sound management.

Description: A description of this setting.

Alarm message
Alarm message
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Language: Set the language when the alarm message is displayed.
Color: Set the color of the text when the alarm message is displayed.
Text: Set the text displayed in the alarm message.
Click the [Alarm Configuration] button. The alarm configuration dialog box is
displayed as below:

Alarm Configuration

Alarm Record

Record Count: 62] (2 -2048)

[ Retentive

o OK X cancel |

Alarm record

Record Numbers: Set the number of recorded alarms, ranging from 2 to
2048. When the number of alarms exceeds the set number, the first recorded
data will be deleted one by one to increase the latest alarm record.

Use power-off retention: Select this option to save the data in the alarm
log when the HMI is powered off and then Restart on.

6.1 Alarm case

This chapter uses a simple case to explain how to set the alarm (trigger,
shield), and uses the alarm record table to display the occurred alarm
information.

Step 1. Before setting the alarm information, you need to edit the alarm
screen, as shown in the following figure .
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Step 2. Click [Project]-> [Alarm] in the menu bar or directly select the
[Al_gr__m] icon® in tﬂg toolbar to open the it, _A_s_shown in the following figure.

D AT Dl AT ST T o

| Alarm

b ., b ‘ i o, ‘o o
Add Alarm Edit &larmm Delete Alarm Alarm Set Alarm Configuration Import Export
Alarm Para. Area Alarm
|| Mame Alarm A... | Mask Ad... ||| Index | Level | Trig Met... | Alarm Pi... | Alarm Pictu... | Check Pi.. | Alarm V... | Desc...| Wor... | Abr... |

Step 3. Click the [Add Alarm] button to open the new alarm area window
and set the parameters as shown in the following figure.

210



TP Series HMI Programming Manual

Add Alarm *

—Alrm Area Define

MName: |Alarm-Urgent

Address: no =
Mask: 1 |
Update: |3sec El
Delay: |osec B
Group: LI Alarm Group 0O Ly

L1 alrm Group 1
[ ] Alarm Group 2
Alarm Groun 3 bt

Description:

o OK | X Cancell

After the settings are completed, click the [OK] button to save the settings.
Show as shown in the following figure.

Alarm Management n
o, o, o | ® Q, | L o
Add Alarm Edit Alarm Delete Alarm | Alarm Set Alarm Configuration Import Export
Alarm Para. Area - Alrm Info. 1
Mame Alarm A... | Mask Ad... Updé Index | Level Trig Method | Alrm Picture | Alarm Picture Set | Check Picture | Alarm Voice | Description | Word Color | AlRrm word
Alrm-Urg... N0 35¢f] prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Diglogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined o
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1]
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1}
prompt Undefined Undefined Dialogue Box Undefined Undefined 0
prompt Undefined Undefined Dialogue Box Undefined Undefined 1]
< v |[f < >

Step 4. Select the information bar with an index value of 2 and click the
[Alarm Setting] button, or double-click in the information to open the alarm
information setting dialog box. The setting contents are shown in the following
figure.

211



TP Series HMI Programming Manual

Alarm Set >

Alarm Define ],ﬁ.larm Mes. ]

-Alarm Define-
index
Level: ||3rc| mpt

Trigger methnd1 High-level

Alarm screen: |2 : Alarm Screen2

Alarm screen Seqprumpt,ESec Auto Close

View screen: |g - Alrm Point2

Lef Led Lol Lo Led Lo

Alarm sound: |Unu:|eﬁned

Description:

o 0K | x Cancel‘

After the settings are completed, click the [OK] button to save the settings.
Show As shown in the following figure.

| Alarm Management n
. . A % | % o
Add Alarm Edit Alarm Delete Alarm larm Set Alarm Configuration | Import Export
—Alarm Para. Area ~Alarm Info. 1
|| Nare Alrm A... | Mask Ad... | Upd| || Index | Level Trig Method | Aferm Picture | Afarm Picture Set | Check Picture | Alarm Voice | Description | Word Color | Alarm word |
i|Alrm-Urg... MO M1 35e C)D prompt Undefined Undefined Dialogue Box Undefined Undefined 0
| 1 prompt High-lvel 2 :ARrm S...  prompt,0.55ec... 7 :ARmP... Undefined 0
1 | 2 prompt High-level 2 :ARm S... prompt,25eC Au... 8:ARrmP.. Undefined 0 |
)3 prompt High-level 2:ARmS... prompt,15ec Au... 9:ARrmP... Undefined [1]
@4 prompt Undefined Undefined Diglogue Box Undefined Undefined o
C)S prompt Undefined Undefined Dialogue Box Undefined Undefined 0
(655 prompt Undefined Undefined Dialogue Box Undefined Undefined o
C)? prompt Undefined Undefined Dizlogue Box Undefined Undefined 1]
)s prompt Undefined Undefined Diglogue Box Undefined Undefined 1]
C)Q prompt Undefined Undefined Dialogue Box Undefined Undefined o
C)l[l prompt Undefined Undefined Dialogue Box Undefined Undefined 0
)11 prompt Undefined Undefined Dilogue Box Undefined Undefined 1}
()12 prompt Undefined Undefined Diglogue Box Undefined Undefined 1]
Cpl} prompt Undefined Undefined Dizlogue Box Undefined Undefined 1]
C)lq prompt Undefined Undefined Diglogue Box Undefined Undefined o
C)lS prompt Undefined Undefined Dialogue Box Undefined Undefined 0
4 N £ 3

Step 5: Return to the starting screen, design the starting screen, set the
value of NO by using the increment and decrement buttons, and use the
display lamp to display NO bit situation. As shown in the following figure.
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B 1: Alarm Show Scene [100%]

Description: Press +1 /-1 to change Value of NO to trigger the alarm, display the correspondi
|ng bit value and index table through the binary light signal, to facilitate the understand of th
' e alarm case.

The new added screen is set as a shielding screen, design the shielding
screen, set the value of NO by using the increment and decrement buttons, and
use the display lamp to display NO bit situation. As shown in the following
figure.

B4 3 : Shield Secen [100%] (==

|Description: Press +1 /-1 to change Value of N1 to trigger the alarm, display the correspondin
1g bit value and index table through the binary light signal, to facilitate the understand of the a
: larm case.

|Current Alarm |
Scene

Alarm Show Scene

Use [Alarm Display Table], [Alarm Count Table] and [Current Alarm Table]
respectively to design one screen to record the alarm, as shown in the
following three figures. Please refer to section 3.4.16 for specific instructions
on the alarm record table.
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m 4 Alarm Record Scene [100%]

NUM | Time | Restore | Message

Alarm Show Scene Shield Secen | - - |Current Alarm |
S Scene

Num | Message | Times |lA

Alarm Show Scene| ;- S Scene

:::::] :::::CurrentAIarmééé

214




TP Series HMI Programming Manual

B4 10: Current Alarm [100%] =

Y Index [ alarm Time | Message

Alarm Show Scene

Step 6. After all screen settings are completed, you can start executing
actions. Click [Offline Execution] or press [Shift]+[F9], and the execution
screen is shown in the following figure.

1: Alarm Show Scene x

+1
NO = —
e -l

P‘C}'&“J&?l' :_jfﬁ 215 214 213 212 211 210 29 28 2? 26 25 24 23 22 21 20

T e B &
< carry ) @

Index 1. 0
Description: Prese the correspondi
ling bit value and | anderstand of th
OK I
R wuitTent Alarm
Shield Secen | ‘ | ‘ |
Scene

At this time, we can find that when clicking the [+] button, the value of NO
changes from [0] to [1], but the alarm is not triggered until [4]. Setting the high
level trigger, why does it being triggered when value is 4? the alarm location
is stored in WORD. In step 4, we select index 2 in [Alarm] to set, that is, when
the second bit of NO is 1, the value of NO must be 4 to trigger. Because the
WORD data size is 2bytes and is [0000 0000 0000 0000] (refer to the table in
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this chapter) in binary terms, when in the high level triggers, the binary value
corresponding to index 2 is 1, that is, [0000 0000 0000 0100], and the
corresponding binary screen is 22 power, 1 *22 power = 4, so the setting of
index 2 will only be triggered when NO value is 4.

Step 7. If the user does not turn off the alarm or shield the alarm after the
alarm occurs, the alarm screen will be reproduced every other update cycle
according to the update cycle which is set in [Alarm (Event) Management] (3
seconds in this case) until the alarm is turned off or shielded.

When an alarm occurs, the display information of [Alarm Display Table],
[Alarm Count Table] and [Current Alarm Table] are shown as below.

[Alarm Display Table] will be compiled into a record table according to the

alarms that have occurred.
41 Alarm Record Scene >

Alarm Display Table

MUM | Time | Restore | Message |
000 15:17:28 Alarm Happen0z
001 15:17:31 The front door is opened

Current Alarm

Alarm Show Scene
Scene

Shield Secen ‘

[Alarm Count Table] All the number of alarms that have occurred so far will
be counted and compiled into a count table.
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5: Alarm Count *

Alarm Count Table

Num | Message | Times [l=
000

001 The front door is opered
0oz Alarm HappenD2
003 The back door is opered
004

005

006

007

oog

009

010

011

01z

]

A I e o e T o e o B B

Current Alarm

Alarm Show Scene Scene

Shield Secen ‘

[Current Alarm Table] Displays the alarm information that is currently
happening and has not been cleared into the record table.

10: Current Alarm *
Current Alarm Table
Index [ alarmn Time | Message
ooa 15:17:28 Alarm Happeni2
001 15:17:31 The front door is opened
Alarm Show Scene ‘ Shield Secen ‘ ‘

Step 8: After the alarm occurs, the alarm information sent needs to be
closed or shielded. The method of closing the alarm information is to restore
the value of NO, namely restore the bit corresponding to the index value to 0.
Shield alarm information refers to setting the value of alarm shielded address
N1 to be the same as that of NO. As shown in the following figure, alarm
information can be shielded.
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3: Shield Secen

N1 4 ]

Power sz 215 214 2‘13 212 2‘11 210 29 28 2? 26 25 24 25 22 2‘1 20
22 @O 00 000000000000

Index 15 14 13 12 11 10 9 87 6 5 4 3|2 |1 ©

Description: Press +1 /-1 to change Value of N1 to trigger the alarm, display the correspondin
g bit value and index table through the binary light signal, to facilitate the understand of the a
larm case.

Current Alarm
Scene

Alarm Show Scene ‘ ‘

At this time, the display information of [Alarm Display Table], [Alarm Count
Table] and
[Current Alarm Table] are shown in the following three figures.

[Alarm Display Table] records all alarms that have occurred. If the alarm
has been cleared or shielded, the recovery time will be displayed.

4: Alarm Record Scene

Alarm Display Table

NUM | Time | Restore | Message |
000 15:17:28 Alarm Happen02 I
LILEL LTorla ol e THOrL CO0r 5 Ope el

Current Alarm
Scene

Alarm Show Scene

Shield Secen ‘

[Alarm Count Table ] is the same as before, and will always count the
times each alarm occurs.
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153: Alarm Count x

Alarm Count Table

MNum | Message | Times [l
oo

001 The front door is opened
0oz Alarm Happen02
003 The back door is opened
004

005

006

oo7

oog

009

010

011

012

]

(S T Y O i Y T i I N A P

Current Alarm

Alarm Show Scene Shield Secen Scene

Because the alarm has been cleared, there is no record of any alarm in
[Current Alarm Table].

10 : Current Alarm >
Current Alarm Table
Index [ alarm Time | Message |
Alarm Show Scene Shield Secen

So far, the basic description of the alarm information settings is completed.
The following steps will introduce to use the inspection screen to mark
fault points.

Step 9. First add the viewing screen in the alarm setting dialog, as shown in
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the figure below.

| Alarm Set X
Alarm Define | Alarm Mes. |
—~Alarm Define
Index: |
Level: Iprﬂmpt ;I
Trigger method]pigh-Jevel =l
Alarm screen: |5 : Alarm Screen2 ]
Alarm screen sef prompt, 25ec Auto Close 4]
View screen: (g : Alarm Point2 =]
Alarm sound: | undefined E
Description: o
{ N
|
[ ok | % cancel |

tep 10. Change the screen editing of the current alarm screen to below.

Enter [Current alarm table] property setting page. On the advanced setting
page, when selecting the items in [Options], the viewing screen is displayed.
select it. As shown below.

220



TP Series HMI Programming Manual

Current Alarm Display >

Eevel] Column Set Adv. Set ]

~Title
Index [ &larm Time | Message - Select Bevel
| Out Color: I | -
In Color: T -
Brush Style:
1] |» -
~Option— Select

v iShow Frame when Sel, Item

Brush Style:
[T Index Big-=Small Index _

~Group Option Write Addr. | |
Read: 0 j Format:16 Bits undigned
Format:32 Bits undigned

" 0K | xCanceI|

Plan [View Screen 1], [View Screen 2], and [View Screen 3] as shown
below

Bl 7: Alarm Point! [100%]
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B4 2: Alarm Point2 [100%]

Step 11. Repeat step 4 to set the actions of alarm indexes 1, 2, and 3, and
set the viewing screen like View screen 1,View Screen 2, View Screen 3. That
is, when the value of NO is 14, three alarm messages are triggered
simultaneously. As shown below
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11: Alarm Show Scene =

POWET' sz 215 214 213 212 23_1 210 29 28 2? 26 25 24 23 22 21 20

2 carry .. .. . ...........

Index 15 14 1312 11109 B ¥ 6 5 4 3 2 1 0

Description: Press +1 /-1 to change Value of NO to trigger the alarm, display the correspondi
ng bit value and index table through the binary light signal, to facilitate the understand of th
e alarm case.

At this time, enter the [Current Alarm Screen] and you can see that there
are three alarm
information in the [Current Alarm Table], as shown in the figure below.

&1 Current Alarm 5Scene x

When selecting the alarm item in the [Current Alarm Table], the relative
position of the fault alarm table will be displayed on the screen on the right side
of HMI.
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&: Current Alarm 5cene *

001 15:50:47 Alarmn Happenoz

61 Current Alarm Scene x

| Alarm Recoed Scene
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Chapter 7 Password Management

When operating the equipment, it is often necessary to provide users in
different responsibilities with operating functions of different permissions.
Some important functions are only available to users who have a password
and have sufficient permissions. In this regard, password management
provides protection layer and convenience in rights management.

Click [Project]-> [Password] to open the password edit form, as shown in
the figure below. This software provides 8 sets passwords and 8 types
permission levels for users to set. The first set of systems enforces the highest
permissions to avoid insufficient permissions when setting incorrectly.

Password @
Password
No.1: |User Level 1(High) =] |
Mo.2: |L|5EF Level 2 ﬂ |
Mo.3: |L|5EF Level 3 ﬂ |
No.4: |User Level 4 =]
Mo.5: |L|5EF Level 5 ﬂ |
Mo.6: |L|5EF Level & ﬂ |
Mo.7: |L|5EF Level 7 ﬂ |
Mo.8: |L|5EF Level 8 ﬂ |
o OK X Cancel |

Generally, the default level of the new added screen is [set by screen
group], the default level of the screen group is the lowest authority, and the
default level of all components is [set by screen]. Therefore, unless
otherwise specified, the user can use all the functions of the editing, because
all functions are available at the lowest level of authority.

7.1 Component setting

If some users needs to be restricted to a certain component ( button
component & editing component), you can set the use permission of this
component when setting the component. As shown in the figure below, set the
usage permission of [Screen Button] to [User level 4].
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Scene Button >

Push Button Control | status |

Contral Option

Scene Switch: |1 - Initial Scene j Priority User Leye| 4 -
- Confirm |I-'-‘ress.acti0n j
Switch Notes | j 1 ] Key Def. |L|nc|eﬁnec| j
Befor Macro: | - 2 Key Window  |indefined -
i e | j 5 Destine Voice |Undeﬁned -
Controlled cundi| j

[ Hide Obj.

[~ Hide as priority lack or disable
[ Prompt as priority lack
[ Set Levle 9.

W OK | X Cancel|

When using this button, the authority is lower than the setting authority, the
password input screen will shown as below, requiring the correct password

before continuing to use this function.
2: Size Type x

Present purview: 3 Password Input

‘1234567890-+‘

:‘QWERTYUIOP[]‘

L

‘ASDFGHJKL

ZXCVBNM,./\‘

‘Shift Space | Back | Clear Esc OK ‘

7.2 Screen settings

If you need to restrict the user to the components of the entire screen, you can
set the use Screen Property when editing the screen, and are restricted by the
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settings when using the screen component. The settings are shown below.

Screen Property

Normal ]Adv. | communication |

Screen Data

Mame: JStart screen

: }j Auto Switch

Delay Time:]n

:E_i Sec

Jump to: ]Llndeﬁned

Mum.: |1
Type: |nit Screen |
Security: le sCcene group _1]
Lt User Level 3 P
User Level 5
BG Color:  |User Level 6
User Level 7

Description:{ User Level 8
User Level 9(Low)
By scene group

Stop function of Auto. swith screen
as Delay Time set zero , The Delay
Time rang is 0 .. 32767 .

=]

Load BG Image

Clear BG Image

Position: JCenter

Macro

7 Screen OPEN Macro
<7 Screen CLOSE Macro
7 Screen CYCLE Macro

=

CYCLE Macro Intenval: 0.55ec

s

W OK

X Cancel |

7.3 Password screen setting

In addition to planning the HMI project, you can edit the password to be
used in [Project]-> [Password Management], or you can design a password
page specifically for password management in the man-machine interface
project. Show. The input element is [Password Edit] in [Edit].
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1: Initial Scene [100%]

[Password Edit] The property setting page is as below, you can choose to set
several groups of passwords. Only the first group of passwords, that is, the
password with the highest authority, cannot be set and needs to be set during
project planning.

Password Edit bt

Bevel Control | Text |

—Control 1 —Option-

Password Inde|set No.2 password - Priority |By scene E2
| pEseE o e =
Work notify  [gat Ng.3 password ] : —]
- Set Mo.4 password Key Def. ]Undeﬁned L]

Befor Macro: |Set No.5 password :
i . |Set No.6 password eyt IU”dEﬁ”Ed =

After Macro:  |got o7 password

Set No.8 password Controlled Cﬂnj L]

[~ Hide as priority lack or disable
[~ Prompt as priority lack

[~ Continue Input

[~ Set last priority after play.

W OK | X Cancel‘
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Chapter 8 Sound Management

In this software, users are allowed to edit various sound effects to use, click
[Project]-> [Sound Management] to open the sound management window, as
shown below.

Sound Management n
e N P = = # b
Add Sound | Edit Sound Delete Sound Add Ttem Edit Ttem Delete Item Play
Sound -Content
Index | Name | Repeat .|| Order | Frequence | Time
1] Key Man-rep. | || O 1000 50
1 Dialog Maon-rep. |} B 1500 50
] 3

The part in the circle above is the sound preset by the system. By default, the
system sets the index 0 and index 1 in the figure as the sound of the button

and the dialog box.
Click the [Add Sound] button, and the [Add Sound Window] as shown

below will pop up.
Add Sound s

Sound Definition

idex

Mame: ISnundD
Repeat Count: ]Ngn_rapeat j
Description:

0K | xCance||
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Index: The system automatically adds the index value in sequence.

Name: Enter the name defined for this sound.

Repeat Count: choose the number of repetitions when using this sound,
you can choose not to repeat up to 7 times.

Description: Enter a help description for this sound.

After setting, click [OK] button to save the above settings. Click the [Add
Item] button, and the [Add Sound Item] as shown below will pop up.
Add Sound ltem e

Sound

v |

Frequency: |l

Hz
Time: |5|:| j sl B

W DK X Cancel |

Frequency: Input the frequency of sound. The high and low sound will
change with the frequency. The high frequency means sharp sound, and the
low frequency means low sound. For the setting of sound frequency, please
refer to [Appendix 3 Scale Frequency Table]

Time: Enter the time to make a sound, in ms, 500ms is equal to 0.5s,
indicating that the sound will stop after 0.5 seconds.

The triangle button in the circle in the figure is the function of trying to play
the sound. After setting the sound frequency and duration, you can press this
button to play to confirm whether it is the sound you want to set.

This completes the setting of each parameter of sound. In the process of
setting the attributes of components, if there is a demand for sound, you can
choose to use it, as shown in the following figure.
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Decimal Pos.: |U

<]

—Data —Option
Action: |1nput | Security: | By scene |
Format: |[16Bit] Signed w| || Confim: lpregs.action |
Write Address: | j o) Key Def: |Undeﬁned j
Rule: | =] Key Window: [65000 : value input dialo |
Max: | j E..] Destine Voice Iundeﬁned j
Min: | | = Controlled conjUndefined
Motification: | j ™ Hide Obi.
Befor Macro: | j 5 [ Hide as pri

: : [ Prompt as priorty lack

Sies S | j ¥ [~ Set last priority after play.

—Format

¥ Dec
" Hex
" 32bit Float

v 0K I x&mcell
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Chapter 9 Data Synchronization Management

When the device is actually running, there are some materials that need to be
updated synchronously, or when you need to use one data to affect another
data, you can use [Data Sync] to complete.

Click [Project]-> [Data Sync...] to open the [Data Sync] Window, as shown in

the figure below.
Data Sync n

a a
:E LB

&
Add i = | Import Export
Data Sync

In... | Synchro... | Condition | Synchronize ... | Source ... | Target ... | DataLe... | Desc...

Click the [Add] button to open the [Add Data Sync] window as shown below.
You can edit the data to be synchronized.
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Add Data Syne. X
Data Sync
Tirme: 35ec =]
Format: |[16Bit] Signed =]
Condition:  [1 x| o
Type: |High Level =
Data Type:  |[16Bit] Unsigned z
Source: o | o
Destination: |1 = »
Length: 1 =
[
Description:
O] X cncel |

Time: Select the time to achieve synchronization, that is, when the data of
the source address changes, how long the data of the destination address will
be synchronized after the condition variable reaches. In other words, the time
when the synchronization condition is valid. For example, synchronization
condition mode: high level; condition variable: N10.0; synchronization time: 10
minutes; then N10.0==1 after 10 minutes, the data starts to synchronize, if it is
a falling edge, then the condition must be maintained More than 10 minutes,
otherwise the falling edge cannot be detected, so there is no special
requirement. Generally set the synchronization time of 0.2 seconds (that is, the
trigger condition is very sensitive, and the condition variable is synchronized
immediately).

Format: select the type and type of variable used for synchronization data.

Condition: Set the condition variable and decide whether to synchronize
according to the synchronization condition mode of this condition variable.

Type: In this case, the high level is set to achieve synchronization.

Rising edge: When the data changes from 0 to 1, synchronization is
achieved.

Falling edge: When the data changes from 1 to 0, synchronization is
achieved.

Rising and falling edges: When the data changes from 0 to 1 or from 1 to O,
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both are synchronized.

Positive level: when the data is 1, synchronization is achieved.

Negative level: when the data is 0, synchronization is achieved.

Source: Set the address of the data source, that is, the address where the
data is read. In this case, the system variable NO is used.

Destination: Set the address of the data destination, that is, the address where
the data is written. In this case, the system variable N1 is used.

Description: Enter the definition description for this synchronous data, you
can not enter it.

After the above parameter setting is completed, the editable
synchronization screen can be edited. This screen changes the value of NO by
the increment and decrement buttons. After the value of NO changes for 3
seconds, the value of N1 changes to the same value as NO. Show.

2: Data-5ync Scene [100%5]

: Data-5Sync Scene
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Chapter 10 Recipe Management

When the HMI is connected to the PLC, there are often a large number of
values with the same nature of the data that need to be transmitted. We
categorize and sort these data and transmit them at the same time. This is the
recipe. When the general equipment is in actual operation, there are some
production materials that need to be transmitted to the PLC by the
man-machine interface, or when the man-machine interface is required to
record the data, you can use [Recipe] to achieve.

Click [Project]-> [Recipe] to open the [Recipe] Management Window, as
shown below.

Recipe @|
B & g
Add dit  Dele Import Export
Recipe Content
Index Mame De...

Click the [Add] button to open the [Add Recipe] Definition Window, as
shown in the figure below, you can edit the new recipe data .
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Add Recipe >
Recipe
index: I
Mame: |,.5“.5|
Work: ||.]1[m
Control: |Hﬂ|
Backup Device: |Rea|:| Only LJ
Backup Addr.: |
Recipe Count: |g ii
Description:
o OK X cancel |

Index: The system automatically adds the index value of the recipe data in
sequence.

Name: Set the name of the recipe.

Work: Use the recipe to temporarily store the starting address of the
corresponding variable (the size is 1 group recipe capacity).

Control: variable address that controls the recipe action (the size of the
control area is 4 WORD)

Ad(ires Name Content Remarks
+0 Index0 0..65535
+1 Rev 0 Keep
+2 Rev 0 Keep

BitO=Read(Move from backup area
to work area)
Bit1=Write(Move from backup area
to work area)

Automatically
cleared after
moving parts

+3 Control

Backup Addr: Choose recipe backup, currently only 2 options are
available.

Data read-only: data is stored in the HMIT program, suitable for read-only
recipes.

Use system variable area (NO-N61439): data is stored in the system
variable area, suitable for reading and writing recipes.

Remarks: For the system variable area, please check the power failure
holding section of individual models.

Backup Addr: The storage address of the backup recipe.
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Recipe Count: The total number of recipe groups.
Description: Enter the description text of this recipe, you can not enter it.
Formula variable definition:

Becipe |E
% @B

Add Edit Delete | Import Export

'R'ecipie 1 C'Dntent
Index | Name | De...| = ||be m e
0 AAA 1
| | Recipe\Para.|N100 \
: 1 0 Format
Add / delete variables||; 0 :
: variables
13 0
|4 0
|5 0
I i This is a set of recipe
7 0 . .
information
l .l.tem stDRD

Add / Delete Variables: Click the Add / Delete button directly to add /
delete variables.

Set variable format: Click any column that needs to modify the variable
format, and then click the corresponding variable format required by this
column.

S16: Set to 16-bit signed number.

U16: Set to 16-bit unsigned number.

S32: Set to 32-bit signed number.

U32: Set to 32-bit unsigned number.

F32: Set to 32-bit floating point.

Definition of recipe variables: Recipe actions are controlled by reading
and writing variables in the control area.

Read recipe action::
Address Name Content
+0 Index0 0
+1 Rev 0
+2 Rev 0
3 Control Set 1(Bit0: Move from backup area
to work area)

Move the group 0 recipe from the backup area to the work area
Write recipe action:
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Address Name Content
+0 Index0 7
+1 Rev 0
+2 Rev 0

Set 2(Bit1: Move from backup area

+
3 Control to work area)

Moved from group O recipe in working area to group 7 in backup area.

In addition, in order to write the recipe into the controller PLC or read it out
from the same controller PLC, it is necessary to match the data movement
button component, as shown in the figure below.

Recipe ccontrol

Recipe backup

v Recipe PLC controller
alEa <:> Workspace <:>

Data move button

10.1 Recipe use cases

This case is used to explain how to set the usage data recipe.
Step 1. Click [Project]-> [Recipe] on the menu bar to open the [Recipe]
Management Window, as shown in the following figure:

Recipe E|
@y @ e
Add Edit Dele Import Export

Recipe Content

Index Mame De...

Step 2. Click the [Add Recipe] button to open the [Add Data Recipe
Definition] window and enter each parameter value, as shown in the following
figure.
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Add Recipe X
Recipe
Index: |
Name: |aa
Work: [n10
Control: [no
Backup Device: ]UEEI:I Internal Memory(MO-M61439) LJ
Backup Addr.: 1[41|]|]
Recipe Count: ]g i]
Description:
W OK X Cancel |

Step 3. After setting the parameters, click the [OK] button to return to the
[Recipe] Management window. The newly added recipe data is displayed on
the right side of the window, as shown in the following figure.

.Recipe H
% 9

Add Edit Delete | Import Export

—Recipe | ~Content

Index | Name De... | = = &R B

] AA I
|Recipe\Para.|N10 |
lo 25
¥ 26
2 B8O
3 75l
|1 tems WORD Save addr.:M33

Step 4. Click the [Add] Recipe Variable button &, add the recipe variable

to N13, and enter the numerical value of the recipe, as shown in the following
figure.
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B & -
Add Edit Delete | Import Export I
Recipe Content i
Index | Mame De... | = = | g8 & &R
0 AR | :
Recipe\Para.|N10 N1 [n1z Ni3
[0 25 36 38 95 |
1 26 48 25 74 |
|2 89 28 15 76
3

£ SR [ 24 i } '

Recipe Numerical Value

4 Items.-WORD Sa\re addr.: NES

Step 5. Close the [Recipe] window, return to the project edltlng screen,
and add the numeric editing elements in the work area addresses N10 ~ N13,
as shown in the figure below.

1: Start scene [100%]

Step 6. Add the numeric display elements of backup addresses N100 ~
N123. Generally, it is not necessary to plan the editing of this part during the
actual operation. As shown below.
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m 1: Start scene [100%]

o (B e (el R
e —— D, | — o
i U NN O | o 0NN | e || B |
IZIZIZIZIZIZIZIZIZIZIZIZIZI.;Min:D ......... .........
o NNYOB e || wem || s | w00
N2 | ene || pene | | peen | weer |
U N @ | ween || aene | | aeen | seem |
ey B B B B

Step 7. Add a numeric editing component for the number of recipe groups,
which can be used to read and write the number of specified recipe groups.
The format is shown in the figure below.

| 1: Start scene [100%] E

- MNurmeric Entry |
- - Read AddresstNO [ D - -
- Max:s

L Min0 =
D1 Write Address:ND |- 1]

o Write Notification: | [ [ |

Step 8. Add an ON button component, which is used as recipe data to
write into the backup address of the specified recipe group number from the
work area address, and its variable position is input as N3.1, as shown in the
figure below.
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11: Start scene [100%]

. ork area> Bac
: kUp Addr

B en e e e ON Button

.07 Action:Set ON
* . Read Address:N3.1
- Write AddressN3.1

- Write Motification:

Step 9. Add an ON button component written back to the storage area,
which is used as recipe data to read from the backup address of the specified
recipe group number to the work area address, and enter N3.0 as the variable
position, as shown in the following figure.

i 1: Start scene [100%)]

| #as | | #ene | | #eee | |BackUp Addr->l L

e e 5 Workarea E

! ! ! i ON Eutt i

! G ! e ! G A :Actio::S:ON I

.................................................................................. Read Address:Na.0 [+
_Write Address:MN3.0

Write Motification:

Step 10. The screen editing settings are completed, at this time click the
menu option [HMI]-> [offline execution], the execution screen as shown in the
figure below appears.
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| N10 N11 N12 N13
 Work area Addr| o | [l [ o |[ o

‘Back up Addr N100 N101 N102 N103

25 36 58 95

N104 | = 43 25 74 NO o |

N108| & 28 15 I Work area>Bac |l
kUp Addr

N112| 81 42 57

N116| © 0 0 0 BackUp Addr->
Work area

N120 ] ] ] ]

Step 11. Enter 3 in the recipe group number edit box and press [Backup
Addr-> Work area] to write the third group of recipe data from the backup
address to the work area address, as shown in the figure below.

1: Start scene X

N10 N1l N12 N13

Work area Addr|[ » | [[& -
Back up Addr N100 N101 N1$ N103
25 36 5{ a5

N104 | = 48 ;5 74 NO| |3

N108 | @ % / 15 B Work area>Bac
' kUp Addr

N112| 7= 81 42 57

N116| © 0 0 0 BackUp Addr->
Work area

N120 ] 0 ] ]

Step 12. Change the value in the formula group number edit box to 4, and
then modify the value of each recipe in the work area. After modification, press
[Work Area-> Backup Address] to read out the recipe data in the work area
address to The fourth group of backup addresses is shown below.
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: Start scene *

N10 N1l N12 Ni3
Work area Addr| s |05 [ 7 |] 7

Back up Addr N100 N101 N102 N103

25 36 '# 95

|

N104 | = 48 o5 = NO\ >
N108[ = |[ = {77 7|
N112 | 7 81 > = kUp Addr

N116| © 0 0 0
N120| © 0 0 0

BackUp Addr->
Work area

Step 13. The use of general recipes must be matched with the PLC
register, so the numerical editing components of PLC positions DO ~ D3 are
added as shown in the figure below.

B8 1: Start scene [100%]

nantt |

Mumeric Entry
- Read Address:D0

Write Address: D0 !
iada Write Motification: :

Step 14. Click [Project]-> [Data Synchronization Management] in the
menu bar to add 2 data synchronization from [PLC-> Working Area] and
[Working Area-> PLC], as shown in the figure below, more details please refer
to Chapter 9.
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Data Sync B

m:m EE HE | L | i
L] = (T} HE

Add | Delete | Import Export
Data Sync |
In... | Synchro... | Condition | Synchronize ... | Source ... | Target... | Data le... | Desc... |
] 0.25ec K3.0 2:Faling edge  N10 Do 4
i 0.25ec MN3.1 4:High Level oo M10 4

Step 15. Modify the two ON buttons on the edit screen as shown below.

& 1: Start scene [100%)] @

|

—
| | | ] ;;;;
== = e 1

PLC

Step 16. Click the menu option [HMI]-> [Off-Line Run], the execution
screen is as shown in the figure below.
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X

0

0

Work area Addr
Back up Addr N100 N101 N102 N103

N104
N108
N112
N116
N120

N10O

Ni3

]

0

N1l Ni2

0

0

25

36

58

95

26

48

s

74

NOIT .

g9

28

13

76

PLC>BackUp A
ddr

75

81

42

37

BackUp Addr->

PLC

Step 17. At this time, click the number of recipe groups to enter 2, and
then click [Backup Addr-> PLC], the recipe data of the third group can be read
from the backup address area to the PLC address, as shown in the figure

below.

1: Start scene

PLC Addr DO~D3

Work area Addr .
Back up Addr N100 N101 N102 N103

N104
N108

g9

‘28 H 15

76‘

N10

N11jJ N12

N13

g9

28

15

76

25

36

158

95

26

43

25

74

NO| [z |

g9

28

15

76

N112
N116
N120

75

a1

42

57

PLC>BackUp A
ddr

0

BackUp Addr->

PLC

0

Step 18. Modify the number of recipe groups, enter 1, change the data in
the PLC location DO ~ D3, and then click [PLC-> Backup address], the recipe
data in the PLC location can be written to the third group backup address, as

shown below.
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PLC Addr DO~D3| s

Work area Addr

Back up Addr N100 N101 N1

N104
N108
N112
N116
N120

*
‘ 77 ‘ 88 99
N10 N11 N12/ N13
66 T 85/ 99 ‘
N103
25 36 3 95 Rece
66 77 88 99 NO Z
89 28 15 76 PLC>BackUp A
ddr
75 81 42 57
. o 0 0 BackUp Addr->
PLC
0 0 0 0
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Chapter 11 Macro Types and Grammar

11.1 Types of macros

INITIAL macro

Macro command that starts when the HMI is powered on or restarted. This
macro instruction is executed only once, and is generally used for setting the
initial value. By default, it can execute 4096 steps.

BACKGROUND Macro

After the HMI is powered on or restarted, the program will be executed all the
time. Similar to the background program, 1024 steps can be performed by
default 50ms.

CLOCK macro
After the HMI is powered on or restarted, the program will be executed at

intervals, and the interval is set to 500ms to execute 4096 steps.

Project HMI(M] Component Tool Window Help

% Screen L&
| & Communication L @ a 2 - % 4
| ¢F Tag 3
13 Language 4 ]Ed't ]
EH oa % e ek
@ Alarm . naglish (United States)
“o Password ... 12
i b Sound ... 1 B 1 Start
L@ Protection ...
-nDataSync ———
@Record [
E’%l Data Schedule ..
13 Recipe .., o
1B System Cenfiguration ... S
E %}? [ % INIIAL Macro
[ <& BACKGROUND Macro
{ Setup y | &5 CLOCK Macro
UUS T SYstemm Sertng sCreen 1 Screen OPEN Macro
006 : System message screen Screen CLOSE Macro

007 : HEX input dizlogue box e
010 Duwnlnad screen

o11.: itua anine

17 = 1ISR Nownload ——

Screen Open Macro

When the screen is switched to the currently set screen, the OPEN macro
program will be executed, and the default can perform 4096 steps at a time.
Screen Close Macro

When the current screen is switched to another screen, the CLOSE macro
instruction program will be executed. By default, it can perform 4096 steps at a
time.
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Screen Cycle Macro

When the screen is switched to the currently set screen, the CYCLE macro
command program will be executed all the time. The interval time is preset to
500ms, and the preset can perform 4096 steps at a time.

Screen Property b

Normal ] Adv. | Communication |

5cene Data
SceneNamei Scene
SceneNum.Il ;_] rAuto Switch
Delay Time: |[al Sec
SceneTYPe] Init Scene | Y 10 :_]
S Jump to: -
Security: [y scene group | undefined E
Inherit: Stop function of Auto. swith screen
nhert:  |undefined ~| | as Delay Time set zero , The Delay
Time rang is 0 .. 32767 .
BG Color: j_,i _
Description:
Load BG Image
Clear BG Image
Position: |Center LJ
Macro
i S5creen OPEN Macro CYCLE Macro Intenval: 0.55ac LJ

<7 Screen CLOSE Macro
<7 Screen CYCLE Macro

Component action macro (button component and editing component)

When the button component or editing component is activated, the
corresponding macro program will be executed. The preset can perform 4096
steps at a time.
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Button Data | status|
Data —Option
Action: |Input | Security: |Eh,r scene =l
Format: |[1ﬁBit] Signed | Confirm: |Press.actinn |
Write Address: | =] » Key Def:  [Undefined =l
Rule: | ﬂ Key Window: |55[]E|D  HIER RS ;i
Max: I LI =5 Destine Voice iUndeﬁned -
Min: | LI n Enable Prwiso' LI
Motification: ;I B I Hide Obj.
Befor Macro: ;I 3 [~ Hide as priority lack or disable
[~ Prompt as priority lack
After Macro: - i
I _I ¥4 [~ Set last priority after play.
—Format
& Dec
Decimal Pos.: | | ) B
" 32bit Float
W DK I X Cancel |
MNumeric Entry ot
Bevel Control | Text |
—Controf —Option
Data Type I[lﬂBit] Signed ;i Priority |B1,r scene ;I
Read Addr. | x| e Confirm |Pre55.action |
Max: | | = Key Def. |undefined |
Min: | x| = Key Window 65000 : value input dia v |
Write Addr. | ;I b5 Controlled c0n| Li ]
Write Notificat
| | L . ™ Hide as priority lack or disable
Befor Macro: | LI & [ Prompt as priority lack
. [~ Continue Input
gt e I LI < [~ Set last priority after play.
—Engineer Transfer—————— Display Format
Offset: I[] Integer: |4 vl & Decimal
e Il.U Decimal P-:}s.:IU vl e
™ 32 Bits Float. Point
Aux. Cal. | [ Zero of Hi Bites
" OK I X Cancel |
Sub Macro

The sub-macro instruction is equivalent to the sub-program in the macro
instruction program. The number is provided from 1 to 512 sub-programs.
Common and general functions can be written in the sub-program to facilitate
the main program call.
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%5 Communication
49 Tag

& Language

- v v

vh v v | EY
Ra|m-wve~

|edit |

Keyboard Define ...
Alarm ...

Password ...

Sound ...
Protection ...

Data Sync ...

R -1

Record ...

Data Schedule ...
Recipe ...

System Configuration ...
i Macro ...

L‘:”ﬁ IH E.'I* W %

=] Report Manager

4

TR ER

(ZE) |
S|

< INITIAL Macro
<& BACKGROUND Macro

Setup

wip CLOCK Macro

Screen OPEM Macro

en CLOSE Macra

Screen CYCLE Macro
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Among them, there are 16 groups of sub-macro 496-512, which are reserved
for system use. Using Macro communication, when the communication
receives data, the system will automatically execute [496: Sub Macro (496)]

without calling it.
Y

Macro Editor

e

Add Delets

e
B
¥aa

Check

N L A

Import Export Font

—Macro

~CLOCK

- 400 : Sub Macro (490)
491 : Sub Macro (491)
-402 : Sub Macro (492)
- 493 : S5ub Macro (493)
404 : Sub Macro (494)
- 405 : Sub Macro (495)

- 486 : Sub Macro (496)
- 497 : Sub Macro (497)
- 498 : Sub Macro (498)
409 : Sub Macro (499)
- 500 : Sub Macro (500)
- 501 : Sub Macro (501)
- 502 : Sub Macro (502)
- 503 : Sub Macro (503)
- 504 : Sub Macro (504}
- 505 : Sub Macro (505)
- 506 : Sub Macro (506)
- 507 : Sub Macro (507)
- 508 : Sub Macro (508)
- 509 : Sub Macro (509)
- 510 : Sub Macro (510)
- 511 : Sub Macro (511)
- 512 : Sub Macro (512)

A o001

Message

11.2 Macro Editor
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%2 Macro Editor X
% 2| & | " F| a

Add =lete | Check | Import Export | Font

Macro “INITIAL

E- System 0001

ACKGROUND
- CLoCK
El-Screen

- Sub Macro

£ >

Message

Check OK!

There is a toolbar at the top of the editing screen, with five options: add, delete,
Check, Import and export.

Add: Add a component action macro.

Delete: delete a component action macro.

Check: Check the current macro program for errors.

Import: Imported from the project to the currently edited macro program, the
current edited program will be cleared.

Export: Save the currently edited macro program to the project.

The left side of the editing screen provides a tree diagram of the macro
program, which displays all the macro commands. It is convenient to edit and
preview the macro program.

The right side of the editing screen is the main body of the editing program
screen.

At the bottom of the edit screen is the check program information window. It
will be displayed when the check program is executed. When the check finds a
problem, it will be displayed in the window. Double-click the mouse at the
displayed problem, the edit macro program screen will automatically jump To
the corresponding program position.

11.3 Introduction to Macro Syntax

11.3.1 Data format, operator, command list
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Data format setting table

forma 8bit 8bit 16bit 16bit 32bit 32bit 32bit
¢ Bit | Signed [Unsigned| Signed |Unsigned| Signed |Unsigned| Floating
number | number | number | number | number | number point
defini INT16S IN-?;ZS INT32U |FLOAT32
tion BIT | INT8S | INT8U or INT16U SIGNED or or
SIGNED DW DW FLOAT

Set operator column table

Set operator | Explanation
= Setting
Addition
settings
Subtraction
setting
Multiplication
setting
/= Division setting
Integer
Y%= remainder
setting
Left shift
setting
Right shift
setting
Bits and
settings
Mutually
exclusive or set
|= Bit or setting

<<=

>>=

Operator column table
Operation
symbol
+ addition

- Subtraction

* Multiplication

/ Division
Integer
remainder

Explanation

%
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! Logical inverse

~ Bitwise inverse

== equal

I= not equal to

< Less than

Less than or
equal to

> More than

More than or
equal to

Logical or

I or"OR Operations

Logical and

&& or "AND Operations

Bits and

& .
operations

Bit-exclusive
OR operation

Bits or
operations

<< Left shift

>> Right shift

Command list
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instruction

Explanation

LABEL (constant)

Program position label (constant range is
0-65535)

GOT (constant)

Jump to the program position label
unconditionally (constant range is 0-65535)

CALL <Expression>

Call sub macro (sub macro number 1-512)

RET

Return to calling program location

IF <Expression> THEN GOTO LABEL
<constant>

When the variable condition is established (not
equal to 0), jump to the program position label,
otherwise continue to the next line of
instructions.

IF <Expression> THEN DO

When the variable condition is established (not
equal to 0), continue to the next line of
instructions, otherwise jump to the next
judgment (ELIF) or (ELSE DO) to continue to
execute or execute the next line of instructions
of ENDIF.
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ELIF <Expression> THEN DO

When the variable condition is established (not
equal to 0), continue to the next line of
instructions, otherwise jump to the next
judgment (ELIF) or (ELSE DO) to continue to
execute or execute the next line of instructions
of ENDIF.

ELSE DO

In conjunction with the IF or ELIF instruction, it
indicates the position to be executed when the
variable condition is not established (equal to
0).

ENDIF

With the IF or ELIF instruction, it indicates the
position to jump when the variable condition is
not established (equal to 0).

FOR <Expression>

Program loop, using the value of the
expression as a fixed number of cycles, the
program range is the program from FOR to the
corresponding NEXT.

NEXT

In conjunction with the FOR instruction, it
indicates the range of the program loop.

END

End macro program

SETB (Bit variable address)

Set bit variables

CLRB (Bit variable address)

Clear bit variables

INVB (Bit variable address)

Antiphase variable

System internal address variables NO-N65535
NO-N65535 are address variables planned by HMI internally, with a total of

65536 WORDs (16Bits).

When the data format is set to DWORD, the system will automatically
read a WORD after the number, which is defined as the high bit, Hi WORD,
and together with the selected variable low bit, Lo WORD, to form a DWORD.
For example, DWORD NO, then NO is Lo WROD and N1 is Hi WROD, forming

DWORD.

When the data format is WORD, you can directly use the defined variable

name, namely NO-N65535.

When you want to use bit to define the address, you need to add a ".

Symbol after the definition name before bit position 0 ~ 15. For example, the
fifth bit of NO can be written as "N0.5", and the eleventh bit of N100 can be

written as "N100.11".

11.3.2 Instructions

1. LABEL <constant>

Program position label (constant range is 0-65535)
The position of the label can be any line in the program.
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Examples of label macros:
NO =100

#Define label number 10
LABEL 10

N1 =200

GOTO LABEL 10
GOTO LABEL 20

#Define tag number 20
LABEL 20

2. GOTO <constant>
Unconditionally jump to the program location label (constant range is
0-65536)
NO =100
LABEL 10
N1 =200

# Jump to the position of label number 10
GOTO LABLE 10

3. CALL <variable / constant / expression>
Call sub macro (sub macro number 1-512)
The parameters of the call sub-macro instruction can be variables or
constants or expressions
NO =100
#CALL <variable>
CALL NO

#CALL <constant>
CALL N100

#CALL <expression>
CALL 100 + NO
4. RET
Return to the initial position of the call macro
5. IF <variable> THEN GOTO LABEL <constant>
When the variable condition is established (not equal to 0), jump to the
program position label, otherwise continue to the next line of instructions
LABEL 10
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#When the variable (NO + N1) is equal to 200, jump to the position of label
10

IF (NO + N1) == 200 THEN GOTO LABEL 10
6. IF <variable> THEN DO

When the variable condition is established (not equal to 0), continue to the
next line of instructions, otherwise jump to the next judgment (ELIF) or (ELSE
DO) to continue to execute or execute the next line of instructions of ENDIF. IF,
ENDIF support structure up to 16 layers.

#When the variable NO is not equal to 100, execute the instruction of N1 =
1000 on the next line
IF NO!' =100 THEN DO

N1 = 1000
#IF ... THEN DO must be paired with ENDIF
ENDIF

7. ENDIF <variable> THEN DO

When the variable condition is established (not equal to 0), continue to the
next line of instructions, otherwise jump to the next judgment (ELIF) or (ELSE
DO) to continue to execute or execute the next line of instructions in ENDIF.

#When the variable NO is equal to 100, execute the instruction of N1
1000

#When the variable NO is equal to 200, execute the instruction of N1
2000
IF NO!' =100 THEN DO
N1 = 1000

#ELIF must follow the IF THEN DO syntax

ELIF NO == 200 THEN DO

N1 = 2000

ENDIF

8. ENDIF

With the IF or ELIF instruction, it indicates the position to jump when the
variable condition is not established (equal to 0). IF, ENDIF support structure
up to 16 layers.
#When the variable NO is equal to 100, execute the instruction of N1 = 1000
IF NO!' =100 THEN DO
N1 =1000

#IF ... THEN DO must be paired with ENDIF

ENDIF
9. FOR <variable>

Program loop, the loop takes the value of the variable as a fixed number,
and the program range is from FOR to the program corresponding to NEXT.
FOR, NEXT support structure up to 16 layers.
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#Calculate the total number of 1 to 10 in the NO variable
NO=0
N1 =1
FOR 10
NO + = N1
N1+=1
NEXT
10. NEXT
With the FOR instruction, it indicates the range of the program loop. FOR,
NEXT support structure up to 16 layers.
#Calculate the total number of 1 to 10 in the NO variable
NO=0
N1 =1
FOR 50
NO + = N1
N1+=1
NEXT
11.END
End macro program
12. SETB <Bit Variable Position>
Set bit variables
#Set the fifth bit of N100 variable to 1
SETB N100.5
13. CLRB <Bit Variable Position>
Clear bit variables
#Set the 12th bit of the N10 variable to 0
CLRB N10.12
14. INVB <Bit Variable Position>
Antiphase variable
#Reverse the 15th position of the N1 variable (0 becomes 1, 1 becomes 0)
INVB N1.15

11.4 Introduction to Macro Operator Syntax

In View Macro, in addition to instruction usage, there are two important
syntaxes: operator syntax and set operator syntax.

11.4.1 Operator syntax
Provide mathematical operations or logical operations between
variables. These operation symbols are called operands. The currently
available operators are listed in the table Macro Operators, there are 20
operations in total. The expression is mainly used to set the expression syntax
and the in-command syntax.
Use Cases:
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Pure expression
(NO+N1)/2
(NO + 100)

Collocation operator
NO = (N1 << 2)
NO+=(N1+2)/2

Collocation instruction

IF (NO == 100) && (N1 == 200) THEN GOTO LABEL 10
ENDIF

CALL (NO+100)

11.4.2 Set operator syntax

The setting operator syntax is the most important syntax for setting the value of
variables in macro commands. This setting symbol is called the setting
operator. There are currently 11 kinds of setting operators.

Use Cases:

NO =100

NO =(N1+N2)/2

NO + =100

NO * =

NO << =2

11.4.3 Data format setting of variable data

Variable information: The only variables that can be used in the macros
currently provided are system variables. The default data format of the system
variable is 16-bit symbol number. If you need other format operations, you
must add the data format setting. The data format setting is to add
parentheses before the variable and fill in the data format definition in the
bracket .

Case:

#Indicates the use of 32-bit signed number operation, the data position is in NO
(INT32S) NO

11.4.4 Setting the data format setting for calculation

Setting operation: When the set variable needs to set the data format, the end
of the variable command line must be set with parentheses, and the data
format definition is filled in the parentheses. For example, NO = (INT32S) N100
(INT32S) means that the 32-bit signed number N100 is used for calculation,
and the value of the N100 is set to the 32-bit signed number NO.

Case:

#Bit address and settings

NO.3 = (BIT) N10.4 && (BIT) N10.5 (BIT)

#If the variable data format of the same line is the same, you can only set the
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data format of [Set Calculation]
NO.3 =N10.4 && N10.5 (BIT)

# 32 bit signed number operation
NO = N2 + N4 (INT32S)

NO = N2 + N4 (SIGNED DW)

# 32-bit floating point arithmetic
NO = N2 + N4 (FLOAT)
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Chapter 12 Macro Function
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12.1 Introduction to calculation functions and syntax

12.1.1 Function column table

Fun. . Return |Paramet Para
Fun. function meter
Name value er1 2
| PI Returns 1 floating point value ;LOAT?)
BCD Convert BIN values to BCD INT32U  INT32U
B format
BIN Convert BCD value to BIN INT32U [INT32U
— format value
| SQRT |Square root floating point value;LOAT3 ELOAT3
Natural logarithmic floating FLOAT3 |[FLOAT3
 LOG )
point value 2 2
| LOG10 |Base 10 log floating point value;LOATs ;LOAT?)
RADIAN Conyert degrees to radian FLOAT3 |[FLOAT3
B floating point values 2 2
| DEGRE |Convert radians to degrees FLOAT3 |[FLOAT3
E floating point 2 2
trigonometric function sine FLOAT3 |[FLOAT3
SIN . .
B value floating point value 2 2
Trigonometric function cosine |[FLOAT3 |[FLOAT3
| COS : :
value floating point value 2 2
Trigonometric function tangent [FLOAT3 |[FLOAT3
TAN . .
B floating point value 2 2
Trigonometric function arc sine FLOAT3 [FLOAT3
ASIN : .
B value floating point value 2 2
Trigonometric function inverse |[FLOAT3 [FLOAT3
ACOS : . .
B cosine floating point value 2 2
Trigonometric function arc FLOAT3 |[FLOAT3
ATAN . .
B tangent floating point value 2 2
| ABS Absolute floating point value ;LOAT?) ;LOAT?)
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12.1.2 Introduction to Function Syntax
1. Floating-point constant
Directly set floating point constants to variables
NO = 1.2345 (FLOAT32)
2. BCD
Convert BIN values to BCD format
Function syntax: INT32U _BCD (INT32U)
Input data format: INT32U 32-bit unsigned value
Return data format: INT32U 32-bit unsigned value
Example: N2 = _BCD (NO) (INT32U)
3._BIN
Convert BCD value to BIN format value
Function syntax: INT32U _BIN (INT32U)
Input data format: INT32U 32-bit unsigned value
Return data format: INT32U 32-bit unsigned value
Example: N4 = _BIN (N2) (INT32U)
4. _SQRT
Calculate the square root floating point value
Function syntax: FLOAT32 SQRT (FLOAT32)
Input data format: FLOAT32 floating point value
Return data format: FLOAT32 square root floating point value
Example: NO = _SQRT (1.15129) (FLOAT32) # 1.5129 = 1.23 * 1.23
5. LOG
Calculate natural logarithmic floating point values
Function syntax: FLOAT32 LOG (FLOAT32)
Input data format: FLOAT32 floating point value
Return data format: FLOAT32 natural logarithmic floating point value
Example: NO = _LOG (N2) (FLOAT32)
6. _LOG10
Calculate a logarithmic floating point value with base 10
Function syntax: FLOAT32 LOG10 (FLOAT32)
Input data format: FLOAT32 floating point value
Return data format: FLOAT32 base 10 logarithmic floating point value
Example: NO = _LOG10 (N2) (FLOAT32)
7. _RADIAN
Convert degrees to radian floating point values
Function syntax: FLOAT32 _RADIAN (FLOAT32)
Input data format: FLOAT32 degree floating point value
Return data format: FLOAT32 radian floating point value
Example: NO = _RADIAN (N2) (FLOAT32)
8. DEGREE
Convert radians to degrees floating point
Function syntax: FLOAT32 _DEGREE (FLOAT32)
Input data format: FLOAT32 radian floating point value
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Return data format: FLOAT32 degree floating point value
Example: NO = _DEGREE (N2) (FLOAT32)
9, _SIN
Calculate trigonometric function sine value floating point value
Function syntax: FLOAT32 _SIN (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 sine floating point value
Example: NO = _SIN (N2) (FLOAT32)
10._COS
Calculate trigonometric function cosine floating point value
Function syntax: FLOAT32 _COS (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 Cosine floating point value
Example: NO = _COS (N2) (FLOAT32)
11, _TAN
Calculate trigonometric function tangent floating point value
Function syntax: FLOAT32 _TAN (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 tangent floating point value
Example: NO = _TAN (N2) (FLOAT32)
12, _ASIN
Calculates the trigonometric function arc sine value floating point value
Function syntax: FLOAT32 _ASIN (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 arc sine floating point value
Example: NO = _ASIN (N2) (FLOAT32)
13, _ACOS

Calculate trigonometric function inverse cosine value floating point value

Function syntax: FLOAT32 _ACOS (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 arc cosine floating point value
Example: NO = _ACOS (N2) (FLOAT32)

14. ATAN

Calculate trigonometric function arc tangent floating point value
Function syntax: FLOAT32 _SIN (FLOAT32)
Input data format: FLOAT32 radian floating point value
Return data format: FLOAT32 arc tangent floating point value
Example: NO = _ATAN (N2) (FLOAT32)

15, ABS

Calculate absolute value floating point value
Function syntax: FLOAT32 _ABS (FLOAT32)
Input data format: FLOAT32 input calculation floating point value
Return data format: FLOAT32 absolute value floating point value
Example: NO = _ABS (-1.23) (FLOAT32)
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16, PI
Returns 1 floating point value
Function syntax: FLOAT32 Pl ()
Input data format: none
Return data format: FLOAT32 returns 1t floating point value
Example: NO = _PI () (FLOAT32)
Macro option register
N65152.0 (bit 0)
0 = When the controller variable is set, modify the value through
communication.
1 = When the controller variable is set, directly modify the HMI memory data
and modify the value through communication.

12.2 Introduction to register related functions and syntax

12.2.1 List of register functions
Fun. Name |Function
| MEMCPY |Memory copy
| MEMCMP |Memory comparison
| MEMSET |Memory settings
| REGCPY |Variable area copy
| REGCMP |Variable area comparison
| REGSET |Variable locale
MWORD2 |Convert multiple word data to

BYTE multiple bytes
| MBYTE2W |Convert multiple bytes of data to
ORD multiple words

Read the data in the bank memory
area after power off

Write data to keep Bank memory
area after power off

| RBREAD

| RBWRITE

12.2.2 Introduction to Function Syntax

1. MEMCPY

Memory copy: copy data from variable memory area to another variable
memory area

INT32S _MEMCPY (INT32S destRegNum, INT32S srcRegNum, INT32S len)
The use range of destRegNum is 0 ~ 64511

The use range of srcRegNum is 0 ~ 64511

len use range is 1 ~ 256

The returned value indicates the number of bits copied. 0 means the memory
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range is wrong; 1 ~ 256 means the number of copied bits.
Example 1:

N100 = _MEMCPY (200, 250, 10)

It means that 10 BYTEs starting from the N250 variable (that is, 5
variables N250-N254) are copied into N200-N204, and the number of copy bits
(BYTE) 10 is placed in N100.

Example 2:

N100 = 1000

N101 = 1500

N102 = 20

N500 = _MEMCPY (100, 101, 102)

It means that the 20 BYTEs starting from the N1500 variable (that is, the
10 variables N1500-N1509) are copied into the N1000-N1009, and the number
of copied bits (BYTE) 20 is placed in the N500.
related functions

_MEMCMP, _MEMSET, _REGCPY, REGCMP, REGSET

2. _MEMCMP
Memory comparison: compare the same number of bits (BYTE) in the memory
area of 2 variables
INT32S _MEMCMP (INT32S destRegNum, INT32S srcRegNum, INT32S len)
The use range of destRegNum is 0 ~ 65535
The use range of srcRegNum is 0 ~ 65535
len use range is 1 ~ 256
The returned value indicates the comparison result. -1 means that the memory
range is wrong; 0 means the variable content is the same; 1 means the
variable content is different.
example:

N100 = _MEMCMP (1000, 2000, 10)

Compare whether the variable values of N1000-N1004 and
N2000-N2004 are the same.
related functions

_MEMCPY, MEMSET, REGCPY, _REGCMP, REGSET

3. MEMSET
Memory setting: set all elements in a variable memory area to a specific value
INT32S _MEMSET (INT32U regNum, INT32S value, INT32S len)
regNum use range is 0 ~ 64511
len use range is 1 ~ 256
The returned value indicates the set number of bits. 0 means the memory
range is wrong; 1 ~ 256 means the set number of bits.
example:
N100 = _MEMSET (1000, 55H, 10)
Set the value of N1000-N1004 to 5555H. (The default setting is 8 bits),
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and the N variable is 16 bits.)
related functions
_MEMCPY, MEMCMP, REGCPY, REGCMP, REGSET

4. REGCPY
Variable area copy: copy data from the variable memory area to another
variable memory area
INT32S _REGCPY/(INT32S destRegNum, INT32S srcRegNum, INT32S
len)
The use range of destRegNum is 0 ~ 64511
The use range of srcRegNum is 0 ~ 64511
1en use range is 1 ~ 256
The returned value indicates the number of variables copied. 0 means
that the memory range is wrong; 1 ~ 256 means the number of copied
variables.
Example 1:
N100 = _REGCPY (200, 250, 10)
Copy the value of the N250-259 variable into the N200-N209 variable.
Example 2:
N100 = 1000
N101 = 1500
N102 = 20
N500 = _REGCPY (100, 101, 102)
Copy the N1500-N1519 variables to the N1000-N1019 variables.
Related functions
_MEMCPY, MEMCMP, _MEMSET, REGCMP, REGSET

5. REGCMP
Variable area comparison: compares a certain number of variables (16Bits) in
two variable memory areas
INT32S REGCMP (INT32S destRegNum, INT32S srcRegNum, INT32S len)
The use range of destRegNum is 0 ~ 65535
The use range of srcRegNum is 0 ~ 65535
len use range is 1 ~ 256
The returned value indicates the comparison result. -1 means that the memory
range is wrong; 0 means the variable content is the same; 1 means the
variable content is different.
example:

N100 = _REGCMP (1000, 2000, 10)

Compare whether the variable values of N1000-N1009 and
N2000-N2009 are the same.
related functions

_MEMCPY, MEMCMP, _MEMSET, REGCPY, REGSET
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6. REGSET
Variable area setting: Set all variables in a variable memory area to a certain
value
INT32S _REGSET (INT32U regNum, INT32S value, INT32S len)
regNum use range is 0 ~ 64511
len use range is 1 ~ 256
The returned value indicates the set number of bits. 0 means the memory
range is wrong; 1 ~ 256 means the set number of bits.
example:
N100 = _REGSET (1000, 1234, 10)
Set the value of N1000-N1009 to 1234.
related functions
_MEMCPY, MEMCMP, _MEMSET, _REGCPY, REGCMP

7. MWORD2BYTE
Convert multiple word data to multiple bytes: The return value indicates the
number of conversions
INT32U _MWORD2BYTE (INT32S destByteRegNum, INT32S
srcWordRegNum, INT32S len)
The use range of destByteRegNum is 0 ~ 64511
The use range of srcWordRegNum is 0 ~ 64511
len use range is 1 ~ 256
The returned value indicates the number of conversions. 0 means the
memory range is wrong; 1 ~ 256 means the number of conversions.
example:
_STRW (N200, "ABCD")
_MWORD2BYTE (100, 200, 4)
Results of the
N100 = 4241H
N101 = 4443H
N200 = 0041H
N201 = 0042H
N202 = 0043H
N203 = 0044H
related functions
_MBYTE2WORD

8. _MBYTE2WORD

Conversion of multiple bytes of data to multiple words: the return value
indicates the number of conversions

INT32U _ MBYTE2WORD  (INT32S  destWordRegNum, INT32S
srcByteRegNum, INT32S len)

destWordRegNum is used in the range of 0 ~ 64511
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The use range of srcByteRegNum is 0 ~ 64511
len use range is 1 ~ 256
The returned value indicates the number of conversions. 0 means the
memory range is wrong; 1 ~ 256 means the number of conversions.
example:
_STRW (N200, "ABCD")
_MBYTE2WORD (100, 200, 4)
Results of the

N100 = 0041H

N101 = 0042H

N102 = 0043H

N103 = 0044H

N200 = 4241H

N201 = 4443H
related functions

_MWORD2BYTE

9, RBREAD

Read the data in the bank memory area after power off: the return value
indicates the number of registers read
INT32S _RBREAD (INT32S bank, INT32S destRegNum, INT32S scrAddr,
INT32S cnt)
Bank usage range is 0 ~ 6 (currently only open 0: Bank0)
destRegNum the number of the destination register location for reading data
scrAddr read the number of the bank's source location
cnt can be used in the range 1 ~ 8192
When the returned value is 0O: it means that the variable range is wrong
or the operating model does not provide the power-off retentive bank memory;
other values read represent the number of registers read.
Note: This macro function is only supported for models that provide bank
memory to keep power off.
example:
N100 = _RBREAD (0, 1000, 3000, 100)
Results of the
N100 =100
N1000 ~ N1099 = RBank.3000 ~ RBank.3099
related functions
_RBWRITE

10. _RBWRITE

Write the data in the bank memory area when power off: the return value
indicates the number of registers written

INT32S _RBWRITE (INT32S bank, INT32S scrRegNum, INT32S destAddr,
INT32S cnt)
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Bank usage range is 0 ~ 6 (currently only open 0: Bank0)
ScrRegNum data source register location number
destAddr writes the number of the destination location in the Bank
cnt can be used in the range 1 ~ 8192
When the returned value is O: it means that the variable range is wrong or
the running model does not provide the power-off retentive bank memory;
other values read represent the number of registers written.
Note: This macro function is only supported for models that provide bank
memory to keep power off.
Example:
N100 = _RBWRITE (0, 1000, 3000, 100)
Results of the
N100 =100
RBank.3000 ~ RBank.3099 = N1000 ~ N1099
related functions
_RBREAD

12.3 Introduction to string related functions and syntax

12.3.1 List of string functions

Name Function

STR Set ASCII (bit) string to variable
B memory
| STRW Set Unicode (word) character

string to variable memory

Returns the ASCII (bit) string

| STRLEN | th

Returns the length of the Unicode

| STRWLEN (word) string

Convert decimal string to numeric

STR2DEC
— value

Convert hexadecimal string to

STR2HEX .
— numeric value

Convert binary string to numeric

STR2BIN
— value

DECSTR anvert numeric value to decimal
— string
| HEXSTR Convert numeric value to

hexadecimal string

Convert numeric value to binary
string
12.3.2 Introduction to String Function Syntax

| BINSTR
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1._STR
Set ASCII (bit) character string to variable memory: Write ASCII (8 Bits)
character string to variable memory area
INT32S _STR (REG reg, STRING str)
Reg can be used from NO to N64511
Stris an ASCII string, the string length is 1 ~ 256

The return value indicates the length of the bit, 0 indicates that the
memory range is wrong; 1 ~ 256 indicates the length of the set bit.
In addition to the general text in the string format, you can also use the "\"
escape symbol to add non-string text

SHET Character value
symbol

22H=34

\' 27H=39

\" 22H=34

\? 3FH=63

\\ 5CH=92

\r ODH=13

\n 0AH=10

\000~\777 |Octal code character

\x00~\xFF |Hexadecimal code character

example:
N100 = _STR (N1000, "ABCD")
Results of the
N100 =5
N1000 = 4241H // 'BA
N1001 =4443H //'CD’
N1002 = 0000H // End of string
related functions
_STRW

2. STRW
Set Unicode (word) character string to variable memory: write Unicode (16Bits)
character string to variable memory area
INT32S _STRW (INT32U regNum, STRING str)
regNum can be used in the range of 0 ~ 64511
Stris a Unicode string, the string length is 1 ~ 256

The return value indicates the length of the bit, O indicates that the
memory range is wrong; 1 ~ 256 indicates the length of the set bit.
note:

When the string uses Unicode encoding, when the HMI displays the
string, the internal encoding is only the lower 7 bits (0-127 English font) the
same as Unicode, so when the Unicode encoding exceeds 127 in the string,
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the HMI will display incorrect or unable display.
example:
N100 = _STRW (N1000, "ABCD")
Results of the
N100 =10
N1000 = 0041H //’A
N1001 = 0042H //'B’
N1002 = 0043H //’C’
N1003 = 0044H //'D’
N1004 = 0000H // End of string
related functions
_STR, _STRLEN, _STRWLEN

3. _STRLEN
Returns the length of the ASCII (bit) string: the return value represents the
length of the ASCII string
INT32U _STRLEN (INT32S regNum)
regNum can be used in the range 0 ~ 64383
The return value indicates the length of the character string. 0 indicates that
the variable range is incorrect or the length exceeds 256 or the length of the
character string is O;
example:
_STR (N200, "ABCD")
N100 = _STRLEN (200)
Results of the
N100 =4
N200 = 4241H
N201 = 4443H
related functions
_STR, _STRW, _STRWLEN

4. STRWLEN
Returns the length of the Unicode (word) string: the return value represents the
length of the Unicode string
INT32U _STRWLEN (INT32S regNum)
regNum can use the range 0 ~ 64255
The return value indicates the length of the string, 0 indicates that the variable
range is wrong or the length exceeds 256 or the string length is 0; 1 ~ 256
indicates the length of the string.
example:
_STRW (N200, "ABCD")
N100 = _STRWLEN (200)
Results of the
N100 =4
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N200 = 0041H

N201 = 0042H

N202 = 0043H

N203 = 0044H

related functions

_STR, STRW, STRLEN

5. STR2DEC
Convert a decimal string to a numeric value: The return value represents the
converted numeric value
INT32S _STR2DEC (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65535
cnt can use the range 1 ~ 256 (when the value range is exceeded, an overflow
error will occur, resulting in an incorrect value)
Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted value.
Example 1:
_STRW (N100, "12345")
N200 = _STRWLEN (100)
N500 = _STR2DEC (100, N200)
Results of the
N100 = 0031H
N101 = 0032H
N102 = 0033H
N103 = 0034H
N104 = 0035H
N200 =5
N500 = 12345
Example 2:
_STRW (N100, "1234567")
N200 = _STRWLEN (100)
N500 = _STR2DEC (100, N200) (DW)
Results of the
N100 = 0031H
N101 = 0032H
N102 = 0033H
N103 = 0034H
N104 = 0035H
N105 = 0036H
N106 = 0037H
N200 =7
N500 =-10617
N501 =18
Double word N500 = 1234567
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related functions
_STR2HEX, STR2BIN

6. STR2HEX

Convert hexadecimal string to numeric value: The return value represents the
converted numeric value

INT32S _STR2HEX (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65535

Cnt can use the range 1 ~ 256 (when the conversion exceeds the value range,
an overflow error will occur, resulting in an incorrect value)
Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted value.

Example 1:

_STRW (N100, "55AA")

N200 = _STRWLEN (100)

N500 = _STR2HEX (100, N200)

Results of the

N100 = 0035H

N101 = 0035H

N102 = 0041H

N103 = 0041H

N200 = 4

N500 = 55AAH

Example 2:

_STRW (N100, "1234567")

N200 = _STRWLEN (100)

N500 = _STR2HEX (100, 2)

Results of the

N100 = 0031H

N101 = 0032H

N102 = 0033H

N103 = 0034H

N104 = 0035H

N105 = 0036H

N106 = 0037H

N200 =7

N500 = 0012H

related functions

_STR2DEC, _STR2BIN

7, _STR2BIN

Convert a binary string to a numeric value: The return value represents the
converted numeric value

INT32S _STR2BIN (INT32S regNum, INT32S cnt)
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regNum can be used in the range 0 ~ 65535

Cnt can use the range 1 ~ 256 (when the conversion exceeds the value range,
an overflow error will occur, resulting in an incorrect value)
Binary strings can use ‘H’ or ‘1’ to represent the value of 1
Binary strings can use ‘L’ or ‘0’ to represent the value of 0
Binary strings can use '’ or’_’ to delimit

Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted value.

Example 1:

_STRW (N100, "10100000_00000001")

N200 = _STRWLEN (100)

N500 = _STR2BIN (100, N200)

Results of the

N100 ~ N116 = "10100000_00000001"

N200 =17

N500 = AO01H

Example 2:

_STRW (N100, "HLHL: LHLH: HHHH: LLLL")

N200 = _STRWLEN (100)

N500 = _STR2BIN (100, N200)

Results of the

N100 ~ N118 = "HLHL: LHLH: HHHH: LLLL"

N200 =19

N500 = A5FOH

related functions

_STR2DEC, _STR2HEX

8. DECSTR

Convert the numeric value to a decimal string: The return value indicates the
length of the converted string

INT32S _DECSTR (INT32S destRegNum, INT32S data, INT32S format)
destregNum can use the range 0 ~ 64255

data The converted value entered

Format converts the value format

0: 8-bit signed number

1: 8-bit unsigned number

2: 16-bit signed number

3: 16-bit unsigned number

4: 32-bit signed number

5: 32-bit unsigned number

Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted string length.

Example 1:

N200 = _DECSTR (100, 12345, 2)
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Results of the

N100 ~ N104 ="12345"

N200 =5

Example 2:

N200 = DECSTR (100, -12345, 2)
Results of the

N100 ~ N104 = "-12345”

N200 =6

related functions

_HEXSTR, BINSTR

9. HEXSTR

Convert the numeric value to a hexadecimal string: The return value indicates
the length of the converted string

INT32S _HEXSTR (INT32S destRegNum, INT32S data, INT32S format)
destregNum can use the range 0 ~ 64255

data The converted value entered

Format converts the value format

0: 8-bit unsigned number, convert string lowercase 0-9, a-f

1: 8-bit unsigned number, converted string uppercase 0-9, A-F

2: 16-bit unsigned number, conversion string lowercase 0-9, a-f

3: 16-bit unsigned number, converted string uppercase 0-9, A-F

4: 32-bit unsigned number, conversion string lowercase 0-9, a-f

5: 32-bit unsigned number, converted string uppercase 0-9, A-F

Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted string length.

Example 1:

N200 = _HEXSTR (100, 0AA55H, 2)

Results of the

N100 ~ N103 = "aa55”

N200 = 4

Example 2:

N200 = _HEXSTR (100, 55AAFFO0H, 5)

Results of the

N100 ~ N107 = "55AAFF00"

N200 =8

related functions

_DECSTR, _BINSTR

10._BINSTR

Convert the numeric value to a binary string: the return value indicates the
length of the converted string

INT32S _BINSTR (INT32S destRegNum, INT32S data, INT32S format)
destregNum can use the range 0 ~ 64255
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data The converted value entered

Format converts the value format

0: 8-bit unsigned number, convert string 0, 1

1: 8-bit unsigned number, convert character string H, L
2: 16-bit unsigned number, conversion string 0, 1

3: 16-bit unsigned number, convert string H, L

4: 32-bit unsigned number, conversion string 0, 1

5: 32-bit unsigned number, convert character string H, L
Areturn value of 0 indicates that the variable range is incorrect or the value is 0;
other values indicate the converted string length.
Example 1:

N200 = BINSTR (100, 0AA55H, 2)

Results of the

N100 ~N115="1010101001010101"

N200 = 16

Example 2:

N200 = BINSTR (100, 55AAFFO00H, 5)

Results of the

N100 ~N131 = "LHLHLHLHHLHLHLHLHHHHHHHHLLLLLLLL"
N200 = 32

related functions

_DECSTR, HEXSTR

12.4 Introduction to Mathematical Calculation Related

Functions and Grammar

12.4.1 A column table of mathematical calculation related functions

Name Function
MIN Take the minimum of multiple
B 16-bit signed numbers
MAX Takg thg maximum of multiple
— 16-bit signed numbers
Take the average of multiple 16-bit
AVE :
— signed numbers
MIND Takg thg minimum of multiple
— 32-bit signed numbers
Take the maximum of multiple
| MAXD 32-bit signed numbers
AVED T.ake the average of multiple 32-bit
B signed numbers
| MINF Take the minimum value of
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multiple 32-bit floating point
numbers

Take the maximum value of
| MAXF multiple 32-bit floating point
numbers

Take the average of multiple 32-bit

| AVEF floating point numbers

12.4.2 Introduction to Mathematical Calculation Related Function Syntax
1. _MIN
Take the minimum value of multiple 16-bit signed numbers: the return value
indicates the minimum value of the multiple data
INT32S _MIN (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65535
Cnt can use the range 1 ~ 256
The return value of 0 means that the variable range is wrong or the

minimum value is 0; other values are the minimum value returned.
example:

N100 = 156

N101 = 6578

N102 = -578

N103 = 4568

N200 = _MIN (100, 4)
Results of the

N200 = -578

related functions
_MAX, AVE

2. MAX
Take the maximum value of multiple 16-bit signed numbers: the return value
indicates the maximum value of the multiple data
INT32S _MAX (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65535
Cnt can use the range 1 ~ 256
A return value of 0 means that the variable range is wrong or the

maximum value is 0; other values are the maximum value returned.
example:

N100 = 156

N101 = 6578

N102 =-578

N103 = 4568

N200 = _MAX (100, 4)
Results of the
N200 = 6578
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related functions
_MIN, AVE

3. _AVE
Take the average of multiple 16-bit signed numbers: the return value
represents the average of the multiple data
INT32S _AVE (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65535
Cnt can use the range 1 ~ 256
A return value of 0 means that the variable range is wrong or the

maximum value is 0; other values are the maximum value returned.
example:

N100 = 156

N101 = 6578

N102 =-578

N103 = 4568

N200 = _AVE (100, 4)
Results of the

N200 = 2681

related functions
_MIN, MAX

4. MIND
Take the minimum value of multiple 32-bit signed numbers: the return value
represents the minimum value of the multiple data
INT32S _MIND (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65534
Cnt can use therange 1 ~ 128
The return value of 0 means that the variable range is wrong or the
minimum value is 0; other values are the minimum value returned.
example:
N100 = 1564 (DW)
N102 = 6573458 (DW)
N104 = -574358 (DW)
N106 = 4568 (DW)
N200 = _MIND (100, 4) (DW)
Results of the
N200 = -574358
related functions
_MAXD, _AVED

5. MAXD

Take the maximum value of multiple 32-bit signed numbers: the return value
indicates the maximum value of the multiple data
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INT32S _MAXD (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65534
Cnt can use therange 1 ~ 128
A return value of 0 means that the variable range is wrong or the
maximum value is 0; other values are the maximum value returned.
example:
N100 = 1564 (DW)
N102 = 6573458 (DW)
N104 = -574358 (DW)
N106 = 4568 (DW)
N200 = _MAXD (100, 4) (DW)
Results of the
Double word N200 = 6573458
related functions
_MIND, _AVED

6. AVED

Take the average of multiple 32-bit signed numbers: the return value
represents the average of the multiple data

INT32S _AVED (INT32S regNum, INT32S cnt)

regNum can be used in the range 0 ~ 65534

Cnt can use therange 1 ~ 128

The 32-bit signed number is used to calculate the average value. Please pay
attention to whether the total value overflows.

A return value of 0.0 means that the variable range is wrong or the
maximum value is 0.0; other values are the maximum value returned.
example:

N100 = 1564 (DW)

N102 = 6573458 (DW)

N104 = -574358 (DW)

N106 = 4568 (DW)

N200 = _AVED (100, 4) (DW)
Results of the

Double word N200 = 151308
related functions

_MIND, _MAXD

7. _MINF

Take the minimum value of multiple 32-bit floating point numbers: the return
value represents the minimum value of the multiple data

INT32S _MINF (INT32S regNum, INT32S cnt)

regNum can be used in the range 0 ~ 65534

Cnt can use therange 1 ~ 128
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The return value of 0 means that the variable range is wrong or the
minimum value is 0; other values are the minimum value returned.
example:

N100 = 15.64 (FLOAT)

N102 = 6573.458 (FLOAT)
N104 = -5743.58 (FLOAT)

N106 = 45.68 (FLOAT)

N200 = _MINF (100, 4) (FLOAT)
Results of the

Floating point N200 = -5743.58
related functions

_MAXF, _AVEF

8. MAXF
Take the maximum value of multiple 32-bit floating point numbers: the return
value indicates the maximum value of the multiple data
INT32S _MAXF (INT32S regNum, INT32S cnt)
regNum can be used in the range 0 ~ 65534
Cnt can use therange 1 ~ 128
A return value of 0.0 means that the variable range is wrong or the
maximum value is 0.0; other values are the maximum value returned.
example:
N100 = 15.64 (FLOAT)
N102 = 6573.458 (FLOAT)
N104 = -5743.58 (FLOAT)
N106 = 45.68 (FLOAT)
N200 = _MAXF (100, 4) (FLOAT)
Results of the
Floating point number N200 = 6573.458
related functions
_MINF, _AVEF

9, AVEF

Take the average of multiple 32-bit floating point numbers: the return value
represents the average of the multiple data

INT32S _AVEF (INT32S regNum, INT32S cnt)

regNum can be used in the range 0 ~ 65534

Cnt can use therange 1 ~ 128

The 32-bit signed number is used to calculate the average value. Please pay
attention to whether the total value overflows.

A return value of 0.0 means that the variable range is wrong or the
maximum value is 0.0; other values are the maximum value returned.
example:

N100 = 15.64 (DW)
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N102 = 6573.458 (DW)

N104 = -5743.58 (DW)

N106 = 45.68 (DW)

N200 = AVEF (100, 4) (DW)
Results of the

Floating point number N200 = 222.8
related functions

_MINF, _MAXF

12.5 Introduction to Time-Related Functions and Syntax

12.5.1 A column of time-related functions

Name Function

| TICK Get the current time tick value

| TICK2TIM [Time tick value conversion to date
E and time data

TIME2TIC |Conversion of date and time data
to time tick value

P

12.5.2 Introduction to Time-Related Function Syntax

1._TICK

Get the current time tick value: The return value indicates the current time tick
value

INT32U _TICK ()

Parameter: None

example:

N100 = _TICK () (DW)

N102 = N65448 (DW) // (DW) N65448 has the same function as _TICK
Results of the

Double word group N100 = 1287635383 // The value varies with time
Double word N102 = 1287635383

related functions

_TICK2TIME, _TIME2TICK

2. TICK2TIME

Time tick value conversion to date and time data: the return value indicates
whether the conversion is successful

INT32U _TICK2TIME (INT32S destRegNum, INT32U tick)

The range of destRegNum that can be used is 0 ~ 64255. 7 data registers are
required to convert data

Tick value entered by tick

The return value 0O indicates that the variable range is incorrect or the
conversion fails, and 1 indicates that the conversion is successful.
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Conversion register data configuration

:sec [0 ~ 59]

:min [0 ~ 59]

: hour [0 ~ 23]

:day [1 ~31]

:month [1 ~12]

: year [1970 ~ 2069]

: week [0 ~ 6]

example:

N100 = _TICK () (INT32U)

_TICK2TIME (200, (INT32U) N100)

Results of the

Double word group N100 = 1277639390 // The value varies with time
N200 = 30 // 30 seconds

N201 = 36 // 36 minutes

N202 =5// 5 hours

N203 = 21 // 21st

N204 = 10 // October

N205 =2010// 2010

N206 = 4 // Thursday

related functions

_TICK, _TIME2TICK

3. _TIME2TICK

Date and time data is converted to time tick value: the return value indicates
the time tick value

INT32S _TIME2TICK (INT32S destRegNum)
The range of destRegNum that can be used is 0 ~ 64255. 7 data registers are
required to convert data

The return value of 0 means that the variable range is wrong or the conversion
fails, and the other values are time tick values.
Conversion register data configuration

:sec [0 ~ 59]

:min [0 ~ 59]

: hour [0 ~ 23]

:day [1 ~ 31]

: month [1 ~12]

: year [1970 ~ 2069]

- week [0 ~ 6]

example:

N200 = 30 // 30 seconds

N201 = 36 // 36 seconds

N202 =5// 5 hours

N203 = 21 // 21st

N204 = 10 // October

OO0k WN -0

OO0k WN -0
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N205 = 2010 // 2010

N206 = 4 // Thursday

N100 = _TIME2TICK (200) (INT32U)

Results of the

Double word group N100 = 1287639390 // The value varies with time
related functions

_TICK, _TIMCK2TIME

12.6 Introduction to Functions and Syntax of Data Conversion

12.6.1 List of register functions

Name Function
HIBYTE Variables take high-order
B metadata

| LOBYTE |Variables take low-order metadata
| HHWORD |Variable takes high byte data
| LOWORD |Variables take low byte data
SWAPBYT |Variable high and low bit metadata

E exchange
| SWAPWO |Variable high and low byte data
RD exchange

| BIN2GRAY |Convert binary data to Gray code
Gray code conversion into binary
data

| MAKEWO [Two bits of data combined into
RD one word

| GRAY2BIN

| MAKEDW [Two words combined into one
ORD double word

12.6.2 Introduction to Function Syntax
1._HIBYTE
Variables take high-order metadata: the return value is the high-order
metadata of the input value
INT32U _HIBYTE (INT32U data)
example:
N100 = _HIBYTE (1234H)
Results of the
N100 = 0012H
related functions
_LOBYTE, HIWORD, LOWORD, MAKEWORD, MAKEDWORD

2._LOBYTE
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The variable takes the low-order metadata: the return value is the low-order
metadata of the input value
INT32U LOBYTE (INT32U data)
example:
N100 = LOBYTE (1234H)
Results of the
N100 = 0034H
related functions
_HIBYTE, HIWORD, LOWORD, MAKEWORD, MAKEDWORD

3. _HIWORD
Variable takes high byte data: the return value is the high byte data of the input
value
INT32U _HIWORD (INT32U data)
example:
N100 = _HIWORD (12345678H)
Results of the
N100 = 1234H
related functions
_HIBYTE, LOBYTE, _LOWORD, MAKEWORD, _MAKEDWORD

4. LOWORD
Variables take low byte data: the return value is the low byte data of the input
value
INT32U _LOWORD (INT32U data)
example:
N100 = _LOWORD (12345678H)
Results of the
N100 = 5678H
related functions
_HIBYTE, _LOBYTE, _HIWORD, MAKEWORD, MAKEDWORD

5. SWAPBYTE
Variable high and low bit data exchange: the return value is the data after the
exchange of high and low bits of the input value
INT32U _SWAPBYTE (INT32U data)
example:
N100 = _SWAPBYTE (1234H)

Results of the
N100 = 3412H
related functions

_HIBYTE, LOBYTE, HIWORD, LOWORD, MAKEWORD,
_MAKEDWORD, _SWAPWORD
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6. _SWAPWORD
Variable high and low byte data exchange: the return value is the data after
the exchange of high and low bytes of the input value
INT32U _SWAPWORD (INT32U data)
example:
N100 = _SWAPWORD (12345678H)
Results of the
N100 = 1234H
N101 = 5678H
related functions
_HIBYTE, LOBYTE, HIWORD, LOWORD, MAKEWORD,
_MAKEDWORD, _SWAPBYTE

7, _BIN2GRAY
Convert binary data to Gray code: return the binary data whose input value
is converted to Gray code
INT32U _BIN2GRAY (INT32U data)
example:
N100 = _BIN2GRAY (55555555H) (DW)
Results of the
N100 = FFFH
N101 = 7FFH
related functions
_GRAY2BIN

8. GRAY2BIN
Gray code conversion to binary data: Gray code data whose return value is
input value is converted to binary data
INT32U _GRAY2BIN (INT32U data)
example:
N100 = _GRAY2BIN (7FFFFFFH) (DW)
Results of the
N100 = 5555H
N101 = 5555H
related functions
_BIN2GRAY

9. MAKEWORD
Two bits of data combined into one word: the return value is the data
combined into one word
INT32U _MAKEWORD (INT32U hiData, INT32U loData)
example:
N100 = MAKEWORD (12H, 34H)
Results of the
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N100 = 1234H
related functions
_MAKEDWORD

10. MAKEDWORD

Two words combined into one double word: the return value is the data
combined into one double word

INT32U _MAKEDWORD (INT32U hiData, INT32U loData)

example:

N100 = MAKEDWORD (1234H, 5678H)

Results of the

N100 = 1234H

N101 = 5678H

related functions

_MAKEWORD

12.7 Introduction to Functions and Syntax Related to

Calculation Check Code

12.7.1 Column table related functions of calculation check code
Name Function
Using LRC method to calculate the
variable area check code
| REGCRC1 |Use CRC16 method to calculate
6 variable region check code
| REGCRC3 |Use CRC32 method to calculate
2 variable region check code
Use the CCITT method to calculate
the variable area check code
Use the BCC method to calculate the
variable area check code
Use BCC's complement method to
calculate the variable area check code

| REGLRC

| REGCCITT

| REGBCC

| REGBCC2

12.7.2 Introduction to the Function Syntax Related to Calculation
Check Code

1. REGLRC

Use the LRC method to calculate the check code of the variable area: the
return value is the value of the LRC check code

INT32S _REGLRC (INT32S regNum, INT32S cnt)
regNum can be used in the range of 0 ~ 65535
Cnt can be used in the range of 1 ~ 256
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The return value O indicates that the variable is incorrect or the value is 0,
and the other values are the values of the LRC check code.
example:
_STRW (N100, "1234")
N200 = REGLRC (100, 4)
Results of the
N100 = 0031H
N101 = 0032H
N102 = 0033H
N103 = 0034H
N104 = 0000H
N200 = 202 // 202 = 0CAH
related functions
_REGCRC16, REGCRC32, REGCCITT, REGBCC, REGBCC2

2. REGCRC16

Use the CRC16 method to calculate the variable area check code: the return
value is the value of the CRC16 check code

INT32S REGCRC16 (INT32S regNum, INT32S cnt)

CRC16 algorithm (X16 + X15 + X2 + 1)

regNum can be used in the range of 0 ~ 65535

Cnt can be used in the range of 1 ~ 256

The return value of 0 means that the variable is wrong or the value is 0, and
the other values are the values of the CRC16 check code.

example:

_STRW (N100, "1234")
N200 = REGCRC16 (100, 4)

Results of the

N100 = 0031H

N101 = 0032H

N102 = 0033H

N103 = 0034H

N104 = 0000H

N200 = 30BAH

related functions

_REGLRC, REGCRC32, REGCCITT, REGBCC, REGBCC2

3. REGCRC32

Use the CRC32 method to calculate the variable area check code: the return
value is the value of the CRC32 check code

INT32S REGCRC32 (INT32S regNum, INT32S cnt)

CRC32 algorithm

(X32 + X26 + X23 + X22 + X16 + X12 + X11 + X10 + X8 + X7 + X5 + X4 +
X2 +X1+1)
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regNum can be used in the range of 0 ~ 65535
Cnt can be used in the range of 1 ~ 256
The return value of 0 means that the variable is incorrect or the value is O,
and the other values are the values of the CRC32 check code.
example:
_STRW (N100, "1234")
N200 = REGCRC32 (100, 4) (DW)
Results of the
N100 = 0031H
N101 = 0032H
N102 = 0033H
N103 = 0034H
N104 = 0000H
Double word N200 = 09BE3EOA3H
related functions
_REGLRC, REGCRC16, REGCCITT, REGBCC, REGBCC2

4. REGCCITT

Use the CCITT method to calculate the variable area check code: the return
value indicates the value of the CCITT check code

INT32S REGCCITT (INT32S regNum, INT32S cnt)

CRC-CCITT algorithm (X216 + XA 12+ X5+ 1)

regNum can be used in the range of 0 ~ 65535

Cnt can be used in the range of 1 ~ 256

The return value O indicates that the variable is incorrect or the value is 0,
and the other values are the values of the CCITT check code.

example:

_STRW (N100, "1234")
N200 = REGCCITT (100, 4)

Results of the

N100 = 0041H

N101 = 0042H

N102 = 0043H

N103 = 0044H

N104 = 0000H

N200 = 9741H

related functions

_REGLRC, REGCRC16, REGCRC32, REGBCC, REGBCC2

5. REGBCC

Use the BCC method to calculate the check code of the variable area: the
return value indicates the value of the BCC check code

INT32S REGBCC (INT32S regNum, INT32S cnt)

regNum can be used in the range of 0 ~ 65535
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Cnt can be used in the range of 1 ~ 256
The return value of 0 means that the variable is incorrect or the value is O,
and the other values are the values of the BCC check code.
example:
_STRW (N100, "1234")
N200 = REGBCC (100, 4)
Results of the
N100 = 0041H
N101 = 0042H
N102 = 0043H
N103 = 0044H
N104 = 0000H
N200 = 0004H
related functions
_REGLRC, REGCRC16, REGCRC32, REGCCITT, REGBCC2

6. REGBCC2

Use the BCC's complement method to calculate the variable area check
code: the return value is the value of the BCC's complement check code

INT32S _REGBCC2 (INT32S regNum, INT32S cnt)

regNum can be used in the range of 0 ~ 65535

Cnt can be used in the range of 1 ~ 256

The return value of 0 means that the variable is incorrect or the value is O,
and the other values are the values of the BCC check code.

example:

_STRW (N100, "1234")
N200 = _REGBCC2 (100, 4)

Results of the

N100 = 0041H

N101 = 0042H

N102 = 0043H

N103 = 0044H

N104 = 0000H

N200 = O0FBH

related functions

_REGLRC, REGCRC16, REGCRC32, REGCCITT, REGBCC

12.8 Introduction to Communication Related Functions and

Syntax

12.8.1 A column table of communication-related functions
Name Function
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Data is sent through the

LWRITE .
— communication port

12.8.2 Introduction to Communication Related Function Syntax
1._LWRITE
Data is sent through the communication port: the return value indicates
whether the sending is completed
INT32S _LWRITE (INT32S handle, INT32S regNum, INT32S cnt)
Operation value of the handle communication connection (Handle is
displayed after the [Link Management] parameter in the Link Management
window)

Link Management
B B B »

=B TP6070C
=-4s CoM1
. E-48 CoolMay PLC(3U/3G)/FX3U [QEDD,E,?,l

B e () 0 : CoolMay 3U Series [St=1]

=-5 com2

EI""]_W CoolMay PLC(3U/3G)/FX3U [QEDD,E,?,lE
o[l 1 1 CoolMay 3U Series [St=1]

regNum data source register address number
Cnt can use the range 1 ~ 256
The return value 0 means that the variable range is wrong or the handle is
wrong or there is a problem with the development.
example:
_STR (1000, "A0 =1234\r\n")
N100 = _STRLEN (1000)
N101 = _LWRITE (0, 1000, N100)
Results of the
The character string is sent through the communication port "A0 = 1234 \ r \
N100=9
N101 =1

n
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Chapter 13 Description of Macro Communication

Using Macro communication, when the communication receives data,
the system will automatically execute [496: Sub Macro (496)] without

calling it.
® Macro Editor
@ i F| A
Add |t Check | Import Export | Font
Macro Sub Macro (496)
-440 : Sub Macro (490) ~ 0001

481 : Sub Macro
--492 : Sub Macro
- 483 : Sub Macro

441)
403)
493)
-404 : Sub Macro (494)
- 405 . Syb Macro (495)
| -496:5ubMacro (496) |
=307 1 GUD Macro 1497]

- 498 : Sub Macro (498)
4099 : Sub Macro (499)
- 500 : Sub Macro (500)
- 501 : Sub Macro (501)
- 502 : Sub Macro (502)
- 503 : Sub Macro (503)
- 504 : Sub Macro (504)
- 505 : Sub Macro (505)
- 506 : Sub Macro (506)
- 507 : Sub Macro
- 508 : Sub Macro
- 509 : Sub Macro
-+ 510 : Sub Macro
511 : Sub Macro

507)
508)
509)
510)
511)

- 512 1 Sub Macro (512) v |ll< >
Message
2 Insert

Receive data and send data is up to 253 bytes (Byte).

N63744 [0xfO00] Length of received data (BYTE). (0 ~ 253)

N63745 ~ N63871 Received data The received data is stored from the lower
byte, that is, the first BYTE stores the lower 8 bits of N63745, the second
BYTE stores the upper 8 bits of N63745, and so on.

When the system receives the data from the communication port, it will store
the data in sequence to N63745, and store the number of bytes received to
N63744.

N63872 [0xf980] Length of data to be transmitted (BYTE). (0 ~ 253)

N63873 ~ N63999 Transmitted data The transmitted data is stored from the
lower byte, that is, the first BYTE stores the lower 8 bits of N63873, the second
BYTE stores the upper 8 bits of N63873, and so on.

When the system recognizes that N63872 is greater than 0 and less than
254, it will begin to transmit the data at the variable position of N63873 to the
number of bytes recorded by N63872. Commands sent twice. (When data is
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sent to the communication buffer, the system will sequentially send the data to
the corresponding communication port)

Note: The Macro communication protocol does not support the
simultaneous use of multiple communication ports.
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Appendix 1 Definition of TPWorks Project Editing

Keyboard
keyboard action remark
Ctrl+Z Undo the last action
Ctrl+Shift+Z Undo last action
Ctrl+X Cut
Ctri+C copy
Ctrl+M Multiple copy
Ctrl+V paste
Ctrl+Del delete
Del delete
Ctrl+A select all
Up Component fine-tuning
Down Component fine-tuning
Component fine-tuning to
Left the left
. Components fine-tuned to
Right the right
Shift+Up The cgmponent moves up
one grid
Shift+Down Move t.he component down
one grid
, Move the component one
Shift+Left frame to the left
Shift+Right Move the component one
g space to the right
Ctri+Up Reduced component height
by one
Ctrl+Down Inc?rease the component
height by one
Ctrl+Left Component width minus
one
. Increase the component
Ctri+Right width by one
ESC cancel selection
G Group
U Ungroup
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Enlarged display

@) Zoom out

L Fixed element

Space Edit symbol

F4 Display component order

Shift+F4 Display component name

F5 Display variables (simple)

Shift+F5 Display variables (general)
Only display information

F6
about selected components

F8 Grammar check

F9 Online execution

Shift+F9 Offline execution

Ctrl+F9 Stop

Ctrl+Alt+S Download to HMI

Shift+"+" Change the order of
components (to the top)

Shift+"-" Change the order of
components (to the bottom)

o Change component order

(up one layer)

Change component order

(push back one layer)
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Appendix 2 List of TPWorks System Preset Variables

The user-available variable range is NO~N65023, and the register range for
power interruption is N49152~N61439 (will be expanded to N32768~N49151
in the future). Note that the variables after N65024 are for system use and
cannot be customized by users.

1 System preset variables

Power off retentive

Default Read
No. data Explanation and
value .
write
NB5024 >reen 0...100 70/ RIW
brightness
NB5025 >Creen 0...100 50 RIW
comparison
N65026 Backlight timer  |Unit: second, 30...65535, 65535=0fff 65535 R/W
N65027 volume 0...100 100 R/'W
N65028| O ED loofiash, 1=stop 0| RIW
status display
N65029 >'9na! generator jo_ g 4 0| RIW
switch
N65030 |Key sound index [65535=off 0 R/W
NB5031 |2 '2109 box sound g par_ gt 1] RIW
index
N65040 |Auxiliary cursor |65535=0ff 65535 R/W
NB5041 Auxiliary cursor o R/W
color
Use dialog mask
N65044 Dialog box mask [0X0001, 0X0002 omit the 1| RIW
background picture
Screen
N65048 |brightness 1...20 10| RIW
increase rate
Screen
N65049 |brightness 1...20 2| RIW
reduction rate
NB5050(Cacklight power 1y 4, 0 RIW
saving ratio
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N65056 [Time zone -32768...32767 0
0-auto recognition

Com port 1 is RS232/RS422/RS485

N65072 |connected to 1-RS232 0
electrical 2-RS422

3-RS485

Com port 1 0-150,3-1200,6-9600,9-57600,

N65073 communication [1-300,4-2400,7-19200,10-115200, 10
rate 2-600,5-4800,8-38400,
Com port 1 data |0 - Sbit, 1 - 6bit,

N65074 bit 2 - 7bit, 3 - 8bit 3
Com port 1 check|0 - None, 1 - Odd parity,

N65075 bit 2 - Even parity, 3 - mark, 4 - Space 0

N65076 gi‘t’m port1stop 1y 4pit 1 - 2pit, 0

N65077 |Com port 1 delay |Unit: ms 20
Com port 1 Unit: millisecond, minimum value

N65078 timeout setting {1000 1000
Com port 2

N65080 [connected to Setting as N65072 0
electrical
Com port 2

N65081 |communication |Setting as N65073 10
rate

N65082 gi‘t’m port2data | tting as N65074 3

N65083 gi‘t’m port 2 checkq tiing as N65075 0

N65084 gfm POt 2 StoP I etting as N65076 0

N65085 |Com port 2 delay |Unit: ms 20
Com port 2 Unit: millisecond, minimum value

N65086 timeout setting {1000 1000
Com port 3

N65088 |connected to Setting as N65072 0
electrical
Com port 3

N65089 [communication |Setting as N65073 10
rate

N65090 Sifsm port 3 data o tting as N65074 3

NB5091|[COM POt 3 checkle i o as N65075 0

bit
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Com port 3 stop

N65092 bit Setting as N65076 0

N65093 |Com port 3 delay |Unit: ms 20

NB5094 Cliom port 3' Unit: millisecond, minimum value 1000
timeout setting 1000
Com port 4

N65096 |connected to Setting as N65072 0
electrical
Com port 4

N65097 [communication |Setting as N65073 10
rate

N65098 g‘t’sm port4 data |gting as N65074 3

N65099 gi‘t’m port 4 checkls ting as N65075 0

N65100 g?m port 4 Stop o tting as N65076 0

N65101|Com port 4 delay |Unit: ms 20

NB5102 Qom port 4. Unit: millisecond, minimum value 1000
timeout setting {1000

NB5104| aShing time ;i o 1000
setting 1

N65105| asning time i e 500
setting 2

N65106| 2SN time )i e 200
setting 3

N65107[ ashingtime i e 100
setting 4

NB5112|Dialog boxinput o e 4o 1

effect

N65116

Component
enable display

0: Normal display,

1: When the enabling condition is
not established, the [Prohibition]
symbol is displayed on the upper
left.

2: When the enabling condition is
not established, the module sets
the network type shielding pattern

N65120

RFID_MODE

RFID reading mode 0=Read UID,
1=Read UID+IID, 2=Write IID

N65128

MODBUS slave
station number

N65137

Screen language

Bit0=1: Record the current
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options language

N65152 |Macro options

Adjust column

N65168 height

N65264 |Last boot state  [0=Normal, ! =0 wrong 0

Working temporary register(R/W)

No. Data Explanation Re.a d
write

N65280 Perpetual 1960...2059 R/W
calendar-year

NG5281 Perpetual 1..12 RIW
calendar-month

NG5282 Perpetual 1..31 RIW
calendar-day

N65283 Perpetual 0..23 R/W
calendar-hour

N65284 Perpetual - 0..59 RIW
calendar-minute

N65285 Perpetual 0..59 R/W
calendar-second
Perpetual 0..6,

N65286 P 0-Sunday, RIW
calendar-week

6=Saturday

N65287 Current backlight time|0...65535 R/W

N65288 Dialog box result R/W

NB5289 Dialog box data R/W
format

NB5290 Dlzlalogue box decimal RIW
point

N65291 Number of dialog RIW
boxes

NB5292 Max!mum number of RIW
text in dialog box
Dialog box button 0X8000(Loop

NE5293 clear inputOXO00FF) RIW

2156 5294-N652 Dialogue text R/W

'2\'?5296"\'653 Dialog box text R/W

N65328-N653 |Enter the maximum R/W

29 value
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N65330-N653 [Enter the minimum RIW
31 value
N65332 Right to use RIW
password dialog box
N65340 Current user rights  |1...31 R/W
N65341 Current user ID 1...15 R/W
N65342 Current screen 0..n RIW
language index
N65343 Current screen ID 1..n R/W
N65344 Current key status  |0...3 R/W
N65345 Input disable R/W
N65347 Control register B|t=0.Upda.te.the current R/W
backlight timing
N65360-N653 Dlglog box input max Display data format2: -A |[R/W
75 string
N65376-N653 Dlglog box input min Display data format2: -A |R/W
91 string
Working read-only register
. Read/
No. Data Explanation .
wirte
N65408 HMI Model 0X5000 R
N65409 OS Version R
N65410 Screen width 320 R
N65411 Screen height 240 R
N65412 Screen color 1/4/8/16 R
N65413 screen size 5700 R
N65414 Product Number 1 R
N65415 Product Number 2 R
N65422 Screen update time |Unit: ms R
NB5423 Picture updates per R
second
N65424 CPU Usage rate 0...100 R
Type of alarm
N65430 occurrence 0..2 R
information
NG5431 AIarm.storage
capacity
N65432 Number of alarms
N65440 System Information
Number
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N65448-N6544

Bit15 = 1 at the 15th second.

9 Time TICK R
N65456-N6546 [protocol name of Display format 1-BA display
R
3 com port 1 length 16
N65464-N6547 [protocol name of Display format 1-BA display
R
1 com port 2 length 16
N65472-N6547 |protocol name of Display format 1-BA display
R
9 com port 3 length 16
N65480-N6548 protocol name of Display format 1-BA display
R
7 com port 4 length 16
NB5488 CQM1 Number of At.present, each COM port has 32R
write buffers write buffers
NB5489 CQMZNumber of At.present, each COM port has 32R
write buffers write buffers
N65504 Signal generator1  [[0...359] R
N65505 Signal generator2  ([0...99] R
N65506 Signal generator3  [[0...11] R
N65507 Signal generator4  [[0...59] R
N65508 Signal generator5 Sine wave|[0...327687] R
N65509 Signal generator6  [Sawtooth wave[0...327687] R
N65510 Signal generator7  [Triangle wave[0...327687] R
N65511 Signal generator8 [Square wave[0...327687] R
N65528 communication q;0_ - oM1,Bit1=COM2. R
abnormal alarm
Bit0 = 1 after booting, Bit1 = 1
N65529 Boot time status after 1 second, R

2 The usage of internal pointer variable V

The pointer V and the variable N appear in pairs, and the fixed relationship is
as follows

Vi
N

V1
N1

Vi
N2

Va3
N3

Vd
Nd

VaZ2Teh
VaZ2Teh

V32766
V32766

Va2Ziey
VaZiey

Pointer ¥

Yariable N

In TPWorks, the relationship between the internal variable pointer V and
the variable N is one-to-one. When using it, you need to follow the
corresponding relationship in the above table. If you use VO, the other needs to
use NO, and so on...

Among them, the value of N represents the address that points to the
register, and the value of V represents the value of the register pointed to by N;
for example: use the group NO and VO for indexing, NO=100, N100=255, then
V0=255.
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Examples of batch assignment:
NO=10
FOR 61430
V0=555(INT16U)
NO+=1(INT16U)
NEXT

END
Analysis: NO=10, the register that specifies the start of the index is N10;

V0=555, specify the value to be transmitted, that is, N10=V0=555;
Use the FOR loop program to assign all values of 555 to N10-N61439.
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Appendix 3 TPWorks Scale Frequency Table

scale |Octave0 |Octavel |Octave2 |Octave3
Do C 262 523 1047 2093
Db 277 554 1109 2217
Re Db[294 587 1175 2349
Eb[311 622 1245 2489
Mi |[Eb (330 659 1329 2637
F 349 698 1397 2794
Fa Gb(370 740 1480 2960
Sol G [392 784 1568 3136
Ab 415 831 1661 3322
A 1440 880 1760 3520
La Bb [466 923 1865 3729
Si |B 494 988 1976 3951

302



TP Series HMI Programming Manual

Appendix 4 Instructions for Using Operation

Variables

Operation variable

It means that the general numerical data source location can be set using
the calculation between variables.

In this software, if a small icon appears on the right side of the edit box for
the input variable position, it means that the variable input position can use
arithmetic variables. As shown below:

Murneric Display x

Bevel Control | Text |

—Control | rDisplay Format
Data Type ][168'rt] Signed LJ Integer: J4 LJ
Read Addr. - Decimal Pos.: JIZI LJ
s LJ [~ Zero of Hi Bites
Min: LJ

+ Decimal
Visibility: ] ~] " Hex.
(" 32 Bits Float. Point
o OK | X Cancel ‘

The operational symbols that can be used are shown in the table below
Operation Operation symbol Case remarks
category

addition + D100 + D101
Subtraction - D100 - D101
multiplication * D100 * D101
computation Descent / D100/ D101
Take the remainder % D100 % D101

Take a negative

number ) D101

and & D100 & D101

XOR A D100 ~ D101
Bit operation  |or | D100 | D101

Shift left << D100 << D101

Right shift >> D100 >> D101
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Negate ~ ~D100

Equal to == D100 == D101

Not equal to I= D100 !'= D101
Relational Less than < D100 < D101
operation Less than or equal to |<= D100 <= D101

more than > D100 > D101

More or equal to >= D100 >= D101

Logical OR I| D100 || D101

logic operation |Logical AND && D100 &&
D101
Logical inverse ! D100

In the table above:

D100 and D101 refer to variables in the PLC (controller).

Operators can be used together, for example (D100 + D101)/ 2) == 100

To increase the convenience of reading, when the operator occupies a bit, a
space can be inserted between the variable and the operator. However, when
the operator occupies two bits, no space can be added between the operators,

as explained below:
D100 + D101 can be written: D100 + D101
D100 <= D101 The syntax check is correct here

D100 <= D101 The syntax check is incorrect here because the operator <=

has a blank character in the middle.

Definition of constant

Constant Definition description Case
type

Decimal Number0~9 123 or 100000
Numbers 0 ~ 9, English letters A ~ F, the last word|100H or

Hex is 'H', but the first word must not be a letter, it must|/1234H or
be a number OABCDH

Cases

Operation variable Explanation

(D0+D1+D2+D3+D4)/5 |[Take the average of DO to D4

(D0*1234)/1000 Multiply DO by 1.234

(DO==100H)||(D1==200H
) 0.

When DO is equal to 100 in hexadecimal or D1 is equal to
200 in hexadecimal, the value is 1, otherwise the value is

D0>D1 .
value is 0

When DO is greater than D1, the value is 1, otherwise the

(D0<=D1) && (D0==100)

When DO is less than or equal to D1 and DO is equal to
100, the value is 1, otherwise the value is 0.
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DO = [Binary] 0000000000001111-> Decimal = 15

DO & D1 D1 = [Binary] 0000000000010001-> Decimal = 17
DO & D1 = [Binary] 0000000000000001-> Decimal = 1
DO << 2 DO = [Binary] 0000000000001111-> Decimal = 15

DO << 2 = [Binary] 0000000000111100-> Decimal = 60
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Appendix 5 Function Description of Multiple

Intelligent Connected Machines of HMI

At present, more users will have more and more devices connected to the HMI.
One RS485 can be connected to multiple controllers. Under this structure, the
software can distinguish each controller by station number when designing the
HMI program stage, so that the HMI can read the data of each connected
controller. When each controller works normally, the communication will work
normally.

However, in some use cases, not all connected controllers must be powered
on, which will cause the HMI to always try to connect with the controller that is
not powered on during communication, which will affect the overall
communication speed.

When we designed the software, we added the [multiple intelligently
connected machines] function in the HMI software, and the setting page is
shown in the following figure:

Add Protocol ot
Protocol
Protocol:  |coolMay PLC(3U/3G)/FX3U -
Controllor:
Company Maodel Des...
CoolMay CoolMay 3U Series PLC
Port: |Auto Detect(R5232/R5422/R5485) -
Buad Rate: |g,5|:,|:, ﬂ Data Bit: I?E'rtS ﬂ
Parity:  [Even -] Stop Bit:  [1pit -
Delay: loms j TimeOut: | isec ﬂ
v Multi-Station Smart Link Retry Count  [Timeout, Repeat ﬂ
W 0K | X Cancel |

[Multi-Station Smart Link] function basically records the connection status of
each controller to adjust the communication parameters and increase the
connection speed and stability. When the unpowered controller restarts, the
HMI will automatically discover and connect automatically.

The station number must be between 0 and 31 when the station number of the
controller is assigned by using the function of [Multiple Smart Links]. If you
need to know the status of the connected controller, you can check it from HMI
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internal system variables (COM1 = N65352, COM2 = N65354).
The station number corresponds to the bit of the variable, 0 = normal
connection, 1 = not currently connected. The specific corresponding table is as

follows.
Vari
a-bl IN65353 N65352
e
. 1 1 11
bit 15413121109876543210151432 1098|765 41312
Stat
. 3 221212 122 1111 1111
;\ll(z)n 3102928276543 5 |1 209871615143 2 |1 1019187165 432
\ari
a-bl IN65355 N65354
e
bit 151 1312111 9876514 |1321)|0 15141 11 1098765 432
4 0 3121
Stat
. 3 221212 2|2 1111 1111
;\llc())n 3102928276543 5 11 209876 15143 5 |y 1098765 432

Note: [Multiple Smart Links] only supports controllers with station number
communication protocol.
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Appendix 6 Function Description of Embedded

Numerical Value Display in String

The value embedded in the character string means that when a static text

component is used, the dynamic variable character string value is displayed in

a general static component using the [variable display character string]

function.

[Variable display character string]: Refers to the definition character string
that uses ‘{’ as the starting symbol and ‘}’ as the ending symbol. For example
{NO,4.2d}, {N100,81X}.

If you want to display the {’ symbol in the character string, you need to type

two consecutive {"’s of* {{"to recognize the' {’as a normal character string.

[Variable display string] The definition is divided into 6 parts: prefix, variable

definition part, integer part, decimal part, display format definition, suffix. The
variable definition part and the integer part are separated by a’,;’ comma
(English comma).

Variable display string format description

Prefix dZ;;I;gﬁs Integer part | decimal part| Display format definition [suffix
Value: 1-12. |d: Decimal signed number
If this bit is 0, |(16Bits)
that is, the u: decimal unsigned number
Value: 1-12. (fractional part |(16Bits)
When is not needed, x: Hexadecimal display
System variables |high-order  |[this bit can be |(16Bits)
NO ~ N65535 zero padding jomitted. Id: Decimal signed number
Index variable VOQ|is required, |Whenitis (32Bits ) )
~ V255 add a omitted, the |lu: decimal unsigned number
number '0" in |[separator "." |(32Bits >)
front. With the Ix: hexadecimal display
integer part  |(32Bits )
needs to be (f: floating point display (32Bits
deleted. X))

Note: There can be no white space in the variable display string definition

% The reading of 32Bits is lower 16-bit data, and higher 16-bit data.

Examples of variable display string settings:

In {NO,4.2d},
Prefix: {;
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Variable definition: NO;

Integer part: 4;

Decimal part: 2;

Display format: d;

Suffix:}

An example of variable display character string display, taking decimal NO =
123 as an example:

Set variable |displ

display string | ay Explanation

Display the value of NO in the form of hexadecimal

{NO.04x) 0078 high-order zero-filling

(NO,2.2d) 1923 Display the value of NO in decimal and 2 decimal
places

{NO,d} 123 |Display the value of NO in decimal format

Examples of software settings:
1. Newly added components [static text]

Label

2. Set the [Label] property as shown below
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Label o
Bevel Text ]
rText
Language: |English (United States) |
Color: T vl W Word Wrap
Align: | Center |
Effect: [Normal |
Flash: [normmal |

Font: Tahoma [24] Font
' |iurrent Temp: {NO,2.1d}

W OK | xCanceI|

3. [Static text] The display status is shown as below

Current Temp: {NO,2.1d}

4. Executing the program, the display status of [static text] is shown in the
figure below

Current Temp: 29.8
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Appendix 7 List of Communicable Controllers

518 Singlex Series

AD-4401 Series

Allen-Bradley DH-485

ARCUS Series

CoolMay PLC(2N)

CoolMay PLC(3U/3G)/FX3U

CSIM Series

DELTA DVP Series

DPS Series

Facon FB Series

Fama Series

Fuji MICREX-SX Series

GALIL Series

Jing Yi elevator Series

Keyence KV Series

Koyo K sequence

LG Master-K K120S Series

LUSTBUS Series

Macro Series

Matsushita FP Series

Mitsubishi A1SH Series

Mitsubishi FX Series

Mitsubishi FX Series-Computer link

Mitsubishi FX2N Series

Mitsubishi FX2N-10GM/20GM Series

Mitsubishi FX3U Series

Mitsubishi MR-J2S Series

Mitsubishi MR-J3 Series

Mitsubishi MR-J4 Series

Mitsubishi Q Series

Mitsubishi QO6HCPU Series

Mitsubishi QnA Series

Modbus ASCII Mode

Modbus RTU Mode

Omron C Series

Omron CompoWay

P900 Series

Phoenixtec UPS Series
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SAMCO-VmO05 Series

Simatic S7-200 Series

SMAC LLC-10 Series

SmartMotor Series

TAIE Series

TECORP HC1 Series(ASCII Mode)

TECORP V5000 Series

TOHO TTM-004/X04 Series

TRIO Host link Series

Unidriver Series

UNIPULSE Series

VIGOR M/VB/VH Series

WDH IR-BOX Series

WDH Lamp Series

XP989 Series

Yamatake CPL
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Appendix 8 TP Series HMI Storage Data export

Operation Instruction

Software: xExpress
xExpress software is specially designed for TPWorks TP series HMI. The
main function is to read the recipe data and record data of the TP series HMI in
operation through the communication port, and save it as a text file, which is
convenient for customers to further data analysis or make reports, output data
can be customized display format, so that the data display closer to actual use.
Simple operation steps
1. Edit TPWorks software, design HMI program, and define recipe data or
record data.
Test the connected HMI program to confirm that is working properly.
Use TPWorks software to export [cache definition export].
Open xExpress editor, connect device and communication parameters.
Import data definition (the file exported by step 3).
Read the data in the buffer area through the connection
. Select the edited recipe or recorded data, and after editing the attributes,
export the data to a text file.
8. Use Microsoft Excel software to open text documents, and then do data
analysis and reports.
Step1
First of all, use TPWorks to edit the HMI program. When the recipe data or
record data is used in the program, it can be used with xExpress software.
Note that editing recipe data [backup device: use system variable area
(NO-N61439)]

NOoO O RWD

Edit Recipe x
Recipe
Index: I
Marne: |Reci|:|el
Waork: In100
Control: IND
Backup Device: |Used Internal Memory(NO-N61439) j
Backup Addr.: |HII]I]I}
Recipe Count: |]_|j ii
Description:
W 0K | X cancel |
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Note that editing record data needs [retentive function]
Note: The maximum power-saving interval is 49152 words, which is
related to [Data Length] and [Record Count]

Edit Data Record ad
Data Record-
Hame: ’PrnductManalgement
Data Type: |[16Bit] signed %)
Source: [p1o x| »
Data Length: ]4 j
Record Count: m Range 1 .. 32767
Update Time: IESEC j
Record Flag: ]MD j
Clear Flag: ]Ml j

¥ Clear[Clear flag]
Auto. stop as touch record
Stop Count: fo | setting,No use this function

Description:

¥ Record Date/Time
v Retentive 30004 Word

Use Reg. Addr.: o - |n30003

Provide hold Reg. NO-M49151(49152Word), Only
Advance HMIL

" 0K | X Cancel]

Step2

Download the program to the HMI test operation until the test operation is
confirmed to be normal.
Step3

Open the TPWorks software to edit the HMI program, select
[File]-[Export]-[Register Define] to store the buffer definition file.
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[] MewFile..  Ctrl+N
= OpenFile.. Cirl+0
& saveFile Ctrl+5S
Save Az File
Close File
|mport 4
Exit pteFa | O, 129
(ff ExportScund ...
o Exporthlarm ..
a Keyboard Define ..
=:x Data Sync ..
ﬁ Data Record ...
(E.' Export Data Schedule ...
ExportDictionary ...
35 ExportRecipe ..
Register Define ...
Y& Translate text export
Import/Export x
~Select Data
E!--Recipe
|-

E| @ @ Data Record (Index : Name,Format,Source Data Length Record Num. ,UpdateTime Record Flag,Clear Flag,Clez
@@ 0 : ProductMangement, [16Bit] Signed,D10,4,5000,2000,M0,M1, 1,0, (rull)

W OK I xCancell
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Savein: l . TFWorks v! - EF EE

* MName

Quick access

Date modified Type Size

Mo iterns match your search,

Desktop
L2
™
Libraries
This PC
Network
—y
File name: IBuﬂer definition ;_j I Save I
Saveastyps:  [TPWorks Dafine File (. dsf] = _ Cancel |
Import/Export >

r.-'"_“\_|
|o| Export finish!

Step4

Open the xExpress software, [File]-[Open a new file], press the [Add
Device] button in the lower right corner

o uExpress
File(F) Schedule(S)
0= -

Tools(T) Help(H)

Ptoject

xExpress

Title:

| I Add Device ||

Description:

This demo explain how to use com port to communication, after adding a

316




TP Series HMI Programming Manual

device, please select the communication port; [device] parameter refers to the
com port between the PC and the HMI, and set the communication parameters
(default 115200, 8, none, 1 is enough)

'J‘s‘:J xExpress

File(F} Schedule(S) Tools(T)

O=E-d

Ptoject

Help(H)

v - xExpress

...... [H4 com4 [115200,M,8,1]

COM4 [115200,1,8, 1]

Device: | Serial Port

e

1 | B B o lectronics Virtual COM Port ) iR% |
=

Baud Rate: 115300

Parity: |MNone

e

Data Bits:  &Bits

Stop Bits: | 1Bit

Then click [Add HMI] to add an new HMI

o xExpress
File(F} Schedule(s) Tools(T)
Ow= -

Ptoject

Help(H)

~ [ xExpress
w -l COM4 [115200,N,8,1]

HMI

Station Mumber: |p

Schedule: | 1day

Step5

2

Delete Device

Import Define File
Delete HMI

Read Data

After adding the HMI, you need to import the data definition (defined by
the buffer exported in step 3)
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:_;.i B s s O
File(F) Schedule(s) Tools(T) Help(H)

Ow= -

Ptoject

w [ xExpress
v Gy COM4 [115200,N,8, 1]

HMI

Station Number: |0

~ Import Define File
Schedule: | 1 day b

Delete HMI

Read Dats

Ji‘ Open

- v 4 » ThisPC » Desktop » xiugai

v D Search xiugai 2
Organize + Mew folder SRR 4 T o
%
i Name Date modified Type Size
3 Quick access

1033 .j ProductManagement.def 6/13/2020 1:44 PM DEF File

[ Desktop
English Case
xiugai

@ OneDrive
8 This PC
_J 3D Objects
[ Decktop
E'| Documents
lv Downloads
J’ﬁ Music
&= Pictures

B Videns i

File name: | ProductManagement.def u‘ Define File

[Coen ][ conen

Step6

The definition data of the HMI will record the data definition. After the data
definition is imported, please fix the connection line between the PC and the

HMI (the download line of the HMI) and press [Read Data] on the lower right
corner of the xExpress screen to start reading the HMI. data
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ol xExpress = O X
File(F) Schedule(5) Tools(T) Help(H)
O = - =

Ptoject

v - xExpress
~ L5 coM4 [115200,M,8, 1]
~ -] TK&070FH
BEH1

TKBOTOFH
Schedule: | 1day v [ Delete th |
'3‘3 *Exj == O >
File(F} Schedule(5) Tools(T) Help(H)
O = -3
Ptoject
v [ xExpress

v I COM4 [115200,N,8, 1]
v -[] TKB070FH

BLH1

- AT Communication x

Read Register { 8000 [ 65536)

Close

TKEO70FH

Station Number: o ~ | | Import Define File

v | | Delete HMI

Read Data

319



TP Series HMI Programming Manual

o xExpress ~ O X
File(F) Schedule(s) Tools(T) Help(H)
Q= -
Ptoject
v [ xExpress
w %5 COM4 [115200,N,8,1]
~ -[0] TKeo70FH

g BEA1 -
i TR Communication 'A'

Communication finish!

Close

TKGO70FH

Station Mumber: |0 ~ Import Define File

Schedule: |1 day ¥ Delete HML

Read Data

Step 7

At this time, the recipe data or recorded data has been read back to the
PC, select the edited recipe or record data, after editing the attributes, export
the data to a text file. (When data is not recorded in the running HMI, XxExpress
is empty during data recording)

o xExpress G O ot
File(F} Schedule(s) Tools(T) Help(H)
O = -3
Ploject |
w [ xExpress Item \Field | Record Time Datal Datal Data2 Data3
¥ "?__SMT':{S[;Z'E?_‘D’N'SJ 1 1122 3344 5566 7788
AiA1 16:20: 19. 1122 3344 5566. 7788
i e 16:20:19 1122 3394 5566 7788
16:20:19. 1122 3344 5566. 7788
16:20:‘19. 1122. 3344. 5566. 7788
16:20:19 1122 3344 5566 7788
16:20:19. 1122 3344 5566. 7738
16:20:19. 1122 334 5566. 7788
Setup
Field Name: |Record Time 32 Bits Time
Display Format: |hh:mm:ss ~
TR

Update : 6/13/2020 1:47:14PM
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a’i Save As
T™ 5 ThisPC » Desktop » xiugai

Organize ~ MNew folder

o MName

#F Quick access
1033

B Desktop
English Case

xiugai
@ OnelDrive

& This PC
“J 3D Objects
[ Desktop
Documents
‘ Downloads
j Music v

TP Series HMI Programming Manual

Date modified

Type

v O

Size

Ma items match your search.

Search xiugai )

)

File name: | ProductManagementD&06 I

Save astype: | Text File

A Hide Folders

i Save ! | Cancel

Step 8

Use the Microsoft Excel software to open the text file saved in step 7 for
data analysis and reporting

28

ERED).
HFUE)..
| sEEs SRR
SSEEEED) A
0] V@ HE Web TEW..
XML » FREEEEAN.
1N EEREEER) SESHE..

9 &ffice Online

@9
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BH(M)...

5 = #RO. | 5] Wi erosoft Dffice

ine

HIE AR Excel BIERET

|
Eh AR T
i

|

TR THS AR

TR
SR «ls

5 Ei

0 RIS
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FENEAERE ? h ot
EREED: || FREEST M@ -3 QXowE- TR
E# ZorHE -] Folh f
FEIERIS
=l
’ ) |
iy EATE =
R R
'- | XEE®: | v meEe... || [ IR
* MHZEL): REHHEE (¢ ode: * ndb: * nde|v | i T I‘J
[38] Microsoft Excel - Book2 = m} *
1
- O
_i 7 Office Online
_5 | |ZEERANAS-3HEz1 ? X | | o EEB| Mierosoft 0ffice
3 Online
T | EESSIES AR R AR - ' ' o EEEEER Ercel HIEE
T | EiaERe, BTk DA RS ENEER. el
_8 | Bl | | o EEh) RS ISR
] EHERSBATINE: ~ | . ...
10 @AEFE0) - BORSE MESTHETHIRE =R _

11 W - SHEE T I;@;— i
_11 | s | | >
12 sty 1 = gy | ; I

o SAMRTER): 1 [ HEEEED: | e : HifchIr(cezsIz) . . . -T—1?§H A TENEA I "

% T T ATRES RS R\ R ST S, e | | AT |
S EEER ol
16 FERER - ESE ~ o Ej‘f%

17 o BIIEEET ¢ 2020-06-03 14:02:46 T 1
? 38 \ FR:CFRATEDatallatal Data?Datad ] HERT{EE. .
F 4 016:20: 19112253446066 7 755 Vv £

20 '
2l [ mE | o0 F=Fw| zhm |

23

24

25

26

27

28

29

a1 v

W 4 b v Sheetl {Sheet2 /Sheetd/ < Sll

Hisk
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[38] Microsoft Excel - Book? = m} *
H] xi4e S5E WEY BA0 #R0 IED 5o s0w ZEE .8 x
NEEHRdB 0 e [ Fx ~12 x| B 7 ul|S i I R0 |
111 - f
PO T 7 O T T T | R T
1 BFEWF  EEE
2 EHEEITT : 2020-06-03 14:02:46
2 TWE \ FE {FEAHE Datad Datal Data? Datal
| 4 | 0 16:20:19 1122 3344 5566 7783
| 5 | 1 16:20:19 1122 3344 5566 7733
& | 2 16:20:19 1122 3344 5566 7783
= 3 16:20:19 1122 3344 5566 7783
| & | 4 16:20:19 1122 3344 5566 7783
9 | 5 16:20:19 1122 3344 5566 7783
| 10 6 16:20:19 1122 3344 5566 7783
| 11 | 7 16:20:19 1122 3344 5566 7783 [ 1
B 8 16:20:19 1122 3344 5566 7783
12| 9 16:20:19 1122 3344 5566 7783
| 14 | 10| 16:20:19| 1122 3344 5566 77ER
| 15 | 11 16:20:19| 1122 3344| 5566 7788
| 16 | 12 16:20:19| 1122 3344/ 5566 77BA
L7 13 16:20:19| 1122 3344| 5566 7TBE
| 18 | 14 16:20:19| 1122 3344| 5566 77BE
| 19 | 15 16:20:19| 1122 3344| 5566 7TBR
| 20 | 16 16:20:19| 1122 3344| 5566 778
2L 17| 16:20:19| 1122 3344| 5566 7TBE
| 23 | 18 16:20:19 1122 3344 FBBGE 7788
| 23 | 100 16:20:19 1122 3344 5BGE 7788
24 | 20 16:20:10 1122 3344 5566 7788
25 | 21 16:20:19 1122 3344 5566 7788
26 | 22 16:20:19 1122 3344 5566 7783
o 23 16:20:19 1122 3344 5566 7783
| o5 | 24 16:20:19 1122 3344 5566 7783
29 | 25 16:20:19 1122 3344 5566 7783
30 | 26 16:20:19 1122 3344 5566 7783
31 | 27 16:20:19 1122 3344 5566 7783
n ARCAR-N-10 11279 2244 RRRA TTRE
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Appendix 9 HMI modbus RTU Communication

Instruction

Function codes supported by HMI as modbus host

Function No. 01: Read the coil status and get the current status of a group of
logic coils (ON/OFF)

Function No. 03: Read holding registers and get the current binary value in one
or more holding registers

Function 04: Read the input register to obtain the current binary value in one or
more input registers

Function No. 05: Force a single coil, force a logic coil on and off state (write bit)
Function No. 06: Load specific binary values into a holding register (write
register)

Function No. 15: Forcibly set multiple coils, force a string of continuous logic
coils on and off (write multiple bits)

No. 16 function: preset multiple registers, load specific binary values into a
series of continuous holding registers (write multiple registers)

1. Make the setting of the master with only one slave

1. 1. Communication parameter setting, use 485 communication to select
COM2 to add communication protocol.

[Project] — [Communication] — [Add Protocol], as shown below
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roject |HMIM) Component Tool Window Help
B Screen A e
; ﬂ| Communication * 3 Add Frotocol
- &¥ Tag ¥ @, Edit Protocol
L2 Language bW Delete Protocal
E?ﬁ“@ Keyboard Define ... m. Add Cant
@ Alarm ... B, Edit Contraller
J e Password .. Bl Delete Controller
) Sound #¥ Variable Window
B Protection ...
2 a4 Data Sync ...
& Record ...
| B9 Data Schedule ...
[ Recipe ...
System Configuration ...
% Macro ... r
B Report Manager
Setup »
Add Protocol |__
—Protocol
Protocol | Modbus RTU Mode ]
Controller:
Cormpany | Model | Des... | -
Modbus Modbus Controllor Series —
Modbus Modbus Controllor Series(Sdigit)
Fatek Facon Controllor Series PLC
Mirle Mirle nDX Series |_T|
Port: | auto Detect(RS232/RS422/R5485) ]
Baud Rate: Igﬁm] Li Data Bit: IEE“.'.E Li
Parity: IND-FIE Li Stop Bit: IlE'rt Li
Delay: I oms Li TimeOut: I {sac Li
[~ Multi-Station Smart Link Retry Count | Timeout, Repeat v|

W 0K X Cancel |
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I

Add Controller
—Controller-
1D: 0
Station: 1
Controller: | company | Model | Description =
Modbus Modbus Controllor Series
Modbus Modbus Controllor Series(Sdigit)
Fatek Facon Controllor Series PLC
Mirle Mirle nDX Series
Mirle Mirle SDPLC Series PLC =
Description: %

W OK | xCanceI|

ID: ID number of the controller. (Unique, not repeatable)
Station: the station number of the controller, that is, the slave station number to
be read/written. (The station numbers of com1 and com2 can be repeated)

The station number (HMI station number) in the display unit setting is the ID
(PLC ID) corresponding to the connected controller, and the ID (HMI ID) set in
the display unit is the corresponding Several controllers. For the setting of the
station number, COM1 and COM2 of the display unit are independent, so
COM1 and COM2 can be set separately to connect the controller with the
same station number, but for the setting of ID, each HMI cannot be repeated.
Because the ID describes the controller which is the first controller connected
to the display unit, as shown in the figure below.

COoM1
HMI ID3 HNMIIDZ HNIID1
| | | |
FLC3 FLC2 FLC1
1D3 1D2 1D1
L =tation 3

HMI =tation 2

_HML =tation 1

coMz
HMI ID4 HNMIIDS HMIIDG
| | I I
PLC1 PLC2 FLC3
I1D1 1D2 ID3

HNI =station 1

HMI =tationm 2

.. NI station 3

1.2.After the addition is successful, the corresponding communication protocol
will appear in the selected communication:
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n mView : [C:\Users\EN\Desktop\121.wxf]

File Edit View Project HMI(M) Component Tool Window Help
b -d|e->-|lsmB]ls

MR R

- | B E bt
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% Fr

|#Zl& b bW

I

E-aa|m-w-2-5-|c

O~-fRadBHBEN-E

[Ty [ e O s B B D

Graphic Component  Static Component IButtunl Disolav | Edit |

lpooo@®O®0 0

|| [Engish (unieed states
]

=] |

—Link Management

T S

=] H TK&070FH

G CoM1

5 W COMZ

B9 Modbus RTU Mode [9600,M,8,1]:0

licik 0 : Modbus Controllor Series [St=1

<o 40004
<o 40007

~ Descripton:

Bl 1: Start scene [100%)]

... Modbus RTU'Master = - ©--00 - 000 oo

* r_40001
e 40007

*EER

T r_40004
*EER

©r._40007
FREE

r._40005
w:_ 40005

r_40008
w:_ 40008

40002
wi_A0002

FEEE

140006
- 40006

FEEE

Tr_40003
- w_ 40009

L2243

r_400037
40003

#EEF

#EEF

#EEF

select COM2 to add commumcatlon protocol ]
When usmg 485 to communicate '

—1
ESaeen| @ Lk [ Tag

1.3. Available variables are as follows

Controller: the device that communicates with the HMI;

the address of the variable.

number:

directly enter

n Variable Window

—Variahle
Controller:

Variable/Para.:

Mumber:

0 : FX3U Series [St=1]

»

Type | Name | Range | 5p... | Description |

W BIT Xooo 0-367 1 Inputs

W BIT Yooo 0 - 367 1 Qutputs

W BIT Mnnnn 0-7679 1 Auxiary r...
W BIT Mnnnn 8000 - 8511 1 Speciklau...
W BIT snnnn 0 - 4095 1 States

W BIT TSnnn 0-511 1 Timer con...
BIT CSnnn 0-255 1 Counter c...
3@ \WORD THnnn 0-511 1 Timer curr...
3@ \WORD CHnnn 0-199 1 Counter C...
DWORD  CHnnn 200 - 255 1 Counter C...

m
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1.4.Place the corresponding variable on the HMI screen and use 485 to
connect the modbus communication device, that is, you can read/write the
data of the corresponding variable address, as shown in the following figure:

...... r 40001 r_ 40002 Tk 40003

s e 40007 40002 S 40003

S BHEH BHEH ; BH#H

- fr:'_iujuijai ................. Er:; s r. i
------ W, 40004 -, 40005 40006

e HEBEHE : HHEHH HEHE
e — I —— P rr———
...... Wi, 40007 40008 “wr_ 40003

wrmnd HHEHH HHEHH : HHEHH

2. Set up the master with multiple slaves

2.1. Communication parameter setting, use 485 communication to select
COM2 to add communication protocol.

If you need to connect multiple slaves, you need to add multiple controllers.
Each controller corresponds to a device that reads/writes a different slave
station number. [Project] — [Communication] — [Add Controller], as shown
below Shown

Component Tool Window Help
| %SCFEEH » l o =

ag . Edit Protocol

| age Language &L Delete Protocol
<evhoard Define EN Add Controller

{0 Alarm ... B Fdit Controlls

s

“® Password ...

t E:E- Sound ...
!@ Protection ...
:i?ﬁ Data Sync .. 3
H &9 Record ...

Er% Data Schedule ...

f‘ Recipe ...
System Configuration ...
d ‘35,5 Macro .. r

#¥ Variable Window

IS

T

Setup »

Or directly select the communication protocol, right click mouse — [Add
controller]
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e T e R

= M Tr6070C
=-&s COM1
. BB Mitsubishi FX3U Series [9600,E,7,1]:0
~[E 0 : FX3U Series [St=1]
=-% CoM2

= d Modbus RTU Mode [9600.0.8.11:1

% Add Protocol

ol

td. Edit Protoco
& Delete Protocol

dd Controller

Eadit Controlle

#¥ Variable Window

Note that when connecting multiple products for communication, you need to
tick [Mult-Station Smart Link] and select [Timeout, Non- retransmission]

| Edit Protocol |_§§__!
—Protocal
Protocol:  |Modbus RTU Mode |
Controller: , , ,
Company | Model | Des.. | |~
Modbus Modbus Controllor Series o
Modbus Modbus Controllor Series(Sdigit)
Fatek Facon Controllor Series PLC
Mirle Mirle nD¥ Series |T|
Port: | Auto Detect(R5232/RS422/R5485) |
Baud Rate: |95m] j Data Bit: |BBH:5 j
Parity: |N|:rne j Stop Bit: |15it j
Delay: |oms - TimeOut: | izec j
V¥ Multi-Station Smart Link Retry Lount | Timeout, Non-rej v |
V' 0K X Cancel |

2.2. After adding 3 controllers successfully, it is as follows:
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N e T I

File | Edit View Project HMIM] Component Tc

ERd R RaEE - T

By s Nk e ™

v W B e @
|E'E e

Graphic Component | Static Component | Button  Display IEd
o0 EEEE®E ~8 5| H|

|[mEE

o002

—Link Management

%% 0% 0686 »

EI--HTP&D?{IC

..... l.'% COoM1
=4 comM2
B4 Modh

ID number

5 RTU Mode [2600,M,8,1]:0
Modbus Controllor Series
Modbus Controllor Series
Modbus Controllor Series

[5T=1]
[5t=2]
[5t=3]

Slave
station

2.3. Add the variable requesting to read/write the slave station number in the
order of Q@ R)(@) as follows, (2)Select the slave station corresponding to

the variable address

Bevel Control | Text |

u Variable Window

—Control o_
Data Type  |[168t] Signed =) 4 ]
Read Addr. [ 20001 = Vageble/Para.: [ Type | Mame | Range | Sp... | Oescription |
i = & BIT _Onnnn 1 -9999 i
: | -] @ &8 BIT _lnnnn 1-0999 1
Min: I vl [E...] / &3 \WORD  _3nnnn 1-9999 i3
: @ \WORD 4nnnn 1 - 9999 1
Wirite Addr. - =
[ 40001 =] EBDWORD D4nnnn 1 -9999 1
Wirite Not'rﬁmtl vl
Befor Macro: I 'l
After Macro: I vl &
—Engineer Transfer——————— ~Display Forn] Murmber:
Offset: Ig Integer: LI
Gain: |1 0 ;
2 Decimal P
' OK I X Cancel |
Aux. Cal. | [ Zero obvwowes |
0K I X Cancel |

For example, slave 2 variable address:
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Hismmasc Entiy B4 variable Window = [m} x
Bevel Control I Text i Variable
—Controt
Controfler: Iil : Modbus Controlor Series [St=2] I ;]
Data Type  |[16Bi] Signed B )
Read Addr. [[1: 0001 = Variable/Para.t [ Type [ Name | Range [ sp... | Description |
i = BIT _Onnnn 1 -9999 i
) i B BIT _lnnnn 1 -9999 1
Min: vI EWORD _3nnnn 1 -9999 1
Write Addr. [1;_40001 | vI b 1
Write Motificat vl
Befor Macro: I vl
After Macro: I vl
—Engineer Transfer- Display F{ | MNumber:
Offset: Ig Integer| Il:_40001 I |
L Il.U Decirmal
Aux. Cal. | [T Zerdwrrrowss

' 0K I XCEncell

Slave 3 variable address:

Nameric.tiry B8 variable Window = O *
Bevel Control I Text l Variable
—Control 1
Controler: ||2 : Modbus Controllor Series [5t=3] I j
Data Type  |[16Bit] Signed R o
Read Addr. | [2: 40001 .'_I Variable/Para.: Type | Name | Range | sp... | Description |
BIT _Onnnn 1-94999 1
Max: = =BT _innnn 1-9999 1
Min: vl 3 WORD _3nnnn 1 -9999 1
- WORD 4 1 -9999 £ 3
write Addr. | [2:_40001 | = o
EBDWORD D4nnnn 1 -9999 a3
Write Notificat -
Befor Macro: | vi A
After Macro: | vl e,
—Engineer Transfer Display Fi Number: i
Offset: |g Integer] ||2:_40001 | |
SR |1'U Decimal
Aux. Cal. | ™ Zertwrrmowes |

[ ok | X concel| ‘

2.4.Place the corresponding variable on the HMI screen and use 485 to
connect the modbus communication device, that is, you can read/write the
data of the corresponding variable address, as shown in the following figure:
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e t_40002 t_40003

--------------- 40001 40002 40003

CGlave 1T #EE# e B L

o 140002 +1:_40003

--------------- 1._4000] 1._40002 140003

' Glave 2 B F T 4 o

et SRR k2 400020 c2 A
Slave 3 | 24000l w2_40002 . w2_40003

3. Setting of HMI as slave

3.1 Note: Without adding any protocol and device, the HMI will act as
MODBUS RTU slave.

How to set the station number of the slave station:

(DProject>Setup>ID.

(@Use N65128 to set directly on HMI.

B mview : [C:\Users\EN\Desktop\121.4f]

File Edit View Project HMI(M) Component Tool Windo
D.ﬁ v.ﬂ._ W v oou v | Y [ =
Zl L&k ah e A SR Y
Graphic Commnenti Static Comnonént Button ] Display | Edit | .
@ @E®= | e |
@ @ @@ @ @ & @ @ | English [Un_ite_d

]

Link Management
oW W | BB E | »

E‘"E TPeO70C
el % COM1

J—
B screen | & Link |k Tag|
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Currently only supports MODBUS RTU. Two methods for setting
communication parameters on HMI:

(@ Draw a diagonal line from the upper left corner of the HMI to enter the
system settings.

@Use the jump screen button to switch the screen to [65005: System

setting screen]
Back Button ot

push Button Control | status |

—Control —QOption
Scene Switch: Priority IE‘!' scene -v-!
_ Confirm | Press.action Ea
Switch Notes | ~| =W Key Def. !Undeﬂned -:!
Befor Macro: | ~] & Key Window | |ndefined Ea
AR MG | _'_] 3 Destine Voice lUndeﬂned -
Contraolled cond! L!
[™ Hide Obj.
[~ Hide as priority lack or disable
[~ Prompt as priority lack
[ Set Levle 9.

o DK I b4 Esncell

3.2 The variables available when HMI is used as a slave are as follows

F# Varisble Window '
—Variahle

Controller: 255 : System [St=255] v
Variable/Para.: | Type | Name | Range | 5p... | Description |

B3 WORD Mnnnnn 0-16383 1 Internal M...

B WORD Mnnnnn 16383 - 32767 1 Internal M...

B WORD Mnnnnn 32768 - 49151 1 Internal M...

B3 WORD Nnnnnn 49152 - 635335 1 Internal M...

Index Vnnnnn 0 - 32767 1 Internal P...

BIT MNTBnn 0-63 1 Timer sWi...

3 WORD MNTRnn 0-63 1 Timer curf...
Mumber:

W DK X cancel |
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The corresponding address number of HMI register in modbus
communication:

HMI internal
variables

400000~465535 NO~N65535

The corresponding address number of HMI bit component in modbus
communication:

In HMI, an internal variable N has 16 bits, where NO.0 corresponds to
0X0000, NO.1 corresponds to 0X0001, and so on...

Modbus NO.
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Appendix 10

Instructions of Coolmay HMI
communicating with other band PLC
Hardware specifications:
’ Pin number Description
TP6037C e
R5232 COM port definition
RXD Accept
USB port(In TXD Send
Hevelopment) GND _ Ground/DC24V]
RS485 COM port definition
LAN(In development) A 485+
B 485-
RX TX B A GND 24V HMI download port DC24V Power Supply
(Type C) 24V DC24V+
GND Ground/DC24V-

TP6043C

@ @ ®

COM1/COM2

FG OV 24V nl.
LAN(In development

HMI 232/485 port—

HMI download port (Type C)
USB port(In development)

TP6050C

®@ 66

COM1/COM2

Faovaan lHMI download port(Type C)
USB port(In development)
HMI 232/485 port

335

Pin No. Signal IDescriPtiﬂn
R5232COM port definition
2 RXD Accept
3 TXD Send
5 GND Ground
RS485 COM port definition
1 A 485+
6 B 485-
Pin No. Signal |Description
RS5232 COM port definition
2 RXD Accept
3 TXD Send
5 GND Ground
RS5485 COM port definition
1 A 485+
6 B 485-




TP6070C/HC

Optional SD card{in
development)
LAN{In development

HMI downlocad port{Type D)—J

WIFI switch{Optional)

TP6070KC

HMI download port(Type B)
HMI R5485

TP6100C

USB port (In development)
HMI download port(Type
LAN(In development)

1.Coolmay CX series

TP Series HMI Programming Manual

Pin No. Signal |Description|
RS5232 COM port definition
= = 2 RXD Accept
D@26 @6
cldiele 3 TXD Send
COM 5 GND Ground
R5485 COM port definition
Interface L a
FG OV 24V Bl 485-
HMI 232 port
HMI 485 port(Al B1)
Pin No. Signal Description
COM2Z RS5232 COM port definition
2 RXD Accept
VOB E 3 TXD | Send
(GRoRONE] 5 GND Ground
COM1/COM2 COM1 RS485 COM port definition
1 A 485+
FG OV 24V 6 B 485
HMI RS232
Pin No. Signal Description
RS232 COM port definition
2 RXD Accept
3 TXD Send
= 5 GND Ground
COM1 RS485 COM port definition
1 A 485+
FG OV 24V 8 = e

HMI 232/485 port

Method 1: Use RS232 connection

»TP software setting

Parameter item

Recommended settings

Protocol

CoolMay PLC(3U/3G)/FX3U

Communication port type

RS232

Communication rate

9600

336



TP Series HMI Programming Manual

Synchronization check Even parity
Number of data 7 digits
Stop digits 1 digit
Add Protocal | 28 |
—Protocol
Protocol: | cooMay PLC(3U/3G)/FX3U |
Controller:
Company | Model | Des...J
CoolMay CoolMay 3U Series PLC
Port: | Auto Detect(R5232/RS422/R5485) |
Baud Rate: |95|:||:| j Data Bit: |?Eﬂ:5 j
Parity: |E1.ren j Stop Bit: |1El'rt j
Delay: | oms j TimeQut: | 1ser j
I~ Multi-Station Smart Link Retry Count | Timeout, Repeat ~|
W 0K X Cancel |
» Operable variable
u Variable Window |5 B _|
—Variable
Controller: 0 : CoolMay 3U Series [5t=1] |
Variable/Para.: Type | Mame | Range | Sp... | Description | =
BIT Xooo 0 - 367 1 Inputs
BIT Yooo 0-367 1 QOutputs
BIT Mnnnn 0-7679 1 Auxilary r...
&m BIT Mnnnn 8000 - 8511 1 Spedal au... =
BIT Snnnn 0 -4095 1 States
BIT T5nnn 0-511 1 Timer con...
BIT Csnnn 0-255 1 Counter C... R
3@ WORD THRNM 0-511 1 Timer om...
0@ WORD CHnnn 0-199 1 Counter ...
DWORD CHnnn 200 - 255 1 Counterc... -
MNumber:
W 0K X Cancel |
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» TP(COMH1)-CX series PLC communication line connection diagram (use
CX2N series download line)

Method 2: Use RS485 connection
»TP software setting

Parameter item Recommended settings
Protocol CoolMay PLC(3U/3G)/FX3U
Communication port type RS485

Communication rate 9600

Synchronization check Even parity

Number of data 7 digits

Stop digits 1 digit
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Add Protocol | & |
—Protocol
Protocol: | cooMay PLC(3U/3G)/FX3U El
Controller:
Company | Model | Des...J_
CoolMay CoolMay 3U Series PLC
Port: | Auto Detect(R5232/RS422/R5485) =l
Baud Rate: |'Q‘ﬁ|:||:| j Data Bit: |?Eﬂ:5 j
Parity:  [Even ] Stop Bit:  [1pi =l
Delay:  [oms ~] TimeOut:  [15ec |
I~ Multi-Station Smart Link Retry Count | Timeout, Repeat ~|
W 0K X Cancel |

» Operable variable

H Variable Window |5 =l 2 _|
—Variable
Controller: 0 : CoolMay 3U Series [5t=1] |
Variable/Para.: Type | Mame | Range | Sp... | Description | =
BIT Xooo 0 - 367 1 Inputs
BIT Yooo 0-367 1 QOutputs
BIT Mnnnn 0-7679 1 Auxilary r...
&m BIT Mnnnn 8000 - 8511 1 Spedal au... =
BIT snnnn 0-4095 1 States
BIT TSnnn 0-511 1 Timer comn...
BIT Csnnn 0-255 1 Counter C... R
3@ WORD THRNM 0-511 1 Timer om...
E WORD CHnnn 0-199 1 Counter ...
DWORD  CMnnn 200 - 255 1 Counter c... -
Mumber:
W 0K X Cancel |

»TP(COM1)-CX series PLC communication line connection diagram
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TP series HMI side with 9-hole Coolmay PLC_SidE _
D-shaped female socket connected with 5pin
terminal
- P L
- 3
Y ! .'1
| " 'J
e —. L '
1 A A 485+
6 B B 485-

2. AD4401 (Japan AIAND weighing controller)
> TP software settings

Parameter item Recommended settings
Protocol AD-4401 Series
Communication port type RS232
Communication rate 9600
Synchronization check Even parity
Number of data 7 digits
Stop digits 1 digit
Add Protocol >
~Protocal
Protocol :
Controller:
Company | Model | Des... |
A&D AD-4401 via R5232 Indi...
Port: | Auto Detect(R5232/R5422/RS485) |
Baud Rate: igﬁnu ‘:j Data Bit: ]?B'rts ::j
Pariey:  [Even =] stop Bt [1a¢ =
Delay: ] s :_J TimeOut: ] 1sec ;J
I~ Multi-Station Smart Link Retry Count  [Timeout, Repeat ~|

v 0K I X Cancel]
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¥ Variable
B variable Window — O x
—Variable
Controller:
Variable/Para.: Type | Name | Range | 5p... | Description | "
W BIT DT Clears the...
BB EBIT MG Display th...
B BIT MM Display th...
BIT MZ Clears to z...
B EBIT MT Subtacts ...
BIT CcT Clears the...
B BIT BB Starts bat...
EWEIT BD Starts disc...
(W BIT HB Ernergenc...
r DWORD  SPn 0-7 1 Setpoint I ]
Number:
W 0K X Cancel |

> Diagram of TP(COM1)-AD4401 communication cable

341



TP Series HMI Programming Manual

HMI AD4401
: ‘ i
2 RS232 RXD RS232 RXD |2
3 RS232 TXD RS232 TXD |3
4 —+ RTS 4
5 GND 4 cTS 5
6 \% DSR 6
7 \T GND 7
8 —* D 8
9 9
SH(shell) 10
11
12
13
14
15
16
17
18
19
L4 DTR 20
21
29
23
24
25
SH(shell)
DBY(female )Connector DB25(male )Connector

2 1

20000
2000

2 &

1

L
[ EXEEEEEE R LR JF

3. Fuji MICREX-SX Series (Fuji)

»TP software settings

Parameter item

Recommended settings

Protocol

Fuji MICREX-SX Series
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Communication port type | RS232
Communication rate 38400
Synchronization check Even parity
Number of data 8 digits
Stop digits 1 digit
—Protocol
Protocol:
Controller:
Company | Model | Des... |
Fuji electric MICREX-5X Series PLC
Port: | Auto Detect(RS232/RS422/RS485) |
Baud Rate: igg.qm] ;i Data Bit: IBBitS ;I
Parity: lEven Li Stop Bit: IlEI'rt ;l
Delay: IDrns Li TimeQut: Ilsec ;I
[~ Mulki-Station Smart Link Retry Count ITiﬂ'IEDL.It, Repeat ;I

W 0K I X«Cancell

»Manipulable variable

B8 Variable Window A O x

—Variable

Controller:

Varable/Para.. | Type | Name | Range | Sp... | Description |
WORD MWaoooor 0-7FFF 1
WORD  OQW.ooox 0-7FFF 1
WORD MW1.x... 0-7FFF 1
WORD MW3.x... 0-7FFF 1
MEWORD  MWI10.... 0-7FFF 1

Number:

]

o OK I

X cancel |
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> TP-Fuji MICREX-SX Series Communication cable connection diagram (using

232 crossover cable)

PLC232 communication port connection diagram

HMI 9PIN female port PLC 9PIN female port
& i

RXD 2 |RXD
3 _|TXD 3 _|TXD

5 [GND f===t 5 [GND

4.Mitsubishi FX series
> TP software settings

&

Parameter item | Recommended settings

Protocol Mitsubishi Fx Series

Communication RS232

Communication 9600

Synchronization | Even parity

Number of data | 7 digits
Stop digits 1 digit
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—Protocol
Protocol:
Controller:
Company | Model | Des... |_
Mitsubishi FX Series PLC
Mitsubishi FX15 Series PLC
Port: | Auto Detect(R5232/R5422/R5485) |
Baud Rate: Igﬁnﬂ j Data Bit: I?B'rts j
Parity: |E1.ren j Stop Bit: IlB'rt j
Delay: I 0ms LI TimeOut: I 1gac j
[T Multi-Station Smart Link Retry Count ITimeuut, Repeat ;|
W OK X cancel I

»Manipulable variable

—Variable
Controller: 0 : FX Series [St=1] -]
Varible/Para.: Type | Name | Range | 5p... | Description | ”
W BIT Xooo 0-177 1
BIT Yooo 0-177 1
BIT Mnnnn 0-1023 1
EWBIT Mnnnn 8000 - 8235 1
BIT snnn 0 - 999 1
BIT Tnnn 0-255 1
BIT Cnnn 0-255 1
=3 WORD RTnnn 0-255 T
= WORD RCnnn n-199 i
EB DWORD DRCnnn 200 - 255 1 (¥
Mumber:
d

o 0K

» TP-FX Series Communication line connection diagram (using Mitsubishi

programming line, namely SC-11/SC-09)
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TP series touch side with 9 holes
D-shaped female connector

TP Series HMI Programming Manual

FX series PLC side with 8-pin
male connector

;
TEREY
'.'_?5, 13..:.
o

LEL

2 RXD PLC programming pc& pin definition .
[PIN number|  Signal Description
3 TXD 1 | RXD— | Accept negative
5 GND 2 RXD+ | Accept positive
3 GND ground
4 TXD- Send negative
5 +5V External power supply
6 CCS gg]’?rrc:;lu[mgation direction
T TXD+ | Send positive
8 NC Empty foot
5. Keyence KV series
> TP software settings
Parameter item Recommended
Protocol Keyence KV Series
Communication port type | RS232
Communication rate 9600
Synchronization check Even parity
Number of data 8 digits
Stop digits 1 digit
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—Protocol

Protocol:

Controller:

Port:

Parity:
Delay:

Baud Rate:

Keyence KV Series

Company

| Model

| bescc |

Keyence

K\ Series

PLC

|Auto Detect(RS232/RS422/R5485)

|os00 -
|Even -
|oms =]

[~ Multi-Station Smart Link

Data Bit:
Stop Bit:
TimeQut:

Retry Count

=]
=]

| 8Bits -
| 1Bit |
| 1sec |

lTimenut, Repeat ;‘

W OK I X Cancell

»Manipulable variable

—Variable
Controller:

Variable/Para.:

Number:

0 : KV Series [St=1] |
Type | Hame | Range | 5p... | Deseription | A
8 BIT _nnn 0-415 1 Input Relay
EWBIT _nnn 200 -915 1 CutputR...
EBBIT _nnnn 1000 - 6915 1 Internal R...
W BIT Rnnnnn 0-99915 1 Rely
EBBIT Bxoood 0 - 3FFF 1 Link relay
ENBIT MRnnnnn 0 - 99915 1 Internal a...
BIT LRnnnnn 0 - 99915 1 Latch relay
W BIT CRnnnn 0 - 3915 1 Control relay
EWBIT VBxzoox 0 - 3FFF 1 \Virtual rely
@& WORD DMnnnnn 0O - 65534 1 Data Mem...
@& WORD TMnnn 0-512 1 Temporar...
M@ WORD  EMnnnnn 0 - 65534 1 Extended...
& WORD FMnnnnn 0 - 32767 1 File reqister
@ WORD ZFnnnnn 0 - 99999 1 File register
MmWORD  Wooo 0 - 3FFF 1 Link register
E WORD TMnnn 0-511 1 Temporar...
MmWORD  Znn 1-12 1 Index regi...
3@ WORD CMnnnn 0 - 5999 1 Control m...
MmWORD  VMnnnnn 0 - 59999 1 wvirtual me...
DWORD  Tnnnn 0 - 3999 1 Timer
DWORD  TCnnnn 0-3999 1 Timer {cu...
DWORD  TSnnnn 0-3999 1 Timer (se...
DWORD  Cnnnn 0-3999 1 Counter
DWORD  CCnnnn 0-3999 1 Counter {...
DWORD  CSnnnn 0-3999 1 Counter (...
DWORD  CTHn 0-3 1 High-spee...
DWORD CTCn 0-3 1 High-spee... -
=
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»TP-Keyence KV Communication line connection diagram

HMI KV series
b R5232 RXD \
3 R5232 TXD [ RXD 3
GND 4
5 GMND TXD 5
DBY9{female)Connector RJ12
5 1
g 6
6.Koyo K sequence series
»TP software settings
Parameter item Recommended
Protocol Koyo K sequence
Communication port RS232
Communication rate 9600
Synchronization check | Odd parity
Number of data 8 digits
Stop digits 1 digit
—Protocol
rataco 7
Controller:
Company Model Des...
Koyo Koyo DL Series PLC
Port: |Auto Detect(RS232/R5422/R5485) |
Baud Rate: |95IJD L] Data Bit: |SBit5 L]
Parity: |Ddd L] Stop Bit: |lBit L]
Delay: | 0ms L] TimeQut: | 1gar L]
[~ Multi-Station Smart Link Retry Count  [Timequt, Repeat v |
W OK | X Cancel ‘
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»Manipulable variable

Varigble
Controller: 0 : Koyo DL Series [St=1] Rd
Variable/Para.: Type | Name | Range | 5p... | Description |
BIT Xoooo 0 -3777 1
BIT Yoooo 0 - 3777 1
&8 BIT Toooo 0 - 3777 1
BIT Coooo O - 3777 1
BIT Soo00 0 - 3777 1
BIT Moooo O - 3777 1
BIT Poooco 0 -7777 1
BIT SPoooo O - 3777 1
=8 BIT GQoooo O - 7777 1
BIT GXoooo 0 - 7777 1
Number: M@ WORD Vooooo  0-77777 1

................................

U0 % cancel |

»>TO-Koyo K sequence Communication line connection diagram

HMI DL205

1 ov 1

2 R5232 RXD \ av 2
3 RS232 TXD ¢ — J RXD 3
4 TXD 4
5 GND oV o
ov 5]
DB9(female )Connector RJ12
5 1
Q0000
o000
9 B
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HMI DL250
1 av 1
2 R5232 RXD T 1 TXD2 2
3 R5232 TXD . ! RXD2 3
4 I:] RTS2 4
3 GND CT32 2
RXD2-(RS422)| 6
ov 7
DBS(female)connector DB15(female)connector
5 1 s 3
a‘e‘a.a.o "DTE;;':_';? :
g B 5 11
7.LG series

>TP Software settings

Parameter item Recommended settings
Protocol LG Master-K K120S Series
Communication RS232

Communication 38400

Synchronization | No information

Number of data 8 digits

Stop digits 1 digit
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—Protocol
S MasterK K1205 Series
Controller:
Company | Model | Des... |
LG k1205 Series i i
Port: | Auto Detect(RS232/RS422/R5485) -
Baud Rate: |35‘4|:||:| ;l Data Bit: IBBTtE Ll
Parity: |Nnne ;| Stop Bit: IlBit Ll
Delay: | 0ms ;| TimeOut: I 1gec Ll
™ Multi-Station Smart Link Retry Count  ITimeout, Repeat |
v 0K X cancel |
»Manipulable variable
—Wariable
Controller: 0 : K1205 Series [5t=1] |
Variable/Para.: Type | Name | Range | 5p... | Description |
BIT Prnx 0o - B3F 1 I/O Relay
BIT Mnnnx 00 -191F 1 Auxilary R...
W BIT Knnx 0o - 31F 1 Keep Relay
BIT Lrnx 00 - B3F 1 Link Relay
BIT Fnnx 00 -B63F 1 Special Re...
BIT Tnnn 0-255 1 Timer
BIT Cnnn 0-255 1 Counter
WORD TVnnn 0-235 1 Timer Value
= WORD Cvnnn 0-235 1 CounterV...
3@ WORD Onnnn 0 - 4999 1 Data Reqi...
Number:
¥ OK

»TP-LG Master-K120S Communication line connection diagram
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2 R5232 RXD

3 R5232 TXD

e

TP Series HMI Programming Manual

K1205 series

RS232 TXD 2

RS232 RXD 3

5 GND ’-
DBY(female )Connector
i
g B

8. OMRON C series
>TP Software settings

ﬂ GMD o

DB9({male)connector

Parameter item Recommended settings
Protocol Omron C Series
Communication port RS232
Communication rate 9600
Synchronization check | Even parity
Number of data 7 digits
Stop digits 2 digits
rProtocol
eitoel i
Controller:
Company Model Pes. | =
Ormron C Series PLC
omron CV Series PLC
Omron C11G/H Series PLC
Qrmron CI1M Series PLC &
Port: |Auto Detect(RS232/RS5422/R5485) |
Baud Rate: ]Qﬁl:ll:l _:_| Data Bit: I?El'rts _:_|
Parity: [Even | stop Bit: | 2Bits ]
Delay: I 0ms l.| TimeOut: I 1sec :J
I™ Mutti-Station Smart Link Retry Count  |Timgout, Repeat |
v oK X cancel ‘
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»Manipulable variable

“Wariable-
Controller:

Variable/Para.:

MNumber:

»TP-OMRON communication cable connection diagram

TP series touch

side with
9 holes D-shaped
fermale connector

0 : C Series [St=0] -]
Type | MName | Range | Sp... | Description
BIT Rnn.an - 0.0 - 511.15 1
BIT HRnn.n 0.0 - 99.15 1
&8 BIT ARn.ON 0.0 - 27.15 1
BIT LRnn.nn - 0.0 - 63.15 1
@@WORD PVnnn  0-511 1
@3WORD DMnnnn 0 - 6655 1
W8 BIT TCnnn  0-511 1
)
W OK |

Mseries PLC side 9-pin

D-shaped male connector

){' 3 RXD

2 TXD
9 GND

9.Siemens S7-200 series

>TP Software settings

Parameter item

Recommended settings

Protocol

Simatic S7-200 Series

Communication

RS485

Communication

9600

Synchronization

Even parity
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Number of data 8 digits
Stop digits 1 digit

Communication 1 second

—Protocol
Protocol:
Controller:
Company | Model | Des... |
SIEMEMS Simatic 57-200 PLC
Port: |Auto Detect(RS232/RS422/RS485) |
Baud Rate: IQEIDU ;l Data Bit: ISBitS Ll
Parity: |Even ;' Stop Bit: |lﬂit Ll
Delay: | 0ms ;' TimeOut: I 1gar Ll
[~ Mutt-Station Smart Link Retry Count  |Timeout, Repeat |
V' 0K X cancel |

»Manipulable variable

—Variable
Controler: 0 : Simatic 57-200 [St=2] |
Variable/Para.: Type | Name | Range | Sp... | Description |
mWWORD VWnnnn 0 -8190 2
& WORD TWnnn 0-233 1
& WORD CWnnn 0-235 1
=3 WORD ATWNN 0-63 1
M3 WORD AQWnn 0-63 1
BIT In.nn 0.0 -15.7 1
BIT Qn.nn 0.0 -15.7 1
EBEIT Mnn.nn 0.0-127.7 1
BIT snn.nn 0.0-127.7 1
BIT SMnn.nn 0.0-127.7 1
Number:
-

o 0K
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»>TP-Siemens S7-200 communication line connection diagram

TP series touch side with 9 holes S$7-200 series PLC side 9 pin
D-shaped female connector D type male connector

A ———
B

1
6

10.Delta DVP series
»TP Software settings

Parameter item Recommended settings
Protocol DELTA DVP Series
Communication port type | RS232

Communication rate 9600

Synchronization check Even parity

Number of data 7 digits

Stop digits 1 digit

Communication timeout 1 second

rProtocal
RGN D E| TA DVP Series -
Controller: - - -
Company | Model | Des...
DELTA DVP ES/EX/SS Series PLC
DELTA DVP SA/SX/SH Series PLC
DELTA DVP EH Series PLC
DELTA DVP ES2/EX2/552 Series PLC
Port: | Auto Detect(R5232/RS5422/R5485) |
Baud Rate: ]gﬁnu :J Data Bit: |?Eit5 :J
Parity:  [Even E Stop Bt:  [1pg -
Delay: I oms LJ TimeOut: | 1gac _d
[ Multi-Station Smart Link Retry Count ]Timenut, Repeat LJ

W 0K | X cancel |
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—Variahle

Controller: 0 : DVP ES/EX/SS Series [St=1] -]
Variable/Para.: Type Name Range 5p... | Description | "

BIT Xooo 0-177 1 Inputs

BIT ¥ooo n-177 1 Oufputs

BIT Mnnnn 0-1279 1 Auxiliary r...

BIT snnn 0n-127 1 Sigtes

BIT TSnnn 0-127 1 Timer con...

BIT CsSnnn n-127 1 Counter c...

BIT CsSnnn 232 - 255 1 Counter c...

=3 WORD THnnn 0-127 1 Timer curr...

= WORD CHnnn 0-127 1 Counter c...

DWORD  CHnnn 232 - 255 1 Counter c... ¥
Mumber:

E
Tk % cancel |

»TP - Delta DVP communication cable connection diagram

HMI

2 R3232 RXD

3 RS232 TXD

5 GMND

DBY(female)connector

X
9 B
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DVP-ES2

GMND 3

R5232 RXD 4

RS232TXD | 5
2 1

© 0
Os 40 0|3
209

7




HMI

2 RS5232 RXD

3 RS232 TXD

o GHND

DB9{female )connector

5 1

29809
Do0Y

9 B

11. Xinje PLC series
>TP Software settings

P~

TP Series HMI Programming Manual

DVP-ES2-EX2-582-5A2-8X2

p R5232 RXD

\ RS232 TXD

« 4 GND

mini DIN&(male)connector

Parameter item

Recommended settings

Protocol Xinjie PLC Series
Communication port type | RS232
Communication rate 19200
Synchronization check Even parity
Number of data 8 digits

Stop digits 1 digit
Communication timeout 1 second
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Add Protocol |_E§._I
—Protocol
Protocol:  |xinje PLC Series |
Controller:
Company | Model | Des... |
Xinje Xinje XC PLC Series PLC
Xinje Xinje XD/¥L PLC Series PLC
Port: | auto Detect(RS232/RS422/R5485) ]
Baud Rate: Ilgzm] j Data Bit: IHE“ZS j
Parity: IB,EH j Stop Bit: IlE'rt j
Delay: I ams j TimeOut: I 1sec j
I Multi-Station Smart Link Retry Count | Timeout, Repeat v|
W 0K X Cancel |
»Manipulable variable
H Variable Window |E_E 2 )]
—\ariable
Controller: 0 : Xinje XC PLC Series [St=1] |
Variable/Para.: Type | Mame | Range | 5p... | Description | .
BIT Xooo 0-511 I
BIT Yooo 0-511 1
BIT Mnnnn 0-7999 i
8 BIT Mnnnn 8000 -8511 T £
@ BIT Snnnn 0-1023 1
BIT Tnnn 0-p618 I
BIT Cnnn 0-6834 1 R
@& WORD Dnnnn 0-7999 I
&8 WORD TDnnn 0-618 I
&3 WORD COnnn 0-634 1 gt
Number:
v OK X cancel |

» TP - Xinje PLC communication line connection diagram
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HMI Xinjie XC Series

z RS232 RXD

RS232 RXD 4

3 | RS232TXD s RS232 TXD 3
T —

o GND GND 6

DB9(Female)interface Mini DIN8{Male)Interface
5 1

20000
000@

9 6

12. Matsushita PLC series
>TP Software settings

Parameter item Recommended settings

Protocol Matsushita FP Series

Communication port type | RS232

Communication rate 9600

Synchronization check Odd parity

Number of data 8 digits
Stop digits 1 digit

Communication timeout 1 second
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' Add Protocol | & |
—Protocol
Protocol:  |matsushita FP Series =l
Controller:
Company | Model | Des... |_
Matsushita FPO Series PLC
Port: | Auto Detect(R5232/RS422/R5485) -l
Baud Rate: g0 ~| Data Bit: | 8Bits |
Parity: |odd | Stop Bit: |1Bit |
Dely:  [oms ~] TimeOut:  [1gec |
[~ Multi-Station Smart Link Retry Count | Timeout, Repeat ~|
W 0K X Cancel |

»Manipulable variable

ﬂ Variable Window | EE P
~Variable
Controller: 0 : FPO Series [St=1] |
Variable/Para.: Type | Name | Range | Sp... | Description | -
BIT xnnnx a0 -511F 1 Bxternali...
BIT Ynnnx a0 - 511F 1 Bxternal o...
BIT Rnnnx 00 - 886F 1 Internalr...
&8 BIT Rnnnx o000 - 910F 1 Spedalint... E
EWBIT Tnnnn 0-3071 1 Timer
W BIT Cnnnn 0-3071 1 Counter
BIT Lnnnx 00 - 639F 1 Link relay 8
& WORD DTnnnnn 0 - 32704 1 Datz reqgis...
M@ WORD  DTnnnnn 90000 - 20511 1 Specal da...
@& WORD svnnnn 0-3071 1 Timer/Co... -
Mumber:
& 0K I X cancel |

»TP- Matsushita PLC communication line connection diagram
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HMI Matsushita FP Series
2 | RS232RXD ‘\
3 | RS232TXD SD
\ -
5 | GND * Ps 5G

DB9(Female)Interface
=] 1

@000
2000

9 6

Appendix 11 HMI program simulation and download

11.1 Program simulation

TPWorks provides the function of simulating directly on the PC. You can
use this function to simulate the actions performed on HMI after planning HMI.
On the one hand, it increases the convenience of finding program errors, and
on the other hand, it can save downloading to the time HMI can connect to the
controller. The simulation function of TPWorks is divided into two types:
[On-Line Run] and [Off-Line Run], as shown in the figure below.

File Edit View Project | HMI(M) Component Tool Window Help

RER T ~ R ¥z Syntax Check ... F8 | B i
: el I A A % & On-Line Run FO s v & v oo
& Off-Line Run Shift+Fg |

Graphic Companent ] Static Ce

Download to HMI ...  Cirl+AlE+S

P & B\ Save To File ... ']

Link Management | Setup | [
=i =l =] M M A L%
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11.1.1 On-Line Run

This function needs to be connected to the controller, and the program will
modify the corresponding contacts and registers set by the controller during
execution. It can be used to verify whether the planned program can normally
act on the controller.

Before [On-Line Run], you need to set up the communication, as shown in
the figure below:

. - a I S |
HMI(M) Component Tool Window Help
~| ¥z Syntax Check ... FB |8; ~ | B | v oi| & FF
.-E} On-Line Run FO s v g v2 | o i ~o
~{ 4w Off-Line Run ShiftskFd | -
g Bk Be®Ya s
= I@ Download to HMI ...  Ctrl+Alt+5 F :
£ %9 save To File .. | ']_. |
! [

Iy

Protocol Set...

Upload/Download Simulate COM Set

—COM Port Set-
COM1: |comt ]
ComMz2: lcomz - (z-TEK USB-to-Serial Comm |

Among them, COM1 and COM2 on the left of [Communication Setup]
refer to the communication ports on HMI, and the setting on the right is the set
of communication ports designated by the user on the PC side to simulate the
sex-corresponding communication ports of HMI side ,As shown below:
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A Computer Management
File Action View Help
=% 25 E HE B

& Computer Management (Local|| + :.'.; DESKTOPR-IFJ55LE
w '[['j System Tools ij| Audic inputs and outputs
@ Task Scheduler g Bluetooth
@ Event Viewer ® Cameras
22| Shared Folders m Computer
) ,E Local Users and Groups = Disk drives
@'l‘,l Performance [E3 Display adapters
M Device Manager F#) Human Interface Devices
w 22 Storage == |DE ATA/ATAP| controllers
= Disk Managerment :|“: Imaging devices
+ G Services and Applications & Jungo
= Keyboards
@ Mice and other pointing devices
[ Monitors
[ Metwork adapters
v [ Ports (COM & LPT)
ﬁ STMicroelectronics Virtual COM Port (COME)
ﬁ Z-TEK USB-to-Serial Cornm Port (COM3)

Protocol Set...

Upload/Download Simulate COM Set ]

COM Port Set
CoM1: |comé - (STMicroelectronics Virtual 1 - |
ComM2: |coMS - (Z-TEK USB-to-Serial Comm |

o DK X Cancel |

11.1.2 Off-Line Run

This function does not need to be actually connected to the controller, it
can be used to test the normal operation of the program and the verification of

various functions.

11.2 Program download and update O.S. version
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After using the PC to simulate and verify that the program is correct, you
can start downloading to the HMI and directly use HMI to connect to the
controller.

11.2.1 Download to HMI

Before downloading the program to HMI, you need to make
communication settings first, please select [HMI]—[Setup] = [Communication
Setup], as shown in the figure below:

HMI(M) Component Tool Window Help

E}__ Syntax Check ... B |8, ~ | B By 1| By
| & On-Line Run FO Flfy w & - B2 - | i @~
| & Off-Line Run Shift+Fa |

—— — b BeEB e
| Im Download to HMI ...  Ctrl+Alt+5 [ 7

"’ Save To File .. s

—
Ev1l -

T - [T

Protocol Set...

Upload/Download ]Simulate COM Set |

—COM Port Set

Connection Device: [COM6 - (STMicroelectronics Virtual | v |

(" Fix Baud Rate(115200,N,8,1)

Order Setting Connect... R
Flo  115200,None,8 Bits,1 Bt 2 =
1 9600,None,7 Bits,1 Bit 0
M2  9600,Even,7 Bits,1 Bit 0
M3  9600,0dd,7 Bits,1 Bit 0
[04 9600 Mask,7 Bits,1 Bit 0
M5 Ga0n.Snace.7 Rits.1 Rit M b
& OK X Cancel l

Specify the communication port of the PC in the [Upload/Download] of the
communication setting window, that is, the port where the download cable is
connected to the PC. For example, COM6, you can select [Use fixed
communication rate] in conjunction with HMI [download screen], or let the PC
automatically try to download at different rates.

Then select [HMI] — [Download to HMI], and then start to download the
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HMI program to the HMI, as shown below:

HMI(M] Component Tool Window

4% Syntax Check ... =3
| & On-Line Run Fag
| & Off-Line Run Shift+Fg

J Download to HMI ..  Ctrl+Alt+S

Download 4

Download Time:
Download Data 81912 Bytes, Meed 12 Sec.

¥ Turbo Download(Valid aft. 05 v1.21, RS5485 non-valid)
COM Port Set: |comé - (STMicroelectronics Virtual COM Port » |

—Cption-
™ Init Register ™ Init Station ID Group
[~ Update Password ¥ Update RTC

[ Clear Retentive Reg.

Download: X cancel | ty Setup |

11.2.2 Save as HMI program

In addition to directly downloading the planned program to HMI, TPWorks
also provides the user to save the planned program into a specific file (*.tpo).
For downloading and using in the future, it should be noted that this file is only
for downloading and its content cannot be modified.

Select [HMI]—[Save project as file...] to save the project as a special file
for man-machine of type tpo, as shown in the figure below:

365



TP Series HMI Programming Manual

HMI(M) Component Tool Window
< %2 Syntax Check ... F&
| £ On-Line Run Fa
. & Off-Line Run chift+FQ
.
d B Stop Cirl+F9

= Download to HMI ...  Ctrl+Alt+5S

| Setup r

After you need to download this program to the HMI, select
[Tool]—[Download HMI Program], as shown below, you can download this
program to HMI.

e
|Download HMI ...
1 Upload HMI ...

T Update HMI OS5 ...

Language Select
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B open
Look in: | test
g MName
§123.4
Quick access E B2
Desktop
| |
Libraries
This PC
Network
4
File: name:
Files of type:
Download

Download Time:

x| e Bk Er
Date modified T
2020-08-19 10:23

-

|123. tpo L] Cpen
|mView HMI Object File (" tpo) =] Cancel
>

Download Data 81912 Bytes, Meed 12 Sec.

¥ Turbo Download(Valid aft. 0S v1.21, RS485 non-valid)

COM Port Set: |comé - (STMicroelectronics Virtual COM Port » |

Qpftion
[~ Init Register

[~ Update Password

[~ Init Station ID Group
W Update RTC

[~ Clear Retentive Reg.

X cancel | ty Setup |

11.2.3 Update HMI OS

Generally speaking, when the new version of TPWorks software is
updated, it will be matched with the corresponding version of the OS. This OS
supports the old version of the planning software downwards, but if the user
wants to use the functions provided by the new version of the planning
software, the new version must be matched OS and HMI OS are updated as

follows.

Step 1: Select [Tools]—[Update HMI OS].
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T4 Download HMI ...
e Upload HMI ...

A IEREERdRE T VK=
|553'|1%-?:ﬁ|‘|1'3|h |E";;_;?ﬁ"

e
Graphic Cnmponentl Static Commnent! Button Display
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j | Update HMI OS ... i

lﬁi.|@|rgﬁ|§ Language Select *E%I

Step 2: Select the OS version to be updated (it is recommended to update with

the planning software version used).

B Open 05 File X
Look in: | | | mView 1.38.02 T e ®@EekE
* MName Date modified Type
: 1028 &/21/2020 701 PM File folder
Quick access )
1033 8/21/2020 7:01 PM File folder
d 2052 8/21/2020 7:01 PM File folder
Desktop model 8/21/2020 7:01 PM File folder
— picture /2172020 T:05 PM File folder
™ protocol 8/21/2020 7:01 PM File folder
Libraries repositary 8/21/2020 7:01 PM File folder
§ res 8/21/2020 7:01 PM File folder
= runtirme 2/21/2020 7:01 PM File folder
e 5 ush driver 8/21/2020 7:01 PM File folder
@ 7] vx0513802.v0s 8/18/2020 9:31 AM VOS5 File
Metwark
£ >
File name: i| j Cpen
Files of type: lm‘u“lew 05 File {* bin;* vos) _ﬂ Cancel |
]

Step 3: Start downloading. (Note: During the OS download process, the HMI

must not be powered off!)

Update 0%

Cownload Time:SSec
Cownload 21248 Bytes

x

- |

COM Port Set: [com6 - (STMicroelectronics Virtual COM Port |

X Cancel G Satup
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Step 4: After the download is complete, restart the power of the HMI.

h
i

Dowmn .
Finish F h Update 05 Finish!Turn off HMI, and turn on.
(][] ]
oK |

T o mm

«" Finish | 2% Cance Gt Setup |

11.3 Program upload

Use this function to upload the program in the man-machine back to the
PC and save it as an HMI program for later downloading or editing by the user.

11.3.1 Upload HMI program

Select [Tool]—[Upload HMI Program] to upload the program from the HMI
back to the PC. After the transfer is complete, the user will be asked to save
the file as a dedicated file named tpo, as shown in the figure below:

File Edit View Project HMIM) Component :TDCI' Window Help
f OE - E o ¥ By il Dcuwnl::rad HMI ..
Eﬂﬁn?—"’:@h R N ol o AR
' Gral:lhu: Component | Static Cnmmnent] Button D|5D|EIY h Hprate Ha e -~ :
[:3,. O = EEeE E - E E E Language Select »

»o
EH
I
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Upload from HMI ot

Upload Time:7Sec
Upload 22272 Bytes

COM Port Set: |ch5 - (STMicroelectronics Virtual COM Port ~|

w7 Upload I X cancel | T Setup |

To make the uploaded program editable, you must add the decompiled
information before downloading the program, otherwise the uploaded program
can only be used for downloading, and the user cannot edit it.

Select [View]—[Option(H)]—[File], and tick [Add Decompiled Information].

As shown below:

Window Help

File Edit | View Project HMI[M] Comp-onent Tool
[3 = = [ Project Management

g | B Message

T - o

Repository

GraphicCe  Component List

s | @ [orpmmmmres

(@ @ G_ Object Propertes [mEEE)
— B Scale L

I_‘-’% ToolBar »

=1 (=1
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| % |
Aux. Setup . B et T TEr el
Snap/Grid I Aux. Data of Obj. I Component Ed Frame Size Transfer'
—Setup

v Auto. Add Protocol after Open File
[~ Save File ? Close Window

[T Archive, automatically backup files
v Automatic backup old files

¥ Program start automatically open file

"De compiled Information

v Add Decompiled Information

¥ Program Compression

¥ 0K X Cancel |
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Appendix 12 HMI USB penetrating function

The penetrating communication function provided by HMI is to use PLC
programming software on the computer and connect to the PLC through the
man-machine interface connected to the computer. In this way, you can
monitor, upload, and download PLC programs.

- -
e =W

PC HMI PLC

Serial connection

As shown in the figure above, the connection between PC and HMI is
USB (virtual serial port), and the connection between HMI and PLC is serial
connection. For debugging convenience, the PC can directly download or
monitor PLC programs through HMI to improve work efficiency.

Note: Single screen COM1 means RS232, COM2 means RS485;

All-in-one machine COM1 means using HMI and PLC internal
communication port, COM2 means using HMI RS232 or RS485.

1. COM1 penetration communication

Step 1: Set a screen button on the HMI program interface, select [65021:
Virtual connection COM1] for [Screen Switch]; download the program to the
touch screen.

| Screen Button X

Push Button Control | Status |

—Control - Option- T
Screen Switch: R ~ Priority |By scene =l
h Confirm |Press.action |
Switch Notes -

| | = Kay Def. [Undefined ~|
Befor Macro: | x| & Key Window | ndefined =
o faer: | _"_J 2 Destine Voice |Undeﬁned -
Controlled cnndq _vj ]

™ Hide Obj.

[~ Hide as priority lack or disable
[ Prompt as priority lack
[~ SetLevle 9.

o 0K | X Cancel‘
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Step 2: HMI and PLC are connected through HMI COM1, the touch
screen is switched to this page, and the PC can directly download or monitor

Enter this screen,USB<->COM1

2. COM2 penetration communication

Step 1: Set a screen button on the HMI program interface, select [65022:
Virtual connection COM2] for [Screen Switch]; download the program to the
touch screen.

| Screen Button >

Push Button Control | status|

Control 1 Option

CECLUR B 6557157 - Virtual connectiohg Priority |By scene |
. Confirm |Press.action =]
Switch Notes | _vj Key Def. |Undeﬂned L]
Befor Macro: | x| @ Key Window  |yndefined =l
e | _'J 3 Destine Voice |Undeﬂned -
Controlled cundi| _vJ 1]

[ Hide Obj.

[ Hide as priority lack or disable
[~ Prompt as priority lack
[ Set Levle 9.

W OK | X Cancel‘
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Step 2: HMI and PLC are connected through HMI COM2, the touch
screen is switched to this page, and the PC can directly download or monitor
PLC programs through HMI.

Enter this screen,USB<->COM?2

3. The data of COM1 and COM2 penetrate each other
Step 1: Set a screen button on the HMI program interface, select [65011:
Virtual Online] for [Screen Switch]; download the program to the touch screen.

Screen Button X

Push Button Control | status |

Control Option

Sl H 65011 ¢ Virtual connectiohg Priority |By scene =l
. Confirm |Press.action Rd|
Switch Notes | L‘ [ ] Key Def. [Undeﬁned _'_l
Befor Macro: | ~| & Key Window  ||ndefined -]
T I Ll 9 Destine Voice [undeﬁned >
Controlled condq j -

[ Hide Obj.

[ Hide as priority lack or disable
™ Prompt as priority lack
™ Set Levle 9.

v 0K I X cancel ‘

Step 2: Connect COM1 and COM2 of HMI to serial controller respectively,
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the touch screen will switch to this page, and the controllers connected to
COM1 and COM2 of HMI can transmit data to each other;

When you enter this frame, it will stop all the
communication and PLC connection.
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Appendix 13 Version Change Record

Date Char)ged Change content
version
€ Appendix 8 -- Simple operation steps 6.,
Dec.2021 | v21.121 correct the mistake

€ 12.2.2 Introduction to Function Syntax-- 4.
_REGCPY, change parameters
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